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Introduction
This guide describes the features and procedures that are specific to the Siebel Life 
Sciences applications (which consists of Siebel ePharma, Siebel eMedical, and 
Siebel eClinical). It should be used in combination with other books in the Siebel 
Bookshelf CD-ROM. However, the information in this book supersedes information 
about standard Siebel products provided in other documentation. In addition, some 
configuration information that is specific for Siebel Life Sciences is included in this 
guide.

This book will be useful primarily to people whose titles or job descriptions match 
one of the following:

Call Center 
Administrators

Persons responsible for setting up and maintaining a call center. 
Duties include designing and managing Computer Telephony 
Integration (CTI), SmartScripts, and message broadcasts.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Trainers Persons responsible for training end users of the Siebel Life 
Sciences application.
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Introduction

How This Guide Is Organized
How This Guide Is Organized
This book is divided into four parts.

The first part contains information that applies to the initial setup of Siebel Life 
Sciences.

The remaining chapters are divided into parts according to whether they describe 
functions of Siebel eClinical or of Siebel ePharma, or functions common to all Life 
Sciences applications.

The chapters in this guide are workflow-oriented. Each chapter guides you through 
an example workflow that illustrates the use of the important Siebel Life Sciences 
screens and views. 

Configuration information related to the features described in the chapter is 
included at the ends of the chapters, as appropriate. General Siebel Life Sciences 
configuration information is provided in Appendix A, “Information for Siebel 
Application Developers.”
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Revision History
Revision History
Siebel Life Sciences Guide, Version 7.5, Rev. A

March 2003 Bookshelf
Table 1. Changes Made in Rev. A for March 2003 Bookshelf

Topic Revision

“Importing Data with Siebel 
EIM” on page 412

■ Replaced all information (text, figure, procedures, 
and table) with updated version. This information 
overlapped the information found previously in 
Siebel Data Warehouse Installation and 
Administration Guide. 

■ Added text and new heading to introduce table 
previously included in Siebel Data Warehouse 
Installation and Administration Guide.

■ Merged information under two separate headings 
(both called “Data and Related Interface Tables”) 
into one heading.

“Loading Data into the Siebel Life 
Sciences Database” on page 421

Replaced all information with updated version 
previously included in Siebel Data Warehouse 
Installation and Administration Guide.

“Using SQL*Loader to Load the 
Data” on page 423

Replaced all information with updated version 
previously included in Siebel Data Warehouse 
Installation and Administration Guide.

“Troubleshooting Syndicated 
Data Loading” on page 432

Replaced all information with updated version 
previously included in Siebel Data Warehouse 
Installation and Administration Guide.
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Getting Started 1
This chapter lists the applications administration tasks that are specific to Siebel 
Life Sciences. Use this chapter in combination with Applications Administration 
Guide, the main guide for performing administrative tasks.

Applications Administration Guide covers the setup tasks that are common to all 
Siebel eBusiness Applications, such as using license keys, defining employees, and 
defining your company’s structure. It also provides the information you will need 
to implement, configure, and monitor the Sales, Service, and Marketing products 
and to perform Data Administration and Document Administration tasks.

Some tasks listed in this chapter might replace those in the administration guide 
whereas others might be additional tasks. Make sure you review Table 2 on page 20 
before following the procedures in Applications Administration Guide. 

This guide assumes that you have already installed Siebel Life Sciences or 
completed an upgrade from another Siebel application. If you have not, refer to the 
Installation/Upgrade section of the Siebel Bookshelf and click the links to the guides 
that are relevant to your company’s implementation.

The Siebel database server installation script creates a Siebel administrator account 
that can be used to perform the tasks described in this guide. For information about 
this process, see the Siebel Server Installation Guide for the operating system you 
are using, and Siebel Server Administration Guide.

CAUTION: Do not perform system administration functions on your local database. 
Although there is nothing to prevent you from doing this, it can have serious results, 
such as data conflicts, an overly large local database, or a large number of additional 
transactions to route.
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Siebel Life Sciences Administrative Setup Procedures
Siebel Life Sciences Administrative Setup Procedures
Table 2 lists the administrative setup procedures that are specific to Siebel Life 
Sciences and procedures that might differ from those of the other Siebel eBusiness 
Applications. The table also directs you to documentation containing information 
about each task.

When setting up your application, use Table 2 in combination with the main 
resource, Applications Administration Guide. 

Table 2. Siebel Life Sciences Administration Tasks 

Administrative 
Task Description For More Information

Define sales 
territories

■ Define sales territories and set 
up the territory assignment 
process

■ Siebel Assignment Manager 
Administration Guide

■ Chapter 3, “Managing 
Contacts”

Define medical 
specialties

■ Defining medical specialties

■ Defining account specialties

■ Specifying a contacts’s 
primary specialty

■ Chapter 3, “Managing 
Contacts”

Set up bricks ■ Defining bricks

■ Associating a brick with a 
contact address

■ Chapter 3, “Managing 
Contacts”

Define decision 
issues

■ Defining decision issues ■ Chapter 3, “Managing 
Contacts”

■ Chapter 18, “Managing 
Products”
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Managing 
Samples

■ Establishing and reconciling 
initial master inventory

■ Transferring inventory to end 
users

■ Monitoring samples activities 
(disbursements, orders, 
transfers between employees, 
user inventory counts, and 
inventory adjustments)

■ Setting up and maintaining a 
home-office master inventory 
(optional)

■ Defining lot numbers 
(optional)

■ Managing electronic 
signatures

■ Identifying sample locations in 
the event of recalls

■ Determine the number of open 
(unreconciled) inventory 
periods allowed

■ Disabling samples tracking by 
lot number

■ Allowing sample product 
reconciliation without lot 
numbers (optional)

■ Chapter 6, “Managing 
Samples” 

■ Appendix A, “Information for 
Siebel Application 
Developers”

Specifying a 
Competitor

■ Deleting an account 

■ Creating or identifying a 
competitor

■ Chapter 7, “Administering and 
Managing Accounts”

■ Chapter 3, “Managing 
Contacts”

■ Chapter 5, “Recording Calls”

Table 2. Siebel Life Sciences Administration Tasks 

Administrative 
Task Description For More Information
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Siebel Life Sciences Administrative Setup Procedures
Administer 
Smart Calls

■ Creating a smart call template 
and making it available to end 
users

■ Chapter 8, “Creating Smart 
Calls”

■ Chapter 6, “Managing 
Samples”

Configuring 
Time Off 
Territory

■ Configuring Time Off Territory 
approval process

■ Chapter 10, “Tracking Time 
Off Territory”

Administering 
MedEd

■ Setting up funds for medical 
education plans and 
associating them

■ Creating MedEd master plans

■ Creating MedEd activity 
templates

■ Customizing the list of 
available drop-down values 
and adding literature items to 
the application

■ Designating contacts as 
medical education speakers

■ Chapter 11, “Managing MedEd 
Events”

■ Interface Tables Reference for 
Siebel Industry Applications

■ Siebel Enterprise Integration 
Manager Administration 
Guide

Creating a 
Clinical 
Program

■ Adding a protocol

■ Setting up regions (Optional)

■ Defining a subject visit 
template

■ Revising protocols

■ Chapter 13, “Setting Up and 
Carrying Out a Clinical Trial”

■ Chapter 18, “Managing 
Products”

■ Chapter 14, “Managing Sites 
and Clinical Contacts”

Creating and 
Modifying a 
Site

■ Setting site-level budgeting

■ Entering information for 
subjects

■ Setting up visits and activities 
for subjects

■ Creating activity plans

■ Chapter 14, “Managing Sites 
and Clinical Contacts”

Table 2. Siebel Life Sciences Administration Tasks 

Administrative 
Task Description For More Information
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Setting Up 
Standard 
Payments

■ Standard payment amounts in 
subject visit template

■ Chapter 15, “Setting Up and 
Making Subject 
Activity Payments”

Creating Trip 
Report 
Templates

■ Creating trip report templates ■ Chapter 16, “Administering 
and Using Clinical Trip 
Reports”

Setting up 
Microsoft 
Project 
Integration

■ Setting up data exchange 
between Siebel eClinical 
Projects and Microsoft Project

■ Chapter 17, “Managing 
Clinical Projects”

Creating Project 
Templates

■ Creating project templates ■ Chapter 17, “Managing 
Clinical Projects”

Importing Data ■ Importing data with EIM

■ Importing, extracting, and 
routing syndicated data

■ Charting denormalized 
syndicated data

■ Chapter 19, “Importing Data”

■ Appendix A, “Information for 
Siebel Application 
Developers”

Table 2. Siebel Life Sciences Administration Tasks 

Administrative 
Task Description For More Information
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Siebel Life Sciences Administrative Setup Procedures
Administering 
products

■ Adding an external product

■ Adding an internal product or 
a market

■ Making a product inactive

■ Specifying additional product 
features

■ Adding information on related 
products

■ Associating related literature

■ Adding product comparison 
information

■ Adding a price list

■ Associating a price list with a 
product

■ Decision issues or product 
issues

■ Chapter 18, “Managing 
Products”

Configuring 
Siebel Life 
Sciences

■ Targeting 

■ New visit type

■ Charting denormalized 
syndicated data

■ Modifying business 
component user properties

■ Configuring the Submit button

■ Changing read-only status of 
fields

■ MedEd special C++ classes

■ Appendix A, “Information for 
Siebel Application 
Developers”

Table 2. Siebel Life Sciences Administration Tasks 

Administrative 
Task Description For More Information
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Understanding the My Team’s Filter
Understanding the My Team’s Filter
The Show drop-down list is found on many screens. It provides a list of filters such 
as My Contacts, My Team’s Contacts, and All Contacts. These filters determine what 
records appear in the view.

The behavior of the My Team’s filter varies from screen to screen. In some screens, 
this filter displays those records where the primary member of the team reports to 
the user. In other screens, the filter displays records where any of the team members 
reports to the user.

This behavior is determined in the business component by the Manager List Mode 
user property. For more information on Manager List Mode user property, see Siebel 
Tools Reference.

If the Manager List Mode user property is active and set to Team, the My Team’s 
filter displays all records where the user’s subordinate is on the team but is not 
necessarily the primary member.

Table 3 lists the default setting of the Manager List Mode user property for some 
Siebel Life Sciences screens and business components.

Table 3. The Default Setting for the Manager List Mode User Property

Screen Business Component Manager List Mode

Accounts Accounts Inactive

Contacts Contact Inactive

MedEd Pharma ME Event Professional Invitee Active

Objectives Objective Active

Protocols Clinical Protocol Active

Site Management Clinical Protocol Site Active
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Using Assignment Manager in Siebel Life Sciences
Siebel Assignment Manager allows the Siebel Administrator to automatically assign 
tasks to specific people. To do this, however, the Siebel Administrator must first 
define assignment rules for each task. For more information on using and 
implementing Siebel Assignment Manager, see Siebel Assignment Manager 
Administration Guide. This section provides Siebel Assignment Manager 
information that is specific to Siebel Life Sciences. 

Predefined Assignment Objects
Some of the predefined assignment objects and underlying criteria described in 
Siebel Assignment Manager Administration Guide have been modified in Siebel Life 
Sciences to support pharmaceutical business processes. Table 4 on page 27 
describes the assignment objects that are changed in Siebel Life Sciences.

NOTE: Assignment Item Type Industry Name is not supported. This assignment rule 
is defined for Siebel eBusiness Applications and currently conflicts with Siebel Life 
Sciences assignment rules. Siebel Life Sciences uses the assignment item type 
Industry SIC Code. 
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Table 4. Assignment Objects Changes in Siebel Life Sciences

Assignment Object Modifications

Account The assignment criteria SIC Code has been renamed Account Class 
of Trade.

Its assignment criteria are:

■ Account City State Country

■ Account Brick

Account Brick source table has been changed to S_CON_ADDR and 
source column has been changed to BRICK_ID.

Contact This assignment object was created specifically for Siebel Life 
Sciences and is not described in Siebel Assignment Manager 
Administration Guide. Its assignment criteria are:

■ Contact

■ Contact Medical Specialty Code

■ Contact Wildcard

■ Contact City

■ Contact State

■ Contact Country

■ Contact Zip Code

■ Contact City State Country

■ Contact Brick

■ Medical Specialty

■ Organization

■ Position
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Contact Assignments in Siebel Life Sciences
In most Siebel eBusiness applications, assignment of contacts is based on primary 
address. This process is different for Siebel Life Sciences. A Siebel Life Sciences 
contact may have multiple addresses, and each representative on the contact’s sales 
team may indicate a different primary address for the same contact. For this reason, 
do not base the assignment of contacts on the primary address. 

For example, Representative A might indicate a hospital address as the primary 
address, while Representative B might indicate a private-office address as primary. 
In the All Contacts and My Team’s Contacts views, the primary address that appears 
is the one assigned by the primary team member. For more information, see 
“Predefined Assignment Objects” on page 26.

Contact Denormalization Mode in Siebel Life Sciences
Contact Denormalization mode in Siebel Life Sciences differs from the description 
in Siebel Assignment Manager Administration Guide in the following ways: 

■ It denormalizes positions from the account team table to the contact team table 
for all contacts directly affiliated with an account. Users can specify a direct 
affiliation between a contact and an account by selecting:

■ The Direct field in the Contacts, Account Affiliations view tab 

■ The Direct field in the Accounts, Contact Affiliations view tab

For more information, see “Indicating an Affiliation Between an Account and a 
Contact” on page 200.

■ It does not denormalize positions from the opportunity team table to the contact 
team table. 

■ It must be run after running batch mode jobs for contacts and accounts 
separately. Run three separate batch mode jobs in this order: 

■ Contacts

■ Accounts

■ Contact Denormalization
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Contact Denormalization in Siebel Life Sciences has the following additional 
important rules, requirements, and exceptions:

■ Running Contact Denormalization mode in Dynamic mode. To enable the Contact 
Denormalization Policy, set the expiration date to a future date or leave it blank. 
Then generate the database triggers by running Generate Triggers.

■ Running Contact Denormalization mode in Batch mode. Remember to specify the 
parameters:

Object Name = Contact Denormalization
Assignment Mode = Denorm

■ Contact Denormalization mode does not evaluate rules. Therefore, it is not necessary 
to create a Contact Denormalization rule-based object to run Assignment 
Manager in this mode. Also, since it does not evaluate rules, Contact 
Denormalization mode does not set the primary team position. 

■ Contact Denormalization assigns contacts to employees who are on the Account Team 
for which the contacts are directly affiliated. In order to reduce the number of 
contact-to-position relationship (S_POSTN_CON) rows routed to the manager's 
local database, the value of the ASGN_DNRM_FLG field is set to “N”. With this 
default setting, the contacts that team members have been assigned by the 
Contact Denormalization process will not be visible to managers on their local 
databases. However, if the desired behavior is for managers to see all contacts 
that are assigned to their team members, regardless the assignment method, set 
the ASGN_DNRM_ “Y”.

For more information, see “Charting Denormalized Syndicated Data” on page 446.
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Setting Up Mobile Web Clients for Position Rollup
In Siebel eClinical, a clinical research associate (CRA) can create sites and assign 
employees to positions at the site level. When the CRA clicks the position rollup 
button, these positions become visible at the region and protocol levels. Typically, 
the CRA works in a disconnected mode, on a laptop computer. 

The administrator must set up each mobile Web client to enable position rollups. 
The setup requires the following steps in Siebel eClinical:

■ The administrator exports workflow processes and data maps from the server 
database to XML files.

■ The administrator connects to a local client, imports the XML files to the client 
database and activates the workflow processes on the local client.

NOTE: Users of the local client must have Workflow Process Definition, EAI DATA 
Map View, and EAI Data Map Editor in their user responsibilities to accept imported 
workflow processes and data maps.

To export workflow processes from the server database to an XML file

1 In Siebel eClinical, connect to the server database.

2 From the application level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

3 In the Workflow Processes list, query for Clinical Assign*.

The query returns two records, Clinical Assign Position From Region and Clinical 
Assign Position From Site.

4 Select one of these records and select Import Workflow from the drop-down 
menu.

5 In the dialog box, select Save to Disk, select a location, and save the XML file 
with a unique name.

6 Repeat Step 4 and Step 5 for the second record.
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To export DTE data maps from the server database to an XML file

1 In Siebel eClinical, connect to the server database.

2 From the application level menu, choose View > Site Map > Integration 
Administration > Data Maps.

3 In the Integration Object Map list, query for Clinical*.

The query returns four records—Clinical Region Position to Protocol Position 
Map, Clinical Site Position to Account Position Map, Clinical Site Position to 
Protocol Position Map, and Clinical Site Position to Region Position Map.

4 In the drop-down menu, select Export Data Map.

5 In the dialog box, check Export All Rows in Current Query and click Export.

6 In the dialog box, select Save to Disk, select a location, and save the data maps 
as PositionRollupDataMap.xml.

To import workflow processes to a local client from an XML file

1 In Siebel eClinical, connect to the local client.

2 From the application level menu, choose View > Site Map > Business Process 
Administration > Workflow Processes.

3 In the Workflow Processes list, select Import Workflow in the drop-down menu.

4 In the dialog box, select Browse and find the workflow XML files created in the 
first procedure in this section, “To export workflow processes from the server 
database to an XML file” on page 30.

5 Import one of the XML files.

6 Repeat Step 4 and Step 5 to import the second XML file.

7 In the Workflow Processes list, query for Clinical Assign*.

The query returns two records, Clinical Assign Position From Region and Clinical 
Assign Position From Site, both with a status of In Progress.

8 Select both records and click Activate.

The status of both records becomes Active.
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To import DTE data maps to a local client from an XML file

1 In Siebel eClinical, connect to the local client.

2 From the application level menu, choose View > Site Map > Integration 
Administration > Data Maps.

3 In the Integration Object Map list, select Import Data Map from the drop-down 
menu.

4 In the dialog box, select Browse and find PositionRollupDataMap.xml created in 
the second procedure in this section, “To export DTE data maps from the server 
database to an XML file” on page 31.

5 In the Integration Object Map list, query for Clinical*.

The query returns four records—Clinical Region Position to Protocol Position 
Map, Clinical Site Position to Account Position Map, Clinical Site Position to 
Protocol Position Map, and Clinical Site Position to Region Position Map.
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Samples and Lot Numbers
The use of product samples for product promotion by pharmaceutical companies 
around the world is governed by local country legislations. Siebel Samples 
Management maintains a samples transaction record for every sample transfer, 
receipt, disbursement, order, and inventory adjustment. 

The following three options are available to customers who are implementing Siebel 
Samples Management:

1 Use Lot numbers for samples creation, transfer, adjustment, order, 
disbursement, inventory, and reconciliation. 

This option is the default setting. It is made possible with the system preferences 
settings shown on the following table.

NOTE: An administrator sets system preferences by navigating to the application-
level menu > View > Site Map > Application Administration > System 
Preferences. 

System Preference Value

Lots for Disperse Only FALSE

Sample Lots Enabled TRUE
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2 Use Lot numbers for samples creation, transfer, adjustment, order, 
disbursement, but do not use lot numbers for inventory and reconciliation.

This option is made possible with the system preferences settings shown on the 
following table.

In addition to these system preference changes, a Siebel administrator must use 
Siebel Tools to control product visibility associated with this behavior. For more 
information, see Appendix A, “Information for Siebel Application Developers.”

NOTE: The Lot# Tracking flag on the Product Administration screen must be 
checked.

3 Do not use lot numbers for samples management at all. 

This option is made possible with the system preferences settings shown on the 
following table.

The Lot# Tracking flag on the Product Administration screen does not have to be 
checked. 

System Preference Value

Lots for Disperse Only TRUE

Sample Lots Enabled TRUE

System Preference Value

Lots for Disperse Only FALSE

Sample Lots Enabled FALSE
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The Siebel Life Sciences product comprises Siebel ePharma, Siebel eMedical, and 
Siebel eClinical. Siebel Life Sciences is the only integrated professional and 
investigator database that captures, tracks, and routes information to other parts of 
an organization, including the mobile sales force and customer service centers.
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About Siebel ePharma
Siebel ePharma is a suite of eBusiness applications specifically designed for the 
pharmaceutical industry. Siebel Life Sciences provides industry's only integrated 
solution that allows information captured through multiple channels to be shared 
between sales and marketing, clinical affairs, customer services and other parts of 
an organization.

Siebel ePharma provides:

■ Flexible contact management, supporting a wide range of contact types, both 
prescribers and nonprescribers, including physicians, pharmacists, nurses, office 
staff, and business administrators

■ Account management, supporting a wide range of account types, such as 
hospitals, pharmacies, health maintenance organizations (HMOs), clinics, 
wholesalers, and group purchasing organizations (GPOs)

■ Advanced, specific querying and list generation, allowing product promotion to 
targeted accounts and health care professionals

■ Activity management, tightly integrated with the Siebel Calendar, promoting 
streamlined call planning and call reporting

■ Medical education event planning, aiding efficient planning and preparation for 
many types of medical education events by tracking speakers, invitees, meeting-
related activities, and expenses

■ Smart Calls, which are call report templates supporting true one-button call 
reporting

■ Comprehensive analysis charts, presenting sales and prescription (Rx) trends by 
postal code, brick (retail sales analysis territory), territory, plan, and prescriber

■ Dedicated formulary-opportunity management, allowing focused product 
promotion and opportunity tracking

■ Sales effectiveness tools and methodologies, including Target Account Sales 
(TAS), Miller Heiman, and Enterprise Selling Process (ESP), to shorten the sales 
cycles and increase account revenue and production
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■ Contract and pricing management, including contract creation, approval, 
execution, renewal, and contract-based pricing

■ Enterprise-wide product information for employees, allowing consistent, 
accurate, and up-to-date information sharing across sales teams and sales forces

■ Simplified sampling workflow for users and administrators, supporting 
shipments in or out, orders, inventory counts, adjustments, and reconciliation, 
as well as tracking by lot numbers

■ Support for a full customer service center that handles medical inquiries, 
adverse events, and other related issues

■ Handling of a large number of inbound telephone calls, faxes, email, and 
Internet correspondence for customer service, sales, and medical support

■ Support for outbound calling for telesales, telemarketing, and meeting planning

About Siebel eMedical
Siebel eMedical is a suite of eBusiness applications designed specifically for the 
medical products industry to increase revenue and profitability through strategic 
customer–partner relationship management, enhanced customer and partner 
productivity and reduced cost of process inefficiencies.

Siebel eMedical provides:

■ Flexible contact management, supporting a wide range of contact types, 
including physicians, nurses, technicians, office staff, and business 
administrators

■ Account management, supporting a wide range of account types, such as 
hospitals, health maintenance organizations (HMOs), clinics, wholesalers, and 
group purchasing organizations (GPOs)

■ Advanced, specific querying and list generation, allowing product promotion to 
targeted accounts and health care professionals

■ Activity management, integrated with the Siebel Calendar, promoting 
streamlined customer support and service
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■ Medical education event planning, aiding planning and preparation for many 
types of medical education events by tracking speakers, invitees, meeting related 
activities, and expenses

■ Comprehensive analysis charts, presenting sales and product usage trend by 
account, postal code, territory, and plan

■ Opportunity management, allowing focused product promotion and opportunity 
tracking

■ Enterprise-wide product information for employees, allowing consistent, 
accurate, and up-to-date information sharing across sales teams, customer 
support, and field service

■ Simplified workflow to manage assets at customer site, supporting shipments in 
or out, orders, inventory counts, adjustments and reconciliation

■ Support for customer service centers that handle medical inquiries, service 
requests, and other related issues

■ Handling of a large number of inbound telephone calls, faxes, email, and 
Internet correspondence for customer service, sales, and medical support

■ Support for outbound calling for telesales, telemarketing, and meeting planning

■ Modeling of products and services that incorporates internal expertise, allowing 
sales representatives to configure and quote error-free customer solutions

■ Field-service functions that provide service center agents, warehouse staff, and 
field service engineers the tools to respond to service requests

■ Functionality to receive service calls, verify service agreements and 
entitlements, enter a service request, search for solutions, create activities for a 
service request, and assign and dispatch field service engineers

■ Detailed customer configuration, management of trunk inventory, tracking of 
parts consumption and logistics, management of inventory replenishment, and 
integration of return materials authorizations and service orders

■ Service details, including the required skills, tools, and parts for service activities

■ Management of preventive maintenance plans, and repair of defective parts
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■ Tracking and analysis of service costs, preparation of invoices for service, and 
tracking of payments

■ Definition of asset characteristics and recording of readings from medical 
equipment (assets) in the field for preventive maintenance, billing, and service

■ Audit trail of activities

■ Single application to manage partner interactions through the entire partner life 
cycle, from recruitment, registration, profiling, certification, joint planning, and 
execution through measurement and analysis of partner performance

■ Sharing of opportunities, service requests, accounts, solutions, and other 
business information with partners in the same way as with employees

■ Processes and tools to work collaboratively with partners to develop plans to 
meet strategic goals; helps analyze partnership effectiveness, forecast revenue, 
manage market development funds, and analyze partner performance 

About Siebel eClinical
Siebel eClinical allows pharmaceutical companies, biotechnology companies, and 
contract research organizations (CROs) to better manage the clinical trial process, 
maintain quality of clinical trials, and manage investigator relationships. It provides 
a comprehensive set of tools for clinical research associates (CRAs), clinical 
investigators, and site coordinators, including a personalized Internet portal to 
conduct study activities more efficiently.

Siebel eClinical includes:

■ Personalized Internet portal to help site coordinators, clinical investigators, and 
CRAs better manage clinical trials over the Web

■ Support for full clinical trial hierarchies of Subject-Site-Region-Protocol-Program

■ Support for global trials running in multiple countries, multiple languages, and 
multiple currencies. 

■ Site management tools for CRAs, including trip reports, document tracking, and 
payment generation

■ Investigator and site profiling
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■ Activity and calendar management for CRAs and study sites

■ Clinical trial status and management reports for study manager and clinical 
research associates

■ Integrated payment tracking for sites and investigators

■ Visit templates for study staff to better plan subject visits and promote protocol 
adherence 

■ Trip report templates for CRAs to facilitate compliance with Good Clinical 
Practice (GCP)

■ Project and resource management integrated with Microsoft Project

■ A flexible audit trail engine

Siebel eClinical was designed to allow pharmaceutical and biotech companies, 
clinical research organizations, and other clinical trial sponsors to:

■ Deploy a Web-based clinical trial management system to internal and external 
users

■ Make better decisions throughout the clinical trials process, leading to more 
efficient use of resources and faster time to market

■ Increase productivity of CRAs and their managers by automating repetitive tasks 
and allowing real-time information sharing

■ Create sustainable competitive advantage by allowing customers to provide 
breakthrough service to sites and investigators

■ Provide a solution integrated with Siebel ePharma Sales and Siebel ePharma 
Service to allow customers to deploy one customer management system across 
the entire enterprise
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Product Modules and Options
Many Siebel eBusiness Applications modules can be purchased and used with 
Siebel Life Sciences. In addition, optional modules specific to Siebel Life Sciences 
can be purchased to provide enhanced functionality for various business processes.

For information on the optional modules that can be used with Siebel Life Sciences, 
contact your Siebel sales representative.

NOTE: This guide documents Siebel Life Sciences with the optional modules 
installed. In addition, the Sample database includes data for optional modules. If 
your installation does not include some of these modules, your software interface 
will differ from that described in some sections of this guide.

The exact configuration of Siebel Life Sciences screens and views depends on your 
company’s configuration of the application. For introductory information on using 
the Siebel Life Sciences interface, see Fundamentals, Online Help, and Chapter 1, 
“Getting Started.”
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Business Functions of Screen Tabs in Siebel Life 
Sciences

The Siebel Life Sciences interface provides various task-specific screens and views 
for administrative and end-user functions.

NOTE: Most administrative tasks are performed from administration screens that are 
accessed from the Site Map. You cannot access these from the screen tabs.

Table 5 lists the most frequently used Siebel Life Sciences screens and the functions 
of the views in those screens. The screens listed here appear on the screen tabs. 

Table 5. Siebel Life Sciences Screens 

Screen Tab Functions For More Information

Accounts Manage information about accounts (such as 
hospitals, HMOs, clinics, wholesalers, GPOs, 
and pharmacies) and affiliate accounts, 
contacts, and other information about a 
particular account. 

Chapter 7, “Administering and 
Managing Accounts,” in this guide

Activities Manage activities with contacts and accounts, 
and create contact and account calls (with or 
without Smart Calls).

Chapter 4, “Planning Calls,” in this 
guide and Siebel Call Center User Guide

Agreements Manage information about agreements, 
administrative contracts, and entitlements.

Siebel Field Service Guide, Siebel Sales 
User Guide

Analysis Display prescriber, account, plan, payer, and 
territory-level sales and Rx data. 

Chapter 9, “Using Analysis,” in this 
guide

Assets Manage information about products sold to 
accounts.

Siebel Field Service Guide

Calendar Create and display activities (including to-do 
activities) and share calendar information with 
coworkers. 

Chapter 4, “Planning Calls,” in this 
guide and Fundamentals

Campaigns Manage outbound communications with 
prospects targeted for a particular marketing 
effort.

Siebel Marketing Guide, Siebel Sales 
User Guide, Siebel Call Center User 
Guide
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Clinical Programs Manage information about clinical trial 
programs.

Chapter 13, “Setting Up and Carrying 
Out a Clinical Trial,” in this guide

Contacts Manage information about health care 
professionals (such as formulary directors, 
hospital administrators, pharmacists, and 
physicians) and their affiliations with other 
contacts and accounts. 

Chapter 3, “Managing Contacts,” in 
this guide

Document 
Tracking

Track documents at multiple levels (Site, 
Region, or Protocol) for multiple entities 
(Contact or Account)

In this guide:

■ Chapter 13, “Setting Up and 
Carrying Out a Clinical Trial”

■ Chapter 14, “Managing Sites and 
Clinical Contacts” 

■ Chapter 7, “Administering and 
Managing Accounts”

■ Chapter 3, “Managing Contacts”

Home This is the first screen you see when you log in 
to the Siebel Life Sciences application. It is a 
centralized screen that summarizes contacts, 
accounts, and activities. 

Fundamentals

Literature Display company- and industry-related 
literature cataloged by the Siebel 
administrator.

Siebel Sales User Guide

MedEd Manage medical education events. Chapter 11, “Managing MedEd 
Events,” in this guide

Objectives Define objectives for contacts and accounts 
and monitor progress made toward meeting 
goals.

Chapter 12, “Objectives,” in this guide

Opportunities Manage formulary opportunities and affiliate 
contacts, accounts, and other information with 
a particular opportunity. 

Siebel Sales User Guide

Orders Manage information about samples ordered by 
physicians through your company’s Web site, 
as well as all goods and service orders recorded 
by the service organization.

Siebel Order Management Guide

Table 5. Siebel Life Sciences Screens 

Screen Tab Functions For More Information
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Payments Keep track of payments pertaining to clinical 
trial activities at sites.

Chapter 15, “Setting Up and Making 
Subject Activity Payments,” in this 
guide

Products Display current product information, including 
key features and product trends.

Chapter 18, “Managing Products,” in 
this guide

Protocols Maintain information about clinical trial 
protocols.

Chapter 13, “Setting Up and Carrying 
Out a Clinical Trial,” in this guide

Quotes Automatically generate quotes tailored to meet 
customer requirements.

Product Administration Guide and 
Siebel Sales User Guide

Regions Manage region or country level information 
about clinical trial protocols.

Chapter 13, “Setting Up and Carrying 
Out a Clinical Trial,” in this guide

Routes Create routes to schedule regular visits to 
groups of accounts.

Chapter 4, “Planning Calls,” in this 
guide

Samples Organize phases of samples workflow: 
shipments, orders, adjustments, inventory 
counts, and reconciliation. 

Chapter 6, “Managing Samples,” in 
this guide

Service Requests Manage requests for medical or product 
information and related activities and 
attachments.

Siebel Field Service Guide

Site Management Manage information about a particular clinical 
trial site, including associated contacts, 
subjects, activities, payments, and site visits.

Chapter 14, “Managing Sites and 
Clinical Contacts,” in this guide

SmartScripts Define the application workflow for an 
interactive situation in a script. These 
interactive situations could include inbound 
communications (such as customer service) 
and outbound contacts (such as 
telemarketing).

Siebel SmartScript Administration 
Guide

Smart Calls Create and edit Smart Call templates that are 
applied in the Contact Call Detail and Account 
Call Detail views.

Chapter 8, “Creating Smart Calls,” in 
this guide

Solutions Enter and display resolutions successfully used 
for reported problems.

Siebel Field Service Guide, Siebel Call 
Center User Guide

Table 5. Siebel Life Sciences Screens 

Screen Tab Functions For More Information
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Subjects Manage information about clinical trial 
subjects.

Chapter 13, “Setting Up and Carrying 
Out a Clinical Trial,” in this guide

Targeting Perform queries on profile information (such 
as best times to call and market ranking), as 
well as sales and Rx data, in order to generate 
target lists of contacts or accounts.

Chapter 4, “Planning Calls,” in this 
guide

Time Off 
Territory

Manage information about time when sales 
representatives and field personnel are out of 
their territories, not working on activities 
directly associated with accounts, contacts, or 
opportunities.

Chapter 10, “Tracking Time Off 
Territory,” in this guide

Table 5. Siebel Life Sciences Screens 

Screen Tab Functions For More Information
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In Siebel Life Sciences a contact is typically a physician, nurse, or pharmacist or 
other medical professional. In a more general sense, a contact can be any individual 
a pharmaceutical company deems significant to their business process including a 
formulary director, contracts administrator, or medical education event speaker.

This chapter describes how to manage Siebel Life Sciences contact information. 
Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of defining and specifying medical specialities, deleting a 
contact, defining bricks, and associating contacts to a brick. End users such as sales 
representatives and managed care account managers can use the Contacts view to 
create and track a variety of contact information, including contact affiliations, 
contact and account relationships, contact assessments, and the best times to call 
on a contact. 

For more information on the differences between administrator and end-user tasks, 
see “Business Scenario for Managing Contacts” on page 48. 
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Business Scenario for Managing Contacts
This section outlines an example workflow performed by a Siebel administrator and 
end users. Your company may follow a different workflow according to its business 
requirements.

A pharmaceutical company is reviewing the contact information in their database 
to make sure it is as current and up-to-date as possible. During this update process, 
the administrator deletes obsolete contacts and associates new contacts with 
existing bricks (geographic areas). In addition, he adds new medical specialties and 
updates existing contacts needing a primary specialty designation. 

Sales representatives use Siebel Contacts to manually add and modify contact 
information. They can add more depth to contact data by creating user-defined 
fields called categories. Using categories, representatives can track private or shared 
information about a contact. In addition, representatives can track referral 
relationships between contacts.
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Example Workflow for Managing Contacts
This section details sample tasks often performed by administrators and end-users 
when managing contacts. Your company may follow a different workflow according 
to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to manage contacts:

■ Define medical specialities within the system and specify a contact’s primary 
specialty. For more information, see “Defining a Specialty” on page 51.

■ Delete contacts. For more information, see “Deleting a Contact” on page 52.

■ Define new bricks. For more information, see “Defining a Brick” on page 53.

■ Associate a contact with a brick. For more information, see “Associating a Contact 
with a Brick” on page 55.

End-User Procedures
The following list shows tasks end users typically perform when managing 
contacts: 

■ Add a contact. For more information, see “Adding a Contact” on page 58.

■ Add contact category information. For more information, see “Adding Category 
Information” on page 60.

■ Specify the best times to make contact calls. For more information, see “Specifying 
the Best Time to Call Based on Address” on page 61.

■ Indicate affiliations between a contact and an account. For more information, see 
“Indicating Affiliations Between a Contact and an Account” on page 64.

■ Indicate affiliation between contacts. For more information, see “Indicating 
Affiliations Between Contacts” on page 63.

■ Create contact assessments. For more information, see “Creating a Contact 
Assessment” on page 66.
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■ View pre-call summary information about a contact. For more information, see 
“Viewing Pre-call Information” on page 67.

■ Track documentation associated with a contact. For more information, see 
“Tracking Documentation Associated with a Contact” on page 69.
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Administrator Procedures
The following administrator procedures are described in this section:

■ To define a specialty on page 52

■ To specify a contact’s primary specialty on page 52

■ To delete a contact on page 53

■ To define a brick on page 54

■ To associate a contact with a brick on page 55

Primary Specialty and Unique Identifiers
As a Siebel administrator, you are responsible for entering the following contact 
information:

■ Primary Specialty. The Primary Specialty field is read-only for end users and can 
be edited only from the Data Administration, Contact form. For more 
information, see “Defining a Specialty” on page 51.

■ Company Identifier. Use the Company Identifier field on the Data Administration, 
Contact form to enter a unique contact identifier that your company uses as a 
unique identifier for contacts. 

■ License. Use the License number field on the Data Administration Contact form 
to enter a contact’s professional license numbers (such as an authorized state 
license number).

Defining a Specialty
The Siebel administrator defines medical specialties within Siebel Life Sciences 
using the Applications Administration, Specialty view. 

NOTE: Please note that the Primary Specialty field is different from the Rep Specialty 
field on the Contacts screen. To add additional values to the Rep Specialty drop-
down list, follow the procedures on modifying a list of values in Applications 
Administration Guide.
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To define a specialty

1 From the application-level menu, choose View > Site Map > Application 
Administration > Specialty.

The Primary Specialty view appears. 

2 In the Primary Specialty list, add a record and complete the necessary fields. 

The Primary Specialty field is read-only for end users and can be edited only from 
the Data Administration, Contacts view. To specify a contact’s primary specialty, see 
the next procedure.

To specify a contact’s primary specialty 

1 From the application-level menu, choose View > Site Map > Data 
Administration > Contacts.

2 In the Contacts list, select the contact for whom you wish to specify a primary 
specialty.

3 In the Contacts form, select a specialty in the Primary Specialty field.

NOTE: On initial data load, you can use EIM to load 

Primary Specialty data into the base table S_MED_SPEC. For more information on 
using EIM, see Siebel Enterprise Integration Manager Administration Guide.

Merging Contact Records
If you find that two or more contact records contain the same information, you 
should merge the records into one in order to keep the database accurate. For more 
information on merging records, see Fundamentals.

Deleting a Contact
Deleting a contact completely removes the contact from the system. Be aware that 
deleting a contact could have undesired consequences. 
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As an alternative to deleting a contact, consider making the Siebel administrator the 
primary team member so that he or she can remove all other employees from the 
account’s team. 

NOTE: If a Contact record is deleted from the Data Administration, Contacts view, 
any records for that contact in the Signature Audit Administration view display with 
blank Last Name, First Name, and Reference # fields. To avoid this problem, you 
may want to enforce a business rule that prevents the delete record function from 
operating in the Data Administration, Contacts view.

If you are certain that the contact is no longer active, use the following procedure 
to delete it.

To delete a contact

1 From the application-level menu, choose View > Site Map > Data 
Administration > Contacts.

The Contact Administration view appears.

2 In the Contacts list, select and then delete the appropriate contact.

The contact is deleted from the list. 

Defining a Brick
A brick is a collection of accounts and contacts, normally in a common geographic 
area. The primary purpose of a brick is to allow a company to publish RSA (retail 
sales analysis) data while making sure that specific sales cannot be tracked to a 
particular contact or account. 

IMS Health publishes retail sales data and determines the definition of bricks. Brick 
definitions are reviewed every six months and adjusted to make sure that the brick 
is as small as possible while providing the required level of anonymity.

Because brick data is a key measure of return on a pharmaceutical company's 
investment in sales promotion, outside the United States most pharmaceutical 
companies build sales territories based on brick data available for that country. This 
provides a meaningful way to measure performance over time. 
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How Bricks Work in Siebel ePharma
In Siebel Life Sciences, administrator can associate a contact or an account address 
with a brick. A contact can be associated with multiple bricks and an account with 
multiple addresses can have one brick for each address.

This implementation of Siebel ePharma also supports “mini-bricks.” A mini-brick 
data is a subset of brick data that narrows the number of contacts and accounts in 
a geographic area. Mini-bricks provide a more detailed view of an area, without 
identifying the individuals in the unit.

It is the Siebel administrator’s responsibility to set up and maintain brick definitions 
as well as associate bricks with account addresses and contacts. For more 
information on associating a brick with a specific contact, see “Associating a 
Contact with a Brick” on page 55. For more information on associating a brick with 
an account address, see “Generating Account Hierarchies” on page 188.

To define a brick

1 From the application-level menu, choose View > Site Map > Data 
Administration > Brick Details.

The Bricks view appears. 
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2 In the Bricks list, add a record and complete the necessary fields. 

Some of the fields in a Brick record are described in the following table.

 

NOTE: On initial data load, you can use EIM to load brick data into the base table 
S_REGION. For more information on using EIM, see Siebel Enterprise Integration 
Manager Administration Guide.

Associating a Contact with a Brick
You can associate a brick directly with one or more contacts. 

NOTE: Before you can associate a brick with a contact, the brick must be defined. For 
more information, see “To define a brick” on page 54.

To associate a contact with a brick

1 From the application-level menu, choose View > Site Map > Data 
Administration > Brick Details.

2 In the Bricks list, select a Brick.

Field Comments

Name The name for the brick being defined.

Parent Brick The Pick Brick dialog box lists all the bricks in the database. If the new 
brick is a mini-brick, click the parent brick in the Pick Brick dialog box.

Active If checked, the brick is active. Only active bricks are listed in the Pick 
Brick dialog box.

Position Defines positions associated with the brick and controls visibility on the 
Analysis screen > Brick views.

Note: For users to see the Bricks for which they are responsible, the 
administrator must associate their position with those Bricks in the Data 
Administration screen > Brick Details.
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3 In the Contacts list, click New.

The Add Contact dialog box appears.

4 Add a contact record by performing one of the following:

■ Click New and enter a new contact

■ Click Query to find an existing contact

Scores on Assessment Templates
The purpose of an assessment is to determine a single total score or a percentage 
that can be used to rank a contact. The total score for the assessment is determined 
by summing weighted scores for each assessment attribute. For more information 
on creating assessment templates, see “Creating an Assessment Template” on 
page 327.
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End-User Procedures
The following end-user procedures are described in this section:

■ To add a contact on page 59

■ To add category information for a contact on page 61

■ To specify the best time to call on a contact on page 62

■ To indicate an affiliation between contacts on page 63

■ To indicate an affiliation between a contact and an account on page 64

■ To specify a role for an affiliated account on page 65

■ To specify the best times to call on an affiliated account on page 66

■ To create an assessment of a contact on page 66

■ To view pre-call information on page 67
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Adding a Contact
A contact can be any individual an end user deems significant in achieving their 
business goals. Multiple employees can be assigned, as a team, to a contact. Any 
employee assigned to the team can update the contact’s information. A user who 
adds a contact is automatically designated as the primary contact team member. 
However, he or she can also be assigned to other contact teams by another user 
(such as a manager). 

NOTE: Starting with Siebel Life Sciences version 7.0.3, the My Team’s Contacts view 
is limited to showing only those contacts with a subordinate person as the primary 
on the team. It does not show contacts where the subordinate is on the team but is 
not primary. If you prefer the older behavior of displaying all contacts that are on 
the team of the subordinate person, please contact Siebel Technical Support.

Because the contacts shell is assigned to individual people (that is, employees) and 
not positions, this view does not show contacts that are assigned to a position that 
has no employee assigned. To prevent this behavior, assign a “placeholder” 
employee to every position.

Contacts can also be viewed on an account hierarchy tree that shows accounts, their 
child accounts and all activities, contacts, and opportunities associated with the 
accounts. For more information, see Chapter 7, “Administering and Managing 
Accounts.”

Editing a Contact Address
Contacts in Siebel Life Sciences can have multiple addresses. Users can edit existing 
addresses directly in the Address field. However, users should be careful when 
editing an existing address. Editing an existing address changes it for all contacts 
currently associated with the address. 

NOTE: If an address is associated with multiple contacts and you are unsure whether 
the change applies to all of them, create a new address.
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To add a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts More Info form, add a record and complete the necessary fields. 

Some of the fields in the Contacts record are described in the following table.

Field Comments

Address A contact can have multiple addresses. Use the Addresses dialog 
box to select an existing address or add a new one. Each user must 
specify one address as primary by selecting the Primary field. 
Each sales representative assigned to a contact can specify a 
different primary address. 

For example, one representative might specify a private office as 
the primary address, while another representative might specify a 
hospital department as the primary address. In the All Contacts 
view and the My Team’s Contacts view, the primary address 
displayed is the one assigned by the primary team member.

Brick Indicates an impartial geographic code that groups contacts in a 
way that mirrors the definition provided by syndicated data 
providers. These codes are loaded by the administrator and are 
read-only for all users. 

For more information, see “How Bricks Work in Siebel ePharma” 
on page 54, and “Associating a Contact with a Brick” on page 55.

First Name First name of the contact. 

Last Call Date The date of the most recent call that has been submitted for each 
member of the team. 

Last Name Last name of the contact. 

License # Used to record all contact licenses. 

Primary Specialty Only Siebel administrators can define this value. For more 
information, see “Primary Specialty and Unique Identifiers” on 
page 51 and “Defining a Specialty” on page 51. 
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NOTE: Contacts can only be deleted by a Siebel administrator in the Data 
Administration, Contacts view. For information on administering contacts, see 
“Deleting a Contact” on page 52. 

Adding Category Information 
End users can create categories to track additional contact information, such as a 
particular sports a contact enjoys or food a contact prefers. In creating a category, a 
user can define possible category values and specify the relative importance of the 
category and each of its values. In addition, there are no restrictions on how many 
times a user can apply a specific category. Categories can be used as many times 
and with as many contacts as necessary.

By default, all categories are visible system-wide. However, users can mark 
categories as private. Private categories are only visible to the user who created 
them.

Rep Specialty The specialty or area of expertise the end user sees this contact 
has having within their organization. 

To add additional values to this drop-down list, follow the 
procedures on modifying a list of values in Applications 
Administration Guide.

Route Allows users to select a when to visit an account from a 
predefined schedule. For more information, see “Defining a Route 
Plan” on page 87.

Speaker A check mark indicates this contact is a speaker for MedEd events. 
This field is used to track various speakers at any level. For more 
information, see “Designating MedEd Event Speakers” on 
page 256.

Team Multiple people can be assigned to the contact’s team. The team 
member who created the record is indicated as primary. 

Type Indicates the type of contact. The choices available in the drop-
down list are configured using the CONTACT_TYPE in the List of 
Values.

Field Comments
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To add category information for a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Categories view tab.

5 In the Categories list, add a record and complete the necessary fields. 

Some of the fields in the Categories record are described in the following table.

Specifying the Best Time to Call Based on Address
A contact can have more than one address. Using the Addresses view, end users can 
enter the best times to call on a contact based on a selected address. Entering 
information in this view automatically populates other views such as the PreCall 
view. 

Field Comments

Category The type of this category. The Pick Category dialog box lists all the 
categories previously defined by you or others. Select an existing 
category or create a new one. 

Category Rank Optionally, enter a number to indicate the importance of this 
category relative to other categories.

Value A specific category value, such as golf or sailing. The Category 
Values dialog box lists all the values previously defined for the 
category. Select an existing value or create a new one. 

Value Rank Optionally, enter a number to indicate the importance of this value 
relative to other values. 

Private Selecting this field prevents other users from seeing the category.
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For more information on adding addresses, see the addresses field description in 
“Adding a Contact” on page 58. For more information on using the PreCall view, see 
“Viewing Pre-call Information” on page 67. 

To specify the best time to call on a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Addresses view tab.

5 In the Addresses list, select an address.

6 In the Best Times list, add a record and complete the necessary fields. 
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Indicating Affiliations Between Contacts
The Contacts Affiliations view allows end users to track referral relationships 
between contacts. Using this view, users can track:

■ Referral or Referring Relationship. Users can specify whether a contact receives or 
gives referrals to other contacts.

■ Influence of Contacts on One Another. Users can specify whether or not one contact 
influences another contact.

To indicate an affiliation between contacts

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Affiliations view tab.

5 In the Affiliations list, add a record.

The Add Contacts dialog box appears.

6 Select one or more contacts and click OK.

The selected contacts are added to the Affiliations list.

7 In the Affiliations list, select a value for the Relationship field; the default value 
is None Specified.

8 To specify one contact’s influence over another:

a In the Affiliations list, select a contact.

b In the Influenced list, add a record.

The Add Contacts dialog box appears.
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c Select one or more contacts and click OK.

The selected contacts are added to the Influenced list.

9 In the Influenced list, specify the contact relationship by making a selection in 
the Relationship field.

Indicating Affiliations Between a Contact and an Account
Using the Account Affiliations view tab, end users can associate a contact with an 
account. One reason to indicate these affiliations is for greater efficiency in call 
reporting, as described in Chapter 5, “Recording Calls.”

Once you record an affiliation between an account and a contact, you can also:

■ Specify a role for the affiliated contact. For more information, see “To specify a role 
for an affiliated account” on page 65.

■ Specify the best times to call the contact at the affiliated account. For more 
information, see “To specify the best times to call on an affiliated account” on 
page 66.

The Account Affiliations view also shows the formulary status of products in the 
affiliated account as read-only information. Formulary status can be updated from 
the Account Plan Formulary view.

To indicate an affiliation between a contact and an account 

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Account Affiliations view tab.
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5 In the Account Affiliations list, add a record and complete the necessary fields. 

Some of the fields in the Account Affiliation record are described in the following 
table.

End users can track a contact’s importance within an organization by defining their 
role in the Roles list. Users can then refer to this information prior to calls and adjust 
their discussions with each contact accordingly.

To specify a role for an affiliated account

1 Affiliate an account with a contact as described in the previous procedure. For 
more information, see “To indicate an affiliation between a contact and an 
account.”

2 In the Account Affiliations list, select an account. 

NOTE: When selecting an account, do not drill down on any hyperlinks. Doing so 
takes you to another view.

3 In the Roles list, add a record and complete the necessary fields. 

Field Comments

Direct Select this field to route profile data for the contact to the members 
of the team assigned to the affiliated account. The Siebel 
administrator must enable this behavior. For more information, see 
“Modifying the Routing of Affiliated Contact Data” on page 71.

Do not select this field to route the profile data for the contact to the 
members of the team assigned to the contact. (Users who are 
connected to the server see the profile data whether or not a check 
mark appears in the field.) 

Account The account to be affiliated with the selected contact. 

Start date The beginning date on which the contact became affiliated with this 
account.

End date The date on which the contact ended affiliation with this account.
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End users can specify the best time to call on an affiliated account in the Best Times 
list.

To specify the best times to call on an affiliated account

1 Affiliate an account with a contact as described in the previous procedure. For 
more information, see “To indicate an affiliation between a contact and an 
account.”

2 In the Account Affiliations list, select an account. 

NOTE: When selecting an account, do not drill down on any hyperlinks. Doing so 
takes you to another view.

3 In the Best Times list, add a record and complete the necessary fields. 

Creating a Contact Assessment
End users can rate and rank a contact on key indicators using the Assessments view. 
By selecting a predefined template, users can extract a measurable statistic that 
allows them to determine a relative value of a specific contact.

To create an assessment of a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact for which you want to create an assessment.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Assessments view tab.

5 In the Assessments list, add a record. 
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6 In the Template Name field, select a template from the Select Assessment dialog 
box and then click OK.

NOTE: For more information on creating assessment templates, see “Creating an 
Assessment Template” on page 327.

Viewing Pre-call Information
The PreCall view tab is a single view that provides end users with a thumbnail view 
of important information about a contact. Users can access this view prior to 
making a call to get a summary of key information about the customer they are 
about to visit.

To view pre-call information

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.
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4 Click the PreCall view tab.

The PreCall view appears, displaying the lists described in the following table.

5 To add information, select the Calls, Best Times, Notes, or Account Affiliations 
lists, add a record, and complete the necessary fields.

NOTE: The Rx Trend data is not editable in this view.

List Comments

Account Affiliations Lists all accounts affiliated with this contact. 

This list can also be populated from the Account Affiliation 
view tab. For more information, see “Indicating Affiliations 
Between a Contact and an Account” on page 64.

Best Times Lists the best times to visit the contact. 

This list can also be populated in the Addresses view tab. For 
more information, see “Specifying the Best Time to Call Based 
on Address” on page 61.

Calls Features an historical list of all calls made on the contact. 

Formulary status Provides formulary status information for products in affiliated 
accounts.

Rx Trends Syndicated data about prescription trends. A show drop-down 
menu provides options for Rx Trend and Formulary and Rx 
Trend By Plan. 

Rx Trend and Formulary shows prescription trends and 
formulary status information at affiliated accounts. Rx Trend by 
Plan shows prescriptions by managed care plans.

Rx Trend data can be viewed as a chart or as a list.

Notes Contains end-user notes regarding the selected contact.
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Tracking Documentation Associated with a Contact
Clinical research associates can attach electronic files, such as CVs, contracts, and 
reports, that may be associated with a contact and record significant dates, such as 
the date the document is sent, received, expected, or expires.

To add an attachment to a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact for whom you want to create a document.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

4 Click the Document Tracking view tab.

5 In the Document Tracking list, add a record and complete the necessary fields.

Some of the fields in a Document Tracking record are described in the following 
table.

6 Select the record you just created and click the Attachments view tab.

Field Comments

Activity Must be Document.

Assigned To The person to whom responsibility for the document has been 
assigned.

Expected Date The date that the signed document is expected to be received from 
the contact.

Expiration Date The date the document expires.

Name The document name. This is a hyperlink to the Attachments view 
tab.

Lock Assignment Determine whether the Assigned To field should be locked. If the 
activity is locked, Assignment Manager will not access it. If it is 
unlocked, Assignment Manager can reassign it.
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7 Add a record, click the select button in the Name field, and specify the filename 
or URL of the electronic document you are attaching.

To track documentation associated with a contact

1 Navigate to the Contact screen.

2 In the Contacts list, select the contact for which you want to track 
documentation.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.

3 Click the Document Tracking view tab.

A list of documents associated with the contact appear.

4 Query for the document of interest and complete the necessary fields.

For more information on associating electronic documents with contacts, see 
“Creating Documentation Tracking Activities” on page 305.
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Information for Configurators
This section offers guidelines to follow when configuring this module.

Modifying the Routing of Affiliated Contact Data
In the Account Affiliations view, end users can associate contacts with affiliations. 
In the preconfigured application, contact data is routed to the members of the team 
assigned to the contact when the end user does not check the Direct field. For more 
information, see “Indicating Affiliations Between a Contact and an Account” on 
page 64.

Siebel configurators can modify routing of contact profile data to send the data to 
all members of the team assigned to the affiliated account when the end user checks 
the Direct field.

To modify contact data routing

1 In the Siebel server directory, navigate to the SQLTEMPL folder and find the 
comdb40.sql file.

2 Open comdb40.sql and search for ASSGN_GET_DENORM_Contact.

3 Remove the comment marker in front of the following line: 

and p.DIRECT_REL_FLG=’Y’
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Planning Calls 4
This chapter describes the tools available in Siebel Life Sciences to plan account and 
contact calls. For more information on recording account and contact calls, see 
Chapter 5, “Recording Calls.”

Using the procedures given in this chapter end users will be able to add products to 
personal lists, create and apply target lists, define route plans, create activities, set 
up meetings, and schedule calls.

For more information on all end-user tasks associated with planning calls, see “End-
User Procedures” on page 81.
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Tools for Planning Calls
Siebel Life Sciences offers end users the following tools for planning their account 
calls:

■ Personal Lists. For more information, see “Personal Lists” on page 74.

■ Targeting. For more information, see “Targeting” on page 74.

■ Routes. For more information, see “Understanding Routes” on page 75.

■ Activities. For more information, see “Understanding Activities” on page 75.

Personal Lists
Personal lists allow for faster call reporting by limiting the number of products that 
appear in drop-down lists. Before end users can record call details, they must 
configure personal lists of the products they detail, the products they distribute as 
samples, and the products they provide as promotional items. For more information 
on personal lists, see the business scenario “Users Set Up Personal Lists” on page 76 
and “Creating a Personal List” on page 82.

Targeting
Targeting is an extension of querying. In targeting, end users save the results of 
queries in a target list and then apply those saved lists to other views within the 
system. A target list can consist of either a set of contacts or accounts and can be 
applied to any view that contains contacts or accounts. 

Using the Targeting screen, users can create advanced queries on contacts and 
accounts. Users can apply target lists to views individually or in combination with 
other target lists. If combining multiple target lists, users have the option of applying 
an intersection or a union of the lists. For more information on targeting, see the 
business scenario “Users Create Target Lists” on page 76 and “Creating and 
Applying Target Lists” on page 84.
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Understanding Routes
End users can create routes to schedule regular calls to groups of accounts. By 
defining a route, a user can plan the order in which to visit accounts and the 
determine a starting time for each account call. Users can also use routes to 
schedule non-routine calls to accounts by assigning target lists (for example, when 
supporting a promotion or campaign). By arranging a group of accounts into an 
efficient route, users can minimize the amount of time spent traveling between 
accounts. After a route has been created, it can be used repeatedly to schedule 
future account calls. For more information on routes, see the business scenario 
“Users Define Route Plans” on page 77 and “Defining a Route Plan” on page 87.

Understanding Activities
An activity is a scheduled task or event. Activities represent the ways in which users 
spend their time. Although activities are typically performed or planned for 
opportunities, contacts, or accounts, they can also be personal tasks that users want 
to track. For more information on activities, see the business scenario “Users Create 
Activities” on page 79 and “Creating Activities” on page 97. 

All activities with valid dates and times appear in the Siebel Life Sciences Calendar 
views as well as in the Activities views. The views in the Calendar screen provide a 
visual representation of each user’s scheduled activities and appointments. For 
more information using the calendar, see “Creating a General Activity in the 
Calendar” on page 100.

Contact and Account Calls
Contact and account calls are a type of activity record. Although users create 
contact calls in the Contact screen, they actually record calls details in the Activities 
screen. For more information on scheduling calls, see “Creating a Contact Call” on 
page 108 and “Creating an Account Call” on page 112. For information on recording 
calls, see Chapter 5, “Recording Calls.”
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Business Scenarios for Planning Calls
This section outlines four scenarios that are examples of workflows performed by 
end users in planning calls. Your company may follow different workflows 
according to its business requirements. 

Users Set Up Personal Lists
This scenario describes how end users set up and configure their personal lists. 
Personal lists determine which products appear in the Name drop-down lists in 
Siebel Life Sciences. For more information, see “Personal Lists” on page 74.

A sales representative has recently joined a pharmaceutical company which uses 
Siebel Life Sciences in the field. During her sales training, the representative’s sales 
manager tells her that before she can record calls within the system, she must first 
set up her personal lists. The sales manager explains that personal lists allow for 
faster call reporting by limiting the number of products that appear in the 
application’s Name drop-down lists. The sales manager then demonstrates how to 
add products to the sales representative’s Call Products Detailed, Samples Dropped, 
and Promotional Items Dropped views. Following her manager’s instruction, the 
sales representative updates all her personal lists and is ready to record call details.

The workflow for this business scenario comprises two end-user procedures:

■ Configure personal lists. For more information, see “Creating a Personal List” on 
page 82.

■ Record contact and account calls. For more information, see Chapter 5, 
“Recording Calls.”

Users Create Target Lists
This scenario describes how end users use targeting to create lists of contacts and 
accounts. Targeting is an extension of querying. In targeting, end users save the 
results of queries in a target list and then apply those saved lists to other views 
within the system. For more information, see “Targeting” on page 74.

A sales representative for a pharmaceutical company has just been assigned a new 
territory. As a first step in becoming more familiar with her territory, she queries 
Siebel Life Sciences and creates target lists of the following information:
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■ Contacts located within specific zip codes, bricks, or cities with NRx (new Rx) 
in Product A greater than 100 over the last two months

■ The highest-potential contacts in a given zip code or city with a Best Time To 
Call setting that includes noon to 1:00 p.m. on Tuesdays (useful if a lunch 
appointment cancels)

■ Accounts with sales in Product B greater than $60,000 over the last half-year that 
are available for calls on Monday afternoons, located within a specific range of 
zip codes, and last seen over five weeks ago

■ Accounts or contacts with high ratings in a product’s therapeutic class but low 
ratings in a specific product

Once she has saved these target lists, she can apply them to other views within the 
application. 

The workflow for this business scenario comprises two steps:

1 Create and save a target list. For more information, see “To create a target list” on 
page 85.

2 Apply target lists to other views. For more information, see “To apply one or more 
target lists” on page 86.

Users Define Route Plans
This section illustrates how end users can use the Routes views to group accounts 
by location and then use that information to schedule calls. The second business 
scenario illustrates how sales managers can create routes and schedule calls for the 
sales representatives they manage.

Sales Representative Creates Routes to Schedule Account Calls
A sales representative for a pharmaceutical company needs to plan his account call 
schedule. Because he always visits the same accounts in the same order, he decides 
to organize his accounts into routes so that he can efficiently schedule all account 
calls.
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He begins by dividing up his accounts into specific geographic areas. Then, he 
creates a four-day route that includes all accounts in the outlying portions of his 
sales territory. In addition to specifying which accounts fall into what routes, he 
defines additional details such as the starting time and the duration of each call. 
Once all routes have been defined, he schedules calls to all accounts in his territory 
for the upcoming month. 

Sales Manager Creates Routes for New Direct Report
A sales manager for a pharmaceutical company manages 10 sales representatives. 
One of her representatives, a new employee, is not familiar with his territory. To 
help her new representative get up-to-speed, she organizes the new representative’s 
accounts into a series of routes. 

Each route is divided into sections and will be visited every two weeks. The sales 
manager creates 10 routes—one for each workday in a two-week period. Each route 
includes multiple accounts in the same neighborhood. Once the sales manager has 
finished creating the routes, she uses them to schedule a month’s worth of account 
calls for her new sales representative. 

Once her new direct report becomes familiar with his territory, she gives him the 
responsibility of maintaining and updating his routes. The new sales representative 
can then add new accounts to a route, change the order in which routes are visited, 
or adjust the start time and duration of each visit.

The workflow for this business scenario comprises four procedures:

1 Create a route. For more information, see “To create a route” on page 88.

2 Add accounts to a route. For more information, see “To add accounts to a route 
using the Accounts view tab” on page 90.

3 Optional: Assign target lists to a route. For more information, see “To assign a 
target list to a route” on page 94.

4 Schedule account visits using routes. For more information, see “Using a Route to 
Schedule Calls” on page 95.
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Users Create Activities
This scenario describes how end users use activities to manage their own time, keep 
their manager informed of their workload, and track their expenses. Typically 
activities are performed or planned for opportunities, contacts, or accounts, but 
they can also be used to track personal tasks. Consider the following example.

A sales manager for a pharmaceutical company wants to review her schedule. She 
uses the Activities screen in Siebel Life Sciences to create, categorize, and track all 
the activities on which she plans to spend her time during the next month. 

From the My To Do List view, she prints a report detailing her current activities, 
their due dates, and all pertinent account information. Remembering she wants to 
meet with each of her direct reports in next two weeks, she prints a report 
summarizing all the calls her team has made over a 20-week period. Then, she 
schedules meeting with each of her direct reports to discuss their sales goals for the 
next quarter. Finally, she schedules a contact call with a prominent customer whose 
regular sales representative is on a long leave. Then, she reviews the Calendar 
screen to review her schedule for the upcoming weeks.

NOTE: End users also use the Activities screen to record and submit details of Contact 
and Account Calls. For more information, see Chapter 5, “Recording Calls.”

The workflow for this business scenario comprises four procedures:

1 Create general activities. For more information, see “Creating Activities” on 
page 97.

2 Create contact or account call. For more information, see “Creating a Contact 
Call” on page 108 and “Creating an Account Call” on page 112.

3 Set up a meeting. For more information, see “Setting Up a Meeting” on page 104.

4 View activities and create new activities on the Calendar screen. For more 
information, see “Creating a General Activity in the Calendar” on page 100.
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Example Workflow for Planning Calls
This section details sample tasks often performed by end-users when planning calls. 
Your company may follow a different workflow according to its business 
requirements. 

The following list shows tasks end users typically perform when planning contact 
and account calls:

■ Set up and update their personal lists. Personal lists determine which products 
appear in the Call Detail views in Siebel Life Sciences. For more information, see 
“Users Set Up Personal Lists” on page 76.

■ Optional: Create and apply target lists. Using target lists users can query for 
accounts or contacts and then apply those lists to other views within the 
application. For more information, see “Users Create Target Lists” on page 76.

■ Optional: Create route plans. Route plans are groups of accounts sorted by 
location. Once created, users can use route information to schedule calls. For 
more information, see “Users Define Route Plans” on page 77.

■ Optional: Add general activities, set up meetings, and create calls. Activities allow 
users to manage their own time, keep their manager informed of their workload, 
and track expenses. For more information, see “Users Create Activities” on 
page 79.

■ Create contact and account calls. For more information, see “Creating a Contact 
Call” on page 108 and “Creating an Account Call” on page 112.

NOTE: As soon as end users set up their personal list, they can record calls. For more 
information, see “Recording Contact Calls” on page 124 and “Recording Account 
Calls” on page 129.
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End-User Procedures
The following end-user procedures are described in the section:

■ Updating a personal list:

■ To add a product to a personal list on page 83

■ Creating and applying target lists:

■ To create a target list on page 85

■ To delete a target list on page 86

■ To apply one or more target lists on page 86

■ Creating a route plan:

■ To create a route on page 88

■ To add accounts to a route using the Accounts view tab on page 90

■ To add accounts to a route using the Explorer view tab on page 91

■ To merge a target list on page 92

■ To assign a target list to a route on page 94

■ To schedule calls from the My Routes view on page 95

■ To schedule calls from the Target Accounts view on page 96

■ Creating activities:

■ To add a general activity on page 99

■ To create a general activity in the Calendar view on page 100

■ To give other users access to your calendar on page 103

■ Setting up meetings:

■ To add a meeting on page 104

■ To add a meeting activity on page 105
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■ To add a meeting speaker on page 106

■ To add a meeting invitee on page 107

■ To update the Cost field in the Meeting Invitees list on page 108

■ Creating contact calls:

■ To add a contact call from the Activities screen on page 109

■ To automatically schedule a contact call using the Schedule button on 
page 110

■ To manually schedule a contact call in the Calls view tab on page 111

■ To schedule a contact call in the Calendar on page 111

■ Creating account calls:

■ To add an account call from the Activities screen on page 112

■ To automatically schedule an account call using the Schedule button on 
page 114

■ To manually schedule an account call in the Account view tab on page 114

■ To add an account call using the New Call button on page 115

■ To schedule an account call in the Calendar on page 115

Creating a Personal List
Personal lists determine which products appear in the drop-down lists of the Call 
Products Detailed, Samples Dropped, and Promotional Items Dropped views. End 
users must specify at least one product in a personal list or the corresponding drop-
down list will be empty when they try to enter call details. For more information on 
recording calls, see Chapter 5, “Recording Calls.”

Setting up personal lists is a one-time setup procedure. Once end users have 
completed it, they do not need to repeat it. However, they can revise their personal 
lists at any time, deleting or adding products as necessary. For more information on 
personal lists, see “Personal Lists” on page 74 and the business scenario “Users Set 
Up Personal Lists” on page 76.
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To add a product to a personal list

1 Navigate to the Activities screen.

2 From the Show drop-down list, select one of the following:

■ Personal Details List. Adds products to the Personal Details List.

■ Personal Samples List. Adds products to the Personal Samples List.

■ Personal Promotional Items List. Adds products to the Promotional Items List.

3 In the appropriate list, add a record and complete the necessary fields. 

Some of the fields on the Activities view are described in the following table.

 

Complete this procedure for each of the views:

■ Personal Details List view

■ Personal Samples List view

■ Personal Promotional Items List view

Field Comments

Product The products being detailed during contact and account calls. 
This field appears in the Product Details List.

Sample The products to be dropped as samples during contact and 
account calls. This field appears in the Personal Samples List.

Promotional Item The promotional items being dropped during contact and 
account calls. This field appears in the Personal Promotional 
Items List.

Order Enter a number that indicates where this product should appear 
in the drop-down list. This field appears in the Product Details 
List, Personal Samples List, and Personal Promotional Items List.

For example, if you want a product in the Product Details List to 
appear first, enter 1. If this field is null for all products in the list, 
the products will appear in alphabetical order. If this field is null 
for some products but not for others, records with a null Order 
field appear at the beginning of the list, in alphabetical order. 
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Creating and Applying Target Lists
Targeting is an extension of querying. In targeting, end users save the results of 
queries in a target list and then apply those saved lists to other views within the 
system. A target list can consist of either a set of contacts or accounts and can be 
applied to any view that contains contacts or accounts. For more information on 
targeting, see “Targeting” on page 74 and the business scenario “Users Create Target 
Lists” on page 76.

To create a target list, users must perform these steps:

■ Create and save a target list. Users must create a query to locate the contacts or 
accounts they want to target. Saving a target list gives the query a descriptive 
name and optionally allows the user to capture the creation date. For more 
information, see “To create a target list” on page 85.

NOTE: A saved target list consists only of contacts or accounts that matched the 
query criteria when the query was performed. Remember to periodically re-create 
your target lists to include contacts or accounts who were added after the target 
list was saved, or whose data has changed since the target list was saved. 

■ Apply target list to other views. Once saved, users can apply a target list in any 
view which contains contacts or accounts, including forms, charts, and some 
dialog boxes. For more information, see “To apply one or more target lists” on 
page 86.

For example, a user could create a target list of contacts using one of the views 
in the Targeting screen, apply it to a view in the Contacts screen, and then print 
a report on those contacts. Or, a user could use the target list to generate a list 
of meeting invitees in the Activities screen. In this second example, the user 
would apply the target list in the Add Invitees view tab. For more information, 
see “Setting Up a Meeting” on page 104. 

NOTE: In order to enhance system performance, logging for targeting is disabled by 
default. To enable logging for targeting, locate the Pharma Targeting Detail and 
Pharma Targeting Header business components in Siebel Tools and set the Enable 
Log Changes property to TRUE. 
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To create a target list

1 Navigate to the Targeting screen.

2 From the Show drop-down list, select Contact Attributes.

NOTE: If Contact Attributes is not the view you want to use, make another 
selection from the Show drop-down list. To target contacts, select Contact 
Attributes or Contact Profiles. To target accounts, select Account Attributes or 
Account Profiles.

3 In the Contact Attributes form, click Query.

The application clears all fields in all forms. 

4 Enter your query criteria in the appropriate fields of the Contact Attributes and 
Rx Consumption forms. 

NOTE: Remember that the more fields in which you enter query criteria, the 
longer the query will take to execute. Also, entering a query condition that is too 
general may also lengthen the query execution time.

5 In the Contact Attributes form, click Go.

The application returns the query results in the Target Contacts list.

6 Click the save target list button.

NOTE: The save target list button is located in the row of buttons next to the 
history button.

7 In the Save Target List dialog box, enter a unique name (up to 50 characters long) 
in the Target Name field and click Save.

CAUTION: If you enter a name already in use, the previously saved target list will 
be overwritten without warning.

The application saves the target list.
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NOTE: The saved target list includes only those records that matched the query 
criteria when the query was generated. You should re-create your target lists 
periodically, since data may have been modified, or new contacts or accounts 
may have been added since you created the target list. For example, you must 
re-create your target lists after a territory realignment.

To delete a target list

NOTE: This procedure can also be used in any Siebel Life Sciences view that 
supports target lists and in which the Save Target List command is available from 
the Edit application-level menu.

1 Navigate to the Targeting screen.

2 From the Show drop-down list, select the type of list you want to delete:

■ To delete a list of contacts, select Contact Attributes or Contact Profiles. 

■ To delete a list of accounts, select Account Attributes or Account Profiles.

3 From the application-level menu, choose Edit > Save Target List.

The Save Target List dialog box appears.

4 In the Save Target List dialog box, select the target list you wish to delete and 
click Delete.

Target lists can be applied in any Siebel Life Sciences view in which the Apply Target 
List command is available on the Edit application-level menu. Typically, users apply 
target lists to lists that display contacts or accounts. However, they can also apply 
them to forms and dialog boxes from which they select contacts to populate a field. 

To apply one or more target lists 

1 Navigate to the view or dialog box in which you want to apply the target list. 
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2 Click the apply target list button.

NOTE: The save target list button is located in the row of buttons next to the 
history button.

The Apply Target List dialog box appears.

3 In the Target Name field, select one or more target lists and click one of the 
following:

■ Intersection. Click Intersection to retrieve only those records common to all 
the selected target lists. For example, if List 1 contains A, B, and C, and List 
2 contains B, C, and D, the resulting list will contain only B and C, which are 
common to both target lists.

■ Union. Click Union to retrieve all records from all the selected lists. For 
example, if List 1 contains A, B, and C, and List 2 contains B, C, and D, the 
resulting list will contain A, B, C, and D, the combination of both target lists.

Defining a Route Plan
End users can create routes to schedule regular calls to groups of accounts. By 
defining a route, a user can plan the order in which to visit accounts and determine 
a starting time for each account call. For more information, see “Understanding 
Routes” on page 75 and the business scenario “Users Define Route Plans” on 
page 77.

When creating a route, users must complete the following tasks in the order lists:

■ Create a route. Users must specify the person for whom they are creating the 
route. Although each user can be assigned multiple routes, each route can only 
be assigned to one user. For more information, see “To create a route” on 
page 88.

■ Add accounts to a route. Once users have established a route, they can add 
accounts to it. There is no limit to the number of accounts that can be assigned 
to one route. 
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■ Optional: Assign a target list to a route. If a user is using the Account Targeting 
features to create target lists, they can assign them to a route. For more 
information, see “To assign a target list to a route” on page 94.

■ Schedule calls. When a route has been created, users can use it to schedule calls 
to every account in the route. For more information, see “To schedule calls from 
the My Routes view” on page 95 and “To schedule calls from the Target Accounts 
view” on page 96.

NOTE: When creating and scheduling a route with a limited duration, such as in 
support of a promotion, users can perform all the proceeding steps in the 
Targeting screen.

Creating a Route
When creating a route, users must specify the person for whom they are creating 
the route (generally a field sales manager or sales representative). When creating a 
route remember that:

■ Each user can be assigned many routes

■ A route can have any number of accounts

■ A route can only be assigned to one user

■ A route name can only be used once for each user

■ The same route name can be used for routes assigned to different users

To create a route

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.
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3 In the Routes form, add a record and complete the necessary fields.

NOTE: In the My Routes view, the Sales Person field is automatically filled with 
the current user name. If you are assigning a route to someone other than 
yourself, enter that person’s name in the Sales Person field.

Some of the fields in a Routes record are described in the following table.

Adding Accounts to a Route
Once users have established a route, they can add accounts to it. There is no limit 
to the number of accounts that can be assigned to one route. Two views are 
available for adding accounts to routes:

■ Accounts view tab. Shows accounts associated with the selected routes. For more 
information, see “To add accounts to a route using the Accounts view tab” on 
page 90.

Field Comments

Active Select this field if the route is active and available for use in scheduling 
calls. 

Description A description of the route.

Last Updated The application automatically populates this field with the time and 
date the route was last changed.

Route Name A user-defined name for the route, such as Northeast Richmond. A 
route name must be unique to the end user to which it is assigned.

Sales Person The sales person to whom the route is assigned. A route can be 
assigned only to one person.

Start Day The day of the week on which the route is designated to begin. This is 
used as reference information only and does not prevent you from 
using the route to schedule calls starting on some other day of the 
week.

Updated By The application automatically populates this field with the name of the 
user who last changed the route.
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■ Explorer view tab. Shows routes and accounts in a hierarchical format. For more 
information, see “To add accounts to a route using the Explorer view tab” on 
page 91.

NOTE: When associating an account with a route, only select accounts where the 
owner of the route is represented on the sales team. It is possible to pick any 
existing account in the database when associating an account with a route. There 
is no check to determine whether you or the owner of the route has access to the 
account. This is standard behavior; dialog boxes for Accounts are always 
unconstrained. When drilling into an account which is not accessible to you, an 
error message will appear, stating that you do not have the required access to view 
that account. This is especially relevant for Siebel Mobile Web Client users who can 
only view their own accounts on their local database.

To add accounts to a route using the Accounts view tab

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

3 In the Routes list, select a route.

4 Click the Accounts view tab.

5 In the Accounts list, add a record and then click the Select button in the Account 
field.

The Pick Account dialog box appears.

6 In the Pick Account dialog box, select an account and click OK.

7 For each new account, complete the necessary fields.

Some of the fields in an Account record are described in the following table.

Field Comments

Call Duration The scheduled duration of the account call.

Call Time The application automatically enters the current time in this field. Edit 
the value to reflect the time at which the account is to be visited.
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Repeat Step 5 on page 90 through Step 7 on page 90 until all accounts have been 
added to the Accounts list.

To add accounts to a route using the Explorer view tab

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

3 In the Routes list, select a route 

4 Click the Explorer view tab.

5 In the Routes explorer tree, click the plus sign next to the route to which you 
want to add an account.

6 Click the plus sign next to the Accounts folder displayed under the route.

A list of all the accounts assigned to the route appears.

7 In the Accounts list, add a record and then click the Select button in the Account 
field.

The Pick Account dialog box appears.

8 In the Pick Account dialog box, select an account and click OK.

Last Call Identifies the date and time of the most recent call to this account.

Offset Day Allows you to create routes that span more than one day. Indicates the 
number of days after the beginning of the route that an account should 
be visited. 

For example, if an account is to be visited on the first day of a route, 
this field should be set to 0. If the account is to be visited on the 
second day of a route, this field should be set to 1.

Field Comments
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9 For each new account, complete the necessary fields.

Some of the fields in an Account record are described in the following table.

Repeat Step 7 on page 91 through Step 9 for each account you want to add.

Assigning Target Lists to a Route
After creating and saving a target list, end users can optimize a target list by merging 
(intersecting, excluding, or combining) it with other target lists. Once target lists 
have been merged, users can assign the results to a route. Users can also add or 
delete accounts after assigning the list of accounts to a route.

NOTE: End users must create and save a target list using the Account Targeting 
feature before they can merge it with other target lists and assign the results to a 
route. For information on creating and saving target lists, see “Creating and 
Applying Target Lists” on page 84.

To merge a target list

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

Field Comments

Call 
Duration

The scheduled duration of the account call.

Call Time The application automatically enters the current time in this field. Edit 
the value to reflect the time at which the account is to be visited.

Last Call Identifies the date and time of the most recent call to this account.

Offset Day Allows you to create routes that span more than one day. Indicates the 
number of days after the beginning of the route that an account should 
be visited. 

For example, if an account is to be visited on the first day of a route, 
this field should be set to 0. If the account is to be visited on the second 
day of a route, this field should be set to 1.
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3 In the Routes list, select a route.

4 Click the Target Accounts view tab.

5 Click the Target Accounts list to activate it. 

A blue line appears around the Target Accounts list. 

6 Click the apply target list button.

NOTE: The save target list button is located in the row of buttons next to the 
history button.

The Apply Target List dialog box appears.

7 In the Target Name field, select one or more target lists, click one of the 
following, and then click OK:

■ Intersection. Click Intersection to retrieve only those records common to all 
the selected target lists. For example, if List 1 contains A, B, and C, and List 
2 contains B, C, and D, the resulting list will contain only B and C, which are 
common to both target lists.

■ Union. Click Union to retrieve all records from all the selected lists. For 
example, if List 1 contains A, B, and C, and List 2 contains B, C, and D, the 
resulting list will contain A, B, C, and D, the combination of both target lists.

NOTE: If only one target list is selected, the radio buttons are ignored.

8 Optional: To apply additional logic to the target list, click the save target list 
button, located in the row of buttons next to the history button.

The Targeting dialog box appears.

9 In the Target Name field, enter a unique name for the target list.

CAUTION: If you enter a name already in use, the previously saved target list will 
be overwritten without warning.
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10 Click Save.

The target list is saved. You can merge this list with other target lists to optimize 
your list of accounts.

Repeat Step 6 on page 93 through Step 10 until you have optimized your target list. 
You are now ready to assign the target list to a route.

To assign a target list to a route

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

3 In the Routes list, select a route.

4 Click the Target Accounts view tab.

5 In the Target Accounts list, merge target lists until you have an optimized list of 
accounts.

NOTE: For information on merging target lists, see “To merge a target list” on 
page 92.

6 In the Target Accounts list, select the accounts that you want to add to a route.

7 Click the Double Arrow button.

The selected accounts are added to a route and appear in the Accounts list. 
When you are adding target accounts to an existing route, the target accounts 
will be added without duplicating accounts. If necessary, you can add or delete 
accounts from the Accounts list.
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8 Fill in the fields in the Accounts list for each account you added. 

Some of the fields in the Accounts record in are described in the following table.

Using a Route to Schedule Calls
After a route has been created, end users can use it to schedule calls to all the listed 
accounts. Users can schedule route calls from a number of views. The following 
procedures demonstrate how to schedule routes from the My Routes view, the 
Target Accounts view, and the Daily Calendar view.

To schedule calls from the My Routes view

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

3 In the Routes list, select the route you want to schedule.

4 In the More Info form, click Schedule.

The Auto Schedule dialog box appears.

Field Comments

Call Duration The scheduled duration of the account call.

Call Time The current time is automatically entered in this field. You should edit this
field to reflect the time at which the account is to be visited.

Last Call Identifies the date and time of the most recent call to this account.

Offset Day Allows you to create routes that span more than one day. It indicates the 
number of days after the beginning of the route that an account should be
visited. For instance, if an account is to be visited on the first day of a 
route, this field should be set to 0. If the account is to be visited on the 
second day of a route, this field should be set to 1.
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5 In the Start Date field, enter a date, and then click OK.

Appointments for each account in the route are added to the calendar of the end 
user to whom the route is assigned. 

CAUTION: It is possible to schedule multiple appointments for the same time 
period when using the Routes views to schedule calls. Such scheduling conflicts 
do not trigger any sort of automatic notification. Sales representatives should 
check the Daily Calendar view for possible conflicts after routes have been 
added to their schedules. If scheduling conflicts exist, they should adjust the 
starting times of appointments or delete them as necessary to resolve the 
conflicts.

To schedule calls from the Target Accounts view

1 Navigate to the Routes screen.

2 From the Show drop-down list, select My Routes.

3 In the Routes list, select a route.

4 Click the Target Accounts view tab.

5 Assign a target list of accounts to the route. 

For information on assigning a target list of accounts to a route, see “To assign 
a target list to a route” on page 94.

6 In the Target Accounts form, click Schedule.

The Auto Schedule dialog box appears.
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7 In the Start Date field, enter a date, and then click OK.

Appointments for each account in the route are added to the calendar of the end 
user to whom the route is assigned. 

CAUTION: It is possible to schedule multiple appointments for the same time 
period when using the Routes views to schedule calls. Such scheduling conflicts 
do not trigger any sort of automatic notification. Sales representatives should 
check the Daily Calendar view for possible conflicts after routes have been 
added to their schedules. If scheduling conflicts exist, they should adjust the 
starting times of appointments or delete them as necessary to resolve the 
conflicts.

Creating Activities
End users use general activities to manage their own time, keep their manager 
informed of their workload, and track their expenses. Managers can also create 
general activities and assign them to members of their teams. The kinds of activities 
that end users can create in Siebel Life Sciences include:

■ General. Used to track non-call and non-meeting tasks such as to-do items, 
personal events, and correspondence. Users can create an alert for a general 
activity to remind them of significant tasks or events. 

■ Contact call. Used to track a planned or past call activity with a contact. Users 
can record details about contact calls such as the products detailed, the samples 
and promotional items dropped, and decision issues discussed. Before users can 
record details about a contact call, they must set up their personal lists. For more 
information, see “Creating a Personal List” on page 82.

■ Account call. Used to track a planned or past call activity at an account. Users 
can record products detailed, attendees, promotional items dropped, and 
decision issues discussed. For more information, see Chapter 5, “Recording 
Calls.”

■ Meeting. Used to track meetings, such as a “lunch-and-learn” or a symposium, 
designed to increase sales through product awareness. A meeting typically 
involves one or more speakers who give presentations in support of one or more 
products. For more information, see “Setting Up a Meeting” on page 104.
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■ Time off territory. Used to track blocks of time that users spend on activities not 
directly associated with an account or contact. Examples of time off territory can 
include field training sessions, national sales meetings, vacations, or personal 
activities such as doctor's appointments. For more information on working with 
time off territory activities, see “Tracking Time Off Territory” on page 233.

■ MedEd activity. Used to track and plan medical education events such as a 
“lunch-and-learn” meetings or seminars. A MedEd event is similar to a meeting 
activity, but offers planning, budgeting, and cost aggregation functionality. 
MedEd activities are only associated with the separate Siebel MedEd module. For 
more information, see “Managing MedEd Events” on page 243.

■ Subject activities. Used to track subject activities for a protocol. Subject activities 
are generated by applying the visit template based on the screening or 
enrollment date. Visit activities can also be created for a non-scheduled visit. For 
more information, see “Adding a Subject and Setting Up Visits and Visit 
Activities” on page 312.

■ Clinical protocol site activities. Used to track the activities associated with 
initiating the protocol sites, for example, collecting the essential documents. For 
more information, see “Creating Site Activity Plans” on page 332.

■ Checklist activities. Used to provide a checklist for clinical research associates 
(CRAs) to check activities associated with visiting a protocol site. Once a trip 
report record has been created, checklist activities are generated by selecting a 
trip report template. Checklist activities specific to a trip report can also be added 
to a trip report from the Trip Report Details view. For more information, see 
“Creating a Trip Report Before a Site Visit” on page 356.

■ Follow-up activities. Used to record follow-up issues for a trip report. Users can 
add a follow-up activity to a trip report from the Trip Report Details view. Only 
the follow-up activities with open status are listed in a Follow-up Activities 
report generated from the Reports menu. For more information, see “Creating a 
Trip Report Before a Site Visit” on page 356.

■ Project Activities. Used to track activities associated with clinical projects. These 
activities appear in the Projects screen and the Activities screen and can be 
created by project activity templates and by importing from Microsoft Project 
files. For more information, see “Adding Activities and Tasks to a Project” on 
page 380.
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For more general information on activities, see “Understanding Activities” on 
page 75 and the business scenario “Users Create Activities” on page 79.

NOTE: End users also use the Activities screen to record and submit details of contact 
and account calls. For more information, see Chapter 5, “Recording Calls.”

Adding a General Activity
End users use general activities to manage their own time, to keep their manager 
informed of their workload, and to track their expenses. Managers can also create 
general activities and assign them to members of their teams.

To add a general activity

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 Click the More Info view tab.

4 In the More Info form, add a record and complete the necessary fields. 

Some of the fields in the Activities record are described in the following table.

Field Comments

Change 
Request #

The change request with which the activity is associated, if relevant. 

Description A description of this activity. 

Duration The length of time, in minutes, that you expect the activity to take.

Employees Delegate the activity to someone else. Select the appropriate 
employee and click OK. If you delegate an activity this way, the 
activity appears in the My Delegated Activities view.

Expense Select this field to include the activity in an expense report generated 
by the Siebel Expenses module. For information on expense reports, 
see Online Help.
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Creating a General Activity in the Calendar
The views in the Calendar screen provide visual representations of a user’s 
scheduled activities, or appointments; that is, activities with a start time. For 
instance, in the My Daily view, users can see a particular day’s agenda, their 
unscheduled activities, or a to-do list. To appear in the Calendar views, all activities 
must have a start time.

To create a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select My Calendar.

The My Daily Calendar view appears, displaying the current date.

3 Select one of the view tabs described in the following table:

 

Suppress 
Calendar

Selecting this field causes the activity to not appear in Calendar 
views.

Type The type of activity. If you select Alert, the activity appears in the My 
Alerts view. The values displayed in this drop-down list depend on 
the value of the Activity field. For example, the activity types that you 
can select for a contact call are different from those that you can 
select for a general activity. 

Field Comments

View tab Description

My Daily Shows activities for the day and allows users to create general activities. 

My Weekly Shows scheduled activities for the week in a calendar grid and allows 
users to create general activities.

My Monthly Shows scheduled activities for the month in a calendar grid or list 
format and allows you to create general activities. 
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4 Navigate to the day on which you want to schedule a general activity and add a 
record. 

NOTE: If you are performing this procedure from the My Weekly view or the My 
Monthly view, you must first select the day on which you want to schedule the 
appointment. 

5 In the Calendar Detail form, click the show more button and complete the 
necessary fields.

NOTE: This procedure describes how to create a general activity. For more 
information on creating a call in the Calendar, see “To schedule a contact call in 
the Calendar” on page 111 and “To schedule an account call in the Calendar” on 
page 115.

Some of the fields in a Calendar Detail record are described in the following 
table.

 

Field Comments

Account Complete this field if the activity is related to a particular account. 
The value of this field cannot be modified for Contact Call activities.

Alarm Select this field to have an alarm remind you of the appointment. A 
setting on the Calendar tab of the Options dialog box determines 
how many minutes before the appointment the alarm will ring. 

Contacts Complete this field if the activity is related to a particular contact. 

Cost Estimate Enter a cost to include the call in an expense report generated by the 
Siebel Expenses module. 

Duration This value is based on the duration preset on the Calendar tab of the 
Options dialog box. When you change the duration, the end time is 
automatically updated. 

Employees The employees assigned to this activity. Select an employee from the 
Employees dialog box if the activity is assigned to particular 
employees. 
Version 7.5, Rev. A Siebel Life Sciences Guide 101



Planning Calls

End-User Procedures
Expense Select this field to include the activity in an expense report generated 
by the Siebel Expenses module. For information on expense reports, 
see Online Help.

Frequency Select a frequency of your repeating appointment; Weekly is the 
default.

Opportunity Complete this field if the activity is related to a particular 
opportunity. If the opportunity is for a different account than the one 
listed in the Account field, the account field will be updated 
automatically. The value of this field cannot be modified for Contact 
Call activities.

Planned 
Completion

This value is based on the duration preset on the Calendar tab of the 
Options dialog box. When you change the end time, the duration is 
automatically updated. 

Planned Start If you started from the Daily Calendar view, this date reflects the 
time selected when you created the new appointment. If you started 
from the Weekly Calendar or Monthly Calendar view, the first time 
slot of the day (set on the Calendar tab of the Options dialog box) is 
supplied.

Repeat Select this field to have this appointment repeat at regular intervals 
in the future.

Type The type of activity. The default value is Other. If you select Alert, 
the activity appears in the My Alerts view. The values displayed in 
this drop-down list depend on the kind of activity; that is, a contact 
call will display different values for this field than you see for a 
general activity. 

Until The end date of a repeating appointment. If you do not select a 
value, 12 more appointments will be scheduled. The value of this 
field cannot be modified for Contact Call or Account Call activities.

Field Comments
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6 Click Save This One.

The new appointment appears in the Calendar view.

NOTE: From the My Daily view tab, you can also create an activity in the 
Activities list by right-clicking and choosing New Record. The Activities list only 
shows an activity if the Start Time field of the activity is blank. Once you give the 
activity a start time and refresh the view, the activity appears in the Daily 
Agenda. 

7 To print the current Calendar view, click Print. 

8 To edit an existing activity, drill-down on the activity description hyperlink. 

The Calendar Detail form appears. 

To create specialized activities in the Calendar view

■ Click New Contact Call to schedule a call to a contact.

■ Click New Acct Call to schedule a call to an account.

■ Click New Meeting to schedule a meeting and to list activities, meeting speakers 
and invitees.

Users who work as part of a team, may find it useful to share access to their 
calendar. 

To give other users access to your calendar

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Calendar Access List.

3 In the Calendar Access list, add a record.

4 In the Add Employees dialog box, select one or more employees and click OK.

The employee’s name and login name appear in the Calendar Access list.

5 To give an employee the ability to modify your calendar items, click the Allow 
Updates field.
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Setting Up a Meeting
Use the Meetings subviews of the Activities screen to manage information about 
activities, speakers, and invitees associated with meetings. Meetings themselves are 
activities that appear in the My Activities view. The activities that a user adds for a 
meeting are child records of the meeting and are not displayed in the Activities list 
in the My Activities view; they appear only in the Meeting Activities view and in the 
Calendar views.

NOTE: A MedEd event is similar to a meeting activity, but offers planning, budgeting, 
and cost aggregation functionality. MedEd activities are only associated with the 
separate Siebel MedEd module. For more information, see Chapter 11, “Managing 
MedEd Events.”

Setting up a meeting involves the following steps:

■ Add a new meeting record. For more information, see “To add a meeting” on 
page 104. 

NOTE: Users can also add a meeting by clicking the New Meeting button in the 
Activities list of the My Activities view. 

■ Add activities for the meeting. For more information, see “To add a meeting 
activity” on page 105. 

■ Add speakers for the meeting. For more information, see “To add a meeting 
speaker” on page 106. 

■ Add invitees for the meeting. For more information, see “To add a meeting invitee” 
on page 107. 

To add a meeting 

1 Navigate to the Activities screen.

2 From the Show drop-down list, My Activities.

3 In the Activities list, click New Meeting.

The Meetings form appears.
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4 In the Meetings form, complete the necessary fields.

Some of the fields in the Meetings record are described in the following table. 

 

Add information about activities, speakers, and invitees, as described in the 
following procedures. 

To add a meeting activity

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, do one of the following:

■ Create a new meeting. For more information, see “To add a meeting” on 
page 104.

■ Select an existing meeting and then drill-down on the Activity field.

The Meetings form appears.

Field Comments

Account The account associated with this meeting. Select an account from the Pick 
Account dialog box. The Location and Site fields are automatically filled 
based on the account you specify.

Cost The application calculates this field based on costs entered for meeting 
activities. For more information, see “To add a meeting activity” on 
page 105. 

The application calculates this field when you click the Distribute Costs 
button in the Meeting Invitees view and updates it each time you click the 
Distribute Costs button again. For more information, see “To add a 
meeting invitee” on page 107.

Name The name of this meeting. 

Start Date The application automatically populates this field with the date and time 
that the record was created. If needed, make additional changes.

Status The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

This field is hard-coded so that its value cannot be set to Submitted to 
avoid interference with other activity types, such as contact calls and 
account calls that are based on the same class of Siebel business 
components.
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4 Click the Meeting Activities view tab.

5 In the Meeting Activities list, add a record and complete the necessary fields. 

Some of the fields in the Meeting Activities record are described in the following 
table. 

 

Add information about speakers and invitees, as described in the following 
procedures. 

NOTE: Meetings are activities that appear in the My Activities view. However, 
activities that you add to a meeting are child records of the meeting. These records 
only appear in the Meeting Activities tab view and as activities in the Calendar 
views. 

To add a meeting speaker

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, do one of the following:

■ Create a new meeting. For more information, see “To add a meeting” on 
page 104.

■ Select an existing meeting and then drill-down on the Activity field.

The Meetings form appears.

4 Click the Meeting Speakers view tab.

Field Comments

Activity The type activity associated with this meeting. 

Cost Enter the cost related to this activity, if applicable. This 
information is used to distribute meeting costs across attendees. 
For more information, see “To add a meeting invitee” on 
page 107. 
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5 In the Meeting Speakers list, add a record. 

The Add Speakers dialog box appears.

6 In the Add Speakers dialog box:

■ If no contacts appear, click All Contacts.

■ To only display contacts affiliated with the selected account, click Affiliated 
Contacts. 

■ Select those contacts you want to add as speakers for the meeting and click 
OK.

New records for the selected contacts are added to the Speakers list. 

Add information about invitees, as described in the following procedure. 

To add a meeting invitee

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, do one of the following:

■ Create a new meeting. For more information, see “To add a meeting” on 
page 104.

■ Select an existing meeting and then drill-down on the Activity field.

The Meetings form appears.

4 Click the Meeting Invitees view tab.

5 In the Meeting Invitees list, add a record. 

The Add Invitees dialog box appears.

6 In the Add Invitees dialog box:

■ Click Affiliated Contacts to display only contacts affiliated with the selected 
account. For more information, see “Indicating an Affiliation Between an 
Account and a Contact” on page 200.
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■ Click All Contacts, if no contacts appear.

■ Select those contacts you want to add as invitees for the meeting and click 
OK.

New records for the selected contacts are added to the Speakers list. 

The application calculates the value of the Cost field the Meeting Invitees list based 
on values entered in Cost field of the Meeting Activities list. It then distributes the 
costs across all invitees whose Invitee Status field is set to Attended. 

To update the Cost field in the Meeting Invitees list

1 Click the Meeting Activities view tab.

2 In the Meeting Activities list, record the costs associated with each meeting 
activity in the Cost field. 

3 To distribute the meeting costs across those individuals who attended the 
meeting, click the Meeting Invitees view tab.

4 In the Meeting Invitees list, update the Invitee Status for each invitee. Selecting 
the status Attended includes the selected invitee in the count of contacts for 
distribution of meeting costs.

5 Click Distribute Costs. 

As you add costs and attendees to the meeting, repeat the previous steps as many 
times as needed. 

Creating a Contact Call
End users track details about calls made on a contact with contact call records. 
Although users can create and display contact calls on the Contacts screen, they 
enter details about the actual call on the Activities screen. Also, as activities, contact 
call records can also be viewed in the Calendar screen as planned events. 
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For more information on entering call details, see “Recording Contact Calls” on 
page 124.

NOTE: Before user can enter information about products detailed, samples, and 
promotional items dropped during a contact call, they must set up their personal 
lists. For more information, see “Creating a Personal List” on page 82.

To add a contact call from the Activities screen

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, click New Contact Call.

4 In the Contact Call form, add a record and complete the necessary fields. 

Some of the fields in the Contact Call record are described in the following table.

 

Field Comments

Cost The cost you want to include the call in an expense report generated by 
Siebel Expenses. Also do the following before submitting the call: 

■ Specify the actual start time for the call.

■ Check the Expense flag for the call in the My Activities view. For 
more information, see “Adding a General Activity” on page 99.

Last Name The contact to be visited during this call. Make a selection from the Pick 
Contact dialog box and click OK. 

Ref # A reference number for this call. This reference number becomes the 
transaction number (Transaction # field) for a samples transaction 
corresponding to this call. For information on samples transactions, see 
Chapter 6, “Managing Samples.”
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For more information on how to enter information in Call Products Detailed, Sample 
Products Dropped, Promotional Items Dropped, and Issues lists, see “Recording 
Contact Calls” on page 124.

NOTE: If you applied a Smart Call to the call (as described in Step 4), you may only 
need to verify that all the information in the four lists is accurate.

To automatically schedule a contact call using the Schedule button

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

4 Click the Schedule button.

The Auto Schedule dialog box appears, displaying the date range specified on 
the best-times-to-call information on the Addresses view tab.

5 In the Auto Schedule dialog box, review the displayed values, make any needed 
changes, and click OK.

Smart Call The Smart Call template to be associated with this call. Make a selection 
from the Pick Smart Call dialog box. 

A Smart Call is a template that you apply to contact calls that defines 
information about the products detailed, samples and promotional 
items distributed, and issues discussed on a call. Once you apply a 
Smart Call template to a call, you can make additional edits any fields 
in the Contact Call Detail view. For more information on Smart Calls, see 
Chapter 8, “Creating Smart Calls.” 

Status The status of this call. The default value is Planned. This value changes 
to Synchronized after synchronization. 

Be aware, you cannot select the value Submitted. To change the status 
of the call to Submitted, you must submit the call. For more information, 
see “To submit a completed contact call” on page 128. 

Field Comments
110 Siebel Life Sciences Guide Version 7.5, Rev. A



Planning Calls

End-User Procedures
NOTE: The auto-scheduling function does not check for scheduling conflicts. 
Therefore, users need to verify that automatically scheduled calls do not conflict 
with other activities in their calendar.

To manually schedule a contact call in the Calls view tab

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

3 In the Contacts list, select a contact.

NOTE: When selecting the contact, do not click a hyperlink (underlined field), or 
you will go to another view.

4 Click the Calls view tab.

5 In the Call list, add a record and complete the necessary fields.

NOTE: You cannot change the call’s Status field to Submitted from this view. To 
change the status of the call to Submitted, you must submit the call. For more 
information, see “To submit a completed contact call” on page 128. 

6 To go to the Contact Call Detail view, drill down on the date hyperlink in the 
Start Date field. 

The Contact Call Detail view appears.

For more information on recording calls, see “Recording Contact Calls” on page 124.

To schedule a contact call in the Calendar

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select My Calendar.

The My Daily Calendar view appears, displaying the current date.

3 Select either the My Daily or My Weekly view tab.
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4 Navigate to the day on which you want to schedule the call and click New 
Contact Call. 

The Contact Call Detail view appears.

For more information on recording calls, see “Recording Contact Calls” on page 124.

Creating an Account Call
End users track details about calls made on specific accounts with account call 
records. An account call is a type of activity record. Although users can create and 
display account calls on the Accounts screen, they enter details about the actual call 
on the Activities screen. Also, as activities, account call records can also be viewed 
in the Calendar screen. 

For more information, entering call details see “Recording Account Calls” on 
page 129.

NOTE: Before users can enter information about products detailed, attendees, and 
activities associated with an account call, they must set up their personal lists. For 
more information, see “Creating a Personal List” on page 82.

To add an account call from the Activities screen

1 Navigate to the Activities screen.

2 From the Show drop-down list, select My Activities.

3 In the Activities list, click New Acct Call.
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4 In the Account Call form, add a record and complete the necessary fields. 

Some of the fields in the Account Call record are described in the following table.

 

For information on how to enter information in the Call Products Detailed, 
Attendees, and Activities lists, see “Recording Account Calls” on page 129.

NOTE: If you applied a Smart Call to the call (as described in Step 4), you may only 
need to verify that all the information in the four lists is accurate.

Field Comments

Account The account to be visited during this call. Make a selection from the Pick 
Account dialog box.

Click the select button to choose an account and then click OK. 

Cost Enter a cost if you want to include the call in an expense report generated 
by Siebel Expenses. Also do the following before submitting the call: 

■ Specify the actual start time for the call.

■ Check the Expense flag for the call in the My Activities view. For 
more information, see “Adding a General Activity” on page 99.

Site A unique location identifier that distinguishes this account from any 
other accounts with the same name. 

Smart Call The Smart Call template to be associated with this call. Make a selection 
from the Pick Smart Call dialog box. 

A Smart Call is a template that you apply to contact calls that defines 
information about the products detailed, samples and promotional items 
distributed, and issues discussed on a call. Once you apply a Smart Call 
template to a call, you can make additional edits any fields in the 
Account Call Detail view. For more information on Smart Calls, see 
Chapter 8, “Creating Smart Calls.” 

Users can apply a Smart Call that includes products not included in their 
personal lists. Keep in mind, however, that users who do this will see a 
warning message. To continue and apply the Smart Call template, click 
OK. 

Status The status of this call. The default value is Planned. You cannot select 
the value Submitted. To change the status of the call to Submitted, you 
must submit the call. For more information, see “To submit a completed 
account call” on page 133. 
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To automatically schedule an account call using the Schedule button

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account and click Schedule.

The Auto Schedule dialog box appears, displaying the date range specified on 
the best-times-to-call information on the Account Profile view tab.

4 In the Auto Schedule dialog box, review the displayed values, make any needed 
changes, and click OK.

NOTE: The auto-scheduling function does not check for scheduling conflicts. 
Therefore, users need to verify that automatically scheduled calls do not conflict 
with other activities in their calendar.

To manually schedule an account call in the Account view tab

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting an account, do not click a hyperlink (underlined field), or 
you will go to another view.

4 Click the Calls view tab.

5 In the Calls list, add a record and complete the necessary fields.

NOTE: You cannot change the Status field to Submitted from this view. To change the 
status of the call to Submitted, you must submit the call. For more information, see 
“To submit a completed account call” on page 133. 

To enter details about the call, drill-down on the Date hyperlink in the Date field to 
display the Account Call Detail view.

For more information on recording calls, see “Recording Account Calls” on 
page 129. 
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To add an account call using the New Call button

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting an account, do not click a hyperlink (underlined field), or 
you will go to another view.

4 In the More Info view tab, click New Call. 

The Account Call Detail view of the Activities screen appears. The selected 
account automatically appears in the Account Call form. 

For more information on recording calls, see “Recording Account Calls” on 
page 129. 

To schedule an account call in the Calendar

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select My Calendar.

The My Daily Calendar view appears, displaying the current date.

3 Select either the My Daily or My Weekly view tab.

4 Navigate to the day on which you want to schedule the call and click New Acct 
Call. 

The Account Call Detail view appears.

For more information on recording calls, see “Recording Account Calls” on 
page 129. 
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This chapter describes how to record account and contact calls in Siebel Life 
Sciences. For more information on planning account and contact calls, see 
Chapter 4, “Planning Calls.”

Using the procedures given in this chapter you will be able to perform the end-user 
tasks of recording contact and account calls. For more information on end-user 
tasks associated with recording calls, see “End-User Procedures” on page 124.

Contact and account calls are both types of activity records. Although users can 
create contact and account calls in the Activities screen, they can only record the 
details of calls in the Activities screen. For more information on creating calls, see 
“Creating a Contact Call” on page 108 and “Creating an Account Call” on page 112.
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Understanding the Submit Button
Clicking the Submit button in Siebel Life Sciences causes a number of important 
events to occur within the application. Table 6 describes the specific actions that 
occur when clicking the Submit button in the view listed in the left column.

Table 6. Effects of the Submit Button on Siebel Life Sciences Views

View Access Path
Transaction 
Type Clicking the Submit Button...

Contact Call 
Detail

Activities > 
Contact Call 
Detail

Disbursement Changes the Contact Call detail Status 
field to Submitted.

Except for the Comment field, sets the 
record to read-only.

Sets all child records to read-only.

If samples were dropped, creates a 
Samples Transaction History record.

Inventory 
Count

Samples > 
Inventory Count

Verifies each a value has been entered 
in the Count field.

Changes the status of each record to 
inactive.

Creates a an active transaction by 
moving the count in the latest 
inventory period.

Received 
Samples

Samples > My 
Received 
Samples 

Transfer In Updates the user inventory to reflect 
the quantity entered in Received 
Quantity field of the Line Items list.

Updates Sample Invoices by setting 
the Active flag to N (No).

If the Invoice Status is submitted, the 
application updates the Line Items list 
by:

■ Setting the Stock Update flag to Y 
(Yes)

■ Updates the Stock Position ID 

■ Changes the Item Status to 
Submitted
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Sample 
Order 

Samples > My 
Samples Order

Sample Order Updates the Samples Orders list by 
setting the Active flag to N (No).

If the Order Status is submitted, the 
application updates the Line Items list 
by:

■ Setting the Stock Update flag to Y 
(Yes)

■ Updates the Stock Position ID 

■ Changes the Item Status to 
Submitted

Samples 
Adjustments

Samples > My 
Samples 
Adjustments

Inventory 
Adjustment

Updates the user inventory to reflect 
the quantity entered in Quantity field 
of the Line Items list.

Updates Sample Adjustments by 
changing the Active flag to N (No).

If the Transfer Status is Submitted, the 
application updates Line Items list by: 

■ Setting the Stock Update flag to Y 
(Yes)

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Table 6. Effects of the Submit Button on Siebel Life Sciences Views

View Access Path
Transaction 
Type Clicking the Submit Button...
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When a user clicks the Submit button in either the Contact Call Detail and Account 
Call Detail views, the application verifies that:

■ At least one product has been recorded and detailed. 

This requirement can be changed by the administrator. For more information, 
see Appendix A, “Information for Siebel Application Developers.” 

■ The call’s date and time is the same as or earlier than the current date and time. 
A call cannot be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

■ The Ref# field is not empty. 

■ The samples exist in the inventory for the period indicated by the call’s date and 
time.

■ The period into which the samples will be recorded is an unreconciled period. 
If it is a reconciled period, a warning message appears.

■ A valid lot number has been specified for dropped samples tracked by lot 
number.

Sent 
Samples

Samples > My 
Sent Samples

Transfer Out Updates the user inventory to reflect 
the quantity entered in Line Items list 
Quantity field.

Updates My Sent Samples by setting 
the Active Flag to N (No), Changes 
the Status to Submitted.

If the Transfer Status is Submitted, the 
application updates the Line Items list 
by: 

■ Setting the Update Flag to Y (Yes)

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Table 6. Effects of the Submit Button on Siebel Life Sciences Views

View Access Path
Transaction 
Type Clicking the Submit Button...
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If the call passes these checks, the application:

■ Creates a samples disbursement transaction, with a line item for each dropped 
sample recorded for the call. 

■ Submits a disbursement transaction to update the samples inventory. If the 
submission of the disbursement transaction is successful, the application 
changes the call’s Status field to Submitted. 

■ Sets the Last Call Date field for the contact or account to the date of the 
submitted call, and many fields in the call record become read-only. 

The Siebel administrator can change the fields that become read-only after a call 
is submitted (or synchronized with Siebel ePharma Handheld on a PDA). For 
information, see Appendix A, “Information for Siebel Application Developers.” 

NOTE: If attendees are recorded in an account call, an attendee call is created for 
each attendee, and the process described above is performed for each attendee 
call. Attendee calls are the same as contact calls except that they do not appear 
in the Activities view and they are submitted automatically when the account 
call is submitted.
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Business Scenario for Recording Calls
This section outlines an example workflow performed by a end users when 
recording contact and account calls. Your company may follow a different workflow 
according to its business requirements.

A sales representative for a pharmaceutical company has just finished a busy day 
of customer calls. Having made several important calls, it is important that he 
records the information while it is still fresh in his memory. Critical issues were 
discussed that could influence prescription output, especially in relation to 
indications.

In the late afternoon, he loads Siebel Life Sciences so he can record all his call 
activities. First, he records six contact calls he made in the morning by entering 
information about the products he discussed with each physician, the order in 
which the products were discussed and the indications for which the products were 
promoted. Then, he records information relating to samples delivered to the 
physicians during the call, including details such as the lot number, if required, and 
the quantity. As part of a special campaign the representative also delivered 
promotional items, which he also records as part of the call information. Finally, he 
logs any issues the contact raised during the call so he can follow up on them prior 
to his next visit.

Using the procedures given in this chapter you will be able to perform the end-user 
tasks of recording contact and account calls.
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Example Workflow for Recording Calls
This section details sample tasks often performed by end-users when recording 
contact and account calls. Your company may follow a different workflow according 
to its business requirements. 

NOTE: Prior to recording calls, end users need to set up and update their personal 
lists, create target lists and route plans, and add activities. For more information, 
see Chapter 4, “Planning Calls.”

The following list shows tasks end users typically perform when recording contact 
and account calls. These tasks are typically performed in the following order:

1 Review the call plan for the day. 

2 Visit contacts and accounts.

3 Record contact calls. For more information, see “Recording Contact Calls” on 
page 124.

4 Record account calls. For more information, see “Recording Account Calls” on 
page 129.

For more information on the tasks associated with recording calls, see “End-User 
Procedures” on page 124. For more information on planning calls and setting up 
meetings, see Chapter 4, “Planning Calls” and “Setting Up a Meeting” on page 104.
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The following end-user procedures are described in this section:

■ Recording contact calls:

■ To display the Contact Call Detail view on page 125

■ To record information about products detailed on page 126

■ To record information about samples dropped on page 126

■ To record information about promotional items dropped on page 127

■ To record information about decision issues discussed during the call on 
page 128

■ To submit a completed contact call on page 128

■ Recording account calls:

■ To enter products detailed information for an account call on page 130

■ To enter attendee information for an account call on page 131

■ To enter general activities for an account call on page 133

■ To submit a completed account call on page 133

Recording Contact Calls
End users track details about calls made on a contact with contact call records. 
Although users can create and display contact calls on the Contacts screen, they 
enter details about the actual call on the Activities screen. To record a contact call, 
users must complete the following procedures:

■ Display the Contact Call Detail view

■ Enter information on products detailed

■ Enter information about samples dropped (optional)

■ Enter information about promotional items dropped (optional)
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■ Record any decision issues (optional)

■ Submit the call

NOTE: End users can view all activities, contacts, and opportunities associated with 
an account and its child accounts on the account hierarchy tree. For more 
information, see Chapter 7, “Administering and Managing Accounts.”

The sections that follow explain how to perform each of these tasks.

To display the Contact Call Detail view

1 Select an existing contact call:

■ From the Activities screen:

❏ Navigate to the Activities screen.

❏ From the Show drop-down list, select My Activities.

❏ In the Activities list, select an existing contact call and then drill-down on 
the Activity field.

■ From the Contacts screen:

❏ Navigate to the Contacts screen.

❏ From the Show drop-down list, select My Contacts.

❏ In the Contacts list, select a contact and then click the Calls view tab.

❏ In the Start Date field of the Calls list, drill-down on the date hyperlink of 
the call for which you want to add information.

NOTE: For more information on scheduling and creating contact calls, see 
“Creating a Contact Call” on page 108. 

The Contact Call Detail view appears.

2 Enter information about the products detailed as described in the following 
procedure.
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To record information about products detailed

1 Display the Contact Call Detail view. For more information, see “To display the 
Contact Call Detail view” on page 125.

NOTE: If you have not yet set up your personal lists, you must do so before you 
can proceed with the next step. For more information, see “Creating a Personal 
List” on page 82.

2 In the Call Product Detailed list, add a record for each product discussed during 
the call and complete the necessary fields.

Some fields in the Call Product Detail are described in the following table.

Enter information about dropped samples as described in the following procedure.

To record information about samples dropped

1 Display the Contact Call Detail view. For more information, see “To display the 
Contact Call Detail view” on page 125.

2 In the Contact Call form, enter a reference number (if required) in the Ref # field.

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the call.

Note that this field can be configured to automatically assign 1 to the 
first record and then sequentially number each additional record. For 
more information, see Appendix A, “Information for Siebel Application 
Developers.”

Product The product detailed during the call. The products appearing in this 
drop-down list are based on the products added to your Personal list. 
For more information on adding products to your personal lists, see 
“Creating a Personal List” on page 82.
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3 In the Samples Dropped list, add a record for each product dropped during the 
call and complete the necessary fields.

Some fields are described in the following table.

NOTE: If the sample you dropped does not appear in the Name field drop-down 
list, either you need to add it to the Personal Samples list or the sample has not 
been defined as a product. For information about adding products to the 
Personal Samples list, see To add a product to a personal list on page 83. It is the 
responsibility of your administrator to define products.

Enter information about dropped promotional items as described in the following 
procedure.

To record information about promotional items dropped

1 Display the Contact Call Detail view. For more information, see “To display the 
Contact Call Detail view” on page 125.

Field Comments

Lot # The lot number (if applicable) of the products dropped during the call. 
If tracking samples by lot number, select a lot number in the Pick Lot 
dialog box. For more information, see “Defining Lot Numbers” on 
page 148.

Name The name of the products dropped during the call. The products 
appearing in this drop-down list are based on the products available in 
your samples inventory. For more information on samples, see 
Chapter 6, “Managing Samples.”

Quantity The quantity of sample dropped during the call.
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2 In the Promotional Items Dropped list, add a record for each item dropped 
during the call and complete the necessary fields.

Some fields are described in the following table.

 

Enter information about decision issues discussed as described in the following 
procedure.

To record information about decision issues discussed during the call

1 Display the Contact Call Detail view. For more information, see “To display the 
Contact Call Detail view” on page 125.

2 In the Issues list, add a record for each issue discussed during the call and 
complete the necessary fields.

NOTE: Decision issues are the objectives a contact may raise when evaluating a 
product before making a prescribing decision. For more information, see 
“Defining Decision Issues” on page 405.

If no further changes should be made to the call, submit the call as described in the 
following procedure.

To submit a completed contact call

1 Display the Contact Call Detail view. For more information, see “To display the 
Contact Call Detail view” on page 125.

NOTE: You cannot submit a call with a future date. 

Field Comments

Name The promotional item dropped during the call. The items appearing in 
this drop-down list are based on items added to your Personal 
Promotional Items list. For more information, see “Creating a Personal 
List” on page 82.

Quantity The quantity of the promotional item dropped during the call.
128 Siebel Life Sciences Guide Version 7.5, Rev. A



Recording Calls

End-User Procedures
2 Verify that all information in the Contact Call Detail view is accurate and 
complete. For more information, see:

■ To record information about products detailed on page 126

■ To record information about samples dropped on page 126

■ To record information about promotional items dropped on page 127

■ To record information about decision issues discussed during the call on 
page 128

NOTE: Once you submit a call, you cannot modify any fields except the Comment 
field. However, using Siebel Tools, the Siebel administrator can change this 
default behavior and configure which fields are editable. For more information, 
see Siebel Tools Reference. 

3 If you dropped samples when making the call, verify that you entered a samples 
reference number (if required) in the Ref# field in the Contact Call form.

CAUTION: If you are a mobile user, submit your calls before connecting to the 
server, and then synchronize. Mobile users should not submit calls while 
connected to the server or they run the risk of introducing errors into their 
inventory counts.

4 In the Contact Call form, click Submit.

Recording Account Calls
End users track details about calls made on an account with account call records. 
Although users can create and display account calls on the Accounts screen, they 
enter details about the actual call on the Activities screen. To record an account call, 
users must complete the following procedures:

■ Display the Account Call Detail view

■ Enter information on products detailed

■ Enter attendee information (the names of contacts met and any samples 
dropped)
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■ Enter information about any activities related to the call (optional)

■ Submit the call

The sections that follow explain how to perform each of these tasks.

To display the Account Call Detail view

1 Select an existing account.

■ From the Activities screen:

❏ Navigate to the Activities screen.

❏ From the Show drop-down list, select My Activities.

❏ In the Activities list, select an existing account call and then drill-down 
on the Activity field.

■ From the Accounts screen:

❏ Navigate to the Accounts screen.

❏ From the Show drop-down list, select My Accounts.

❏ In the Accounts list, select an account and then click the Calls view tab.

❏ In the Start Date field of the Calls list, drill-down on the date hyperlink of 
the call for which you want to add information.

The Account Call Detail view appears. 

2 Enter information about the products detailed as described in the following 
procedure.

To enter products detailed information for an account call

1 Display the Account Call Detail view. For more information, see “To display the 
Account Call Detail view” on page 130.

NOTE: You must set up your personal lists before you can complete this 
procedure. For more information, see “Creating a Personal List” on page 82.
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2 In the Call Products Detailed list, add a record for each product detailed during 
the call and complete the necessary fields.

Some fields in the Call Products Detailed record are described in the following 
table.

 

Enter attendee information as described in the following procedure. Attendees may 
include both contacts and employees.

To enter attendee information for an account call

1 Display the Account Call Detail view. For more information, see “To display the 
Account Call Detail view” on page 130.

2 In the Attendees list, click New.

The Add Attendee dialog box appears displaying contacts and employees. For 
more information, see “Indicating an Affiliation Between an Account and a 
Contact” on page 200.

3 In the Add Attendee dialog box:

■ If no contacts appear, click All Contacts.

■ To only display contacts affiliated with the selected account, click Affiliate 
Contacts. 

Field Comments

Indication The purpose or therapeutic area for which a drug is designed.

Priority Priority of this product relative to others discussed during the call.

Note: This field can be configured to automatically assign 1 to the first 
record and then sequentially number each additional record. For more 
information, see Appendix A, “Information for Siebel Application 
Developers.”

Product The product detailed during the call. The products appearing in this 
drop-down list are based on the products added to your Personal list. 
For more information on adding products to your personal lists, see 
“Creating a Personal List” on page 82.
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■ Select those contacts and employees that you want to add as attendees and 
click OK.

The application creates an attendee call record (similar to a contact call) for each 
contact you include as an attendee of the account call. These attendee call 
records are child records of the account call and appear in the Activities screen 
under each contact’s name.

NOTE: You must set up your personal lists before you can complete the next step. 
For more information, see “Creating a Personal List” on page 82.

4 In the Samples Dropped field, click the select button.

5 When the Samples Dropped dialog box appears, select a product from the Name 
drop-down list and then complete the Lot # and Quantity fields.

NOTE: The items appearing in the Name drop-down list are based on items added 
to your Personal Promotional Items list. For more information, see “Creating a 
Personal List” on page 82.

6 If samples were dropped during the call, enter a reference number in the 
Samples Reference Number field of the Attendees list. 

This reference number becomes the transaction number (Transaction # field) for 
a samples transaction corresponding to this call. For information on samples 
transactions, see “Managing Samples” on page 135.

7 Drill down on the Name field for each attendee added to the account call. 

The Contact Call Detail view appears, displaying the child attendee call you 
created by adding the contact as an attendee of the account call. 

8 In the Contact Call Detail view enter any relevant information. For more 
information, see the procedure “To display the Contact Call Detail view” on 
page 125.

NOTE: To return to the parent account call in the Account Call Detail view, click 
the arrow to the left of the Favorites drop-down list.
132 Siebel Life Sciences Guide Version 7.5, Rev. A



Recording Calls

End-User Procedures
To enter general activities for an account call 

1 Display the Account Call Detail view. For more information, see “To display the 
Account Call Detail view” on page 130.

2 Scroll down to the Activities list.

3 In the Activities list, add a record and complete the necessary fields.

For more information, see the field descriptions in “To add a general activity” on 
page 99.

4 If no further changes should be made to the call, submit the call as described in 
the following procedure.

To submit a completed account call

1 Display the Account Call Detail view. For more information, see “To display the 
Account Call Detail view” on page 130.

NOTE: You cannot submit a call with a future date. 

2 Verify that all information in the Account Call Detail view is accurate and 
complete. For more information, see:

■ To enter products detailed information for an account call on page 130

■ To enter attendee information for an account call on page 131

■ To enter general activities for an account call on page 133

CAUTION: If you are a mobile user, submit your calls before connecting to the 
server, and then synchronize. Mobile users should not submit calls while 
connected to the server or they run the risk of introducing errors into their 
inventory counts.

3 In the Account Call form, click Submit.

NOTE: Be aware that once you submit a call you cannot modify any fields except the 
Comment field. However, using Siebel Tools, you can change this default behavior 
and configure which fields are editable. For more information, see Siebel Tools 
Reference. 
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Managing Samples 6
Most pharmaceutical manufacturers provide free samples to health care 
professionals in an effort to influence the prescribing habits of physicians and 
accounts across the United States and the world. In the United States, samples 
distribution is regulated by the FDA and must be reconciled at least once a year. 

This chapter describes how to manage and maintain an electronic inventory of 
samples and promotional items using Siebel ePharma Samples Management. Using 
the procedures given in this chapter, you will be able to perform the administrator 
tasks of setting up and maintaining a home-office master inventory (optional) and 
monitoring samples disbursements, orders, transfers, receipts, discrepancies, 
adjustments, and inventory counts. End users use the Samples Management screens 
to track an electronic inventory of samples stock, create samples request order and 
transfers, acknowledges receipt of samples transfers, and adjust inventory balances 
for reconciliation purposes.

Siebel Samples Management allows sales representatives and administrators to 
measure and monitor sample disbursements at every level throughout the 
organization. For more information on the differences between administrator and 
end-user tasks see “Business Scenarios” on page 140.
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Siebel Samples Management maintains a samples transaction record for every 
sample transfer, receipt, disbursement, order, and inventory adjustment. The 
application assigns each samples transaction record an unique identifier for 
tracking purposes. Depending on the type of transaction, you can display this 
identifier as a transaction number, an order number, an invoice number, or a 
transfer number. 

Each samples transaction record represents a single transaction consisting of one or 
more line items. As shown in Figure 1, the application tracks a transfer of multiple 
samples as a single transaction record with multiple corresponding line item 
records—one line item for each type of product transferred. These line item records 
are child records of the parent transaction record.

Inventory Reconciliation 
In the United States, pharmaceutical companies may request that sales 
representatives perform an inventory reconciliation from one to twelve times a year 
to remain compliant with the Prescription Drug Marketing Act (PDMA). (Sampling 
regulations vary significantly in North America, Europe, Asia, and Latin America.) 
If sales representatives’ physical sample inventories do not match their 
disbursement and transaction histories, they may perform inventory adjustments to 
justify the discrepancies. For more information, see “Reconciling an Inventory 
Period” on page 173.

Figure 1. Transaction Record and Line Item Relationship 
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It is also possible to create sample products by lot numbers and to disburse samples 
to contacts by lot numbers and yet not reconcile by lot numbers. For more 
information, see “Reconciling an Inventory Period” on page 173.

PDMA Compliance and Lot Numbers
Companies in the United States may need to perform additional tasks to meet 
PDMA requirements. According to the Food and Drug Administration’s Final Ruling 
of December 3, 1999 (21 CFR Part 203 and 205), samples must also be tracked by 
lot number to the level of disbursement. Siebel Samples Management provides 
additional functionality that allows you to meet this lot number tracking 
requirement. For more information on using lot numbers, see “How a Samples 
Transaction Works” on page 146.

Inventory Periods
Since samples inventory reconciliation can happen as often as once a month, Siebel 
Samples Management allows you to reconcile as often as you like and provides 
three types of inventory periods for maximum flexibility. These period types are 
described in Table 7.

 

The default Siebel Samples Management configuration provides two unreconciled 
periods: one active period and one inactive period. The Siebel administrator can 
control the number of unreconciled periods allowed. For more information, see 
“Reconciling an Inventory Period” on page 173.

Table 7. Samples Inventory Periods

Period Type Description

Active The current period; it shows no end date and it is not reconciled. You can 
enter any type of samples transaction, including adding new products; 
inventory counts will be adjusted accordingly.

Inactive A past, unreconciled period; it shows an end date but has not been 
reconciled yet. Except for adding new products into inventory, you can 
enter any type of samples transaction; inventory counts will be affected 
accordingly. The default application configuration provides one inactive 
period, but can be configured for multiple instances.

Reconciled A past, inactive period; it shows an end date and has been reconciled. 
Although you can enter samples disbursements for a reconciled period, the 
inventory counts for the active period will not be affected. 
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How Siebel Samples Management Works with Calls
This section describes how Siebel Samples Management works with the Contact 
Call Detail and Account Call Detail views. For more information on recording calls, 
see Chapter 5, “Recording Calls.”

When you click the Submit button in either the Contact Call Detail and Account Call 
Detail views, the application verifies that:

■ At least one product has been recorded and detailed. 

This requirement can be changed by the administrator. For more information, 
see Appendix 2, “.” 

■ The call’s date and time is the same as or earlier than the current date and time. 
A call cannot be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

■ The Ref# field is not empty. 

■ The samples exist in the inventory for the period indicated by the call’s date and 
time.

■ The period into which the samples will be recorded is an unreconciled period. 
If it is a reconciled period, a warning message appears.

■ A valid lot number has been specified for dropped samples tracked by lot 
number.

NOTE: When the Lots for Disperse Only system preference is set to TRUE, the lot 
number is not required. For more information, see “Managing Inventory Tracking 
and Reconciliation Without Lot Numbers” on page 154.
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If the call passes these checks, the application:

■ Creates a samples disbursement transaction, with a line item for each dropped 
sample recorded for the call. 

■ Submits a disbursement transaction to update the samples inventory. If the 
submission of the disbursement transaction is successful, the application 
changes the call’s Status field to Submitted. 

■ Sets the Last Call Date field for the contact or account to the date of the 
submitted call, and many fields in the call record become read-only. 

As an administrator, you can change the fields that become read-only after a call 
is submitted (or synchronized with Siebel ePharma Handheld on a PDA). For 
information, see Appendix 2, “” 

NOTE: If attendees are recorded in an account call, an attendee call is created for 
each attendee, and the process described above is performed for each attendee 
call. Attendee calls are the same as contact calls except that they do not appear 
in the Activities view and they are submitted automatically when the account 
call is submitted. 
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This section outlines three scenarios that are examples of workflows performed by 
a samples administrator and the sales representatives who distribute samples to 
health care professionals. Your company may follow a different workflow according 
to its business requirements.

A pharmaceutical company has new products to bring to market. To set up a 
samples inventory, the samples administrator adds the products to the database, 
associates any lot numbers, and transfers samples to the managers and sales 
representatives in the field. Once sales representatives and managers receive the 
samples, they add them to their personal lists so they are available options in their 
call reporting. The sales representatives then visit the doctors in their territories and 
drop the new samples. After a month goes by, each sales representative is required 
to reconcile his or her inventory. One sales representative realizes there are some 
discrepancies in her inventory. After she makes the needed adjustments, she 
reconciles her inventory and starts a fresh inventory period. 

Business scenarios discussed in this chapter include:

■ Administrator Establishes a Master Inventory. The Siebel samples administrator 
establishes and transfers inventory to end users.

■ Administrator and End Users Establish a Master Inventory. The Siebel samples 
administrator and the end user establish an initial inventory and then reconcile 
it before they disburse any samples.

■ Users Transfer Samples to One Another. Describes the basic workflow of how users 
can exchange samples inventory within the system.

Using the procedures described in this chapter, sales representatives can track their 
samples inventories, record inventory transfers, and track lost or damaged 
inventory. However, to record samples disbursements, sales representative should 
use the procedures described in Chapter 5, “Recording Calls.”
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Administrator Establishes a Master Samples Inventory
In this scenario, samples administrators are responsible for their company’s 
samples inventory and making sure it complies with regulatory rules and 
regulations. In this role, they take the responsibility for establishing a master 
samples inventory and then transferring samples to each end user. 

Having the samples administrator establish a master inventory and then transfer 
samples to each end user is a simpler process from the end user’s perspective. Once 
the samples administrator establishes the master inventory, the next step is to 
transfer inventory to each end user. When each recipient electronically receives the 
shipment, they submit a receipt and application automatically enters the received 
samples into their inventory counts. 

Once the samples administrator establishes the master inventory, the next step is to 
transfer inventory to each end user. When each recipient electronically receives the 
shipment, they submit a receipt and the application automatically enters the 
received samples into their inventory counts.

In this workflow, the representative, the representative’s manager, and the samples 
administrator can monitor discrepancies between shipped quantities and received 
quantities.

Administrator Procedures
The samples administrator requires administrative responsibilities in Siebel 
Samples Management to:

■ Define samples as products. For more information, see Chapter 18, “Managing 
Products.”

■ Define lot numbers (optional). For more information, see “Defining Lot Numbers” 
on page 148.

■ Set up and reconcile initial master inventory. For more information, see 
“Establishing an Initial Inventory” on page 152.

■ Transfer inventory to end users. For more information, see “Creating a Samples 
Transfer” on page 158.
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■ Monitor samples activities. Activities for samples include disbursements, orders, 
transfers between employees, user inventory counts, and inventory adjustments. 
For more information, see “Monitoring Samples Activities” on page 160.

■ Manage electronic signatures. For more information, see “Checking Electronic 
Signatures” on page 166.

■ Identify sample locations in the event of recalls. Follow your company’s guidelines 
for managing sample recalls.

End-User Procedures
The end users are the sales representatives who distribute samples to health care 
professionals. They enter information to:

■ Acknowledge receipt of the inventory transfers. For more information, see 
“Acknowledging Receipt of a Samples Transfer” on page 171.

■ Add inventory to personal lists. For more information, see “Creating a Personal 
List” on page 82.

■ Use the new samples in regular call reporting. For more information, see Chapter 5, 
“Recording Calls.”

■ Transfer samples to other end users. Sales representatives exchange samples 
among themselves. For more information, see “Creating a Samples Transfer” on 
page 158.

■ Request more samples. For more information, see “Creating a Samples Order” on 
page 170.

■ Perform inventory adjustments. For more information, see “Adjusting a Past 
Samples Transaction” on page 162.

■ Reconcile inventory periods as needed. For more information, see “Reconciling an 
Inventory Period” on page 173.
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Administrator and End Users Establish a Master Inventory
In this scenario, both the samples administrator and the end user establish a master 
samples inventory or inventory count. Samples administrators are again responsible 
for their company’s samples inventory and making sure it complies with regulatory 
rules and regulations. 

From a process perspective, this workflow requires more steps for the end user since 
they must first establish an initial inventory and then reconcile it before they can 
disburse any samples. For more information, see “Disabling Lot Number Tracking” 
on page 151.

Administrator Procedures
Samples administrators requires administrative responsibilities in Siebel Samples 
Management to:

■ Define samples as products. Product inventory is maintained in the database. For 
more information, see Chapter 17, “Managing Clinical Projects.”

■ Optional: Define lot numbers. Samples may be tracked by lot numbers For more 
information, see “Defining Lot Numbers” on page 148.

■ Set up and reconcile initial master inventory. This step is required only if you are 
not using a third-party system to populate the samples inventory. For more 
information, see “Establishing an Initial Inventory” on page 152.

■ Monitor samples activities. Samples activities that are monitored include 
disbursements, orders, transfers between employees, user inventory counts, and 
inventory adjustments. For more information, see “Monitoring Samples 
Activities” on page 160.

■ Check electronic signatures. Regularly check Signature Audit Administration to 
verify that signatures collected from contacts are consistent. For more 
information, see “Checking Electronic Signatures” on page 166.

■ Identify sample locations in the event of recalls. Follow your company’s guidelines 
for managing sample recalls.
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End-User Procedures
The end users are the sales representatives who distribute samples to health care 
professionals. They enter information to:

■ Set up and reconcile initial master inventory. For more information, see “About 
Establishing an Initial Inventory Count” on page 169.

■ Add inventory to personal lists. For more information, see “Creating a Personal 
List” on page 82.

■ Use the new samples in regular call reporting. For more information, see Chapter 5, 
“Recording Calls.”

■ Transfer samples to other end users. Sales representatives exchange samples 
among themselves. For more information, see “Creating a Samples Transfer” on 
page 158.

■ Acknowledge receipt of the inventory transfers. End users must acknowledge 
receipt of a samples transfer transaction before the transfer can be completed. 
For more information, see “Acknowledging Receipt of a Samples Transfer” on 
page 171.

■ Perform counts and adjustments. For more information, see “Adjusting a Past 
Samples Transaction” on page 162.

■ Reconcile inventory periods as needed. For more information, see “Reconciling an 
Inventory Period” on page 173.

Users Transfers Samples to One Another
This scenario describes the basic process for exchanging inventory with other users 
within the system. This process can be used by both the administrator and end 
users to exchange samples. When a user creates a samples transfer to move 
inventory to another user, the recipient electronically receives a shipment of 
samples. Once the recipient submits a receipt for that shipment, the application 
automatically enters the received samples into their inventory counts.
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Figure 2 illustrates this process.

Figure 2. Workflow for Users to Transfer Samples to One Another 

(page 158) (page 171)
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Administrator Procedures
The following administrator procedures are described in this section:

■ To define lot numbers on page 149

■ To disable lot number tracking for samples on page 151

■ To add products to inventory and submit an initial count on page 153

■ To track and reconcile inventory without lot numbers on page 155

■ To create and submit initial count adjustments on page 155

■ To reconcile the initial inventory period on page 157

■ To create a samples transfer on page 158

■ To access monitor samples activities on page 160

■ To add a product to a samples transaction on page 163

■ To adjust a quantity in a samples transaction on page 165

■ To display Signature Audit Administration on page 166

■ To display Sample Event Administration on page 167

■ To display the Disclaimer Administration screen on page 167

NOTE: Before you can set up Siebel Samples Management, you must first define your 
products. For more information, see Chapter 18, “Managing Products.”

How a Samples Transaction Works
In the default configuration, Siebel Samples Management supports two open 
inventory periods. The samples administrator can override this default behavior by 
adding additional open periods using Siebel Tools. When users click the Submit 
button for a samples transaction, the system checks that transaction date and time 
to determine the inventory period into which the transaction should be entered. 
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For all transactions except receipts, the application enters the transaction into the 
inventory period that includes the transaction’s date and time. If no such period 
exists, the transaction submission fails. 

If the situation involves samples receipts (that is, received samples transactions 
displayed in the Samples Receipts screen) and no inventory period exists that 
includes the transaction’s date and time, Siebel Samples Management creates a new 
inventory period. 

For example, this situation might happen during initial deployment, before any 
inventory periods have been opened. The new period’s start date and time are set 
to the invoice receipt’s date and time. However, the application first checks whether 
any pending transaction has an earlier transaction date than the one being 
submitted. This is done to prevent any impasse that might occur if a second invoice 
receipt is later submitted with an earlier transaction date. 

NOTE: Once the first inventory period has been created, another period with an 
earlier start date and time cannot be created. 

Submitted samples transactions impact inventory counts in the following ways: 

■ Samples orders are independent of inventory periods because they have no 
effect on inventory counts. 

■ Receipts (transactions whose Type field is either Transfer In or Receipt) are 
added to the submitter’s inventory counts. 

■ Samples transfers (transactions whose Transfer Type or Transaction Type field is 
Transfer Out or Return) are subtracted from the submitter’s current inventory 
counts. In addition, a corresponding invoice receipt is created for the receiving 
party.

NOTE: Typically, samples returns (samples transfers whose Transfer Type field is 
Return) are expired products that are sent back to the home office to be 
destroyed. Samples returns are not added back into the home office’s master 
inventory counts. The samples administrator can track samples returns by using 
the Sent Samples administration view or the Samples History administration 
views and querying for those samples transactions with a type equal to Return.
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■ Samples adjustments (transactions whose Transaction Type field is Inventory 
Adjustment) are either added to or subtracted from the submitter’s inventory 
counts. Samples adjustments are the only type of samples transaction in which 
negative quantities are allowed.

In the Samples History view, the Add, Adjust, and Submit buttons are enabled or 
disabled as follows: 

■ If the transaction’s Status field is set to Submitted, the Add and Adjust buttons 
are enabled and the Submit button is disabled. 

■ If the transaction’s Status field is set to Adjusted, all the buttons are disabled. 

■ If the transaction’s Status field is set to In Progress, the Submit button is enabled 
and the Add and Adjust buttons are disabled. 

Defining Lot Numbers
Siebel Samples Management allows you to define your samples and promotional 
items according to a number of different implementation scenarios. By specifying 
certain product settings, you can make Siebel Samples Management suit your 
company’s strategy for inventory tracking and distribution of samples. You can 
implement samples using lot numbers in the following ways:

■ Tracking samples for inventory purposes at a lot level or a sample product level.

■ Disbursing some products with lots and others without lots.

■ Managing existing samples that have already been distributed and tracked 
without lot numbers in Siebel Samples Management.

■ Using lot numbers for samples creation, transfers, adjustments, orders, and call 
reporting, but not using lot numbers for inventory and reconciliation. For more 
information, see “Managing Inventory Tracking and Reconciliation Without Lot 
Numbers” on page 154.
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Before you can track samples by lot number, you must:

■ Verify that the Samples Lots Enabled system preference is set to TRUE (the 
default setting). For more information, see “Disabling Lot Number Tracking” on 
page 151. 

■ Define the products that will be disbursed as samples. For more information, see 
“Defining Internal Products” on page 391.

■ Define the lot numbers for each product. For more information, see the 
procedure “To define lot numbers” on page 149. 

If you track disbursements at the lot number level, you may track inventory with or 
or without using lot numbers. For more information on disabling lot number 
tracking see “Disabling Lot Number Tracking” on page 151. For more information 
on reconciliation without lot numbers, see “Managing Inventory Tracking and 
Reconciliation Without Lot Numbers” on page 154 and “Enabling Inventory 
Reconciliation Without Lot Numbers” on page 451.

If you are implementing either full or partial lot number tracking for samples use 
the following procedure to define the lot numbers associated with those samples. 
This procedure creates lot number records that are children of the parent sample 
product record. For more information setting up lot tracking, see “Defining Internal 
Products” on page 391.

Existing products (that is, products that were previously defined without lot number 
tracking specified) cannot be tracked by lot number if they exist in any user 
inventory. To begin tracking lot numbers for an existing product, you must create a 
new product record with a product name indicating that this product will be tracked 
by lot number. For example, if the existing product is named Aracid 200, you could 
name the new product Aracid 200 (Lot).

To define lot numbers

1 Verify that you have specified the correct settings for the products to be 
disbursed as samples. 

For more information setting up lot tracking, see “Defining Internal Products” 
on page 391 paying specific attention to Table 17 on page 391 and Table 18 on 
page 393. 
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2 From the application-level menu, choose View > Site Map > Samples 
Administration > Lot Setup.

3 In the Lot Setup list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

 

4 Repeat Step 3 to define other lot numbers.

NOTE: Multiple lot numbers can be defined for a sample product, as long as each 
lot number is unique.

You can also include the lot number in the product name when defining the 
product. For more information, see “Defining Internal Products” on page 391. However, 
using this method can make the drop-down lists that users select from very long. 
Only use this method if the number of products that will be disbursed is small.

Field Comments

Expiration Date This information can be used for recalls of expired products.

Effective Start Date The date of manufacture, the date on which the product was 
received, or another date defined by your company.

Lot # Enter an unique value that corresponds to the lot number 
printed on the label of the product.

Inventory By Lot Check this field if inventory tracking by lot number is required 

For more information, see “Defining Internal Products” on 
page 391 paying specific attention to Table 17 on page 391 and 
Table 18 on page 393. 

Sample The name of the product for which this lot number will be 
affiliated. This field should indicate both product name and 
dosage. Only products that are set up for lot number tracking 
appear in the dialog box. 

For more information, see “Defining Internal Products” on 
page 391 paying specific attention to Table 17 on page 391 and 
Table 18 on page 393. 
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Disabling Lot Number Tracking 
Lot number tracking for sample products is enabled by default. With lot number 
tracking enabled, the constraints and data checks described in “How Siebel Samples 
Management Works with Calls” on page 138 and “Defining Internal Products” on 
page 391 become active. 

Setting the Samples Lots Enabled system preference to FALSE causes samples 
dispersed with lot numbers to not appear in the Samples History or the Inventory 
Count views. If you plan to disperse samples with lot numbers, the Samples Lots 
Enabled system preference should be set to TRUE to assure that all relevant data 
appears in these views.

To disable lot number tracking for samples

1 From the application-level menu, choose View > Site Map > Application 
Administration > System Preferences.

2 In the System Preference Name list, locate and select the Samples Lots Enabled 
record. 

3 Change the field value to FALSE. 

4 Exit and relaunch the application.

The change takes effect after the application has been restarted.

Setting the Lots for Disperse Only system preference to TRUE allows you to ship 
samples to users by lot numbers and allows sales representatives to disburse the 
samples by lot numbers while maintaining and reconciling inventory without lot 
numbers. To retain sample product visibility, the samples administrator must 
reconfigure the Siebel repository. For more information, see “Managing Inventory 
Tracking and Reconciliation Without Lot Numbers” on page 154.

NOTE: By default, Sample Lots Enabled is set to TRUE and Lots for Disperse Only is 
set to FALSE. If you do not want to use lot numbers, you can change both of these 
system preferences, setting Sample Lots Enabled to FALSE and Lots for Disperse 
Only to FALSE. 
Lots for Disperse Only works only when Sample Lots Enabled is set to TRUE. If 
Sample Lots Enabled is set to FALSE, the system ignores Lots for Disperse Only.
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Establishing an Initial Inventory
Establishing an initial master inventory is only necessary if you are manually 
entering and tracking samples. If you are populating your samples inventory from 
a third-party system, it is not recommended that you establish an initial master 
inventory. 

As outlined in “Business Scenarios” on page 140, either an administrator or an end 
user may establish an inventory. However, since Siebel Samples Management routes 
and maintains transactions by Employee ID, only the user who creates an inventory 
(the initial inventory count) can create or manipulate that inventory. 

Before adding products to the master inventory, you must verify that the products 
are correctly defined for inventory tracking. For more information, see “Defining 
Internal Products” on page 391 paying specific attention to Table 17 on page 391 
and Table 18 on page 393. 

In particular, in the Products form, you must select one of the following fields:

■ Orderable 

■ Either Inventory or the Lot# Tracking 

When neither Inventory nor Lot # Tracking are checked, the sample is not tracked 
in inventory.

For more information, see “Defining Internal Products” on page 391 and “How a 
Samples Transaction Works” on page 146. 

NOTE: End users do not need to perform the procedures described in this section if 
their initial counts consist only of samples transfers routed to them by their samples 
administrator. Instead, they should simply acknowledge the receipt of those 
shipments. For more information, see “Acknowledging Receipt of a Samples 
Transfer” on page 171. However, end users do need to perform the procedures 
described in this section if their initial counts contain any records that they entered 
manually. End users who enter records manually must submit those counts and 
reconcile the initial inventory period.
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To establish an initial master inventory:

■ Count products on-hand. Establish an inventory count by physically counting the 
products currently on-hand. This process creates a list of the products in your 
inventory and an inventory period solely for your initial count. 

■ Add products and submit count. Add products to the inventory and submit an 
initial count. (See “To add products to inventory and submit an initial count” on 
page 153.)

■ Submit adjustments. Create and submit adjustments for the initial count. (See “To 
create and submit initial count adjustments” on page 155.)

■ Reconcile. Reconcile the initial inventory period. (See “To reconcile the initial 
inventory period” on page 157.)

To add products to inventory and submit an initial count

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select Inventory Count.

3 In the Inventory Count list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

 

Repeat Step 3 to add a record and count for each product in your inventory. 

NOTE: Records added to this view can be deleted only if the value of the On Hand 
Quantity field is zero. 

Field Comments

Count The amount of your initial inventory.

Difference Shows a negative number after you enter a value in the Count field. 

Lot The lot number for this sample.

Sample The name of the sample to be added.
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4 Click Submit.

The Difference field is cleared for all records. The application transfers the 
number you entered in the Count field to the On Hand Quantity field and clears 
the Count field. 

Once you submit an initial count, the Siebel Samples Management deactivates 
the inventory period into which you entered your initial counts and creates a 
new active inventory period. You can view this change using the My Samples 
History filter.

5 From the Show drop-down list, select My Samples History.

The Samples History view appears. 

The inventory period into which you entered your initial counts becomes 
inactive—a date and time appear in the End Date field, and there is no check 
mark in the Active field. In addition, a new active period has been opened. 

Create adjustment transactions for the period, as described in the next procedure.

NOTE: You cannot submit adjustment transaction if the product is not currently 
active. Siebel Samples Management considers a product inactive if the 
administrator has made it inactive, or the product does not exist in the inventory 
count list (it could have been deleted if the on-hand quantity was zero). Inactive 
products do not display in drop-down lists or dialog boxes, although they may be 
visible in views displaying products. 

Managing Inventory Tracking and Reconciliation Without Lot Numbers
Siebel Samples Management supports using lot numbers for samples creation, 
shipment, receipt, transfers, adjustment, ordering, and disbursement while not 
using lot numbers for inventory and reconciliation.

To enable this behavior, you must make three changes:

■ Set the value of two system preferences—Samples Lots Enabled and Lots for 
Disperse Only—to “True.”

■ Check the Lot# Tracking flag in the Product Administration screen.

■ Implement product visibility. For more information, see “Retaining Sample 
Product Visibility” on page 451.
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When this behavior has been enabled, the Lot No. field is available but not required 
for samples creation, shipment, receipt, transfers, adjustment, ordering and call 
reporting. In addition, the Lot No. field is disabled in the Inventory Count and 
Reconciliation views.

To track and reconcile inventory without lot numbers

1 From the application-level menu, choose View > Site Map > Application 
Administration > System Preferences.

2 In the System Preference Name list, query for two records—Samples Lots 
Enabled and Lots for Disperse Only.

3 Set the field value for both records to TRUE.

4 Exit and relaunch the application.

The change takes effect after the application has been restarted. 

To create and submit initial count adjustments

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select My Samples Adjustment.

3 In the Samples Adjustments list, add a new record and complete the necessary 
fields. 

Some fields are described in the following table.

 

Field Comments

Adjustment Reason Select Initial Count from the drop-down list.

Inventory Period Selecting an Inventory Period automatically enters the correct 
date in the Transaction Date (Txn Date) field, making sure that 
the adjustment is entered into the appropriate inventory period. 

Transaction # The application automatically generates an unique identifier. 
You can change this value. 

Transaction Date It is recommended that you complete the Inventory Period field 
to auto-fill this field so that the adjustment is entered into the 
correct period. 

Transaction Status The application automatically changes this field value to 
Submitted when you submit the adjustment.
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4 In the Line Items list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

 

Repeat Step 3 and Step 4 to enter a line item for each sample needing 
adjustment.

5 Click Submit.

The values in the Transaction Status field (in the Samples Adjustment form) and 
the Item Status fields (in the Line Items list) are changed to Submitted. 

Reconcile the initial inventory period, as described in the next procedure.

Field Comments

Item # The application automatically generates this value. Edit this value to 
have the items appear in a particular order.

Item Status The application automatically changes this field value to Submitted 
when you submit the transaction.

Lot Name The lot number for this sample.

Quantity The amount of your initial inventory. This quantity should be the same 
as the value you entered in the Count field in the Inventory Count 
view. For more information, see “To add products to inventory and 
submit an initial count” on page 153). 

Sample The sample to be adjusted.
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To reconcile the initial inventory period

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select Reconciliation.

The Reconciliation view contains the following lists.

 

3 In the Unreconciled Inventory list, verify that the Difference field shows zero for 
the products listed. 

If a product shows a value other than zero, you must make an adjustment to 
correct the difference. For more information, see “Adjusting a Past Samples 
Transaction” on page 162. 

4 In the Unreconciled Inventory Periods list, click Reconcile. 

The lists in the view are cleared.

5 From the Show drop-down list, select My Samples History.

The Samples History view appears. In the Inventory Periods list, a check mark 
appears in the Reconciled field of the inactive period that you just reconciled. 

List Description

Unreconciled 
Inventory Periods

Shows all inactive (past, unreconciled) inventory periods. An 
active period becomes inactive once you submit an inventory 
count for the period (as described in “To add products to 
inventory and submit an initial count” on page 153). 

Unreconciled 
Inventory

Shows the products in your inventory, their physical and 
electronic counts, and the difference between the two counts (if 
any). The Difference field must be zero for all products before 
you can reconcile the period.

Samples History Shows samples transactions entered for the currently selected 
product in the Unreconciled Inventory list. If no transactions 
were entered for the selected product during the inactive 
inventory period, this list is empty.
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Creating a Samples Transfer
You create a samples transfer whenever product samples are exchanged within your 
company. This procedure can be used by:

■ A samples administrator to send shipments to end users in the field

■ End users to exchange samples between themselves

■ End users to return samples to the home office 

Once the samples transfer has been submitted into the system, the recipient receives 
a samples transfer. After the recipient acknowledges the receipt of the transaction, 
the application enters the new inventory into the his or her inventory count. For 
more information, see “Acknowledging Receipt of a Samples Transfer” on page 171.

NOTE: Samples returns are defined as transfer transactions for which corresponding 
received shipment transactions have not been created. Returned samples are 
subtracted from the sender’s inventory counts but are not added to the master 
inventory, since they are typically expired or damaged products.

To create a samples transfer

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select My Sent Samples.

3 In the My Sent Samples list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Transfer # The application automatically generates an unique identifier. You 
can change this value. 

Transfer Date The application automatically generates a date and time value that 
falls in the active period. 

Transfer Status The application automatically changes this field value to 
Submitted when you submit the transaction.
158 Siebel Life Sciences Guide Version 7.5, Rev. A



Managing Samples

Administrator Procedures
4 In the Line Items list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

 

Repeat Step 4 to enter a line item for each product or promotional item you are 
transferring. 

Transfer to Last 
Name

The employee to whom you are transferring the samples. If the 
value of the Transfer Type field is Transfer Out, you must complete 
this field. Leave this field empty if the value of the Transfer Type 
field is Return. 

Transfer Type Select the appropriate value:

■ Transfer Out - Indicates you are transferring samples to 
another employee.

■ Return - Indicates you are returning samples to the home 
office. Samples are typically returned because they are expired 
or damaged products that should be destroyed. Transfers with 
the Transfer Type field set to Return do not generate shipment 
transactions (since there is no recipient), and they are not 
added to the master inventory counts. However, the samples 
administrator can see returned samples transactions in the 
samples administration views. For more information, see 
“Monitoring Samples Activities” on page 160. 

Field Comments

Field Comments

Item # The application automatically generates an unique identifier. Edit 
this value to have the items appear in a particular order. 

Item Status The application automatically changes this field value to Submitted 
when you submit the transaction.

Lot # The lot number for this samples transfer.

Quantity The quantity that you are transferring.

Sample The samples being transferred.
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5 Click Submit.

NOTE: A transfer transaction cannot be modified or deleted after it has been 
submitted. 

The value of the Transfer Status field (in the Sent Samples list) and the Item 
Status field (in the Line Items list) changes to Submitted. 

6 From the Show drop-down list, select My Samples History.

The Samples History appears. 

When you select a product that has been transferred in Inventory List, the line items 
of the transfer transaction appear in the Samples History list.

Monitoring Samples Activities
As the samples administrator you are responsible for your company’s samples 
inventory and making sure it complies with regulatory rules and regulations. Use 
the views described in Table 8 to monitor samples activity across the enterprise.

To access monitor samples activities

1 From the application-level menu, choose View > Site Map > Samples 
Administration > Samples Administration.

2 From the Show drop-down list, select the view listed in the left column of Table 8 
on page 161.

NOTE: The views discussed in Table 8 on page 161 are read-only and appear only 
when you are connected to the server. 
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Table 8. Administrator Views for Monitoring Samples Activity

View Description

 Inventory Count Shows samples inventory counts that have been submitted 
within the enterprise. 

Inventory Adjustments Shows inventory adjustments for the organization. Adjustment 
transactions can be submitted by end users or by the samples 
administrator to resolve discrepancies between physical and 
electronic inventory counts. Adjustment transactions provide a 
clear audit trail of samples inventory adjustments. 

Received Samples Shows samples receipt transactions submitted by end user. The 
Line Items list shows the line items of the samples receipt 
currently selected in the Samples Receipts list. 

This view allows the administrator to review sent shipments 
between end users.

Sample Discrepancies Shows samples receipts submitted by users in which the 
received quantity did not match the shipped quantity. The Line 
Items list shows the line items for the receipt currently selected 
in the Sample Discrepancies list. 

This view allows the administrator to make sure that samples are 
not being diverted. 

Samples History Shows a list of samples transactions. Be aware that:

■ If a Contact record is removed, the application removes the 
that name from all lists that reference that contact's name in 
the S_CONTACT table. This can cause the name fields in 
Samples History records to appear empty. Use caution when 
deleting Contacts records.

■ Drilling down on the Transaction # takes users to the 
Samples Adjustment list. In order to assure that users can 
take advantage of these hyperlinks, they must have the 
destination view for product hyperlinks in their 
responsibilities.
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Adjusting a Past Samples Transaction
The samples administrator and end users can adjust inventory counts of samples 
stock by making adjustments to past samples transactions. Common reasons for 
adjusting past transactions include product loss or expiration, counting mistakes, or 
data entry errors. You can add products or adjust quantities for any type of samples 
transaction (disbursement, transfer, order, and so on). 

NOTE: You cannot add a product to your inventory that did not exist when the 
original transaction was created. 

You adjust a past samples transaction in the Samples History view.

When you select a product in the Inventory List, the Samples History list shows 
samples transactions entered for that product. For example, if a sales representative 
dropped multiple samples on a call, the Samples History list would display one line-
item record for each sample. Also, if an adjustment has been made to an item in the 
transaction, an additional row (corresponding to the adjustment) will appear in this 
view. 

Samples Orders Shows samples order transactions submitted by end users or 
their managers. The Line Items list shows the line items of the 
samples order currently selected in the Samples Orders list. 

This view allows the administrator to review samples order sent 
from end users.

Sent Samples Shows samples transfer transactions submitted. The Line Items 
list shows the line items of the samples transfer currently 
selected in the Sent Samples list. 

This view allows the administrator to review shipments sent 
between end users.

Table 8. Administrator Views for Monitoring Samples Activity

View Description
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To add a product to a samples transaction

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select My Samples History.

3 In the Inventory List, select a product.

When you select a product in the Inventory List, the Samples History list shows 
all samples transactions entered for that product. You can identify the 
transaction record in the Samples History list by the Transaction Date, Last 
Name, or Transaction # field values. 

NOTE: To make it easier to find a transaction, sort the records in the Samples 
History list by the field you are using to identify the transaction. For example, if 
you know the Transaction #, sort the list by that field to locate the records you 
are looking for. 

4 In the Samples History form, click Add. 

When you add a new record, the application adds a new line-item record for the 
transaction in the Samples History list and sets the line-item record’s Item field 
Status to Pending Approval. With the exception of the Item Status value, the new 
record is a copy of the record selected in Step 3. 

5 In the Samples History form, modify the new record to reflect the correct product 
information. 

Some of the fields in a Samples History record are described in Table 9.

 

Table 9. Some of the Fields in a Samples History Record

Field Comments

Created By Last 
Name

The last name of the creator of the transaction.

Description A description of the product or comment describing the transaction.

Last Name The last name of the doctor. Used only if the transaction type is 
disbursement.
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Item Status The application automatically changes this field value to Submitted 
when you submit the adjustment.

For any row that shows an item status of Submitted, you can also see 
one or more rows with the identical sample name and transaction 
number but with an item status of In Progress or Adjusted. 

Valid values include:

■ In Progress - Indicates that the adjustment record has not yet been 
submitted, so it can still be modified. However, the record’s data 
is not reflected in the inventory count.

■ Submitted - Indicates that the record has been submitted and 
therefore cannot be modified. Since it has been submitted, the 
record’s data is reflected in the inventory count.

■ Adjusted - Indicates that a previously submitted record has been 
superseded by a subsequent adjustment record. The record 
cannot be modified.

Lot # The correct lot number for this sample.

Quantity The quantity of samples shipped or disbursed in the transaction.

Sample Verify that the correct product name is selected. 

Transaction # The transaction number or, in the case of samples disbursements, the 
reference number. The Transaction # value corresponds to the Ref # 
value displayed in the Contact Call Detail view.

Transaction Date The date the transaction was created.

Transaction Status An indicator of the status of the original sample transaction. 

Transaction Type Shows the type of transfer. Valid values include Transfer Out and 
Transfer In.

Transfer To/From 
Last Name

The name of the employee receiving or generating the transaction. 
Used only if the transaction type is Transfer Out or Transfer In.

Table 9. Some of the Fields in a Samples History Record

Field Comments
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To adjust a quantity in a samples transaction

1 From the application level menu, choose View > Site Map > Samples screen.

2 From the Show drop-down list, select My Samples History.

3 In the Inventory Periods list, select the period containing the transaction for 
which you want to adjust a quantity. 

The products for the selected period are displayed in the Inventory List. 

4 In the Inventory List, select the product whose quantity you want to adjust. 

When you select a product in the Inventory List, the Samples History list lists all 
samples transactions entered for that product. You can identify the transaction 
record in the Samples History list by the Transaction Date, Last Name, or 
Transaction # field values. 

5 In the Samples History form, click Adjust Qty and then OK. 

The application first verifies that you have sufficient rights to make the 
adjustment and then adds a new line-item record for the transaction in the 
Samples History list and sets the line-item record’s Item Status field to In 
Progress. With the exception of the Item Status value, this record is a copy of the 
record you selected in Step 4.

6 In the Samples History form, enter the correct quantity in the Quantity field.

7 Click Submit, and then OK. 

The application adds new item with an Item Status of Submitted and changes the 
original item record (whose quantity you adjusted) to an Item Status of Adjusted. 
The new quantity is reflected in the on-hand quantities in the Inventory Count view.
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Checking Electronic Signatures
End users can use Siebel ePharma Handheld to electronically capture signatures. 
The Signature Audit Administration view lists the four most recent electronically 
captured signatures of a contact to whom samples were dropped. For more 
information on using Siebel ePharma Handheld, see Siebel ePharma Handheld 
Guide for Windows-Powered Devices. 

As the samples administrator, be sure to check Signature Audit Administration 
regularly and perform signature capture verification to make sure that signatures 
collected from each contact are consistent.

The signature capture verification determines if the call information has been 
modified by comparing the information captured from the signature (the signature 
event string) with the current call information (the current call string). Reasons for 
call information modification include:

■ Recreation of a sample receipt

■ Sample adjustments

■ Fraud

Signature capture verification is launched from the Verify button on the Signature 
Audit Administration view. For an example of signature audit administration, see 
Siebel ePharma Handheld Guide for Windows-Powered Devices. 

As the samples administrator you are responsible for your company’s samples 
inventory and making sure it complies with regulatory rules and regulations. Use 
the views described in Table 8 on page 161 to monitor samples activity across the 
enterprise.

To display Signature Audit Administration

1 From the application-level menu, choose View > Site Map > Samples 
Administration > Samples Administration.

2 From the Show drop-down list, select Signature Audit Administration.

The Signature Audit Administration view appears. 
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NOTE: If a Contacts record is deleted, the application removes the contact name from 
lists that reference that contact’s name in the S_CONTACT table. Therefore, if the 
Contact Id is deleted from the S_ACT_SIGN table, the last name and first name fields 
appear empty in the Signatures form within the Signature Audit Administration 
view. However, deleting a Contacts record does not affect the Contact Full name 
since it is stored in a text field in the same table. In the Pharma Signature Receipt 
Form, the control above the Signature shows the full name of the contact at the time 
of the call (that is, no reference to the S_CONTACT table). Since the contact’s name 
is not removed from this list, a permanent and complete electronic record of calls 
captured with signatures recorded electronically is maintained.

Generating a Receipt for Calls with Electronic Signatures
The Sample Event Administration screen shows an entire sample transaction as it 
was recorded at the time the signature was captured. Sales representatives can 
submit electronically captured signatures using Siebel ePharma Handheld. For more 
information on using Siebel ePharma Handheld, see Siebel ePharma Handheld 
Guide for Windows-Powered Devices. 

To display Sample Event Administration

1 From the application-level menu, choose View > Site Map > Samples 
Administration > Samples Administration.

2 From the Show drop-down list, select Samples Event Administration.

The Samples Event Administration view appears.

Creating New Disclaimer Text for Signature Capture Display
The Disclaimer Administration screen shows the disclaimer information that 
appears in the Siebel Signature Capture display for Siebel ePharma Handheld. For 
more information on using Siebel ePharma Handheld, see Siebel ePharma Handheld 
Guide for Windows-Powered Devices. 

To display the Disclaimer Administration screen 

1 From the application-level menu, choose View > Site Map > Samples 
Administration > Samples Administration.

2 From the drop-down list, select Disclaimer Administration.
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3 To replace existing disclaimer text, create a new record in the Disclaimers list 
and complete the necessary fields.

The new disclaimer becomes active immediately. Only one disclaimer can be 
active at a time. 
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End-User Procedures
The following end-user procedures are described in this section:

■ To create a samples order on page 170

■ To acknowledge receipt of a samples transfer on page 172

■ To record a sample theft or loss on page 173

■ To create and submit an inventory count on page 175

■ To identify discrepancies in inventory counts on page 176

■ To adjust multiple quantities with a new adjustment transaction on page 177

■ To reconcile an inventory period on page 179

NOTE: End-users must configure personal lists of the products they detail, the 
products they distribute as samples, and the products they provide as promotional 
items before they can record information about contact calls or account calls. For 
more information on creating personal lists, see “Creating a Personal List” on 
page 82.

About Establishing an Initial Inventory Count
End users only need to establish an initial inventory count when their initial counts 
contain records that they manually entered into Siebel Samples Management. If that 
is the case, they must set up an initial master inventory, make adjustments, and 
then reconcile it as described in “Establishing an Initial Inventory” on page 152.

If their initial counts only contain samples routed to them by their samples 
administrator, they simply need to acknowledge the receipt of those shipments. For 
more information, see “Acknowledging Receipt of a Samples Transfer” on page 171.
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Creating a Samples Order
End users can request additional samples by creating a samples order. Once 
submitted, the application routes the samples order to the samples administrator. 
The samples administrator then creates a samples transfer that is routed back to the 
requestor. Once the requestor acknowledges receipt of the transfer, Siebel Samples 
Management automatically enters the new inventory into their inventory counts.

NOTE: Creating samples orders is optional. Siebel Samples Management allows users 
to acknowledge receipt of samples shipments even if they have not created orders 
for those samples. The Siebel administrator determines whether or not users are 
required to create samples orders for record-keeping purposes. 

To create a samples order

1 Navigate to the Samples screen.

2 From the Show drop-down list, select My Samples Orders.

3 In the Samples Orders list, add a new record.

The application adds a new record and automatically sets the Order Date field 
to a date and time in the active period.

NOTE: It is not necessary to change the Order Type field. You can include both 
samples and promotional items in a single order.
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4 In the Line Items list, add a new record and complete the necessary fields. 

Some fields are described in the following table.

 

Repeat Step 4 to enter a line item for each product or promotional item you want 
to order. 

5 Click Submit. 

NOTE: An order cannot be modified or deleted after it has been submitted. 

The values of the Order Status field (in the Samples Order list) and the Item Status 
field (in the Line Items list) change to Submitted. 

Acknowledging Receipt of a Samples Transfer
Siebel Samples Management supports two ways of electronically moving samples 
inventory:

■ By creating a samples transfer (see “Creating a Samples Transfer” on page 158)

■ By creating a samples order (see “Creating a Samples Order” on page 170)

In either case, the application creates a samples transfer transaction and routes it to 
the recipient for acknowledgement. Once the recipient submits a receipt, the 
application transfers the new inventory into their active inventory period. End users 
can then view the new inventory in the Samples History screen. For more 
information on displaying the Samples History view, see “Adjusting a Past Samples 
Transaction” on page 162. 

Field Comments

Line # The line number of this item in the transaction. The application 
automatically generates, values for this field, but it can also be edited. 
You might want to edit this value to have the items appear in a 
particular order (other than the order in which you entered them). 

Item Status Initially set to In Process. The application automatically changes this 
field value to Submitted when you submit the transaction.

Sample The product to be ordered.
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To acknowledge receipt of a samples transfer 

1 Navigate to the Samples screen.

2 From the Show drop-down list, select My Received Samples.

3 In the Received Samples list, select the transfer that you want to acknowledge.

Samples transfers that have not been acknowledged as received show an Invoice 
Status value of In Progress. Those that have been acknowledged as received 
show an Invoice Status value of Submitted. 

4 In Line Items list, modify the Received Quantity field if the value does not 
accurately reflect the quantity received. 

5 Click Submit. 

NOTE: The samples transfer quantities do not appear in end users inventory 
counts until they submit a samples receipt. However, once the samples receipt 
has been submitted, it cannot be modified or deleted. 

The values in the Invoice Status field (Received Samples list) and the Item Status 
field (Line Items list) change to Submitted. 

End users can track discrepancies between shipped quantities and received 
quantities by using the My Received Samples Transfer Discrepancies filter. A 
manager’s version of this view is also provided, and the samples administrator 
can track samples discrepancies system-wide by using a samples administration 
view. For more information on available administration views, see “Monitoring 
Samples Activities” on page 160. 

6 From the Show drop-down list, select My Samples History.

The Samples History view appears. Selecting a period in the Inventory Periods 
list shows the line items of the received transfer in the Samples History list.
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Adjusting an Inventory Count
The administrator and end users can adjust inventory counts of samples stock by 
making adjustments to past samples transactions. Common reasons for adjusting 
past transactions include product loss or expiration, counting mistakes, or data 
entry errors. When adjusting an inventory account, users may add products or 
adjust quantities for any type of samples transaction (disbursement, transfer, order, 
and so on). For more information on adjusting inventory counts, see “Adjusting a 
Past Samples Transaction” on page 162.

Recording Thefts and Losses
End users record sample thefts or losses in the Samples Adjustments view. 

To record a sample theft or loss

1 Navigate to the Samples screen.

2 From the Show drop-down list, select My Samples Adjustments. 

3 In the Samples Adjustments list, add a new record.

4 In the Adjustment Reason field, select Lost.

5 In the Line Items list, add a new record and complete the necessary fields.

6 Click Submit.

Reconciling an Inventory Period
At least once a year, end users are required to perform an inventory reconciliation 
to remain in PDMA compliance. Users might also need to perform an inventory 
reconciliation if they are receiving a promotion or leaving the company. For more 
information on reconciliation, see “Inventory Reconciliation” on page 136. 

Prior to starting inventory reconciliation, users must perform the steps outlined in 
Figure 3.

Figure 3. Inventory Reconciliation Prerequisites 
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These inventory reconciliation prerequisites must be performed in the following 
order:

■ Verify previous inventory periods are reconciled. End users must reconcile previous 
inventory periods in chronological order. This is only a concern if a company’s 
configuration allows more than one inactive, unreconciled period. For more 
information, see “About Establishing an Initial Inventory Count” on page 169.

■ Acknowledge receipt of inventory transfers. End users must send 
acknowledgements for all received sample inventory shipments. For more 
information, see “Acknowledging Receipt of a Samples Transfer” on page 171. 

■ Create transfer transactions for transferred samples. End users must create transfer 
transactions for any samples transferred to another representative or returned to 
the home office. For more information, see “Creating a Samples Transfer” on 
page 158. 

■ Mobile users synchronize with server database. Mobile end users must synchronize 
their local database with the server database before submitting an inventory 
count. This is especially important if they are recording samples received in a 
prior period or to be received in a future period. For more information on 
synchronizing a local database, check with your Siebel administrator.

NOTE: Counts for transferred and received samples are not reflected in the inventory 
count until their records have been submitted. 

An inventory period cannot be reconciled if any discrepancy exists between the 
physical and electronic counts. If a discrepancy exists, it must be corrected before a 
user can reconcile the period. For more information, see the procedure “To identify 
discrepancies in inventory counts” on page 176. 

The reconciliation process consists of the steps outlined in Figure 4.

Figure 4.  Inventory Reconciliation Process 
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These reconciliation steps must be performed in the following order:

■ Create and submit an inventory count. End users must create and submit an 
inventory count (either by product or lot number) of the products currently on-
hand. For more information, see the procedure “To create and submit an 
inventory count” on page 175.

End users cannot submit a count differently from the way they submitted the 
previous period’s count unless the previous period has been reconciled. For 
example, if they submitted the previous period’s count by product name, they 
must reconcile that period before they can submit a subsequent count by lot 
number.

■ Correct physical and electronic count discrepancies. End users must correct any 
discrepancies between the physical counts and the electronic counts by:

■ Creating and submitting a sample adjustment transaction with one or more 
line items. For more information, see the procedure “To adjust multiple 
quantities with a new adjustment transaction” on page 177.

This method allows end users to adjust the inventory counts of multiple 
products with a single adjustment transaction (containing multiple line 
items). However, they may want to use this method if they need to adjust 
more than two or three counts. 

■ Adjusting previous transactions. Adjusting line-item records of previously 
entered transactions. For more information, see the procedure “To adjust a 
quantity in a samples transaction” on page 165. 

This method allows end users to adjust the quantity of a selected line item in 
a previously entered transaction. However, they may want to use this method 
if they only need to adjust one or two counts.

■ Reconcile the inventory period. For more information, see the procedure “To 
reconcile an inventory period” on page 179. 

To create and submit an inventory count

1 Physically count all samples currently on-hand.

2 Navigate to the Samples screen.
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3 From the Show drop-down list, select Inventory Count.

The Inventory Count list lists records for every product in your inventory.

NOTE: Records in the Inventory Count view can be deleted only if the value of the 
On Hand Quantity field is zero. Do not delete records from this view unless you 
are certain that you will not need to enter adjustments to any transactions 
containing the product in the future or in a past unreconciled period.

4 In the Inventory Count list, enter a value in the Count field for all records.

The Difference field in some records may show a value other than zero. 

Proceed in one of the following ways:

■ If the Difference field in any record shows a value other than zero, click Submit 
and follow the procedure “To identify discrepancies in inventory counts” on 
page 176. 

■ If the Difference field in all records is equal to zero, click Submit and follow the 
procedure “To reconcile an inventory period” on page 179. 

To identify discrepancies in inventory counts

1 Navigate to the Samples screen.

2 From the Show drop-down list, select Reconciliation.

3 In the Unreconciled Inventory Periods list, select the period that you want to 
reconcile.

4 In the Unreconciled Inventory List, scroll to determine how many product 
records show a value other than zero in the Difference field. 

The number of discrepancies determines the adjustment method.

5 For every record in the Unreconciled Inventory List whose Difference field does 
not equal zero, write down the sample name, the lot number, and the value 
displayed in the Difference field.

A positive value in the Difference field means that your electronic count (the 
Stock Quantity field) is greater than your physical count (the Counted Quantity 
field). A negative value in the Difference field means that your electronic count 
(the Stock Quantity field) is less than your physical count (the Counted Quantity 
field). 
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Proceed in one of the following ways: 

■ If only one or two records require adjustments, enter individual line-item 
adjustments for those transactions. In this case, write down the transaction 
numbers of the transactions you plan to adjust. 

The Samples History list displays all transactions corresponding to the product 
selected in the Unreconciled Inventory List. You can find the transaction number 
in the Transaction # field of the Samples History list. Then proceed with the 
procedure “To adjust a quantity in a samples transaction” on page 165. 

■ If more than two records require adjustments, enter a single adjustment 
transaction, with multiple line items, that adjusts all the quantities. Proceed to 
the following procedure, “To adjust multiple quantities with a new adjustment 
transaction” on page 177.

To adjust multiple quantities with a new adjustment transaction

1 Navigate to the Samples screen.

2 From the Show drop-down list, select My Samples Adjustments. 

3 In the Samples Adjustments list, add a new record and complete the necessary 
fields. 

Some of the fields in a Samples Adjustment record are described in the following 
table.

 

Field Comments

Adjustment Reason Follow your company’s guidelines for what to select for 
this field. 

Transaction # The application automatically generates an unique 
identifier. You can change this value. 

Transaction Date The application automatically generates an unique 
identifier for this field. 

Transaction Status The value will be changed to Submitted when you submit 
the transaction. 
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4 In the Line Items list, add a new record and complete the necessary fields.

Some of the fields in a Line Items record are described in the following table. 

 

Repeat Step 4 until you have entered a line item for each needed adjustment.

5 In the Samples Adjustments list, click Submit. 

The values of the Transaction Status field (in the Samples Adjustments list) and 
the Item Status field (in the Line Items list) change to Submitted. 

6 Reconcile the inventory period, as described in the following procedure. 

Field Comments

Expiration 
Date

Read-only. This field is automatically filled when you complete the 
Lot # field.

Item Status The application changes value in this field changes to Submitted 
when you submit the transaction. 

Item # The number of this item in the transaction. Line numbers are 
automatically generated but can be edited. You might want to edit this 
value to have the items appear in a particular order (other than the 
order in which you entered them). 

Lot Name The lot number for this sample.

Quantity The amount of the sample adjustment. The quantity you enter can be 
positive or negative, depending on the value you recorded in Step 5 
on page 176: 

■ If the value that you recorded was positive, enter a negative 
quantity. 

■ If the value that you recorded was negative, enter a positive 
quantity.

Sample The product for which you want to enter a quantity adjustment. 
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To reconcile an inventory period

1 Navigate to the Samples screen.

2 From the Show drop-down list, select Reconciliation.

3 In the Unreconciled Inventory Periods list, select the inventory period that you 
want to reconcile. 

4 Scroll through the records.

5 In the Unreconciled Inventory List, scroll through the records and verify that the 
value of the Difference field for each record is zero. 

6 Click Reconcile. 

The Samples Reconciliation view is cleared. 
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An account is any healthcare business that generates sales for your company or 
potentially could generate business. Typical examples of accounts include hospitals, 
clinics, HMOs, wholesalers, group purchasing organizations (GPOs), and 
pharmacies. An account can also be any organization with which multiple contacts 
are associated, such as a group practice or an assisted-living facility. 

This chapter describes how to administer and manage Siebel Life Sciences account 
information. Using the procedures given in this chapter, you will be able to perform 
the administrator tasks of generating account hierarchies, deleting an account, 
specifying which accounts are competitors, and associating bricks with account 
addresses. End users use the Accounts views to track a variety of account 
information, including account affiliations, account and contact relationships, 
activities and opportunities associated with accounts, and formulary information.

For more information on specific administrator and end-user tasks, see “Business 
Scenario” on page 184.
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About Account Hierarchies
An account hierarchy is a group of accounts that are organized by parent-child 
relationships. All of the Siebel Life Sciences applications support displaying these 
account relationships and the contacts, activities, and opportunities associated with 
each account on a hierarchical tree. 

The hierarchical tree is a visual representation of account hierarchy data that allows 
end users to view the relationships between accounts. By viewing an account 
rollup, users can see aggregated account information, including contacts, coverage 
teams, activities and opportunities.

When end users have access to an account, they can review the hierarchical 
structure for that account, its child accounts and the contacts that work there. 
Account hierarchies are stored in five subviews of the Account screen—Relationship 
Hierarchy view, Activity Roll-up, Contact Roll-up, Opportunity Roll-up, and 
Coverage Team Roll-up. 

Depending on your configuration, an account that does not have a parent-child 
relationship with another account may not appear in the rollup views.
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About Bricks
A brick is a collection of accounts and contacts, normally in a common geographic 
area. The primary purpose of a brick is to allow a company to publish RSA (retail 
sales analysis) data while making sure that specific sales cannot be tracked to a 
particular contact or account. For more information on creating bricks, see 
“Defining a Brick” on page 53.

IMS Health publishes retail sales data and determines the definition of bricks. Brick 
definitions are reviewed every six months and adjusted to make sure that the brick 
is as small as possible while providing the required level of anonymity.

Because brick data is a key measure of return on a pharmaceutical company's 
investment in sales promotion, outside the United States most pharmaceutical sales 
territories are built based on brick data available for that country. This provides a 
meaningful way to measure performance over time. 

How Bricks Work in Siebel ePharma
In Siebel Life Sciences, you can associate a contact or an account address with a 
brick. A contact can be associated with multiple bricks and an account with 
multiple addresses can have one brick for each address.

This implementation of Siebel ePharma also supports “mini-bricks.” Mini-brick 
data is a subset of brick data that narrows the number of contacts and accounts in 
a geographic area. Mini-bricks provide a more detailed view of an area, without 
identifying the individuals in the unit.

It is the Siebel administrator’s responsibility to set up and maintain brick definitions 
as well as associate bricks with account addresses and contacts. For more 
information on associating a brick with an account address, see “Associating a Brick 
with an Account Address” on page 191. For more information on associating a brick 
with a specific contact, see “Associating a Contact with a Brick” on page 55. 
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Business Scenario
This section outlines an example workflow performed by a Siebel administrator and 
end users. Your company may follow a different workflow according to its business 
requirements.

A pharmaceutical company is updating account information in their database. 
During this update process, the administrator is responsible for setting up and 
updating Siebel Accounts so that sales representatives can plan, track, and access 
account information. The administrator first deletes any obsolete accounts, then 
adds new information on competitors, and generates an account hierarchy. Finally, 
the administrator associates new accounts with existing bricks (geographic areas), 
if applicable.

Sales representatives use Siebel Accounts to manually add and modify account 
information. For accounts with multiple departments and divisions, representatives 
can enter additional information for subaccounts. They can also add more depth to 
account data by creating user-defined fields called categories. Using categories, 
representatives can track private or shared information about accounts (for 
example, which accounts have memberships to specific professional associations). 

Account-based sales personnel, such as managed care account managers, use Siebel 
Accounts to manage information on managed care plans offered by an account and 
track the formulary information on each plan. They can also track the associations 
between plans and contacts.

For greater efficiency in call reporting, representatives can associate a contact with 
a specific account. Once these relationships are tracked within the system, they can 
record attendee calls. Attendee calls (very similar to contact calls) allow users to 
record the account call and samples disbursements for contacts seen at the account. 
Prior to visiting an account, representatives can view a snapshot of important 
information related to an account using the Pre-Call view. For more information on 
recording account calls, see “Recording Account Calls” on page 129.

Finally, both representatives and managers can evaluate the business potential of 
accounts by using the Account Rankings and Ratings view and the various charts 
provided in the Charts views.
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Example Workflow for Managing Accounts
This section details sample tasks often performed by administrators, sales 
representatives and account-based sales personnel to record account calls. Your 
company may follow a different workflow according to its business requirements.

Administrator Procedures
The following list shows tasks administrators typically perform to manage accounts:

■ Enter information on competitors. For more information, see “Specifying a 
Competitor” on page 187.

■ Delete existing accounts. For more information, see “Deleting an Account” on 
page 188.

■ Generate a default account hierarchy and dynamic account hierarchies. The account 
hierarchy lists accounts, child accounts and the activities, contacts and 
opportunities associated with all the accounts. For more information, see 
“Generating Account Hierarchies” on page 188.

■ Associate a brick with an account address. For more information, see “Associating 
a Brick with an Account Address” on page 191.

End-User Procedures
The following list shows tasks end users typically perform when managing account 
information in the field:

■ View aggregated data across account hierarchies. End users can see data rolled up 
as a hierarchical structure of accounts. For more information, see “Viewing 
Account Hierarchies in Roll-up Views” on page 196.

■ Create new accounts. For more information, see “Adding an Account” on 
page 194.

■ Specify account profiles. For more information, see “Specifying an Account 
Profile” on page 195.

■ View account hierarchies in roll-up views. For more information, see “Viewing 
Account Hierarchies in Roll-up Views” on page 196.
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■ Add account categories. For more information, see “Adding Category 
Information” on page 199.

■ Indicate affiliations contacts with accounts. For more information, see “Indicating 
an Affiliation Between an Account and a Contact” on page 200.

■ Indicate affiliations between accounts. For more information, see “Indicating 
Affiliations Between Accounts” on page 201.

■ Create subaccounts. For more information, see “Adding Subaccounts” on 
page 203.

■ View pre-call information. Before making a call, representatives can review details 
about an account. For more information, see “Viewing Pre-call Information” on 
page 205.

■ Enter information on managed care plans and formularies offered by accounts. 
Managed-care account managers can record details of plan designs and 
formularies at an account, including the products on those formularies, 
formulary review frequency and next review date. For more information, see 
“Adding Plan and Formulary Information” on page 206.

■ Update contact information. Representatives can add information about contacts 
associations with plans and their roles on P & T committees. For more 
information, see “Associating Contact Information to Plans” on page 208.

■ Track account documentation. Representatives can review documentation 
associated with an account, the contacts responsible for each document and 
when reviews are due. For more information, see “Tracking Documentation 
Associated with an Account” on page 209.
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The following administrator procedures are described in this section:

■ To specify an account as a competitor

■ To delete an account on page 188

■ To generate a default account hierarchy on page 189

■ To create a dynamic account hierarchy of selected accounts on page 190

■ To associate a brick with an existing account address on page 191

Specifying a Competitor
You enter competitors into Siebel Life Sciences as accounts, but with the Competitor 
field selected.

To specify an account as a competitor

1 From the application-level menu, choose View > Site Map > Data 
Administration > Accounts.

2 In the Accounts form, add a record and then click the show more button.

3 Complete the necessary fields.

4 Select the Competitor field.

For more information on creating accounts from the Accounts screen, see “Adding 
an Account” on page 194. For more information on adding competitive product 
information, see “Managing Competitor Information” on page 402.
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Deleting an Account
Deleting an account completely removes the account from the system. Be aware 
that deleting an account could have undesired consequences. 

As an alternative to deleting an account, consider making the Siebel administrator 
the primary team member so that he or she can remove all other employees from 
the account’s team. 

If you are certain that the account is no longer active, use the following procedure 
to delete it.

To delete an account

1 From the application-level menu, choose View >Site Map > Data 
Administration > Accounts.

2 In the Accounts list, select and then delete the appropriate account.

Generating Account Hierarchies
Data aggregation is available via the Roll-up views provided the administrator 
defines one or more hierarchies. The application administrator typically defines a 
“default” hierarchy by associating accounts with one another using the parent field 
on a company form, or the subaccount view for child accounts. Administrators can 
define account hierarchies display aggregated data—the activities, opportunities, 
contacts, and coverage teams—across account organizational structures. For 
example, the top node of the hierarchy contains activities for the organization, the 
subsidiaries below the organization, the departments at the subsidiaries, and 
contacts working at any level of the tree. As the end users move up and down the 
tree, they see more or less data rolled up to the selected level.

The application administrator can define two types of hierarchies for data 
aggregation—a default hierarchy for all end users and specific hierarchies that are 
used only by certain end users.
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Default Account Hierarchies
The application administrator sets up a default account hierarchy once, during the 
initial application setup. The default hierarchy is available to all end users who are 
not tied to a specific hierarchy and who have been granted view access to the 
accounts represented in the hierarchy. It is the administrator’s responsibility to give 
end user access to Account views. For more information, see Applications 
Administration Guide.

When new accounts are added, they are automatically added to the default 
hierarchy tree and the contacts, coverage teams, activities, and opportunities that 
are associated with the accounts are automatically displayed in the rollup views. 

In the preconfigured application, using the Generate Hierarchy button adds only 
parent account and child accounts to the hierarchy. Any account that does not have 
a child or parent is not displayed in the rollup views. In Siebel Tools, you can change 
the DynHierarchy LoadAllAccounts user property to alter this behavior.

The DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct 
Relationship business component can be set to N or Y. When it is set to N, only 
parent and children appear in the generated hierarchy. When DynHierarchy 
LoadAllAccounts user property is set to Y, all accounts are added to the account 
hierarchy. For information on setting user properties, see Siebel Tools Reference.

To generate a default account hierarchy

1 In the application-level menu, choose View > Site Map > Application 
Administration > Account Hierarchies.
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2 In the Account Hierarchies list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your 
application are registered for participation in the roll-up views. This process may 
take some time, depending on the quantity of account records that are in your 
existing environment.

When the account hierarchy has been generated, a new record appears in the 
Account Hierarchies list. The Hierarchy Name field of the record contains the 
user Id of the administrator who generated the account hierarchy and the time 
it was generated. If it is the only account hierarchy record, the Default field is 
automatically checked. The accounts that have been added for participation in 
the roll-up views appear in the Account Relationships list.

NOTE: If no accounts are visible in the Account Relationships list, click the query 
button, step off the query, and click Go to refresh the view.

3 Optional. Rename the account hierarchy and, if necessary, check the Default 
field.

NOTE: If end users are using the application when you generate the account 
hierarchy, they must log off and log on again to see the default account hierarchy 
in the rollup views.

Dynamic Account Hierarchies
In some cases, users work with particular accounts or subaccounts of a large 
corporation, but not with others. In these instances, some end users do not need to 
or should not see aggregated data across the entire corporation. An administrator 
can define a custom hierarchical structure across which data can be aggregated. 
This defined structure, called a dynamic hierarchy, can be as simple or complex as 
needed and offers users the ability to aggregate data across the accounts they are 
interested in seeing. 

To create a dynamic account hierarchy of selected accounts

1 In the application-level menu, choose View > Site Map > Application 
Administration > Account Hierarchies.

2 Create a new account hierarchy record.
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3 Click the add button in the Account Relationships list, select accounts in the Add 
Account dialog box, and click OK.

All the accounts in the Account Relationship list belong to the new account 
hierarchy.

4 To define parent and child relationships, select an account in the Account 
Relationship list that has no parent account, click the select button in the Parent 
Account field, and select a parent account in the Pick Parent Account dialog box.

5 Repeat Step 4 for all accounts that have no parents.

6 Associate the dynamic hierarchy with an organization.

End users can only see the account hierarchy with which their current position’s 
primary organization is tied. It is the administrator’s responsibility to associate 
end users with positions, positions with organizations, and organizations with 
hierarchies. For more information, see Applications Administration Guide.

Associating a Brick with an Account Address
In Siebel Life Sciences, you can associate a brick with an account address. Because 
bricks are associated with an account’s address (and not the account itself), you can 
associate accounts that have multiple addresses with multiple bricks. 

NOTE: For more information on bricks, see “About Account Hierarchies” on 
page 182. For more information on associating a brick with a specific contact, see 
“Associating a Contact with a Brick” on page 55.

To associate a brick with an existing account address

1 Verify that brick records have been set up. 

For information, see “Defining a Brick” on page 53.

2 From the application-level menu, choose View > Site Map > Data 
Administration > Accounts.

3 In the Accounts list, select an account.

4 In the Account form, click the show more button.
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5 In the Brick field, click the select button.

6 In the Pick Brick dialog box, select a brick.

If there is more than one account address for the account, a brick may be 
assigned for each address. 
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The following end-user procedures are described in this section:

■ To add an account on page 194

■ To add account profile information for an account on page 195

■ To view aggregated activities for an account on page 197

■ To view the aggregated coverage team for an account hierarchy on page 197

■ To view the aggregated opportunities for an account hierarchy on page 198

■ To view an aggregated list of contacts an account on page 198

■ To add category information for an account on page 199

■ To indicate an affiliation between an account and a contact on page 200

■ To add a new role for an affiliated contact on page 201

■ To indicate an affiliation between accounts on page 201

■ To view an account’s upward and downward account affiliations on page 202

■ To add a subaccount on page 204

■ To indicate an affiliation between a contact and a subaccount on page 205

■ To view pre-call information on page 206

■ To add plan information to an account on page 207

■ To add formulary information to an account on page 207

■ To associate contacts with account plans on page 208

■ To update a contact’s role on page 209

■ To track documentation associated with an account on page 209
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Adding an Account 
Accounts are businesses and organizations that either currently generate sales for 
your company or have the potential to do so. Because formulary opportunities are 
created and managed based on accounts and contacts can be affiliated with one or 
more accounts, entering and maintaining accurate account information is a critical 
task. 

Accounts are also used to track competitor information. An account record with the 
Competitor field selected represents a competing company. Only the administrator 
can edit the Competitor field to create a competitor record. For more information, 
see “Specifying a Competitor” on page 187.

Multiple employees can be assigned, as a team, to an account. Any employee 
assigned to the team can update the account’s information. A user who adds an 
account is automatically designated as the primary account team member. 
However, he or she can also be added to an account team created by another user 
(such as a manager).

Editing an Account Address
Accounts in Siebel Life Sciences can have multiple addresses. Users can edit existing 
addresses directly in the Address field. However, users should be careful when 
editing an existing address. Editing an existing address, changes it for all accounts 
currently associated with the address. 

To add an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.
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3 In the More Info form, add a record and complete the necessary fields. 

Some of the fields in an Account record are described in the following table.

NOTE: Only a Siebel administrator can delete an account. For more information, see 
“Deleting an Account” on page 188.

Specifying an Account Profile
Using the Account Profile view end users can track profile information about an 
account, including the call frequency, details about the account size, the best times 
to call on the account, and historical list of all activities at the account. The Account 
type field in the Account form (at the top of the screen) determines what fields 
appear in the Account Profile form. 

To add account profile information for an account

1 Navigate to the Accounts screen.

Field Comments

Account Team Multiple people can be assigned to the account team. The team 
member who created the record is indicated as primary.

Address Line 1 The account can have more than one address. One address 
must be specified as primary (Address Line 1).

Brick The brick (geographic area) code associated with the account's 
primary address. Brick assignment is made using the Account 
Administration view on the Marketing Administration Screen. 
For more information, see “Generating Account Hierarchies” on 
page 188.

Competitor Selecting this field indicates that the company is a competitor. 
Only the administrator can edit this field. For more information, 
see “Specifying a Competitor” on page 187.

Name Name of the account.

Parent If this account is a subaccount of another account, select the 
parent account. 

Site A unique location identifier that distinguishes this account from 
any other accounts with the same name. For example, enter a 
city or county name in this field to uniquely identify a hospital.
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2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting an account, do not click a hyperlink (underlined field). 
Doing so takes you to another view.

4 Click the Account Profile view tab.

NOTE: The fields that appear in the Account Profile form depend upon which 
Account Type field in the Account form at the top of the screen. All fields in the 
Account Profile form are editable.

5 In the Account Profile form, review field values and edit those needing 
modification.

You can track the best times to call on the account in the Best Times list.

6 Scroll down to the Best Times list, add a record, and complete the necessary 
fields. 

The Activities list shows all of the activities associated with the account.

Viewing Account Hierarchies in Roll-up Views
End users can review the account and its parent organization, subsidiaries, 
contacts, opportunities and relationships to other entities in the graphical 
relationship hierarchy tree control available in the roll-up views. By drilling down 
on hypertext links on the hierarchy tree, end users can navigate to related views.

NOTE: If the account has not been added to a hierarchy tied to the user's position's 
organization (either default hierarchy or dynamic hierarchy), the hierarchy tree is 
not visible to the end user. Instead they see “The selected record is not included as 
part of your defined hierarchy. If you feel this is in error, please contact your system 
administrator.” The administrator is responsible for associating positions with 
organizations and an organization with a hierarchy.
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The Activities-Roll-up view shows all of the activities associated with the selected 
account and its children. End users can apply filters to the list to find specific 
activity records and save the filtered list.

To view aggregated activities for an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 Select an account and click the Activities-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All 
activities associated with the account and all of its child accounts appear in the 
Activities-Roll-up list. 

In the Activities-Roll-up List, you can:

■ Drill down on an activity type to navigate to the Activities > Attachments 
view.

■ Drill down on an account name to navigate to the Account > Contacts view.

NOTE: If you create an activity in the Activities screen and do not set the Account 
field, the activity will not appear in the Activities-Roll-up list.

To view the aggregated coverage team for an account hierarchy

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 Select an account and click the Coverage Team-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All 
coverage team members associated with the account and all of its subsidiaries 
appear in the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:

■ Drill down on a last name to navigate to the Employees screen.
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■ Drill down on an email address to open a blank email message addressed to 
the team member who has that address.

To view the aggregated opportunities for an account hierarchy

1 Navigate to the Accounts screen. 

2 From the Show drop-down list, select My Accounts.

3 Select an account and click the Opportunities-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All 
opportunities associated with the account and all of its child accounts appear in 
the Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:

■ Drill down on an opportunity name to navigate to the Opportunities screen.

■ Drill down on an account name to navigate to the Account > Contacts view.

To view an aggregated list of contacts an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 Select an account and click the Contact-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All 
contacts associated with the account and all of its child accounts appear in the 
Contacts-Roll-up list.

In the Contacts-Roll-up list, you can:

■ Drill down on a last name to navigate to the Contacts screen.

■ Drill down on an account name to navigate to the Account > Contacts view.

■ Drill down on an email address to open a blank email message addressed to 
the contact who has that address.
198 Siebel Life Sciences Guide Version 7.5, Rev. A



Administering and Managing Accounts

End-User Procedures
Adding Category Information
End users can create categories to track additional account information. In creating 
a category, a user can:

■ Define possible category values.

■ Specify the relative importance of the category and each of its values. 

By default, categories are visible system-wide. However, users can mark categories 
as private. Private categories are only visible to the user who created them.

To add category information for an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 Click the Categories view tab.

4 In the Categories list, add a record and complete the necessary fields. 

Some of the fields in a Categories record are described in the following table.

Field Comments

Category The Pick Category dialog box displays previously categories. Select 
an existing category or create a new one. 

Category Rank Optionally, enter a number to indicate the importance of this 
category relative to other categories.

Private If you do not want other users to see the category, select this field.

Value The Category Values dialog box displays the values previously 
defined for the category. Select an existing value or create a new 
one. 

Value Rank Optionally, enter a number to indicate the importance of this value 
relative to other values. 
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Indicating an Affiliation Between an Account and a Contact
For accounts having multiple contacts, you associate contacts with an account 
using the Contact Affiliations view. One reason to indicate these affiliations is for 
greater efficiency in call reporting, as described in “Recording Calls” on page 117. 

NOTE: The records for contacts you want to affiliate must already exist in the system; 
you cannot add new contact from this view. For more information on adding 
contacts, see “Adding a Contact” on page 58.

To indicate an affiliation between an account and a contact

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting the account, do not drill down on any hyperlinks. Doing 
so takes you to another view.

4 Click the Contact Affiliations view tab.

5 In the Contact Affiliations list, add a record and complete the necessary fields. 

Some of the fields in a Contact Affiliations record are described in the following 
table.

Field Comments

Direct If a check mark appears in this field, profile data for the contact is 
routed to members of the team assigned to the affiliated account. 

If no check mark appears in this field, the profile data is routed only to 
the members of the team assigned to the contact. (Users who are 
connected to the server see the profile data regardless of whether a 
check mark appears in the field or not.) 

Last Name The contact affiliated with this account.
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End users can track a contact’s importance within an account by defining their role 
in the Roles list. Users can then refer to this information prior to calls and adjust 
their discussions accordingly.

To add a new role for an affiliated contact

1 Affiliate an account with a contact as described in the previous procedure, “To 
indicate an affiliation between an account and a contact.”

2 Scroll down to the Roles list, add a record, and complete the necessary fields. 

Indicating Affiliations Between Accounts
In addition to specifying affiliations with contacts, accounts can also have 
affiliations with one another. For example, a hospital can have affiliations with 
certain pharmacies and referring clinics. Users can use the Account Affiliations view 
to indicate affiliations between accounts and to indicate whether the relationship is 
an upward or downward affiliation. 

NOTE: Do not use the Account Affiliations view to indicate a child account of an 
account, such as a department within a hospital or a subsidiary of an account. To 
specify this kind of association, see “Adding Subaccounts” on page 203. 

The Account Affiliations view includes two lists users can use to distinguish 
between upward (or peer affiliations) and downward affiliations:

■ Upward or Peer Affiliations list. Add an account to this list if it is the agent of the 
affiliation. 

■ Downward Affiliations list. Add an account to this list if it is the object of the 
affiliation.

To indicate an affiliation between accounts 

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.
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3 In the Accounts list, select an account.

NOTE: When selecting the account, do not click a hyperlink (underlined field). 
Doing so takes you to another view.

4 Click the Account Affiliations view tab. 

5 In Account Affiliations view, scroll down and select one of the following lists:

■ Upward or Peer Affiliations. Indicates an affiliation in which the selected 
account is the agent of the affiliation, such as an organization responsible for 
referring patients to another hospital. 

■ Downward Affiliations. Indicates an affiliation in which the selected account is 
the object of the affiliation, such as an organization receiving referrals from 
another hospital.

NOTE: If the relationship between the accounts is generic or unknown, select the 
Upward or Peer Affiliations list.

6 In the appropriate list, add a record and complete the necessary fields. 

7 In the Add Accounts dialog box, select one or more accounts and click OK.

The selected accounts are added to the list. Each account’s name becomes a 
hyperlink. 

8 Optionally, select a value for the Relationship field. The default value is None 
Specified. 

NOTE: It is recommended that you not select Subsidiary in the Relationship field to 
indicate a subaccount. If the affiliated account is a subsidiary, delete the newly 
added record and use the procedure in “Adding Subaccounts” on page 203.

To view an account’s upward and downward account affiliations

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select Explorer.
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3 Expand the account for which you wish to view upward and downward 
affiliations.

Adding Subaccounts
Some accounts may have child accounts or subaccounts; for example, a hospital can 
have several departments or clinics. End users can add subaccounts for existing 
accounts using the Sub Accounts view. End users can also use this view to indicate 
affiliations between contacts and subaccounts. 

Once a user has created a subaccount, it can be viewed and modified in any of the 
views in the Accounts screen. All accounts—parent accounts and child 
subaccounts—exist as separate accounts in the system. In the Account Explorer 
view, however, a subaccount appears under its parent, reflecting the hierarchical 
relationship between the two.

Table 10 describes how parent and subaccount team membership affect account 
data access. Users assigned to a parent account team but not to a subaccount team, 
only have partial access to subaccount data. In contrast, users assigned to a 
subaccount team but not to the parent account team, have no access to the parent 
account except to the account name.

NOTE: Do not use the Account Sub Accounts view to indicate affiliations between 
independent accounts, such as a hospital and a referring clinic. For more 
information on establishing this type of association, see “Indicating Affiliations 
Between Accounts” on page 201. 

Table 10. Access to Account and Subaccount Data

Assigned Only to Parent 
Account’s Team

Assigned Only to 
Subaccount’s Team

Access to 
Parent Account Data

Full access Partial access, account name only

Access to 
Subaccount Data

Partial access Full access
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To add a subaccount

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting the account, do not click a hyperlink (underlined field). 
Doing so takes you to another view.

4 Click the Sub Accounts view tab.

5 In the Sub Accounts list, add a record and complete the necessary fields. 

Some of the fields in a Sub Accounts record are described in Table 11.

NOTE: To enter detailed data for a subaccount (such as activities and best times to 
call), drill down on the Name field and complete the fields in the various views in 
the Account Profile view.

Table 11. Some of the Fields in a Subaccounts Record

Field Comments

Account Team Multiple people can be assigned to the account’s team. The team 
member who created the record is indicated as primary.

Name Name of the subaccount. 

Site A unique location identifier that distinguishes this account from any 
other accounts with the same name. For example, enter a city or 
county name in this field to uniquely identify a hospital.
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To indicate an affiliation between a contact and a subaccount

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting the account, do not click a hyperlink (underlined field). 
Doing so takes you to another view.

4 Click the Sub Accounts view tab.

5 In the Sub Accounts list, select a subaccount.

6 Scroll down to the Contact Affiliations list, add a record, and complete the 
necessary fields. 

Some of the fields in a Contact Affiliations record are described in the following 
table.

Viewing Pre-call Information
The Pre-Call view tab is a single view that provides end users with a thumbnail view 
of important information related to an account. Users can access this view prior to 
making a call to get a summary of key information about the account they are about 
to visit.

Field Comments

Direct If a check mark appears in this field, profile data for the contact is routed 
to members of the teams assigned to the affiliated account.

If no check mark appears in this field, the profile data is routed only to 
the members of the team assigned to the contact. (Users who are 
connected to the server see the profile data regardless of whether a 
check mark appears in the field or not.)

Last Name The contact affiliated with this subaccount.

Role Reflects the contact’s relative importance within the subaccount. 
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To view pre-call information

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

NOTE: When selecting an account, do not click a hyperlink (underlined field). 
Doing so takes you to another view.

4 Click the Pre-Call view tab.

The Pre-Call view appears, displaying the lists described in the following table.

5 Optional: Select the Contact Affiliations or Activities lists, add a record, and 
complete the necessary fields.

Adding Plan and Formulary Information
Managed-care account managers can use the Account Plan Formulary view to enter 
and maintain information about plan designs and formularies at an account and the 
products on those formularies. They can associate P & T committee members and 
track formulary review dates to be well prepared for calling on their contacts within 
the accounts.

List Comments

Product Sales Product sales information associated with the account.

Contact Affiliations Lists all contacts affiliated with the account.

This list can also be populated in the Contact Affiliations view 
tab. For more information. see “Indicating an Affiliation 
Between an Account and a Contact” on page 200.

Activities Features a historical list of all activities associated with the 
account. For more information on working with activities, see 
“Creating Activities” on page 97.
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To add plan information to an account

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

4 Click the Plan Formulary view tab.

5 In the Plan Design list, add a record and complete the necessary fields.

Some of the fields in the Plan Design record are described in the following table.

To add formulary information to an account

1 Navigate to the Plan Formulary view tab.

For information on how to navigate to the Plan Formulary view, see “To add plan 
information to an account” on page 207.

Field Comment

% of Total Lives Equal to [(Number of Lives at Plan Level) divided by 
(Number of Lives at Account Level)] multiplied by 100.

No. of Lives Number of lives in the plan. This number cannot exceed 
the number of lives entered for the account.

Note: The total number of lives must be defined in the 
Account form before you enter a value in this field. For 
more information, see “Adding an Account” on 
page 194.

P & T Members Name Names of contacts who are on the Pharmacy & 
Therapeutics committee and their roles.

Pharmacy Distribution Type of distribution, such as in-house, contracted, or 
mail-order.

Utilization Number of plan members who are using plan benefits. 
This number cannot exceed the number of lives in the 
plan.

Utilization % Equal to [(Utilization) divided by (Number of lives at 
Plan Level)] multiplied by 100.
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2 In the Plan Design list, select a plan. 

3 In the Formularies list, add a record and complete the necessary fields. 

Some of the fields in the Formularies record are described in the following table.

4 In the Products list, add a record and complete the necessary fields. 

By adding a product to the Product list you indicate it is on formulary and can 
track its status.

NOTE: You cannot edit the Competitor field. A check mark appears in this field if 
the product you selected for the Name field is a competitor’s product. For more 
information, see “Specifying a Competitor” on page 187.

Repeat Step 3 and Step 4 until you have added a record for every product on the 
formulary.

Associating Contact Information to Plans
Managed-care account managers can associate contacts to plans. This contact 
information may be entered either by the representative for the account or imported 
from external sources. The primary care representative can update information 
about a contact’s plan affiliations and roles on the Pharmacy & Therapeutics (P & T) 
committees. 

To associate contacts with account plans

1 Navigate to the Accounts screen.

2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, select an account.

4 Click the Contacts by Plan view tab.

Field Comment

Type May be Open, Closed, or Limited.

Market A required field. The option selected in 
this field determines which products are 
available in the Products list.
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5 In the Plan Design list, query for the plan to which you want to associate a 
contact.

6 In the Plan Contacts list, click New to add a record for a contact.

Some of the fields in the Plan Contact record are described in the following table.

To update a contact’s role

1 Navigate to the Contacts by Plan view tab.

NOTE: For information on navigating to the Contacts by Plan view, see “To 
associate contacts with account plans” on page 208.

2 In the Plan Design list, query for the account plan with which the contact is 
associated.

3 In the Plan Contacts list, click Query to find the contact by Last Name.

4 Edit the role field for the contact.

Tracking Documentation Associated with an Account
Clinical research associates can use the Document Tracking view to review and 
track documents associated with an account. 

To track documentation associated with an account

1 Navigate to the Account screen.

2 In the Accounts list, select the account for which you want to track 
documentation.

Field Comment

Last Name The last name of the contact.

Role The contact’s role in the plan.
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3 Click the Document Tracking view tab.

A list of documents associated with the account appear.

4 Query for the document of interest and complete the necessary fields.

Some of the fields in a Document Tracking record are described in the following 
table.

Clinical research associates can also create a documentation tracking activity and 
attach a document. For more information, see “Tracking Documentation Associated 
with a Contact” on page 69. For information on associating electronic documents to 
accounts, see “Creating Documentation Tracking Activities” on page 305.

Field Comments

Activity By default, the activity is Document.

Assigned To The person to whom responsibility for the document has been 
assigned.

Expected Date The date that the signed document is expected to come back from 
the account.

Expiration Date The date the document expires.

Lock Assignment Determine whether the Lock Assignment field should be selected. 
If the activity is locked, Assignment Manager will not access it. If 
it is unlocked, Assignment Manager can reassign it.

Name The name of the document. This field is a hypertext link to the 
Attachments tab.

Received Date The date that the signed document returns from the account.

Sent Date The date that the document is sent to the account.
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A Smart Call is a template that users can apply to contact calls and account calls to 
simplify and speed up the call-reporting process. A Smart Call defines a set of 
information about the products detailed, samples and promotional items 
distributed, and issues discussed on a call. 

Smart Calls can be also be used for calls related to a particular campaign or 
promotional effort, or for everyday call reporting. They are intended for situations 
where sales representatives report details about a number of calls that are identical 
in content (the same products are detailed in the same order, the same samples are 
dropped, and so on). 

This chapter describes how to create and modify Smart Calls. Using the procedures 
given in this chapter, you will be able to perform the administrator tasks of creating 
a new Smart Call template and then making it available to end users. Using the 
Smart Calls screens, end users can also create new Smart Call templates, enter 
Smart Call information, and modify Smart Call information after it has been applied 
to a call.

For more information on the differences between administrator and end-user tasks 
see “Business Scenarios” on page 214.
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Business Scenarios
This section outlines an example of workflow performed by the Siebel administrator 
and end users. Your company may follow a different workflow according to its 
business requirements.

A pharmaceutical company is bringing a new product to market. The Siebel 
administrator adds this new product into the database and then creates a Smart Call 
template to distribute to the sales representatives in the field. The administrator 
then makes the Smart Call available to representatives in the field. 

Once the Smart Call has been defined and made public, field sales representatives 
then apply it to their contact calls and account calls. By applying a Smart Call 
template, the representatives can automatically fill in various pieces of information 
in the Contact Call and Account Call Detail views, such as the products they detail, 
the samples they drop, and information they should provide. Representatives can 
also create Smart Call templates that suit their individual purposes. These end-user 
Smart Calls are only visible to each Smart Call creator. 

The Siebel administrator requires administrative responsibilities in Siebel Smart 
Calls to:

■ Create a new Smart Call and enter Smart Call information

■ Make a Smart Call template available to end users

The end users are sales representatives in the field. They enter information to:

■ Create Smart Call templates and enter Smart Call information

■ Apply a Smart Call template to an account or contact call

■ Modify Smart Call information after it has been applied to a call
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Figure 5 and Figure 6 illustrate the workflows for these business scenarios. 

Figure 5. Administrator Creates Smart Call Templates

Figure 6. End User Creates Smart Call Templates 

(page 216)

(page 220)

(page 218)

(page 217)

(page 218)

(page 219)

(page 220)
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The following administrator procedures are described in this section:

■ To add a Smart Call as an administrator

■ To enter Smart Call information as an administrator on page 217

■ To make a Smart Call template available to end users on page 218

By default, a Smart Call is accessible only to the user who created it. However, the 
Siebel administrator can make a Smart Call available to users system-wide by using 
the Smart Call Administration view. The administrator can also add and modify 
Smart Calls using the Application Administration, Smart Call Detail view.

NOTE: Both end users and the Siebel administrator can add and modify Smart Calls 
using the views in the Smart Calls screen. For more information, see “End-User 
Procedures” on page 218.

To add a Smart Call as an administrator

1 From the application-level menu, choose View > Site Map > Application 
Administration > Smart Calls.

2 In the Smart Call form, add a record and complete the necessary fields. 

Some of the fields in a Smart Call record are described in the following table.

 

Field Comments

Created By Name The user who created the Smart Call. 

Expense This amount will appear in the Cost field of the contact call or 
account call. For more information, see “Creating a Contact Call” 
on page 108 and “Creating an Account Call” on page 112.

Name Name of the Smart Call. 
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Enter information in the Smart Call Detail screen, as described in the next 
procedure.

NOTE: Deleting a Smart Call permanently removes the Smart Call from the system. 
Before you delete a Smart Call, make sure that it is no longer needed. Calls that were 
completed using a deleted Smart Call are not affected. 

To enter Smart Call information as an administrator

1 From the application-level menu, choose View > Site Map > Application 
Administration > Smart Calls.

2 In the Smart Calls list, drill-down on a Smart Call name.

3 In the Smart Call Detail view, select any of the four lists:

■ Call Products Detailed

■ Samples Dropped

■ Promotional Items Dropped

■ Issues

NOTE: You may not need to enter information in every one of these lists. 

4 For the appropriate lists, add a record and complete the necessary fields.

Some of the fields in the Smart Call Detail view lists are described in the 
following table.

 

To make the Smart Call available to users, see the next procedure.

Field Comments

Name The name of the samples or promotional items dropped during the 
call. This field appears in the Call Products Detailed and Promotional 
Items Dropped lists.

Quantity The quantity of samples or promotional items dropped during the call. 
This field appears in the Call Products Detailed and Promotional Items 
Dropped lists.
Version 7.5, Rev. A Siebel Life Sciences Guide 217



Creating Smart Calls

End-User Procedures
To make a Smart Call template available to end users

1 From the application-level menu, choose View > Site Map > Application 
Administration > Smart Calls.

2 In the Smart Calls list, select the Smart Call that you want to make available to 
end users.

3 Click the Private field to clear the check mark. 

NOTE: Mobile end users must synchronize before they can access or modify a Smart 
Call.

End-User Procedures
The following end-user procedures are described in this section:

■ To add a Smart Call as an end user

■ To enter Smart Call information as an end user on page 219

Adding a Smart Call
By default, a newly created Smart Call is private; that is, it is available only to the 
user who created it. The Siebel administrator can make a Smart Call available to 
users. For more information, see the procedure “To make a Smart Call template 
available to end users” on page 218. 

NOTE: For account calls where attendees are specified, users can also apply a Smart 
Call to each of the attendees. For more information, see the Smart Call field 
descriptions in “To add a contact call from the Activities screen” on page 109 and 
“To add an account call from the Activities screen” on page 112. 

To add a Smart Call as an end user

1 Navigate to the Smart Calls screen. 
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2 In the Smart Calls list, add a record and complete the necessary fields. 

Some of the fields in a Smart Calls record are described in the following table.

 

Enter information in the Smart Call Detail view as described in the next procedure.

NOTE: Deleting a Smart Call permanently removes the Smart Call from the system. 
Before you delete a Smart Call, make sure that it is no longer needed. Calls that were 
completed using a deleted Smart Call are not affected. 

To enter Smart Call information as an end user

1 Navigate to the Smart Calls screen. 

2 In the Smart Calls list, select a Smart Call.

3 Click the Smart Call Detail view tab.

4 Make sure that the correct Smart Call appears in the Smart Call form. 

5 Select any of the four lists in the Smart Call Detail view:

■ Call Products Detailed

■ Samples Dropped

■ Promotional Items Dropped

■ Issues

NOTE: You may not need to enter information in every one of these lists. 

Field Comments

Created By Name The user who created the Smart Call. 

Expense This amount will appear in the Cost field of the contact call or 
account call. For more information, see “Creating a Contact Call” 
on page 108 and “Creating an Account Call” on page 112.

Name Name of the Smart Call. 
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6 Add a record and complete the necessary fields.

Some of the fields in the Smart Call Detail lists are described in the following 
table.

NOTE: To protect system integrity and make sure users enter the correct 
information, users cannot enter dates and reference numbers for samples with 
Smart Calls. For more information on entering information on dropped samples, 
see “Recording Contact Calls” on page 124 and “Recording Account Calls” on 
page 129.

About Applying a Smart Call Template to a Call
Users apply a Smart Call template by making a selection from the Smart Call field 
in the Contact Call Detail and Account Call Detail views. For more information, see 
the field descriptions in “To add a contact call from the Activities screen” on 
page 109 and “To add an account call from the Activities screen” on page 112. 

NOTE: Once a user applies a Smart Call template to a call, they can make additional 
edits to any fields in the current view. 

Field Comments

Name The name of the samples or promotional items dropped during the 
call. This field appears in the Call Products Detailed and Promotional 
Items Dropped lists.

Quantity The quantity of samples or promotional items dropped during the call. 
This field appears in the Call Products Detailed and Promotional Items 
Dropped lists.
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The views in the Analysis screen present sales, prescription, and call detailing data 
in an accessible format. These views allow you to evaluate your performance and 
determine where to focus your sales activities. 

Much of the data displayed in these views derives from syndicated data.

NOTE: All the views in the Analysis screen are read-only. 

The terms direct sales and indirect sales are used in some views of the Analysis 
screen as follows:

■ Direct sales. Refers to product sales directly from your company to accounts.

■ Indirect sales. Refers to product sales from wholesalers to accounts.
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This section outlines an example of workflow performed by the Siebel administrator 
and end users. Your company may follow a different workflow according to its 
business requirements.

A pharmaceutical company has bought syndicated data concerning its retail 
product sales. This syndicated data is displayed in most of the Siebel Life Sciences 
Analysis views. 

Periodically, the Siebel administrator extracts portions of the syndicated data and 
distributes it according to territory assignments. As part of this process, the Siebel 
administrator updates responsibilities, which affect the data that can be viewed by 
an individual, and updates payer and plan information.

In order to use the new information, the application user must download the 
syndicated data updates. 
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Example Workflow for Analysis
This section details sample tasks often performed by administrators and end-users 
working with the Analysis screen. Your company may follow a different workflow 
according to its business requirements. 

Administrator Procedure
The following administrative procedure is described in this section:

■ Add a payer. For more information, see “To add a payer” on page 224.

Other administrator procedures, applicable to the data used in the Analysis screen, 
are described elsewhere:

■ Load syndicated data. For more information, see “Loading Data into the Siebel 
Life Sciences Database” on page 421.

■ Extract portions of data according to territory assignments. For more information, 
see “To create a data extraction rule” on page 426.

■ Send the compressed data extracts to mobile users. For more information, see “To 
specify the data that is routed to mobile users” on page 427.

■ Update responsibilities (optional). For more information, see Applications 
Administration Guide.

■ Associate position to bricks. For more information, see “Defining a Brick” on 
page 53.

End-User Procedures
The following list shows tasks end users typically perform using the Analysis 
screens: 

■ Import syndicated data extracts. For more information, see “Importing Syndicated 
Data Files” on page 225.

■ Analyze Brick-Level Syndicated Data. For more information, see “Analyzing Brick-
Level Syndicated Data” on page 228.
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Defining Payer and Plan Information
You can use the Payer Administration view to define payer and plan information. 
This information appears in the plan and payment type–based views in the Analysis 
screen. 

To add a payer 

1 From the application level menu, choose View > Site Map > Application 
Administration > Payer. 

2 Click the New button and complete the fields in the new record.

Some of the fields are described in the following table.

 

Field Comments

Type Required. Three types are supported: Total, Plan, and Payer.

Name Required. Enter the name of the payer, plan, or payment type. If 
you selected Plan in the Type field, enter the plan name.

Account Name If relevant, select the payer account, or add a new account for the 
payer in the Pick Account dialog box. 

Account Site Read-only. The location of the plan.

IMS Id The identifier assigned to the plan by the syndicated data provider.
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End-User Procedures
The following end-user procedures are described in the section:

■ To import syndicated data extracts

■ To display all contacts associated with a brick on page 229

■ To correlate actual calls made with indirect sales by brick on page 229

■ To correlate actual calls made with prescription trends by brick on page 229

■ To display data with the views in the Analysis screen on page 230

Importing Syndicated Data Files
If data extracts have been routed to you by the Siebel administrator, you will receive 
notification when you synchronize your local database. During synchronization, the 
data extracts are downloaded to your hard drive (as attachments), where they are 
stored until you import them. After you import the data into your local database, 
the files are deleted from your hard drive.

NOTE: If you want to postpone receiving data extracts until a later time, turn off the 
Retrieve Published Files option in your synchronization setup. To find this option, 
choose File > Synchronize, and then click Setup in the Siebel Remote dialog box.

To import syndicated data extracts

1 Navigate to Syndicated Data Files > Syndicated Data Files. 

NOTE: Even if you postponed receiving data extract files by turning off the 
Retrieve Published Files option in your synchronization setup, this view displays 
records for all the files routed to you. Although the files are listed here, you 
cannot import them until you have received them during a subsequent 
synchronization. 
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2 Select one or more files and click Import. 

The Syndicated Data Files view is cleared, and the data extract files that you 
received during synchronization are deleted from your hard drive. 

Siebel Life Sciences Views
In Siebel Life Sciences, the availability of certain views can be limited according to 
each user’s responsibilities. Therefore, the views you see may differ from those 
shown and described in Table 12. 

NOTE: Analysis data is read-only. Data refresh cycles are determined by your 
company’s business process and data availability. 

Table 12 describes the functions of the views in the Analysis screen. Your 
responsibilities determine which views are available to you. To update 
responsibilities, affecting the data viewed by users, refer to Applications 
Administration Guide.

 

Table 12. Views Available from the Analysis Screen

View Functions

All Markets > Direct Sales Trend by 
Territory - Volume

For managers, displays internal product sales data at the 
territory level over a selected period of time. Displays direct 
sales data for areas covered by their sales representatives.

All Markets > Direct Sales Trend by 
Account - Volume

For representatives, displays internal product sales data at the 
account level over a selected period of time. 

All Markets > Indirect Sales Trend by 
Territory - Volume

For managers, displays product sales data at the territory level 
over a selected period of time. Allows managers to see indirect 
sales data for the areas covered by their sales representatives.

All Markets > Indirect Sales Trend by 
Territory - Share

For managers, displays product sales data at the territory level 
over a selected period of time. 

All Markets > Indirect Sales Trend by Brick 
- Volume

For representatives, displays product sales data at the brick 
level over a selected period of time.

All Markets > Indirect Sales Trend by Brick 
- Share 

For representatives, displays market share data at the brick 
level over a selected period of time. 
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All Markets > Indirect Sales Trend by Postal 
Code - Volume

For representatives, displays product sales data at the ZIP Code 
level over a selected period of time.

All Markets > Indirect Sales Trend by Postal 
Code - Share 

For representatives, displays market share data at the ZIP Code 
level over a selected period of time. 

All Markets > Indirect Sales Trend by 
Account - Volume 

For representatives, displays product sales data at the account 
level over a selected period of time. 

All Markets > Indirect Sales Trend by 
Account - Share 

For representatives, displays market share data at the account 
level over a selected period of time. 

All Markets > Rx Trend by Territory - 
Volume 

For managers, displays product Rx trends in a territory. Allows 
managers to see Rx trends for the areas covered by their sales 
representatives.

All Markets > Rx Trend by Territory - Share For managers, displays product Rx trends in a territory. 

All Markets > Rx Trend by Prescriber - 
Volume

For representatives, displays product Rx trends by prescriber.

All Markets > Rx Trend by Prescriber - 
Share

For representatives, displays product Rx trends by prescriber. 

All Markets > Rx Trend by Plan and 
Territory - Volume

For managers, displays product Rx trends by plan and territory. 

All Markets > Rx Trend by Plan and 
Territory - Share

For managers, displays product Rx trends by plan and territory. 

All Markets > Rx Trend by Plan and 
Prescriber - Volume 

For representatives, displays product Rx trends by plan and 
prescriber. 

All Markets > Rx Trend by Plan and 
Prescriber - Share

For representatives, displays product Rx trends by plan and 
prescriber.

All Markets > Rx Trend by Payment Type 
and Prescriber

For representatives, displays product Rx trends by the payment 
types associated with prescriptions and prescribers. 

All Markets > Rx Trend by Payment Type 
and Territory

For both representatives and managers, displays product Rx 
trends by the payment types associated with prescriptions. 

 Activities > Account Detailing For both representatives and managers, shows the number of 
times a product was detailed during account calls, as well as 
the priority, or order, of the product details. Use this view to 
assess your product emphasis and plan your account calls.

Table 12. Views Available from the Analysis Screen

View Functions
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Analyzing Brick-Level Syndicated Data
End users can analyze syndicated data that is associated with a brick. They can also 
analyze activities, such as calls, associated with an account or contact within a 
brick. Using the brick-level analysis views, end users can correlate those activities 
with prescription or sales trends.

The data that appears in the Analysis screen > Bricks is determined by the user’s 
position and the Bricks that the administrator has associated with that position. For 
more information, see “Defining a Brick” on page 53.

Activities > Contact Detailing For both representatives and managers, shows the number of 
times a product was detailed during contact calls, as well as 
the priority, or order, of the product details. Use this view to 
assess your product emphasis and plan your contact calls.

Bricks > Bricks Rx Analysis > Rx trend by 
brick

For representatives, displays product prescription trends by 
brick. This data is for the entire brick that is selected in the 
Bricks list and is not related to any contact.

Bricks > Bricks Rx Analysis > Rx trend by 
brick-Product NRx

For representatives, displays new prescriptions for a given 
product by brick. This data is for the entire brick that is 
selected in the Bricks list and is not related to any contact.

Bricks > Bricks Rx Analysis > Rx trend by 
brick-Product TRx

For representatives, displays total prescriptions for a given 
product in a given period by brick. This data is for the entire 
brick that is selected in the Bricks list and is not related to any 
contact.

Bricks > Bricks Sales Analysis > Indirect 
sales by brick

For representatives, displays indirect sales data at the brick 
level for the brick selected on the Bricks list.

Bricks > Bricks Sales Analysis > Indirect 
sales trend by product value

For representatives, displays indirect sales data at the brick 
level for the selected product and for the brick selected on the 
Bricks list.

Bricks > Bricks Sales Analysis > Indirect 
sales trend by product units

For representatives, displays indirect sales data at the brick 
level for the selected product unit and for the brick selected on 
the Bricks list.

Table 12. Views Available from the Analysis Screen

View Functions
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To display all contacts associated with a brick

1 Navigate to Analysis > Bricks.

2 Select a brick in the Bricks list.

3 Click on the Contacts view tab.

The Contacts applet displays all contacts associated with the selected brick.

To correlate actual calls made with indirect sales by brick

1 Navigate to Analysis > Bricks.

2 Select a brick in the Bricks list.

3 Click on the Indirect Sales by Brick view tab.

4 Select a record and click the actual calls button. 

The list shows the number of account calls submitted for the selected product 
and period. Remember to select a record that contains your company’s product 
in order to see the activity data.

To correlate actual calls made with prescription trends by brick

1 Navigate to Analysis > Bricks.

2 Select a brick in the Bricks list.

3 Click on the Rx Trend by Brick view tab.

4 Select a record and click the actual calls button.

The list shows the number of account calls submitted for the selected product 
and period. Remember to select a record that contains your company’s product 
in order to see the activity data.
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Working with Sales, Rx, and Call Data
The views in the Analysis screen display prescriber, account, plan, payer, and 
territory level sales and Rx data, as well as call data. These views provide the 
capability to view data in both list and chart formats. 

To access any of the views listed in Table 12 on page 226, navigate to the Analysis 
screen default Analysis view, select the appropriate market in the All Markets list, 
and then select the desired view from the view tabs. 

A list format appears by default when you select a view from the Analysis view tabs. 
You can view your sales and Rx data numbers in a chart format by clicking the 
toggle button.

The data in the Analysis screen must be updated periodically. Mobile users must 
download files that have been extracted and sent by the Siebel administrator and 
then import the new data into their local databases. For more information, see “To 
import syndicated data extracts” on page 225. 

To display data with the views in the Analysis screen

1 Navigate to the Analysis screen.

2 Select the appropriate market (therapeutic class) in the All Markets list.

NOTE: You can select a different market at any time in all views in the Analysis 
screen, except in the Activities subviews (the Account Detailing Analysis and 
Contact Detailing Analysis views). 

3 Click a category from the view tabs. 
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4 Display only the sales, Rx, or call data you want to view using query by example 
or targeting. 

See Chapter 4, “Planning Calls,” for information on targeting. 

NOTE: By default, Siebel ePharma displays (and charts) all available data 
appropriate to the selected Analysis view. Siebel Systems recommends that you 
always filter your data lists to make the displayed data more meaningful. The 
charts in the Account Detailing Analysis and Contact Detailing Analysis views 
display all calls, regardless of status, unless you filter the data in the upper list. 

5 Select a chart type from the drop-down list to specify which type of chart you 
want to use for viewing the selected data. 

Examples of available chart types include 3D stacked bar, 3D bar, and 2D bar.

6 Zoom in on data or limit the chart to particular data points by hovering the 
mouse cursor over the chart element (a bar or pie segment) to see the data only 
for that chart element. To return to the complete set of data for the original chart, 
execute a new query. 
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In order to better manage their sales and field personnel, pharmaceutical companies 
need a way to measure and track the amount of time individuals take off. 

This chapter describes how to use Siebel ePharma Time Off Territory (Siebel Time 
Off Territory) to record blocks of time that a sales representative or field person 
spends on activities not directly associated with an account, a contact, or an 
opportunity. Using the procedures given in this chapter, you will be able to perform 
the end-user tasks of adding and submitting a territory record.
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About Time Off Territory
A time off territory is any block of time during normal business hours in which sales 
representatives are out of their territories. Examples of time off territory include 
field trainings, national sales meetings, sick leave, vacation, or personal activities 
such as doctor’s appointments. 

Companies can use time off territory information to track the time that remote sales 
and field personnel spend on activities that do not directly relate to accounts, 
contacts, or opportunities. Companies can use this information to:

■ Maintain a record of field employee time such as vacation and sick days

■ Evaluate market penetration based on territory coverage and to assess the 
effectiveness of field personnel

Using the views in the Time Off Territory screen, users can record blocks of time 
that should not be included in call-frequency reporting. In addition, they can enter 
and record past and future time off information, including the duration, reason, 
date, and description of the time off territory event. 

Because time off territory is actually a type of activity in Siebel ePharma, time off 
territory records appear in the Activities screen and in views that display activities. 
For more information activities, see “Creating Activities” on page 97.
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Business Scenario for Time Off Territory
This scenario is an example workflow performed by two types of end users, a field 
sales representative and his or her regional sales manager. Your company may 
follow a different workflow according to its business requirements. 

Susan Porter is a sales representative for a pharmaceutical company. Susan has 
been invited to a two-day, out of town seminar. She speaks to her manager and they 
decide she should attend it. Susan uses Time Off Territory to record why her 
territory will not be worked on the days on which the seminar will take place. Once 
she submits the information, her manager has a record of where she is and why she 
is gone.
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Example Workflow for Tracking Time Off Territory
This section details sample tasks often performed by end-users when tracking time 
off territory. Your company may follow a different workflow according to its 
business requirements. 

When tracking time off territory, end users typically perform the following tasks: 

■ Create a new time off territory record. Typically, the sales representative creates a 
record for all of the days she will be attending the seminar. For more 
information, see “Adding a Time Off Territory Record” on page 237.

■ Submit the time off territory record. For more information, see “Submitting a Time 
Off Territory Record” on page 238.

The regional sales manager would use Siebel Time Off Territory to:

■ View time off territory charts. The regional sales manager can review the time off 
territory records that have been submitted to the system. For more information, 
see “Viewing Time Off Territory Charts” on page 239.

Once the sales representative submits a time off territory record to the system, 
Siebel ePharma:

■ Adds a new time off territory record to the Activities list. For more information on 
creating new activities, see “Creating Activities” on page 97.

■ For each time off territory record, creates an all-day appointment in the calendar. For 
more information on using the calendar, see “Creating a General Activity in the 
Calendar” on page 100.
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The following end-user procedures are described in this section:

■ To add a time off territory record

■ To submit a completed time off territory record on page 238

■ To view time off territory charts on page 239

NOTE: Siebel Time Off Territory includes two filters for displaying time off territory 
records: My Time Off Territory and My Team’s Time Off Territory. Each user’s 
responsibilities determines which of these views are available.

Adding a Time Off Territory Record
End users must add at least one time off territory record for business days that they 
spend on activities not directly related to an account, contact, or opportunity. A 
single time off territory record can represent one or many days. Multiple time off 
territory records can represent different activities performed on a single day. For 
example, a user could add one record for a conference attended in the morning and 
another for vacation time taken in the afternoon. 

To add a time off territory record

1 Navigate to the Time Off Territory screen.

2 From the Show drop-down list, select My Time Off Territory.

3 In the More Info form, add a record and complete the necessary fields. 

Some fields in a Time Off Territory record are described in the following table.

Field Comments

Description Describes the reason for the time off.

End Time The time when this territory time off activity ends.
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Submitting a Time Off Territory Record
End users must submit a time off territory record for the information to be included 
in ROI (return on investment) analyses and expense reports. Once a time off 
territory record has been submitted, it can no longer be modified or deleted. 

To submit a completed time off territory record

1 Navigate to the Time Off Territory screen.

2 From the Show drop-down list, select My Time Off Territory.

3 In the More Info form, select the record you want to submit.

4 To include the time off territory expense in an expense report generated by the 
Siebel Expenses, you must:

■ In the Time Off Territory list, specify an a start time.

■ In the Activities screen, enter a cost estimate and select the Expense flag. For 
more information, see “Creating Activities” on page 97. 

5 In the More Info form, click Submit and then OK. 

Once a time off territory record has been submitted, Siebel ePharma:

■ Changes the status of the time off territory record to Submitted.

■ Adds a new time off territory record to the Activities list. For more information 
on activities, see “Creating Activities” on page 97.

Hours Represents duration of the time off request. The application 
automatically calculates this value when you enter or update the Start 
Time and End Time fields.

Start Time The time when this territory time off activity starts.

Status The status of a time off request. 

End users cannot select Submitted. For more information on changing 
the status of a record to Submitted, see “Submitting a Time Off 
Territory Record” on page 238. 

Field Comments
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■ Creates an appointment in the calendar for each submitted record. For more 
information on using the calendar, see “Creating a General Activity in the 
Calendar” on page 100.

■ Routes the time off territory request to the manager.

Viewing Time Off Territory Charts
Users can view graphical charts of time off territory information by clicking the 
Charts view tab. Using these charts is an effective way see trends and patterns.

To view time off territory charts

1 Navigate to the Time Off Territory screen.

2 From the Show drop-down list, select My Team’s Time Off Territory.

3 Click the Charts view tab.

4 From the Show drop-down list, select how you want the information to be 
displayed:

■ TOT by Reason. Displays the number of hours spent off territory each month, 
by reason.

■ TOT by Creator. For managers. Displays the aggregate and incremental number 
of hours spent off territory.

5 From the By drop-down list, select how you want the information to be 
displayed.
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Configuring Time Off Territory
Most of the procedures in Siebel Time Off Territory are end-user related. However, 
the Siebel administrator may want to:

■ Create an approval process and develop alerts so that managers will be notified 
when sales representatives submit Time Off Territory records. For more 
information, see the message broadcasting chapter in Applications 
Administration Guide.

■ Enter additional selections to the Reason drop-down list. For more information, 
see Applications Administration Guide.

To minimize the volume of data that is routed to the manager’s remote client, Time 
Off Territory records that are created by remote users are visible to their managers 
only when they are connected to the server. If the Time Off Territory records of a 
manager’s team need to be routed to the remote client, the following steps must be 
followed, with assistance from your Siebel representative.

To amend routing rules for Time Off Territory records

1 As a precaution, create a backup of the database. 

2 From the application-level menu, choose Start > Programs > Siebel ePharma 
application and right-click on Properties.

You can also access Properties by right-clicking the Siebel ePharma application 
icon on your desktop.

3 On the Properties dialog box, in the Target field add the following after 
epharma.cfg: /editseeddata.

Be sure to include a space after epharma.cfg

4 Launch the application and log in as Sadmin.

5 From the application-level menu, choose View > Site Map > Siebel Remote 
Administration > Routing Models.

6 In the Routing Models form, query for MOBILE.CLIENT-STANDARD in the Name 
field.
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7 In the Routing Rules Excluded list, query for Activity in the Dock Object Name 
field and Sea-11 or EmpMgr:S_EVT_ACT.PERFRM_BY_PER_ID in the Name 
field.

The query returns two records.

8 Stop the Siebel Server.

9 Create a new database template by running the Generate New Database server 
task.

10 Re-extract for the remote users who are affected by this change.
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This chapter describes how a pharmaceutical company can use Siebel ePharma 
Medical Education (Siebel MedEd) to plan all aspects of a medical education event. 
A medical education event can be as simple as a “lunch-and-learn” in a physician’s 
office or as complex as a seminar series or national sales meeting. 

Using the procedures given in this chapter you will be able to perform the 
administrator tasks of setting up funding for MedEd plans, creating templates for 
activities, making literature selections available to end users, and designating 
contacts as MedEd speakers. After these administrative tasks have been completed, 
end users can then use Siebel MedEd to define MedEd plans, set up MedEd events 
and sessions, and invite and register event attendees.

Siebel MedEd provides a single repository of medical event information to allow 
administrators and end users to:

■ Plan and execute events 

■ Track allocated event budgets 

■ Compare allocated budgets to actual event costs

For more information on the differences between administrator and end-user tasks 
see “Business Scenario” on page 245.
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Before reading further, you should understand the terminology specific to the Siebel 
MedEd application. This chapter includes the following MedEd-specific 
terminology:

■ Event or MedEd event. Refers to a promotional or educational event attended by 
physicians or medical professionals. An event may consist of single or multiple-
sessions and functions as a forum for exchanging information on a particular 
disease, illness, therapeutic class, or product.

■ Session. Refers to a single class or meeting attended by one or more participants 
as part of a particular MedEd event.

■ MedEd Team. Refers to a group of people from various departments or sales teams 
who are primarily responsible for the planning, execution, and funding of a 
MedEd event.

■ Plan. Refers to a hierarchical collection of MedEd events focused on delivering a 
specific set of objectives and sharing common funding. For example, the 
objective might be promotion of a new indication, to gain awareness and 
increase market share for a particular product. A plan may display aggregated 
actual cost and attendee information related to every event associated with that 
plan. 

About MedEd Event Types
A MedEd event can be any type or promotional or education event attended by 
physicians or medical professionals. From a corporate perspective, MedEd event 
types include:

■ Sales Representative Level. Executed by a manager or one or many sales 
representatives in the field.

■ Corporate or National Level. A national training or meeting targeted at a specific 
group of medical professionals.

Depending upon the needs of their environment, users can plan events at the 
national level for either a specific product or time period and then allocate resources 
by region, district, or sales representative. 
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Business Scenario
This section outlines an example workflow performed by a Siebel MedEd 
administrator and end users. Your company may follow a different workflow 
according to its business requirements.

A product manager at a pharmaceutical company is responsible for increasing the 
market share of a new product. To accomplish this objective, he uses Siebel MedEd 
to plan various dinners, symposiums, and lunch-and-learn meetings to 
communicate the budgets and objectives. In Siebel MedEd, he creates a MedEd plan 
and then defines how much money each sales representative will be given to drive 
events within the district. In the process of creating sub plans, the product manager 
allocates a budget and assigns the teams who will be responsible for event planning 
and execution.

Sales representatives in the field use Siebel MedEd to see the events and plans to 
which they have been assigned, itemize the tasks they need to accomplish, invite 
various contacts, record expenses, develop the meetings agendas, associate 
speakers, add materials, and manage the overall calendar of events in his or her 
territory. Over time, the product manager can closely monitor whether his team is 
executing on-time and within budget by comparing each event's allocated budget 
with the actual costs.

In this scenario, the product manager is responsible for administrating Siebel 
MedEd so that end users can plan, track, and execute medical events. As the MedEd 
administrator, he requires administrative responsibilities in Siebel MedEd to:

■ Establish funds for a MedEd plan

■ Create MedEd activity templates

■ Add MedEd literature items to the application

■ Designate a contact as a MedEd speaker

The end users are the sales representatives and managers who execute MedEd 
events in the field. They enter information to:

■ Set up a MedEd plan

■ Set up MedEd events
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■ Track the MedEd event costs

■ Set up sessions within an a MedEd event to track speakers and associate 
literature and materials with the event

■ Designate a contact as a MedEd speaker

■ Invite and register MedEd event attendees
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Example Workflow for Managing MedEd Events
This section details sample tasks often performed by administrators and end-users 
when managing MedEd events. Your company may follow a different workflow 
according to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to manage MedEd 
events. The administrator may be the product manager who is responsible for using 
Siebel MedEd to plan a variety of events that feature the new product. These tasks 
are typically performed in the following order:

1 Establish funds for a MedEd plan. For more information, see “Establishing Funds 
for MedEd Plans” on page 249.

2 Create a MedEd master plan. For more information, see “Creating Master MedEd 
Plans” on page 252.

3 Create a MedEd activity template. For more information, see “Creating a MedEd 
Activity Template” on page 253.

4 Add literature items to the application. For more information, see “Administering 
MedEd Literature” on page 255.

5 Designate contacts as MedEd speakers. For more information, see “Designating 
MedEd Event Speakers” on page 256.

End-User Procedures
The following list shows tasks end users typically perform when managing MedEd 
events. These tasks are typically performed in the following order:

1 Set up a MedEd plan. For more information, see “Setting Up a MedEd Plan” on 
page 258.

2 Set up MedEd events. For more information, see “Setting Up MedEd Events” on 
page 260.

3 Track MedEd event costs. For more information, see “Tracking Costs of MedEd 
Activities” on page 264.
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4 Set up event sessions to track speakers and associate literature with an event. For 
more information, see “Setting Up Sessions Within a MedEd Event” on 
page 267.

5 Invite and register event attendees. For more information, see “Inviting and 
Registering Prospective MedEd Attendees” on page 270.

6 Send correspondence to invitees. For more information, see “Generating 
Correspondence for MedEd Event Invitees” on page 272.

7 Schedule calls to invitees. Scheduled calls to event invitees appear in the 
Calendar. For more information, see “Scheduling Calls to an Invitee” on 
page 272.
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The following administrator procedures are described in this section:

■ To verify that a fund is available for association with a MedEd plan on page 251

■ To create a MedEd master plan on page 252

■ To create an activity template for a MedEd event on page 253

■ To add a literature item to the application on page 256

■ To designate a contact as a MedEd speaker on page 256

Establishing Funds for MedEd Plans
A MedEd plan is a database record in which you specify common funding for a 
group of MedEd events that share a common objective. Each MedEd event can be 
funded by up to one MedEd plan for each event team member who is responsible 
for each event. Using the MedEd Activities view, you can track costs associated with 
each event. Because these events are automatically aggregated by plan, you can 
compare actual expenditures with MedEd plans across sales divisions.
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Figure 7 shows the possible relationships between MedEd funds, master plans, 
subplans, events, sessions, activities, and invitees.

Figure 7. Relationships Between Funds, Plans, Events, Sessions, Activities, and Invitees
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To establish a fund and associate it with a MedEd plan, you must:

■ Define an active period for the fund. Define an active period that can be assigned 
to a fund. For more information on defining periods, see Applications 
Administration Guide.

■ Establish the fund. Establish the fund by loading fund information into the 
database using Siebel Enterprise Integration Manager (EIM). To perform this 
task, you must consult the Interface Tables Reference to determine which 
columns are included in the database table EIM_MDF and how those columns 
map to the columns in the base table S_MDF. Then, use a standard SQL utility 
to place information about the fund you are establishing in the EIM_MDF table.

NOTE: If you want the fund to be active immediately, make sure that the current 
date falls between the start date and end date that you specify for the fund.

For more information on using EIM, see Siebel Enterprise Integration Manager 
Administration Guide.

■ Verify fund availability. Verify that the fund has been successfully established and 
is available for association with a MedEd plan. For more information, see the 
procedure “To verify that a fund is available for association with a MedEd plan” 
on page 251.

To verify that a fund is available for association with a MedEd plan

1 From the application-level menu, choose View > Site Map > Data 
Administration > MedEd Planning.

2 In the Plans list, select a plan.

3 In the Plan Administration form, click the select button in the Funds field.

4 In the Funds dialog box, click New.

All active funds listed in the S_MDF table appear.

5 Verify the fund you want is available and then click Cancel.
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Creating Master MedEd Plans
Administrators and managers create master MedEd plans to allocate funding 
resources and spending privileges to end users who perform tasks associated with 
a MedEd event. Each person who receives a funding allocation from a specific 
MedEd plan can create one or more subplans to further specify how the funds will 
be allocated. For more information on creating MedEd plans and subplans, see 
“Setting Up a MedEd Plan” on page 258.

To create a MedEd master plan

1 From the application-level menu, choose View > Site Map > Data 
Administration > MedEd Planning.

2 In the Plan Administration form, add a record and complete the necessary fields. 

Some of the fields in a Plan Administration record are described in the following 
table.

Field Comments

Assigned To Person responsible for carrying out the plan. Defaults to the 
current user name.

Budget Amount of money authorized for spending under the plan.

Funds One or more funds (cost centers) associated with the plan.

Objective One or more purposes to be accomplished by holding MedEd 
events associated with the plan.

Period Time period during which the plan is to be used.

Plan ID An unique alphanumerical value identifying the plan. The 
application automatically assigns this value when you create the 
plan record.

Plan Name Name for a plan that you want others to associate with MedEd 
events. 

Products Products to be promoted with the funds supplied under this plan.

Status Indicates whether the plan is currently active or inactive.
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Creating a MedEd Activity Template
Activity templates let you provide your MedEd event team with a list of standard 
activities required to successfully complete a particular type of event. Each activity 
plan for an individual event depends upon an activity template. Activity plans assist 
you in scheduling and assigning activities.

To create an activity template for a MedEd event

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Templates list, add a record and complete the necessary fields. 

Some of the fields in an Activity Templates record are described in the following 
table.

NOTE: Leave the Sales Stage, Sales Method, and Protocol Title fields blank. These 
fields do not apply to MedEd activities.

Associate individual activities with the template, as described in Applications 
Administration Guide.

NOTE: Lead times for MedEd activities are defined as the amount of time between 
the start date for an activity plan and the date that the selected activity should start.

Field Comments

Description Description of this activity template.

Name The name of this activity template.

Type The activity template type. 
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MedEd Lists of Values
As you work with various MedEd records, you will find a number of fields that 
require you choose values from drop-down lists. Table 13 lists the locations, field 
names, and values types of some MedEd drop-down lists. 

Table 13. Lists of Values for MedEd Settings

Views Field Name List of Values Type Comments

MedEd Events > More Info 
view tab

Accreditation LS_ME_EVT_ACCREDT_CD Organizations that give 
Continued Medical 
Education (CME) credits for 
attending MedEd events.

Dress Code LS_ME_EVT_DRESS_CD Appropriate types of dress for 
MedEd events.

Status LS_ME_EVT_STAT_CD Status of MedEd events.

Note: When the status is 
Completed, the event and its 
children records—such as 
Invitees, Sessions, Material, 
Activities, and Activity 
Plan—are locked. The status 
can only be unlocked by the 
administrator using the Data 
Administration screen > 
MedEd Event Details.

Type LS_ME_EVT_TYPE_CD Types of MedEd events.

MedEd Events > Invitees 
view tab

Role LS_ME_INV_ROLE_CD Roles that invited contacts or 
employees may fill for 
MedEd events.

MedEd Events > Event 
Details view tab

MedEd Events > Invitees 
view tab

Invitee 
Status

LS_ME_INV_STAT_CD Status of invitees for MedEd 
events.

When the status is 
Completed, the event and its 
children records—such as 
Invitees, Sessions, Material, 
Activities, and Activity 
Plan—are locked.
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If you need to add a value to a list of values, follow the procedures on modifying a 
list of values in Applications Administration Guide.

Administering MedEd Literature
You can associate a literature item with one or more MedEd sessions when it meets 
two conditions:

■ The literature item is stored in the Siebel Life Sciences repository

■ The Literature Type of the item is set to Sales Tool

For information about how to associate the literature item with a MedEd session, 
see “To specify literature for a MedEd session” on page 269.

MedEd Events > Invitees 
view tab > Sessions

MedEd Events > Sessions 
view tab

Registration 
Status

Status

LS_ME_SES_REG_STAT_CD Status of invitees for 
individual sessions within 
MedEd events.

MedEd Events > Sessions 
view tab > Drill down on 
Session Name > Contacts list 

Email LS_ME_REG_EMAIL_CD Status of email registration 
for an attendee.

MedEd Events > Event 
Details > Materials list

Item LS_ME_SES_MAT_CD Materials or equipment that 
may be needed for MedEd 
sessions.

MedEd Events > Sessions 
view tab > Sessions list

Status LS_ME_SES_STAT_CD Status of individual sessions 
within MedEd events.

MedEd Plans > More Info 
view tab

MedEd Plans > Plan Explorer 
view tab

Plan Status LS_ME_STAT_CODE Status of a MedEd funding 
plan.

Table 13. Lists of Values for MedEd Settings

Views Field Name List of Values Type Comments
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To add a literature item to the application

1 From the application-level menu, choose View > Site Map > Document 
Administration > Literature.

2 In the Literature list, add a record and complete the necessary fields.

3 In the File Name field, click the select button.

4 In the Add Attachment dialog box, click Browse.

5 Navigate to the document you want to attach, click Open and then Add.

6 In the Literature Type field, select Sales Tool. 

For more information about adding literature, see Applications Administration 
Guide.

Designating MedEd Event Speakers
Both administrators and end users may designate a contact as a speaker. In order to 
associate a speaker with a MedEd session, you must include the speaker as a 
Contact in the S_CONTACT table and select the Speaker flag.

For more information on working with contacts, see Chapter 3, “Managing 
Contacts.”

To designate a contact as a MedEd speaker

1 From the application-level menu, choose View > Site Map > Contacts screen.

2 From the Show drop-down list, select All Contacts.

NOTE: Depending on your responsibilities, you may also be able to use the My 
Contacts, My Team’s Contacts, or the All Contacts Across Organizations filters.

3 In the Contacts list, select the contact you want to designate as a speaker.

NOTE: When selecting the contact, do not click a hyperlink (underlined field). 
Doing so will take you to another view.
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4 In the More Info form, click the show more button in the upper-right corner.

The More Info form expands and displays available fields.

5 Select the Speaker field.

The application lists the contact as a possible speaker for MedEd sessions.
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The following end-user procedures are described in this section:

■ To create a MedEd plan

■ To create a subplan on page 259

■ To create a MedEd event on page 261

■ To specify which MedEd plan to charge for event costs on page 263

■ To create an activity plan for a MedEd event on page 264

■ To record the cost of an activity on page 266

■ To view aggregated activity costs for a MedEd plan on page 266

■ To create a session for a MedEd event on page 267

■ To specify literature for a MedEd session on page 269

■ To specify materials for a MedEd session on page 270

■ To invite a contact or an employee to a MedEd event on page 270

■ To register an invitee for a MedEd session on page 271

■ To generate correspondence to multiple invitees on page 272

■ To automatically schedule a call to an invitee on page 272

Setting Up a MedEd Plan
A MedEd plan is a database record that lets end users specify common funding for 
a group of medical education events that have a common objective. A subplan 
allocates a specific amount of the parent plan’s funding to a given user in order to 
help accomplish the parent plan’s objectives. 

End users can compare aggregated actual costs of event activities with the MedEd 
plan budget at any time. For information on tracking costs, see “Tracking Costs of 
MedEd Activities” on page 264. 

To create a MedEd plan

1 Navigate to the MedEd screen.
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2 From the Show drop-down list, select My MedEd Plans.

3 In the Plans list, add a record and complete the necessary fields. 

Some of the fields in a Plans record are described in the following table.

4 In the More Info form, enter any additional details. 

The application automatically creates an unique alphanumeric value for the 
Plan ID. 

Specify the details of the new MedEd Plan by creating subplans as described in the 
next procedure.

To create a subplan

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Plans.

3 In the Plans list, drill down on the Name of the plan for which you want to 
specify a subplan.

The Plans form appears.

Field Comments

Assigned To Person responsible for carrying out the plan.

Budget Amount of money that the plan authorizes the responsible person 
to spend.

Parent Plan Name Blank for master plans. For subplans, the application 
automatically provides the name of the associated parent plan. 

Periods Time period during which the plan is to be used. Administrators 
use the Marketing Administration screen to define periods.

Plan Name The name of the MedEd plan for which team members can 
associate event costs with a given fund. 

Products Products to be promoted with the funds supplied under this plan.

Status Status of the plan. Defaults to Active.
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4 In the Sub-Plans list, add a record and complete the necessary fields. 

Some of the fields in a Sub-Plans record are described in the following table.

The application automatically populates the subplan Plan Status and Assigned 
To fields.

5 Scroll down to the Events list. 

In this view, the Events list is read-only.

When you create an event, you associate the event with a funding plan by 
assigning fractions of the event cost to specific end users. Once an event has 
been associated with an end user, that user designates which MedEd plan will 
be charged for his or her share of the total event costs. For more information, 
see the next section, “Setting Up MedEd Events” on page 260.

Setting Up MedEd Events
A MedEd event is a database record that describes an educational event attended 
by physicians or medical professionals. An event may consist of single or multiple-
sessions and functions as a forum for exchanging information on a particular 
disease, illness, therapeutic class, or product.

Field Comments

Assigned To Person responsible for carrying out the subplan.

Budget Amount of money that the subplan authorizes the responsible 
person to spend. If you wish to keep some funding in reserve, do 
not allocate the entire amount of the parent plan to the subplans.

Name Name of the subplan.

Objective One or more purposes to be accomplished by holding the MedEd 
events associated with the subplan.

Period Time period during which the subplan is to be used. For more 
information on defining periods, see Applications Administration 
Guide.

Products Products to be promoted with the funds supplied under this 
subplan.

Status Status of the subplan. Defaults to Active.
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The cost of a MedEd event can be allocated across multiple products and across 
team members. Users who have purchased and installed the optional ePharma 
Analytics product use these cost allocations as input when creating return on 
investment (ROI) analysis reports. 

NOTE: Users who have purchased and installed the optional eMedEd module, can 
also display MedEd event information to selected professionals on their Physician 
Portal Web site. For more information, see Siebel Life Sciences Portals Guide.

To create a MedEd event

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the More Info form, add a record and complete the necessary fields. 

Some of the fields in a My MedEd Events record are described in the following 
table.

Field Comments

Accreditation The organization that will be giving Continued Medical Education 
(CME) credits for attending the event.

Budget The amount of money budgeted for the event. 

CME Credit Number of CME (Continued Medical Education) credits that can 
be earned at the event. For eMedEd, this field appears on the 
Physician Portal Web site.

Confirm Date Date on which MedEd team members should send any 
confirmation reminder messages to registered invitees.

Confirmation Indicates whether MedEd team members should send messages 
to registered invitees prior to the event reminding them to attend 
and asking them to reconfirm their attendance.

Created By User name for the person who created the MedEd event.

End Date and time that the event ends. Set the time fields before 
clicking a calendar day. For eMedEd, this field appears on the 
Physician Portal Web site.

Fee Required Indicates whether the event requires an attendance fee.
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4 In the MedEd Team field, click the select button, and in the Event Team dialog 
box that appears, click New.

All available team members appear in the Event Team dialog box.

Location City and address or venue where the event is to take place. For 
eMedEd, this field appears on the Physician Portal Web site.

MedEd ID The application automatically creates this alphanumeric value 
when you create the event. 

MedEd Team A group of employees who will be responsible for planning, 
managing, and carrying out the MedEd event. Event costs may be 
allocated across team members as well as across product lines. 
For more information, see Step 4 on page 262.

Name The name of the event. If you are using MedEd with eMedEd, this 
field appears to selected contacts on your Physician Portal Web 
site.

Objective The overall goal for the people attending the event. For eMedEd, 
this field appears on the Physician Portal Web site.

Products One or more products targeted for discussion at the event.Event 
costs may be allocated across products. For more information, see 
Step 5 on page 263.

Registration Fee The amount of any fee required for attending the event. 

Start Date and time that the event starts. Set the time fields before 
clicking a calendar day. For eMedEd, this field appears on the 
Physician Portal Web site.

Status Indicates whether the event is active, cancelled, completed, in 
progress, inactive, or planned. For eMedEd, this field appears on 
the Physician Portal Web site.

Note: When the status is Completed, the event and its children 
records—such as Invitees, Sessions, Material, Activities, and 
Activity Plan—are locked. If the event status needs to be changed, 
the administrator can make changes in Data Administration > 
MedEd Event Details.

Type The category of medical education event being offered. For 
eMedEd, this field appears on the Physician Portal Web site.

Field Comments
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a Select the team members who will be responsible for managing and carrying 
out tasks associated with the event, and then click OK. 

b In the Primary column, click the row adjacent to the team member who will 
be primarily responsible for the event.

c In the Cost Allocation field for each team member, enter the percentage of 
the event costs that will be charged to that team member.

For example, if an event team consists of three employees, one employee 
might be allocated 40% of the cost and the remaining two employees might 
be allocated 30% of the cost. 

NOTE: The total of the values you enter for Cost Allocation across team 
members should equal 100%. 

d Select your own record, specify a plan, and click Close.

Each MedEd Team member should log into Siebel Life Sciences and specify 
which MedEd plan will be charged for their portion of the event’s costs.

5 In the Product field, click the select button, and in the Products dialog box that 
appears, click New.

a Select the one or more products that will be discussed at the event.

b In the Cost Allocation field for each product, enter the percentage of the event 
costs that will be charged to each product.

NOTE: The total of the values you enter for Cost Allocation across products 
should equal 100%. 

To specify which MedEd plan to charge for event costs

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select All MedEd Events or My MedEd Events.

3 In the MedEd Events list, select the event for which plans are being specified.

4 In the MedEd Team field, click the select button.
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5 Select your record, specify a plan, and click Close.

Tracking Costs of MedEd Activities
In order to compare MedEd costs with the amount of funds budgeted in MedEd 
plans, event team members must:

■ List task activities associated with MedEd events

■ Enter the costs incurred for each activity

Siebel MedEd aggregates the line item activity costs against the MedEd plans 
specified by team members. For increased efficiency in planning event activities, 
users can create a MedEd activity template for each type of MedEd event that they 
commonly host. 

An activity template allows common recurring tasks to be associated with a given 
event without having to enter each task manually. Such tasks might include renting 
a venue, hiring a caterer, obtaining equipment, printing literature, and arranging for 
other materials to be available for the event. For more information on creating 
activity templates, see “Creating a MedEd Activity Template” on page 253. 

The following procedure describes how to create an activity plan for an individual 
MedEd event, where the plan contains a combination of tasks derived from an 
activity template and tasks that are specific to the given event.

To create an activity plan for a MedEd event

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Activity Plans view tab.
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5 In the Activity Plans list, add a record and complete the necessary fields. 

Some of the fields in an Activity Plans record are described in the following 
table.

6 If this event involves activities that are not included in the selected activity plan 
template, click the Activities subview tab.

7 In the Activities list, add a record and complete the necessary fields. 

Many activity fields are not applicable to MedEd events and can be left blank.

Some of the fields in an Activities record are described in the following table.

Field Comments

Description Enter a description for this activity plan.

Lock Assignment Determine whether the Assigned To field should be locked. If 
the activity is locked, Assignment Manager does not access it. 
If it is unlocked, Assignment Manager can reassign it.

Planned Start Refers to the date that planning and preparation for an event 
starts, rather than the date that the MedEd event starts. 

Changing the value of Planned Start in an activity plan 
automatically changes the value of all Due dates for activities 
that are a part of that plan. In contrast, changing the value of 
an individual activity’s Due date does not affect the values of 
Due dates for other activities or the Planned Start date for the 
activity plan.

Template Select an activity template from the drop-down list. Individual 
activities from the selected template appear in the Activities list. 
For more information on creating activity templates, see 
Applications Administration Guide.

Field Comments

Description Enter a description for this activity.

Employees User name of the person who is to perform the activity. Leave this 
field blank for the activity to be assigned to the active user.
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8 Repeat Step 7 until all activities have been specified.

To record the cost of an activity

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, drill down on the Name hyperlink for the event for 
which you want to record the cost.

4 Click the Activities view tab.

5 In the Activities list, select the activity for which you want to supply cost 
information, and then scroll to the right until the Cost field appears.

6 Enter the cost of the activity in the Cost field.

To view aggregated activity costs for a MedEd plan

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Plans.

3 Drill down on the Name hyperlink for the plan for which you want to view 
aggregated costs.

4 In the Plans form, click Actual Cost in the upper-right corner.

The Actual Cost and Remaining Budget fields are updated in the form.

About Designating MedEd Event Speakers
Both administrators and end users may designate a contact as a speaker. In order to 
associate a speaker with a MedEd session, users must include the speaker as a 
Contact in the S_CONTACT table and select the Speaker flag. For more information, 
see “Designating MedEd Event Speakers” on page 256.

You can review a list of all designated speakers.

To review all available speakers

1 Navigate to the MedEd screen.
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2 From the Show drop-down list, select All Speakers.

The Speakers list shows all contacts that have been designated as speakers. This 
is a read-only list.

3 In the More Info form, click the show more button to see more details about the 
speakers.

Setting Up Sessions Within a MedEd Event
A MedEd event can be a single presentation, such as a lunch-and-learn where 
participants listen to a single speaker, or it can be composed of multiple individual 
sessions covering different subject areas. A session consists of a single class or 
meeting attended by one or more participants of a MedEd event. Because certain 
types of information are only associated with sessions, users must create at least 
one session for an event if they want to:

■ Track speaker participation

■ Associate one or more literature items with the event

■ Associate materials or equipment items with the event

■ Register participants for the event using their Physician Portal Web site and 
eMedEd software

MedEd is designed to allow participants to register for individual sessions, whether 
at one-session or at multiple session events.

NOTE: MedEd event participants can use the optional eMedEd module to register for 
MedEd sessions at your Physician Portal Web site. However, participants can only 
register at the session level. For reasons of configuration flexibility, event-level 
registration must be entered manually in the Invitee Status field of the Invitee view 
tab.

The following procedure describes how to create a session for a MedEd event. 
Repeat this procedure for each required session.

To create a session for a MedEd event

1 Navigate to the MedEd screen.
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2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Sessions view tab.

5 In the Sessions list, add a record and complete the necessary fields.

Some of the fields in a Sessions record are described in the following table.

Field Comments

CME Credit Number of Continued Medical Education Credits (CME) that can 
be earned by attending the session. This field is not typically 
displayed on the Physician Portal Web site, but can be configured 
to do so as an implementation detail.

End Date Defaults to end date and time for the event that includes the 
session. However, for multiple session events, each session’s end 
date and time can differ from the end date and time of the event. 
Typically, the time is the most important part of this setting. For 
eMedEd, this field appears on the Physician Portal Web site.

Location Describes where the session will be held. Typically used to 
indicate a room name or number within a hotel, conference center, 
or other venue.

Max Attendees Indicates the maximum number of attendees for the session.

Products One or more products targeted for discussion during the session.

Session Name Name of the session within a multiple-session event. For single-
session events, simply repeat the event name. For eMedEd, this 
field appears on the Physician Portal Web site.

Session Objective Overall goal for the participants attending the session. For 
eMedEd, this field appears on the Physician Portal Web site, but 
the field name is changed from Objective to Description.

Speaker First 
Name

The application automatically supplies this value if a Speaker Last 
Name is selected. For eMedEd, the value of this field combined 
with the value of the Speaker First Name and appears on the 
Physician Portal Web site.

Speaker Last 
Name

Select the last name of the person giving a presentation during the 
session. For more information on managing contacts, see “Adding 
a Contact” on page 58.

For eMedEd, the value of this field combined with the value of the 
Speaker First Name and appears on the Physician Portal Web site.
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To provide literature to event attendees, end users can associate literature with each 
session of an event. The MedEd administrator can also create an item in an activity 
template directing an event team member to make sure that there is adequate stock 
of the required literature items available. For more information about adding a 
literature item to the database, see “Administering MedEd Literature” on page 255. 

To specify literature for a MedEd session

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Sessions view tab.

5 Drill down on the Session Name hyperlink for the session for which you want 
to specify literature.

6 Scroll down to the Literature list, and add a record. 

The Add Literature dialog box appears.

7 In the Add Literature dialog box, select one or more literature listings, and then 
click OK.

The selected literature items appear in the Literature list. 

Start Date Defaults to start date and time for the event that includes the 
session. However, for multiple-session events, each session’s end 
date and time can differ from the end date and time of the event. 
Typically, the time is the most important part of this setting. For 
eMedEd, this field appears on the Physician Portal Web site.

Status Indicates whether the session is active, canceled, completed, in 
progress, or inactive. For eMedEd, this field appears on the 
Physician Portal Web site.

Note: When the status is Completed, the event and its children 
records—such as Invitees, Sessions, Material, Activities, and 
Activity Plan—are locked.

Field Comments
Version 7.5, Rev. A Siebel Life Sciences Guide 269



Managing MedEd Events

End-User Procedures
In addition to literature, each session can require certain equipment and other 
materials, such as flip charts, markers, projectors, and screens. You may wish to 
create an item in an activity template directing an event team member to make sure 
that the required materials will be available.

To specify materials for a MedEd session

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Sessions view tab.

5 Drill down on the Session Name hyperlink for the session for which you want 
to specify materials.

6 Scroll down to the Materials list and add a record, completing the necessary 
fields. 

The new items appear in the Materials list. 

For more information about adding a materials item to the drop-down list of 
available items, see “MedEd Lists of Values” on page 254. Drop-down values are 
normally added and maintained by an administrator. 

Inviting and Registering Prospective MedEd Attendees
After an end user has scheduled a MedEd event and decided what sessions will be 
offered, the next step is to invite participants.

End users who have purchased and set up the optional eMedEd module can also 
use this procedure to let each invited contact view information about an event on 
their Physician Portal Web site. For those users who are not using eMedEd, the 
Invitee information indicates that the call center agents or sales representatives 
need to convey the invitation to the invitee.

To invite a contact or an employee to a MedEd event

1 Navigate to the MedEd screen.

2 In the MedEd Events list, select an event.
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3 Click the Invitees view tab.

4 In the Invitees list, add a record.

5 In the Invitees dialog box, select individuals to be invited to the MedEd event, 
and click OK.

NOTE: The Pick Invitees dialog box displays those employees and contacts that 
are on the same team as the user.

6 In the Role field of the Invitees list, select the value that best describes each 
individual’s role at the session.

7 In the Comments field, enter any additional information.

As soon as you leave the current record, information about the selected session 
becomes available to the designated invitee at the Physician Portal Web site.

NOTE: When the event status is Completed, the event and its children records—
such as Invitees, Sessions, Material, Activities, and Activity Plan—are locked 
and become read-only lists.

The following procedure describes how to register a contact or employee for a 
MedEd session by using the dedicated client software. This procedure can be used 
whether or not you are using the optional eMedEd module for the Physician Portal 
Web site.

To register an invitee for a MedEd session

1 Invite the contact or employee to the MedEd event as described in “To invite a 
contact or an employee to a MedEd event” on page 270.

2 In the Invitees list, select the invitee to be registered by clicking any field except 
Last Name.

3 Scroll down to the Sessions list and add a record. 

4 In the Sessions field, click the select button.

5 In the Pick Session dialog box that appears, select the sessions the invitee will 
be attending and click OK.

6 In the Registration Status field, change the status to Confirmed.
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Repeat Step 3 through Step 6 for each additional session the invitee will attend.

Generating Correspondence for MedEd Event Invitees
End users can send electronic correspondence, such as an agenda, brochures, or a 
list of hotels, to all event invitees.

To generate correspondence to multiple invitees

1 Navigate to the MedEd Screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Invitees view tab.

5 Perform one of the following:

■ Query for the invitees to whom you wish to send correspondence.

■ From the application-level menu, select Edit > Select All to select all the 
people invited to the MedEd event.

6 From the application-level menu, select File > New > Correspondence.

The Correspondence Recipients list shows all the invitees you selected in Step 5.

7 In the Correspondence List, select a correspondence template and complete the 
necessary fields.

Scheduling Calls to an Invitee
End users can schedule calls to invitees. These calls appear in the Contacts screen.

To automatically schedule a call to an invitee

1 Navigate to the MedEd screen.

2 From the Show drop-down list, select My MedEd Events.

3 In the MedEd Events list, select an event.

4 Click the Invitees view tab.
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5 Query for the invitees with whom you wish to schedule a call.

6 Click the Schedule button.

The Auto Schedule dialog box appears.

7 In the Auto Schedule dialog box, review the displayed values, make any needed 
changes, and click OK.

The auto-scheduling function does not check for scheduling conflicts. Therefore, 
users need to verify that automatically scheduled calls do not conflict with other 
activities in their calendar.
Version 7.5, Rev. A Siebel Life Sciences Guide 273



Managing MedEd Events

End-User Procedures
274 Siebel Life Sciences Guide Version 7.5, Rev. A



Objectives 12
An objective is usually a sales or marketing goal, assigned to a particular individual 
or team and targeted at a particular set of accounts or contacts. It includes one or 
more recommended activities to be performed by sales representatives as they visit 
the target contacts and accounts to which the objective is applied.

Ideally, objectives should be implemented at the beginning of a planning cycle to 
use them effectively.

Objectives can have child objectives associated with them. For example, an overall 
goal of increasing prescriptions of a particular product might have associated sub-
goals of increased calls to certain contacts or accounts and improved education on 
product issues. If necessary, you can enter detailed information about the objective 
in a Summary text.
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Structuring Objectives
Managers typically define objectives for their teams, but individual users can also 
define personal objectives for themselves or create child objectives of larger 
objectives that have been defined for them. If there is general information about the 
objective that all team members need to know, include it in the Summary text. If 
there are electronic versions of documents or graphics that are related to the 
objective, add them as attachments. 

The process of associating accounts and contacts with objectives is an excellent 
candidate for using target lists. After creating target lists of contacts and accounts 
at whom you will direct your sales efforts, you can apply those lists in the Objective 
Targets view.
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This scenario is an example workflow performed by a pharmaceutical district 
manager and sales representatives to create and fulfill sales objectives. Your 
company may follow a different workflow according to its business needs.

Your company, a large pharmaceutical manufacturer, has received approval for a 
new indication for one of your products. The district manager is responsible for 
making sure that the sales representatives reporting to her take the actions 
necessary to have a successful launch of this product for the new indication.

The district manager begins by creating an objective. Next, she adds three 
recommended activities that she wants each member of her sales force to carry out 
in order to meet this objective: to attend a training program, to attend a team 
meeting to outline tactical aspects of promoting the new indication, and to conduct 
contact calls. In order to communicate the importance of these activities to her sales 
force, she assigns the priority “1-ASAP” to all three recommended activities. She 
also adds a product insert to the objective as a literature item. Her sales 
representatives can use this product insert to gain valuable information about the 
new indication prior to visiting contacts. Finally, she adds every targeted contact in 
each territory to the objective, adds each sales representative as an objective team 
member.

As the sales representatives check their calendars, they will see that the district 
manager has scheduled a series of calls for them to complete. As they prepare for 
each of these calls, they can review the objective and the recommended activities 
she has created and the product insert she added. Later, as the new indication 
launch is in progress and the sales representatives are performing sample drops, the 
district manager or sales representatives can review the objective and note whether 
its related recommended activities have been completed.
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See Figure 8 for an objectives workflow diagram.

Figure 8. Objectives Workflow
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These tasks are typically performed by District Managers or Marketing 
Administrators, although some companies choose to allow sales representative to 
create their own objectives. To create an objective and use it to schedule calls, 
complete the procedures described in the following sections.

NOTE: As in all Siebel products, the availability of certain views and functionality can 
be limited according to each user’s responsibilities; therefore, the views mentioned 
here may vary from those on your screen. Generally, an administrator has 
responsibility for updating user privileges.

Table 14 describes the functions of the various views in the Objectives screen. Your 
responsibilities determine which views are available to you. 

 

Table 14. Views Available from the Objectives Screen

View Functions

My Objectives Allows you to view objectives assigned to you and add new ones. 

My Team’s Objectives Allows managers to view objectives assigned to their teams and 
add new ones. A manager’s own objectives also appear in this 
view. 

Targets Allows you to specify and view accounts and contacts targeted 
for an objective. Also allows you to track progress toward your 
defined goals.

Target Accounts Displays target accounts and the contacts for them, and can 
display actual results charted against a quantified goal (same 
view as Charts).

Contact Status Displays a list of contacts and the recommended activities for 
each contact, with actual amount.

Attachments Allows you to add and display electronic file attachments for an 
objective.

Charts Displays actual results charted against a quantified goal. A 
variety of chart formats can be selected. The values used to 
measure progress must be loaded using Enterprise Integration 
Manager (EIM). Generally, the Siebel administrator performs this 
task. 
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Creating an Objective
You must complete this task before performing the remaining tasks in this chapter. 
If you need an objective to recur, see “Creating Recurring Objectives” on page 281.

To create an objective

1 From the application-level menu, choose View > Site Map > Objectives screen.

2 In the Objectives list, add a record, and complete the necessary fields.

Some of the fields in an Objectives record are described in the following table.

Field Comments

Objective Required.

Parent Objective If this objective is a subgoal of another objective, select the 
parent objective.

The parent objective defines some of the criteria for all of its 
child objectives. for instance, child objectives are constrained to 
the products associated with the parent objective, if any.

You can create parent objectives without completing the Parent 
Objective field. You must complete the Parent Objective field 
when creating child objectives.

Parent-child relationships between objectives can be viewed in 
the Objectives Explorer view. Note that child objectives are not 
constrained by the organization or team definitions of the parent 
objectives.

Type The type of objective being created; for example, a promotion or 
a marketing type of objective. Selecting the type of objective 
does not drive any other functionality within the product.

Description A few words which describe the purpose of the objective.

Period The period of time during which an objective must be 
completed.

End Date The ending date of an objective. It must fall within the 
objective’s time period.

Organization The organization will constrain the target accounts that will be 
available to associate with the objective.
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Creating Recurring Objectives
At some time you may wish to create recurring objectives. You can:

■ Change the period of an existing objective

■ Copy an existing objective and apply a new period to it

■ Use Workflow to schedule monthly calls. For more information, please see Siebel 
Business Process Designer Administration Guide.

NOTE: Deleting an objective completely removes the objective from the system. If 
you are unsure about whether the objective is still active (and therefore should not 
be deleted), you can remove yourself from the objective’s team instead of deleting 
the record.

Adding Recommended Activities to an Objective
You can add one or more recommended activities to an objective. Recommended 
activities:

■ Are associated with every target account added to the objective 

■ Are not assigned to individuals, since they will be used when planning calls to 
all of the targeted accounts

■ Can optionally be associated with individual products, if certain activities apply 
to specific products

Team Multiple people can be assigned to the objective’s team.

Actual This data must be imported by the Siebel administrator using 
EIM. You cannot manually edit this field.

Last Actual Update This date must be added by the Siebel administrator using Siebel 
EIM, after the Actual data has been updated. You cannot 
manually edit this field.

Field Comments
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To add recommended activities to an objective

1 From the application-level menu, choose View > Site Map > Objectives screen.

2 In the Objectives list, select the objective to which you want to add an activity.

3 Click the Contact Status view tab, add a record to the Activities list, and 
complete the necessary fields. 

Some of the fields in an Activities record are described in the following table.

NOTE: Recommended activities can only be performed on products that have been 
added to an objective.

Fields Comments

Type The type of activity to be performed; for example, an assessment 
or presentation.

Assessment Template The name of the assessment template assigned to the 
recommended activity. If the recommended activity requires an 
assessment to be carried out, the relevant assessment template can
be associated with the recommended activity. For information on 
assessment templates, see Applications Administration Guide.

Planned Completion The suggested date the recommended activity ends; the default is
the objective period end date. If you choose to edit it, the date 
must come after the planned start date for the recommended 
activity, and must fall within the period assigned to the parent 
objective.

Planned Start The suggested date the recommended activity begins; the default 
is the objective period start date. If you choose to edit it, the date 
must fall within the period assigned to the parent objective.

Products Each activity can have one or more products associated with it. 
The choice of products is restricted to products that are already 
associated with the objective. To add products to an objective, see
“Creating an Objective” on page 280.
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Targeting Accounts to an Objective
You can apply objectives to one or more target accounts. The target accounts that 
will be available are those that belong to the organization of which the user is an 
account team member. 

In the Objective Targets view, add and view accounts and contacts targeted for an 
objective. You can display charts of progress toward a quantified goal for target 
accounts or target contacts. A variety of chart formats can be selected from the drop-
down menu at the right of the toggle button in the chart view. 

NOTE: For information on creating and applying target lists, see Appendix A, 
“Information for Siebel Application Developers.”

To specify target accounts or contacts for an objective

1 From the application-level menu, choose View > Site Map > Objectives screen.

2 Select the appropriate objective in the Objectives list, and click the Targets view 
tab. 

3 Select either the Target Accounts list or the Target Contacts list and click New. 

4 Select the appropriate accounts or contacts.

You can select multiple records in the Add Accounts and Add contacts dialog 
boxes. You can also apply target lists in these dialog boxes, as described in “To 
apply one or more target lists” on page 86.

5 Click Add. 

The accounts or contacts you selected are added to the list. 

NOTE: Data for the Actual Amount fields in the Target Accounts and Target Contacts 
lists must be imported by the Siebel administrator. You cannot manually edit these 
fields. For more information, see Chapter 19, “Importing Data.”
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Adding Attachments to an Objective
An attachment can be any file containing information relevant to the objective. You 
can use the Objective Attachments view to add, delete, and view attachments 
associated with an objective. You can add supporting literature, such as marketing 
and sales documents, to an objective. Any member of the team assigned to the 
objective can add or delete attachments.

To add an attachment to an objective

1 From the application-level menu, choose View > Site Map > Objectives screen.

2 Select the appropriate objective in the Objectives list and click the Attachments 
view tab. 

3 Click New. 

4 In the Name field, specify the filename or URL.

5 Check the Auto Update flag if you want to have the file automatically updated 
during synchronization.

This applies only to local files. If a file is not local, it cannot be updated during 
synchronization.

6 Click Save.

NOTE: In order for users to view a literature item, they need to have software 
capable of opening the literature item file installed on their computers. For 
example, they must have Adobe Acrobat Reader in order to view a .pdf file.
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Changing the Dates for Objectives
During the planning stages for an objective, you can change its start date and end 
date. Date changes that you make to an objective can be applied to its 
recommended activities by changing the dates for each activity manually. 

To change the dates for an objective

1 From the application-level menu, choose View > Site Map > Objectives screen.

2 Select the Objective for which you want to change the start date or end date.

3 Select a new start date or end date for the objective by using one of the following 
methods.

■ Click the down arrow in the Start Date or End Date field and select a new 
start date or end date for the objective.

■ Click the down arrow in the Period field and select a new time period for the 
objective. The start date and end date are automatically set to the first and 
last dates in the period.

The Start and End Dates must fall within the date period of the parent objective.

Loading Actual Amount Fields Using EIM
You must load data into the Actual Amounts fields of Target Accounts and Target 
Contacts using Siebel Enterprise Integration Manager (EIM). Once loaded, this data 
becomes read-only. Refer to Siebel Enterprise Integration Manager Administration 
Guide.
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Sales representatives will use the Objectives screen to create and review objectives, 
recommended activities, target accounts, and literature that apply to the contacts 
and accounts they call on.

For more information on creating an objective, see “To create an objective” on 
page 280.

Reviewing Objectives
When end users navigate to the Objectives screen, the default filter used on the 
Objectives list is My Objectives. The availability of the other view, My Team’s 
Objectives, can be limited by the user’s responsibilities.

The remaining view tabs and fields visible to the end users in the Objectives screen 
are identical to those available to the administrator.

To review objectives

1 Navigate to the Objectives screen or to Objectives > Explorer view.

2 The default filter used on the Objectives view, and the additional filters 
available, depends on the end user’s responsibilities. The filters available from 
the Show drop-down list are:

■ All Objectives Across Organization

■ All Objectives

■ My Objectives

■ My Team’s Objectives

3 From the Show drop-down list, select the appropriate filter:

■ My Objectives: Objectives for which the user is assigned to the team

■ My Team’s Objectives: All Objectives within a manager’s team, including 
their own

■ All Objectives: If available, the list of Objectives for the default organization, 
such as department, business unit, or sales force
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■ All Objectives Across Organization: If available, the most comprehensive list 
of Objectives

4 Use the view tabs to review recommended activities, target accounts, and other 
information about the objectives.

To request literature items when using a local database

1 If you are using a local database and the document you want to view is 
unavailable, click the Request field in the Literature applet.

A dialog box appears and prompts, “Would you like to request this file from the 
server? It will be downloaded the next time you synchronize.”

2 Click Yes.

The next time you synchronize with the server, the requested file will be 
downloaded and available for viewing.

Changing the Status of Activities
After performing the recommended activities, you can change the status of 
objectives and the associated activities.

To change the status of activities associated with an objective

1 Navigate to the Objectives screen.

2 In the Objectives list, select an objective.

3 Click the Account Status view tab.

4 In the Accounts list, select an account.

5 In the Recommended Activities list, change the Status field of the activity.
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Administrator and End-User Maintenance Procedures
During the campaign, managers and sales representatives check on the status of the 
objectives and associated activities.

Checking the Status of Objectives
You can use the Account Status view or a graphical chart to check objectives and 
the status of their recommended activities.

To check the status of an objective

1 Navigate to the Objectives screen.

2 Select the objective whose status you want to review.

3 Click the Account Status view tab.

4 Select the account whose status you want to review.

The recommended activities associated with the account are displayed in the 
Recommended Activities subview. You can check the status of each 
recommended activity.

To check the status of an objective using charts

1 Navigate to the Objectives screen.

2 Select the objective whose status you want to review.

3 Click the Charts view tab.

Choose from the charts available using the Charts view Show drop-down list.
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This chapter describes the main steps involved in carrying out a clinical trial using 
Siebel eClinical. Following the procedures given in this chapter you will be able to:

■ Create a clinical program and clinical protocols

■ Set up document tracking at the protocol, region, and site levels, and for 
accounts and contacts

■ Set up and revise subject visit templates for a protocol

■ Enter data on accounts, sites, and contacts

■ Screen and enroll subjects

■ View charts showing subject status and enrollment rates

■ Review payments made to the protocol
Version 7.5, Rev. A Siebel Life Sciences Guide 289



Setting Up and Carrying Out a Clinical Trial
Figure 9 illustrates the important hierarchical relationship of programs, protocols, 
regions, and sites. In this example, the Bristol General Hospital in the USA region is 
participating in the AMXN 98447 protocol, which is being carried out as part of the 
Anemia program.

Figure 9. Siebel eClinical Hierarchical Relationships
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Business Scenario
This scenario is an example workflow performed by the director of clinical trials, 
clinical study manager, and the clinical research associates (CRAs). Your company 
may follow a different workflow according to its business requirements. 

In this scenario, the clinical director and the study manager, working for a clinical 
research organization, or pharmaceutical, biotech, or medical device company, 
have administrator responsibilities in Siebel eClinical to:

■ Set up a new treatment study program.

■ Create one or more protocols designed to assess the safety and efficacy of certain 
compounds in the treatment of the disease.

■ Set up the geographic regions where the protocols are to be carried out.

■ Compile a list of documents that are critical to the study and implement tracking 
at the protocol, region, and site levels, and for accounts and contacts.

■ Create a subject visit template to facilitate consistent application of the protocol 
across sites and subjects. This template is used to set up subject visit schedules 
and activities according to the guidelines laid out in the protocol.

Once the program, protocol, and subject visit templates have been set up, the 
CRAs who are the end users of the Siebel eClinical product do the following:

■ Enter data about the:

❏ Sites where the protocols are carried out.

❏ Assign members to the teams at the site, region, and protocol levels.

❏ Accounts, institutions such as hospitals and clinics where the studies are 
conducted.

❏ Contacts, site personnel such as investigators, site coordinators, and 
nurse practitioners who carry out the protocols.

❏ Subjects recruited for the clinical trial.

■ Screen and enroll subjects and, if necessary, rescreen the subjects.
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■ Use the subject visit template to set up detailed schedules for the subjects’ visits 
to the sites.

■ Track required documents at the protocol, region, or site level, or for accounts 
or contacts.

NOTE: The tasks of entering subject data and set up screening and enrollment visit 
schedules for subjects may also be performed by the site personnel using Site Portal 
Web site. For more information about Siebel Site Portal, see Siebel Life Sciences 
Portals Guide.

At various times after subjects have been enrolled in the trial, the clinical director, 
study manager, or CRAs can use the charting features of Siebel eClinical to review 
the progress of the trial. Two informative metrics are the subject status and 
enrollment rate. These are plotted for an individual site, for a region, and for the 
protocol. 
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Example Workflow Managing Clinical Trials
This section details sample tasks often performed by administrators and end-users 
when managing clinical trials. Your company may follow a different workflow 
according to its business requirements. 

In the following examples, tasks are carried out in the order presented. For example, 
a protocol must exist before its subject visit template can be created.

Administrator Procedures
The following list shows tasks administrators typically perform to manage a clinical 
trial. These tasks are typically performed in the following order:

1 Create a clinical program. For more information, see “Creating a Clinical Program” 
on page 295.

2 Create protocols for the program. For more information, see “Adding a Protocol” 
on page 297.

3 Optional: Set up regions for the protocol. For more information, see “Setting Up 
Regions” on page 299.

4 Set up subject visit templates that follow the protocol guidelines. For more 
information, see “Defining a Subject Visit Template” on page 300.

5 Assemble electronic documentation that is relevant to the protocol. Documents can 
be attached and tracked at the protocol, region, and site levels, or for accounts 
or contacts. For more information, see “Creating Documentation Tracking 
Activities” on page 305.

6 Revise protocol or create a new version of the visit template. “Revising Protocols” 
on page 306.

End-User Procedures
The following list shows tasks end users typically perform when managing a clinical 
trial. The procedures are performed by the CRA at the site level and are typically 
performed in the following order:
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1 Optional: Enter data on accounts and contacts. For more information, see “Adding 
an Account and Contacts” on page 307.

2 Create sites. For more information, see “Adding a Site” on page 309.

3 Review electronic documents for tracking. For more information, see “Reviewing 
Documentation for Tracking” on page 312.

4 Enter, screen, rescreen, enroll subjects. For more information, see “Adding a 
Subject and Setting Up Visits and Visit Activities” on page 312.

5 Chart subject status and enrollment rates. For more information, see “Monitoring 
Subject Status and Enrollment Rates” on page 318.

6 Update version of visit template used at site. In response to protocol revisions, the 
CRA modifies the site visit template and applies the updated visit template 
version to enrolled subjects. For more information, see “Updating a Protocol 
Version at a Site” on page 316.

7 Review payments made to the protocol. For more information, see “Reviewing 
Protocol Payments” on page 318.
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Administrator Procedures
This section provides instructions for the following tasks:

■ To add a new clinical program

■ To add a new protocol on page 297

■ To add regions to a protocol on page 299

■ To add a subject visit template on page 302

■ To create documentation tracking activities on page 305

■ To update and add existing documentation for tracking on page 305

■ To create a new version of the subject visit template on page 306

Creating a Clinical Program
The clinical program is the highest-level initiative in Siebel eClinical. Protocols, 
region, sites, and subjects must be associated with a program.

Multiple regulatory applications can be associated with a program.

To add a new clinical program

1 From the application-level menu, choose View > Site Map > Clinical 
Administration > Clinical Programs.
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2 In the Clinical Programs list, add a record, and complete the necessary fields.

NOTE: Before you can create an application, the associated product must be 
correctly defined as type Compound. For more information about defining 
products, see Chapter 18, “Managing Products.”

Some of the fields in a Clinical Programs record are described in the following 
table. 

3 Optional: Click the Attachments view tab, and attach files associated with the 
clinical program.

Field Comments

Application A multi-value field containing details of the application.

Filed. Whether the application has been filed with the specified 
regulatory agency.

Indication. The clinical indication for the application. The 
choices in this drop-down list are configured by using the 
CLNCL_PROG_INDICATION type in the List of Values.

Number. The number assigned to the application when 
submitted to the regulatory agency. More than one application 
number may be assigned to a program.

Product. This field must be completed before a protocol can be 
created for the program. 

Sub-Type. Who filed the application. For example, a company or 
an investigator. The choices in this drop-down list are 
configured by using the CLNCL_PROG_APPL_SUBTYPE type in 
the List of Values.

Type. The type of application, such as CTN, IND, or CTX. The 
choices in this drop-down list are configured by using the 
CLNCL_PROG_APPL_TYPE type in the List of Values.

Mechanism Partners associated with the clinical program. The choices in 
this drop-down list are configured by using the 
CLNCL_PROG_MECHANISM type in the List of Values.

Program The name of the clinical program.
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Adding a Protocol
Multiple protocols and multiple versions of a protocol can be associated with a 
program. 

To add a new protocol

1 From the application-level menu, choose View > Site Map > Clinical 
Administration > Protocols.

2 In the Protocols list, add a record, and complete the necessary fields. (To access 
more fields, click the show more button in the form.)

Some of the fields in the Protocol record are described in the following table.

 

Field Comments 

# Planned Sites Number of sites planned for the protocol.

# Planned Subjects Number of subjects planned for the protocol.

Abbreviated Title Short descriptive title for the protocol.

Central Lab The name of the laboratory associated with the study. This is 
entered through the Accounts screen.

Currency Code The currency that is used to display the payments, costs, and 
budgets in the Protocols screen. The default value is USD 
(United States dollars).

Design Information about the type of study.

Exchange Date The date that determines the exchange rate of the currency 
used. By default, the exchange date for the protocol is the date 
the protocol is created. 
This date may be changed in response to changes in currency 
rates. However, changes made to the exchange date at the 
protocol level take effect only when the exchange date also 
changes at the system level. For more information, see 
Applications Administration Guide.

Lab Contact Last 
Name

Contact person associated with the central lab.

Paid to Date The sum of the payments associated with the protocol.
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3 Optional: Add files associated with the clinical protocol as attachments.

Phase Phase of clinical trial such as Phase II, or III.

The choices in this drop-down list are configured by using the 
LS_PTCL_PHASE type in the List of Values.

# Planned Sites Number of sites planned for the region.

# Planned Subjects Number of subjects planned for the region.

Product Only products that have been associated with the clinical 
program, through the Application field in the Clinical Programs 
view, can be selected from the Clinical Product and Indication 
dialog box. See “To add a new clinical program” on page 295.

Program Name of the clinical trial program.

Protocol # Identifying number assigned to the protocol.

Regions Required Flag to indicate the sites for this protocol must belong to a 
region. For information on regions, see “Setting Up Regions.”

When this flag is selected, you cannot create sites directly under 
protocols. You must create regions first and then create sites that 
are associated with regions.

Status Protocol status such as planned, in progress, completed.

The choices in this drop-down list are configured by using the 
LS_PTCL_STAT_CD type in the List of Values.

Team Enter the names of those who need access to the protocol, the 
study manager and others who monitor the clinical trial.

Title Descriptive title for the protocol.

Type Purpose of the protocol. 

The choices in this drop-down list are configured by using the 
LS_PTCL_TYPE_CD type in the List of Values.

Field Comments 
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Setting Up Regions
Clinical trials are often global, taking place in multiple countries. It is useful to track 
and view study data by country and region. The region level in Siebel eClinical 
allows you to do this. 

Regions are optional for protocols. However, if you choose to use regions, by 
flagging the Regions Required field in the protocol record, then each site associated 
with the protocol must belong to a region. 

One of the advantages of using regions is that it provides another way of grouping 
sites and subjects. For example, you can chart subject enrollment by region in 
addition to by protocol and by site.

NOTE: You cannot create regions for a protocol unless the Regions Required flag has 
been selected for the protocol. See “Regions Required” on page 298.

To add regions to a protocol

1 From the application-level menu, choose View > Site Map > Clinical 
Administration > Regions.

2 In the Regions list, add a record, and complete the necessary fields. 

Some of the fields in a Region record are described in the following table.

 

Field Comments

Currency Code The currency that is used to display the payments, costs, and 
budgets in the Regions screen. The default value is USD (United 
States dollars).

Exchange Date The date that determines the exchange rate of the currency 
used. By default, the exchange date for the region is the date the 
region is created. 
This date may be changed in response to changes in currency 
rates. However, changes made to the exchange date at the 
region level take effect only when the exchange date also 
changes at the system level. For more information, see 
Applications Administration Guide.
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3 To add team members to the region, click the select button in the Team field, 
select a name in the Team picklist and click Position Rollup.

The team member is automatically added to the protocol to which the region 
belongs.

4 Create a region record for each country or geographical area where there are or 
will be sites participating in the protocol.

NOTE: It is important to specify the Currency Code for each region if multiple 
currencies will be used for the trial.

Defining a Subject Visit Template
Subject visit templates allow you to set up a template schedule based on the 
protocol. The template is then used to generate screening, rescreening, and 
enrollment schedules for each subject, according to the subject’s screening, 
rescreening, and enrollment dates. 

Protocol # Only protocols where regions are required are listed in the Pick 
Protocol dialog box.

# Planned Sites Number of sites planned for the region.

# Planned Subjects Number of subjects planned for the region.

Name A name for the region. This is automatically filled in with the 
protocol number and the region name.

Region Geographic region to which the site belongs.

The choices in this drop-down list are configured by using the 
CLINICAL_REGION type in the List of Values.

Team Team members associated with the protocol to which the region 
belongs. See Step 3 for information on entering.

Field Comments
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About Subject Visit Templates
Figure 10 and Figure 11 illustrate the relationship between the subject visit template 
and the visit schedule created for a given subject. 

For example, if the subject visit template shown in Figure 10 is applied to a subject 
with a screen date of 11/20/2001, a rescreen date of 11/22/2001, and an enrollment 
date of 11/26/2001, the resulting visit schedule is as shown in Figure 11.

Figure 10. Visits List

Figure 11. Subject Form and Visits List in the Visit Plans View
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The first screening visit takes place on the screen date because the lead time for this 
visit is 0. But this visit can be rescheduled to 11/21/2002 because the allowed 
variation for this visit is two days after the lead date (Max = 2 days). If you enter 
a date before the 11/20/2002 or after the 11/21/2002, an alert message appears, 
warning you that the entered date is outside the allowed range. 

Similarly, the first enrollment visit takes place on 12/03/2001 because the lead time 
for this visit is 1 week after the enrollment date of 11/26/2001.

If the protocol is amended, you will need to create new versions of the subject visit 
template to reflect the modifications made to the protocol. See “Revising Protocols” 
on page 306.

Creating a Subject Visit Template
The following procedure describes how to add a subject visit template.

To add a subject visit template

1 From the application-level menu, choose View > Site Map > Clinical 
Administration > Visit Templates. 

2 In the Subject Visit Templates list, add a record, and complete the necessary 
fields. 

Some of the fields in the Subject Visit Template record are described in the 
following table.

3 For the new subject visit template, in the Template Versions list, create a new 
template version record.

Field Comments

Name Name of the new subject visit template.

Protocol # Protocol to which this subject visit template is to be associated. 
Select from list of existing protocols in the Pick Protocol dialog 
box.

Protocol Title Tied to the Protocol # field.
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4 For the new template version record, in the Visits list, create a visit record for 
each visit (screening, rescreening, and enrollment) that a subject is to make to 
the site. 

Some of the fields in a Visits record are described in the following table.

 

Field Comments

Lead ■ For Screening visits, this is the time from the screen date. 
For example, in Figure 10 on page 301 the Lead value for the 
screening visit is 0. 

■ For Rescreening visits, this is the time from the rescreen date.

■ For Enrollment visits, this is the time from the enrollment date.
The Lead value for an enrollment visit taking place 1 week after 
enrollment would be 1, assuming the Lead Unit is weeks. 

Lead Units Units for lead time.

Max The time after the lead time that the visit may take place.

For example, if Max=2 and Min/Max Units = days, the visit may 
take place up to two days after the scheduled visit.

Do not leave this field blank.

Min The time before the lead time that the visit may take place. 

For example, if Min=1 and Min/Max Units = days, the visit may 
take place one day before the scheduled date. 

Do not leave this field empty.

Min/Max Units Units for the Min and Max values.

Do not leave this field empty.

Name Name of the visit; for example, screening or baseline.
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5 For each visit record, in the Activities record, create a set of activity records to 
describe the procedures and tasks required for the visit. 

Some of the fields in the Activities record are described in the following table.

For more information about payments, see Chapter 15, “Setting Up and Making 
Subject Activity Payments.”

Sequence Sequence number of the visits. Typically, the first visit that will be 
made has order number 1.

Visit Type Screening, Rescreening, or Enrollment. If Screening is selected, the 
visit due date will be based on the screen date. If Rescreen is 
selected, the visit due date will be based on the rescreen date. If 
Enrollment is selected, the visit date will be based on the 
enrollment date.

The choices in this drop-down list are configured by using the 
CLNCL_SUBJ_VST_TMPL_TYPE type in the List of Values.

Field Comments

Field Comments

Duration Length of time the activity is estimated to take.

Payment Amount The standard amount that the investigator is to be paid for this 
activity. This amount may be adjusted on a per site or per 
individual basis.

Payment Flag Select this flag if the investigator is to be paid for this activity.
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Creating Documentation Tracking Activities
Numerous documents are collected during clinical trials, either as electronic files or 
as paper. These documents must be tracked and periodically updated. Documents 
can be associated with sites, regions, protocols, contacts or accounts.

To create documentation tracking activities

1 From the application-level menu, choose View > Site Map > Document 
Tracking.

2 In the Document Tracking list, add a record and complete the necessary fields.

NOTE: A document tracking activity can be associated with only one of the 
available tracking levels or entities.

Some of the fields in a Document Tracking record are described in the following 
table.

To update and add existing documentation for tracking

1 From the application-level menu, choose View > Site Map > Document 
Tracking.

2 In the Document Tracking list, query for the document you want to update.

3 Click the document name hyperlink.

The associated Attachment view appears.

4 In the Attachment list, query for the document, and click the document name.

Field Comments

Name The document name. 

This is a hyperlink to the associated Attachment view.

Site, Region, 
Protocol, Contact, or 
Account

Delegate the document to one of these fields. The field you 
select determines how the hyperlink in the Name field 
operates.

This field is a hyperlink to the associated Activities view.
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5 Open, update and save the document.

6 Use the thread bar to return to the document record on the Document Tracking 
list.

7 Copy the original document record and revise the associated site, region, 
protocol, contact, or account field.

Refer to “To create documentation tracking activities” on page 305, Step 2, for 
descriptions of some of the fields in a Document Tracking record.

Revising Protocols
If a protocol is revised or amended, you may need to create a new version of the 
subject visit template to reflect the changes made in the protocol. 

NOTE: Different sites can carry out different versions of the template at the same 
time.

To create a new version of the subject visit template

■ Copy the current template version record, and edit the version number, visits, 
and activities as necessary.

Or

■ Create a new (blank) template version record as described in “To add a subject 
visit template” on page 302, Step 3 to Step 5.

For information about applying a new version of a subject visit template to an 
enrolled subject, see “To apply a new version of the subject visit template for an 
enrolled subject” on page 316.
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End-User Procedures
This section provides instructions for the following tasks:

■ To add an account

■ To add a contact on page 308

■ To add a site on page 309

■ To enter and screen a subject on page 312

■ To rescreen a subject on page 314

■ To enroll a subject on page 315

■ To apply a new version of a subject visit template to a site on page 316

■ To apply a new version of the subject visit template for an enrolled subject on 
page 316

■ To create graphical charts on page 318

Adding an Account and Contacts
An account is the institution from which clinical trials are managed. Typically, it is 
the facility where the investigators conduct the trials. More than one site can be 
associated with an account, and one account can be carrying out multiple protocols. 
IRBs (institutional review boards), central labs, CROs (clinical research 
organizations), and other subcontractors may also be tracked as accounts.

Contacts is the term used for personnel working at clinical sites. This includes the 
investigators, typically medical professionals who are also researchers, and site 
coordinators, who may be the practicing nurses administering the treatment plan 
according to the clinical protocol.

Bulk loading of data on accounts and contacts is generally performed by the Siebel 
administrator, but end users may add and modify these records as needed. (See 
Chapter 19, “Importing Data.”)

To add an account

1 Navigate to the Accounts screen.
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2 From the Show drop-down list, select My Accounts.

3 In the Accounts list, add a record, and complete the relevant fields. (To access 
more fields, click the show more button in the account form.)

Some fields are described in the following table.

4 Use the views tabs to access other views such as Account Team, Activities, 
Addresses, and so on to add more information to the account record.

For more information about creating and maintaining account affiliations, see 
Chapter 7, “Administering and Managing Accounts.”

To add a contact

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts.

Field Comments

Account Type Hospital, Clinic, IRB, and so on.

The choices in this drop-down list are configured by using the 
ACCOUNT_TYPE type in the List of Values.

Address 
Line 1

Allows you to add addresses for the account by picking from existing 
addresses or by entering new addresses. Avoid duplicating addresses 
by checking if the address exists before entering a new one.

Site Description of the location or function of the account, such as 
“headquarters” or “corporate” or “San Francisco.”

Synonyms Allows you to refer to accounts in the way that you prefer. For 
example, an account named A/B Products, Inc., might have the 
following synonyms: AB, A/B, and AB Products.

When you search for an account or enter an account in another part 
of your Siebel application, you can use a synonym instead of the 
actual name.

Team Multiple users can be assigned to the account team. The team member 
who creates the account record is indicated as primary team member.
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3 In the Contacts list, add a record, and complete the necessary fields. 

Some fields are described in the following table.

4 Add or associate additional information with the contact’s record, using the 
other views on the screen.

For example, use the Relationships view to associate site coordinators and other 
site personnel with the contact. 

For more information about creating and maintaining contact records, see 
Chapter 3, “Managing Contacts.”

Adding a Site
The site is the group at an account, headed by a principal investigator, who carries 
out a particular protocol. In Siebel eClinical, a separate site record must exist for 
each unique combination protocol, account, and principal investigator. 

To add a site

1 Navigate to the Site Management screen.

2 From the Show drop-down list, select My Sites.

Field Comments

Address The contact can have more than one address. One address must be 
specified as primary. Each CRA assigned to the contact can specify a 
different address as primary. For example, one CRA might specify a 
private office as the primary address, while another CRA might specify 
a hospital department as the primary address.

Team Multiple CRAs can be assigned to the contact. The team member who 
created the record is indicated as primary. 
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3 In the Sites list, add a record, and complete the necessary fields. (To access more 
fields, click the show more button in the form.)

Some of the fields in a Sites record are described in the following table.

Field Comments 

Account The institution where the protocol is to be carried out.

Address Select one of the principal investigator’s addresses as the 
site address.

Currency Code The currency that is used to display the payments, costs, 
and budgets for the site.

Exchange Date The date that determines the exchange rate of the currency 
used. By default, the exchange date for the site is the date 
the site is created. 
This date may be changed in response to changes in 
currency rates. However, changes made to the exchange 
date at the site level take effect only when the exchange 
date also changes at the system level. For more 
information, see Applications Administration Guide.

PI Last Name Last name of the principal investigator.

If an account has already been specified for the site, use 
Affiliated Contacts in the Pick Contacts dialog box to view 
only those who are affiliated with the account.

Protocol # Select from list of existing protocols in the Pick Protocol 
dialog box.

Region If regions are required for this protocol, enter a region 
name.

Status Planned, Initiated, Enrolling, Closed

The choices in this drop-down list are configured by using 
the CLNCL_PROTOCOL_SITE_STATUS type in the List of 
Values.

Team The Primary flag defaults to the creator of the site record. 
The flag can only be changed by the manager of the team 
through the My Team’s Sites view. This is consistent with 
the best practice because resource management is normally 
a manager’s responsibility.

See Step 4 for information on entering.

Version See Step 5 for information on entering.
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4 To enter team members, click the select button in the Team field, select a team 
member in the Team picklist, and click Position Rollup.

The team member is automatically added to the region that the site belongs to, 
if the region required flag is checked, and to the protocol to which the site 
belongs.

5 Enter a version for the subject visit template to be used at the site.

a In the Version field, click the select button to open the Template Versions 
dialog box.

b Click New.

c Select the protocol and version template you want to use to create subject 
visit schedules for the site, and click OK. 

The template versions are filtered to display only those related to your 
protocol.

d Enter the IRB Approval Date for the selected version.

The template version cannot be activated without the IRB approval date.

e Click the Active field to make the selected version the active version at the 
site. 

Only one version can be active at a time. The active template is used when 
activities are generated for a subject. 

NOTE: The IRB Approval Date must be entered before the template can be 
activated.

f Close the Template Versions dialog box.

6 Add records for the principal investigator and other key site personnel.

For information, see “To associate contacts with a site” on page 331.
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Reviewing Documentation for Tracking
The CRAs review all the documentation required for meeting regulatory 
requirements at the site and assure that review deadlines are met.

To review and track documentation

1 Navigate to the Site Management screen.

2 From the Show drop-down list, select My Sites.

3 In the Sites list, query for the site for which you want to review documentation.

4 Click the Document Tracking view.

The Document Tracking list shows the required documents.

5 Optional: Complete the necessary fields to maintain a record of document 
events.

Adding a Subject and Setting Up Visits and Visit Activities
CRAs may enter information about clinical trial subjects. Once the subject record is 
added, the subject visit template active for the site can be applied to set up a 
schedule of visits and activities for the subject.

To enter and screen a subject

1 Navigate to the Site Management screen.

2 From the Show drop-down list, select My Sites.

3 In the Sites list, select the site for which you want to add subjects. 

4 Click the Subjects view tab.
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5 In the Subjects list, add a record, and complete the necessary fields. 

Some of the fields in a Subjects record are described in the following table.

6 Click the hyperlink in the Screening # field of the subject.

The Visits view of the Subjects screen appears.

Field Comments 

Enrollment Id This is the principal ID number for the subject. The value is 
entered when you click the Enroll button (Step 8 on page 317).

Informed 
Consent

An informed consent date must be entered before a subject can be 
enrolled in the protocol. See Step 3 on page 315.

Randomization 
Id

An ID number for the subject, which can be used in studies where 
both an enrollment ID and a randomization ID are required.

Screen Failure 
Reason

The choices in this drop-down list are configured by using the 
CLINCL_REASON_EXCLUDED type in the List of Values.

Screening # This field is based on the subject’s initials and date of birth. It is 
automatically populated after Subject Initials and Date of Birth 
fields are entered and the record is saved.

Status A multi-value field that contains a history the subject’s status.

Primary. This flag sets the current status, which displays in the 
Status field of the Subjects view.

Status. The status of the subject, for example, screened, enrolled, 
or re-screened. The choices in this drop-down list are configured 
by using the CLNCL_SUBJECT_STATUS type in the List of Values.

Date. The date the status was changed or updated.

Comments. Comments about the subject’s status.

Withdrawn 
Reason

The choices in this drop-down list are configured by using the 
CLINICAL_WITHDRAWN_REASON type in the List of Values.
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7 To generate screening visits and activities:

a Click Screen in the Subject form.

b Enter the screen date in the Screening dialog box.

Screening visits and activities to take place in those visits appear in the Visits 
and Activities lists. 

NOTE: A subject can be screened only once for each visit template. After 
screening visits have been generated, clicking the Screen button again and 
changing the screen date reschedules the screening visits according to the 
new screen date. (If the subject visit template has been updated since the last 
time the screen button was clicked, new screening visits are generated.) See 
“Updating a Protocol Version at a Site” on page 316.

8 Optional: Edit subject visits dates. 

For example, you might want to edit some subject visit dates so that visits are 
not scheduled on weekends.

If the rescheduled date falls outside the range specified by the subject visit 
template, the application displays a warning message, but still reschedules the 
visit according to the new date.

9 Optional: Add or modify subject visits or activities.

To rescreen a subject

A subject who initially fails screening can be rescreened. The rescreen date must be 
greater than or equal to the screen date, and rescreening cannot happen if the 
subject has not already been screened (that is, if the screen date is null). 

1 Navigate to the Subjects screen, and select the subject who is eligible for the 
study. (The subject must have already been screened.)

2 Click Rescreen in the Subject form, and enter a rescreen date.

The rescreen visits and activities are automatically added to the subject’s 
schedule. 

3 Optional: Edit subject visits dates. 
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4 Optional: Add or modify subject visits or activities.

5 Optional: Rescreen multiple times. 

A subject can be rescreened more than once. Each time the Rescreen button is 
clicked and the rescreen date entered, a new set of the rescreening visits and 
activities is generated and appended to the existing ones. This applies even 
though the subject visit template has not been changed.

To enroll a subject

A subject who has successfully passed screening or rescreening is then enrolled in 
the study.

1 Navigate to the Subjects screen, and select the subject.

2 Click the Visits view tab.

3 Enter the informed consent date:

a Click the select button in the Informed Consent Dates field to open the 
Informed Consent dialog box.

b Click New.

The versions of the subject visit template appear in the drop-down list of the 
Add Informed Consent dialog box. Make sure to select the version before 
entering the informed consent date.

c Click Add.

d In the Informed Consent Dates dialog box, enter an informed consent date 
for the subject, and close the Informed Consent Dates dialog box. 

NOTE: Enrollment activities cannot be generated without an informed consent 
date for the active version of the protocol.

4 Click the Enroll button in the Subject form.

5 Enter the enrollment date and the enrollment ID in the Enrollment dialog box. 

The enrollment date must be greater than or equal to the screen date.
Version 7.5, Rev. A Siebel Life Sciences Guide 315



Setting Up and Carrying Out a Clinical Trial

End-User Procedures
6 Optional: Edit subject visit dates. 

See Step 8 on page 314 for more information about editing visit dates.

7 Optional: Add or modify subject visits or activities.

Updating a Protocol Version at a Site
When a protocol is revised mid-study, you need to update:

■ The subject visit template version associated with the site.

■ The visit schedules of any subjects already in the study. 

To apply a new version of a subject visit template to a site

1 Navigate to the Site Management screen.

2 From the Show drop-down list, select My Sites.

3 In the Sites list, select the site for which you want to apply a new version of the 
visit template.

4 Enter the new version of the subject visit template in the Version field.

Make sure that the new version is active and that you enter the IRB Approval 
Date for the version.

For instructions on editing the Version field, see Step 5 on page 311.

To apply a new version of the subject visit template for an enrolled subject

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to update subject visits.

3 Click the Subjects view tab.

4 Click Apply Active Version.

This creates new records for the new version of the template in the Informed 
Consent Dates field for all subjects in this site except for those whose status is 
“Early Terminated” or “Completed.”
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5 Navigate to the Subjects screen, and select the enrolled subject whose schedule 
you want to update for the revised subject visit template.

6 Click the Visits view tab.

7 Enter the informed consent date for the newer version as described in Step 3 on 
page 315.

8 In the Subjects form, click Enroll, and click OK in the Enrollment dialog box.

Visits for the new protocol are appended to the Visits list.

9 Edit the Visit records. 

Typically you would delete:

■ Future-scheduled visits from the original subject visit template version.

■ Past-scheduled visits from the new subject visit template version.

NOTE: Screening and rescreening schedules are revised in the same way, except that 
informed consent dates are not necessary for these types of visit.
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Monitoring Subject Status and Enrollment Rates
You can view charts of:

■ Subjects by status

■ Enrollment rates 

These charts can be displayed by protocol, region, or site. Charts can be displayed 
in a variety of formats.

To create graphical charts

1 Navigate to the Protocols, Regions, or Site Management screen.

2 In the list, select the record for which you want to create the charts.

3 Click the Charts view tab.

4 To display a subjects-by-status chart:

a From the Show drop-down menu, select Subject Accruals.

b From the second drop-down menu, select Subject Status Analysis. 

5 To display an enrollment rate chart:

a From the Show drop-down menu, select Subject Enrollment.

b From the second drop-down menu, select Subject Enrollment Analysis. 

Reviewing Protocol Payments
End users can view a report of payments made to all sites in the protocol.

To review protocol payments

1 Navigate to the Protocols screen.

2 Select a protocol for which you want to review payments.

3 Click the Payments view tab.
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4 In the application-level menu, select View > Report.
Version 7.5, Rev. A Siebel Life Sciences Guide 319



Setting Up and Carrying Out a Clinical Trial

End-User Procedures
320 Siebel Life Sciences Guide Version 7.5, Rev. A



Managing Sites and Clinical Contacts 14
This chapter describes the tasks that the administrator and end users perform to 
update and maintain information about:

■ Clinical trial sites

■ Contacts (investigators and other site personnel)

■ Accounts (hospitals and clinics where the trials are carried out)

■ Employees on the site team

■ Regulatory documentation relevant to recording the trials

Siebel Life Sciences’ feature set allows you to record the relationships among these 
five entities.

This chapter also describes setting up and using:

■ Site activity plans

■ Contact assessments
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Business Scenarios
These scenarios are example workflows performed by the administrator and the 
clinical research associates (CRAs). Your company may follow a different workflow 
according to its business requirements. 

At the Beginning of the Clinical Trial
In preparation for the clinical trial, the administrator sets up templates to generate 
site activity plans for site initiation and to track documents. 

When the CRAs begin work on a new clinical trial, they add new information and 
update existing information about accounts, contacts, and sites, and about the 
affiliations and associations among them. Maintaining accurate data is critical to 
successful clinical trials. 

When a new contact is entered, the CRA requests that the administrator enter the 
contact’s primary specialty and license number (such as a physician investigator’s 
AMA number). Data cannot be entered in these fields from the CRAs’ views. 

From time to time, CRAs enter account or contact records incorrectly. Or, they 
discover that some account or contact records have become obsolete. The CRA then 
puts in a request to the administrator to have those accounts and contacts deleted. 
CRAs do not have the responsibilities needed to delete these records.

At the End of the Clinical Trial
Before the clinical trial ends, the administrator or the study manager creates a 
contact assessment template that each CRA can use to evaluate the performance of 
the investigators at the conclusion of the trial. 

Similarly, the administrator can create assessment templates for use in screening 
and selecting investigators at the beginning of clinical trials.

CAUTION: In some countries, it is not permitted to evaluate the performance of site 
personnel. Please obtain legal advice before using the contact assessment feature in 
Siebel eClinical.
322 Siebel Life Sciences Guide Version 7.5, Rev. A



Managing Sites and Clinical Contacts

Workflow for Managing Site and Contact Information
Workflow for Managing Site and Contact Information
This section details sample tasks often performed by administrators and end-users 
when managing site and contact information. Your company may follow a different 
workflow according to its business requirements.

NOTE: The administrative tasks described in this section must be performed before 
the related end-user task can be performed. For example, a clinical protocol site 
template must exist before the corresponding site activity plan can be created.

Administrator Procedures
The following list shows tasks administrators typically perform to manage site and 
contact information:

■ Create clinical protocol site templates. An administrator creates templates that 
detail the activities that must be performed at all sites that are carrying out the 
same protocol. For more information, see “Creating a Clinical Protocol Site 
Template” on page 325.

■ Create contact assessment templates. The administrator or the study manager 
creates assessment templates that define weighted attributes for assessing a 
contact. For more information, see “Creating an Assessment Template” on 
page 327.

■ Maintain contact and account data. An administrator maintains records of contact 
license numbers and deletes erroneous or obsolete account and contact data. For 
more information, see “Maintaining Contact and Account Information” on 
page 329.
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End-User Procedures
The following list shows tasks end users typically perform when managing site and 
contact information: 

■ Add and update contact, site, and account data. CRAs record details about contacts, 
accounts, and sites. For more information, see “Adding and Updating Site, 
Contact, and Account Records” on page 330.

■ Add employees to the site team. Managers or CRAs add employees to the team 
associated with the site. For more information, see “Assigning Employees to the 
Site Team” on page 331.

■ Create site initiation and document tracking activity lists. CRAs use the clinical 
protocol site template that has been created by an administrator to plan a list of 
activities for each site. For more information, see “Creating Site Activity Plans” 
on page 332.

■ Add, track, and update documentation. CRAs and regional study managers post 
clinical trial and regulatory documentation for review at site, region, and 
protocol levels. For more information, see “Tracking and Adding Documents at 
Sites” on page 335.

■ Assess investigators at end of the trial. CRAs score each contact, based on the 
attributes defined in an assessment template. For more information, see 
“Assessing an Investigator or Other Contact” on page 337.
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Administrator Procedures
This section provides instructions for the following tasks:

■ To create a clinical protocol site template

■ To create an assessment template on page 327

This section provides information about:

■ Entering specialty and license information

■ Deleting contacts and accounts

See “Maintaining Contact and Account Information” on page 329. 

Creating a Clinical Protocol Site Template
Activities can be associated directly with sites. For example, all sites carrying out 
the same protocol need to perform similar site initiation activities and submit 
similar documents to the regulatory agencies. When many activities are common to 
multiple sites, the clinical protocol site template helps CRAs create site activities. 

The clinical site protocol template is one of a number of activity templates used in 
Siebel eClinical. Others are subject visit templates (“Defining a Subject Visit 
Template” on page 300), trip report templates (“Creating a Trip Report Template” 
on page 354), contact assessment templates (“Creating an Assessment Template” 
on page 327).

NOTE: Unlike trip report templates, clinical protocol site templates are protocol-
specific. To use a clinical site template in association with more than one protocol, 
duplicate the record and then edit the Protocol Title field.

To create a clinical protocol site template

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.
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2 In the Activity Templates list, add a record, and complete the necessary fields.

Some of the fields in an Activity Template record are described in the following 
table.

3 Click the Activity Template Details view tab.

4 In the Activity Template Details list, add a record, and complete the necessary 
fields.

Some of the fields in an Activity Template Details record are described in the 
following table.

Field Comments

Auto Trigger, Public, Sales 
Method, Sales Stage

Typically, these fields are not used in a clinical protocol 
site template.

Protocol Title The protocol with which the clinical protocol site 
template will be used. This field must be completed.

Type Must be Clinical Protocol Site.

Field Comments

Activity The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values.

For document tracking, use either Document or Site Initiation.

Budgeted Cost, Cost 
Estimate

Typically, these fields are not used in a clinical protocol site 
template.

Lead The time after the planned start date when the activity is due.

Priority The choices in this drop-down list are configured by using the 
ACTIVITY_PRIORITY type in the List of Values.

Status Leave this field blank or set it to a value such as Planned, Not 
Started, or Auto-Created.

The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.
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5 Add a record for each activity that you want to appear in the template. 

Creating an Assessment Template
The purpose of the assessment is to determine a single total score or a percentage 
that can be used to rank a contact. 

The total score for the assessment is determined by summing weighted scores for 
each assessment attribute:

where n is the number of assessment attributes in the template.

The score is also calculated as a percentage of the maximum score possible:

where Max_Scorei is the largest score for any value in the Attribute Values list for 
the ith attribute. For example, in Step 4 on page 329, the largest score in the 
Attributes Values list is 10.

To create an assessment template

1 From the application-level menu, choose View > Site Map > Application 
Administration > Sales Assessment Templates.

Type The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values and setting the Parent LIC 
to the activity type.

Units Units for lead time.

Field Comments

Total_Score Weighti( ) Scorei( )
i 1=

n

∑=

Max_Total_Score Weighti( ) Max_Scorei( )
i 1=

n

∑=
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2 In the Assessment Templates list, add a record, and complete the necessary 
fields.

Some of the fields in an Assessment Templates record are described in the 
following table.

:

3 In the Assessment Attributes list, add a record for each attribute you want to 
assess. 

Some of the fields in an Assessment Attribute record are described in the 
following table.

:

Field Comments

Assessment The name of the template.

Sales Method, 
Sales Stages

Typically, these fields are not used in an assessment template.

Type Must be Contact for Contact Assessments.

Field Comments

Name Name of the attribute.

Order Indicates the attribute’s position in the Assessment Attributes list.

Weight Relative importance of the attribute.
328 Siebel Life Sciences Guide Version 7.5, Rev. A



Managing Sites and Clinical Contacts

Administrator Procedures
4 For each assessment attribute, create a record for each possible value of the 
attribute. These values will appear in the Pick Attribute Value dialog box when 
the end user applies the template. See “To assess an investigator or other 
contact” on page 337.

Some fields in the Attribute Value record are described in the following table.

Maintaining Contact and Account Information
The end users are responsible for much of the day-to-day maintenance of their 
account and contact data. However, there are a few tasks for which the 
administrator is responsible. These are:

■ Entering data into the primary specialty field and the license number fields for 
contacts. See “Primary Specialty and Unique Identifiers” on page 51.

NOTE: If the specialty type you need is not available, enter it by following the 
procedure, “To define a specialty” on page 52.

■ Deleting contact and account records that were added in error or are obsolete. 
See “To delete a contact” on page 53 and “To delete an account” on page 188.

Field Comments

Description Additional information about the value to help the assessor.

Order Indicates the value’s position in the Attribute Values list.

Score The number of points that the value represents.

Value The name of the value, for example Excellent, Good, or Average.
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End-User Procedures
This section provides instructions for the following tasks:

■ To assign activities to a site using a template on page 332

■ To track documentation milestones on page 335

■ To assess an investigator or other contact on page 337

This section provides information about:

■ Adding site, contact, and account records

■ Indicating affiliations between accounts and contacts

Adding and Updating Site, Contact, and Account Records
It is important to maintain accurate information in the Siebel eClinical database. 
End users need to keep data about their sites, accounts, and investigators up to date. 
To do this, they create new records, modify existing records, and request that their 
administrator delete obsolete records. In addition, they create and maintain the 
relationships (affiliations) among their contacts, accounts, and sites. 

For more information, see the following topics:

■ “To add an account” on page 307

■ “To add a contact” on page 308

■ “To add a site” on page 309

■ “To indicate an affiliation between contacts” on page 63

■ “To indicate an affiliation between an account and a contact” on page 200

■ “To indicate an affiliation between accounts” on page 201
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To associate contacts with a site

1 Navigate to the Site Management screen.

2 In the Sites list, select the site with which you want to associate contacts.

3 Click the Contacts view tab.

4 In the Contacts list, add a record, and complete the necessary fields.

Some of the fields in the Contacts record are described in the following table.

TIP: Do not forget to add your principal investigator to the Contacts list.

Assigning Employees to the Site Team
CRAs assign employees to the site team. The team members can be rolled up and 
made visible at the region and protocol levels. 

NOTE: If the CRA is working from a mobile Web client, the administrator must set 
up position rollup on the Web client. For more information, see “Setting Up Mobile 
Web Clients for Position Rollup” on page 30.

Before an employees can be added to the site team, an administrator must set up 
the employee record. For more information, see Applications Administration Guide.

Field Comments

Last Name Affiliated Contacts filters the names in the Pick Contacts dialog 
box, displaying only those contacts associated with the site’s 
account.

Role The choices in this drop-down list are configured by using the 
CONTACT_ROLE type in the List of Values.
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To assign employees to the site team

1 Navigate to the Site Management screen.

2 In the Sites list, select the site to which you want to add employees.

3 In More Info, click the show more button.

4 In the Team field, click the select button.

The Access List dialog box appears.

5 In the Access List dialog box, click the New button.

The Add Employees dialog box appears.

6 Query for the employee that you want to add to the team and click OK.

The employee now appears in the Access List dialog box.

7 Click Position Rollup.

The employee is added to the team at the region and protocol levels.

Creating Site Activity Plans
A site activity plan is a list of activities and documents associated with the site.

Although activities can be created without a template, using a clinical protocol site 
template as described here makes creating site activity plans more efficient.

For information on creating templates, see “To create a clinical protocol site 
template” on page 325.

To assign activities to a site using a template

1 Navigate to the Site Management screen.

2 In the Sites list, select the site to which you want to assign activities.

3 Click the Activity Plans view tab.
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4 In the Activity Plans list, add a record, and complete the necessary fields.

Some of the fields in an Activity Plan record are described in the following table.

Field Comments

Planned Start Make sure that this date is correct before you choose a template. 
The due dates for the template-generated activities are based on 
this start date and on the lead time set in the template.

Lock Assignment Determine whether the Lock Assignment field should be 
selected. If the activity is locked, Assignment Manager will not 
access it. If it is unlocked, Assignment Manager can reassign it.

Template Only templates whose type is Clinical Protocol Site and whose 
protocol matches the protocol at the site are displayed.

Only activities with type Document or Site Initiation are shown 
in the document tracking views.
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5 Edit the activities in the Activities list or add more activities to the list.

Some of the fields in an Activities record are described in the following table.

NOTE: To view additional fields in this list, click the menu button and select 
Columns Displayed.

Field Comments 

Completed Date This field is tied to the Status field. When a date is entered in 
this field, the status field is automatically set to Done.

Expected Date For document tracking: The date that the signed document is 
expected to come back from the site.

Received Date For document tracking: The date that the signed document 
returns from the site.

Sent Date For document tracking: The date that the document is sent to 
the site.

Status This field is tied to the Completed Date field. When this field is 
set to Done, the Completed Date field is automatically set to the 
current date.

The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

Suppress Calendar A check mark in this field indicates that the activity does not 
appear on the user’s calendar.
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Tracking and Adding Documents at Sites
During the life of a clinical trial, CRAs need to collect and track numerous 
documents, including critical regulatory documents. CRAs can take advantage of 
the activity plans to generate a list of documents for tracking. In the document 
tracking views, they can also create their own lists of activities to track important 
dates. 

NOTE: Regional study managers can use similar procedures to add and track 
documents at the Region level in the Regions screen.

To track documentation milestones

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to track documentation.

3 Click the Document Tracking view tab.

A list of documents associated with the clinical trial appear.

4 Query for the document of interest and complete the necessary fields.

Some of the fields in a Document Tracking record are described in the following 
table.

Field Comments

Activity By default, the activity is Document.

Assigned To The person to whom responsibility for the document has been 
assigned.

Expected Date The date that the signed document is expected to come back from 
the site.

Expiration Date The date the document expires.

Lock Assignment Determine whether the Lock Assignment field should be selected. 
If the activity is locked, Assignment Manager will not access it. If 
it is unlocked, Assignment Manager can reassign it.
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To add a document to a site

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to track documentation.

3 Click the Document Tracking view tab.

A list of documents associated with the clinical trial appears.

4 Add a record and complete the required fields.

Some of the fields in a Document Tracking record are described in Step 2 of “To 
create documentation tracking activities” on page 305.

5 Step off the record you have just added and drill down on the Name hyperlink.

The Attachment view appears.

6 Add a record and in the Name field specify the file name or URL.

7 Check the Auto Update flag if you want to have the file automatically updated 
during synchronization.

This applies only to local files. If a file is not local, it cannot be updated during 
synchronization.

Name The name of the document. This field is a hypertext link to the 
Attachments tab.

Received Date The date that the signed document returns from the site.

Sent Date The date that the document is sent to the site.

Field Comments
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Assessing an Investigator or Other Contact
Assessments allow end users to calculate a single numerical value that expresses 
the fitness of a contact, according to a set of attributes defined in the assessment 
template. For example, an investigator may be assessed to determine fitness to carry 
out a large scale phase III clinical trial. The results of this assessment help CRAs 
find suitable investigators for subsequent trials.

NOTE: The application automatically updates the score values in the Assessment 
Attributes list and the (total) score value in the Assessments list.

For information on creating templates, see “To create an assessment template” on 
page 327.

To assess an investigator or other contact

1 Navigate to the Contacts screen.

2 In the Contacts list, select the contact whom you want to assess.

3 Click the Assessments view tab.

4 In the Assessments list, add a record.

5 In the Template Name field, select the assessment template that has been 
prepared for you. (For more information, see “Creating an Assessment 
Template” on page 327.)

The application fills in other fields in the record when the record is saved.

6 In the Assessment Attributes list, for each attribute:

a Enter a Value by selecting from the Pick Attribute Value dialog box. 

b Add or edit comments in the Comment field of the attribute.
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This chapter describes managing payments for subject activities made to the site. 

■ Set up payment amounts in the subject visit templates

■ Set up payment amounts on a per site basis (called site-level budgeting or 
payment exceptions)

■ View and generate payments to the site or investigator for subject or site 
activities carried out
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About Activity Payments
Payment amounts are set and adjusted at three levels:

■ Standard payment amounts are set by the administrator through the subject visit 
template

■ Exceptions to standard payment amounts are set according to agreements 
negotiated by individual sites

■ Payments can be further adjusted on a one-off only basis before the payment is 
generated

Not all subject activities have payment amounts associated with them. For example, 
obtaining informed consent may be a subject activity for which the site is not paid, 
but a site would be paid for performing a blood test. Subject activities for which the 
site can be paid are referred to as payment subject activities. (In the Siebel eClinical 
interface, these activities are indicated by the Payment Flag.)

In addition to subject activities, sites can be paid on other activities created at the 
site level, such as IRB fees and equipment costs. Those activities can be flagged as 
payable to the site with the Payment Flag.

NOTE: For information about managing budgets at the protocol level, see Chapter 17, 
“Managing Clinical Projects.”

You can use multiple currencies for a protocol. Currencies and exchange rate dates 
are set at three levels:

■ Protocol level. A single currency code and exchange date is associated with a 
protocol record. All payments made to sites for the protocol are converted to and 
rolled up in the protocol currency.

■ Region level. If regions are used for the protocol, you should set a currency code 
and exchange date for the region. All site payments made in that region are 
converted to and rolled up in the region’s currency.

■ Site level. You should set a currency code and exchange date for each site. When 
you use a subject visit template to create subject visits and activities, all payment 
activities are converted to the currency specified for the site on the exchange 
date that is set at the site level. 

For more information on setting up currency conversions, see Applications 
Administration Guide.
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Business Scenario
This scenario is an example workflow performed by the study manager and the 
clinical research associates (CRAs). Your company may follow a different workflow 
according to its business requirements. 

Based on the input from the clinical contract or grant negotiations group, the study 
manager sets up the standard payment amounts for procedures and tasks that the 
site performs. 

The CRAs set up the payment exceptions for sites where different payments have 
been negotiated for subject activities. (In some organizations, this task is done by 
study manager instead of the CRA.) 

As the sites carry out the procedures, the CRAs verify successful completion of the 
procedures and tasks and generate payments for these activities. 

Occasionally, the sponsor or CRO (clinical research organization) needs to make an 
additional payment to a site, a payment which is not directly associated with subject 
activities. These are ad hoc payments, for example, reimbursement for an 
unscheduled visit.

NOTE: As the clinical trial progresses, the sites carry out the subject activities for 
which they are paid. Typically, site personnel at the sites enter completed dates for 
subject activities using the Site Portal application. For more information about 
Siebel Site Portal, see Siebel Life Sciences Portals Guide.

Example Workflow for Setting Up and Making Subject Activity Payments
This section details sample tasks often performed by administrators and end-users 
when setting up and managing subject activity payments, performed by study 
managers and CRAs. Your company may follow a different workflow according to 
its business requirements. The tasks are generally carried out in the order 
presented, although ad hoc payments can be made any time.
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Administrator Procedures
Administrators set up payment amounts in the subject visit template. For more 
information, see “Setting Up Standard Payment Amounts in the Subject Visit 
Template” on page 343.

End-User Procedures
The following list shows tasks end users typically perform when managing subject 
activity payments. These tasks are typically performed in the following order:

1 Adjust payment amounts for individual sites. For more information, see “Setting 
Payment Exceptions for a Site” on page 344.

2 Mark activities completed for payment. For more information, see “Marking 
Subject Activities Completed” on page 345

3 Make final adjustments and generate payments. For more information, see 
“Adjusting Payment Amounts and Generating Payments for Sites” on page 346.

4 Optional: Make ad hoc payments. For more information, see “Generating Ad Hoc 
Payments for Sites” on page 348.

5 Roll up paid amounts. For more information, see “Rolling Up Paid Amounts to the 
Protocol Level” on page 349.
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Administrator Procedures
This section provides instructions for the following task:

■ To set up standard payment amounts for subject activities

Setting Up Standard Payment Amounts in the Subject Visit Template
Payment amounts can be set up when the subject visit template is created (as 
described in “Defining a Subject Visit Template” on page 300) or may be added later 
following the procedure described here. 

Payments at the site level may be entered in any currency. All payment amounts 
made at the site level are converted to the currency designated for the site and rolled 
up into the currency that is designated for the region. If a region is not required, 
payment amounts at the site level are rolled up into the currency that is designated 
for the protocol. 

To set up standard payment amounts for subject activities

1 From the application-level menu, choose View > Site Map > Clinical 
Administration > Visit Templates. 

2 Select the Subject Visit Template and Template Version for which you want to 
add payment amounts. 

3 For each visit and each activity that the sites will be paid for:

a Set the Payment Flag.

If the Payment Flag is not selected, the activity will not appear in the Payment 
Activities view and a payment cannot be generated.

b In the Payment Amount field, use the currency calculator to enter the amount 
and currency code.
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End-User Procedures
This section provides instructions for the following tasks:

■ To set site-specific payment amounts for subject visit activities on page 344

■ To mark subject activities as completed on page 345

■ To make final adjustments to the payment amounts and generate payments on 
page 346

■ To generate an ad hoc payment on page 348

■ To roll up payment amounts for a protocol on page 349

Setting Payment Exceptions for a Site
The amount paid to individual sites for a particular procedure may differ from the 
standard amount set in the subject visit template (“Setting Up Standard Payment 
Amounts in the Subject Visit Template” on page 343), or the currency used at the 
site might differ from the currency used for the standard amount.

The procedure below explains how to use payment exceptions to change the 
standard amount paid for a payment subject activity for an individual site.

Once the payment exception has been set for an activity associated with the given 
site, visit, and template version, each time the activity is generated for a subject the 
activity will show the site-specific amount.

NOTE: When a new subject visit template becomes active, payment exceptions need 
to be set for the new template.

To set site-specific payment amounts for subject visit activities

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to set up payment exceptions. 

3 Click the Payment Exceptions view tab.
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4 In the Payment Exceptions list, add a record.

The Payment Exceptions dialog box filters payment subject activities to show 
only those for the current protocol version. However, you can query from the set 
of all subject payment activities with Payment Flag selected across all versions 
and protocols. This way, you can set payment exceptions for activities in 
protocol version 2 and in protocol version 1, for example, if the site is expected 
to transition to the newer version in the near future.

5 In the Payment Exceptions dialog box, select all activities for which you want to 
set payment exceptions, and click OK.

6 In the Exception Amount fields, enter the new amounts that are to be paid to 
this site for each activity.

TIP: To edit the Exception Amount for multiple activities at once, use the Change 
Records command on the menu button of the Payment Exceptions list.

NOTE: The Exception Amount to be paid at the site level may be in a different 
currency than the currency designated in the subject visit template or for the site. 
When subject activities are created at a site, the currency is converted to the 
currency designated for the site.

Marking Subject Activities Completed
Usually the site personnel will use the Site Portal Web site to enter when subjects 
complete activities. However, this task can also be performed by the CRA using 
Siebel eClinical, as shown in “To mark subject activities as completed.”

To mark subject activities as completed

1 Navigate to the Subjects screen, and select the subject whose activities have 
been completed.

2 Click the Visits view tab.

3 In the Visits list, select the visit that has just been completed.
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4 In the Activities list, click Check All.

This marks the selected visit and all of its activities as completed:

■ The Completed flag is selected.

■ The Completed Date is set to the due date.

■ The Status is set to Done.

5 If necessary, edit fields in the Activities list.

Adjusting Payment Amounts and Generating Payments for Sites
Although payments are generally set on per-site basis (“Setting Payment Exceptions 
for a Site” on page 344), occasionally the CRA may want to make additional 
adjustments to the amount paid for a given payment activity.

Once the CRA has finalized the amounts, payments are generated for all completed 
payment subject activities in the currency specified for the site. Each payment 
record is given a unique identity number. Other information, such as check number, 
check date, and check amount, can be entered later, either manually or by 
importing the data from a back-office finance system.

To make final adjustments to the payment amounts and generate payments

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to generate payments. 

3 Click the Payment Activities view tab.

This view lists all scheduled payment subject activities for subjects associated 
with the site.

4 Optional: Adjust the Actual Amount to be paid to the site by entering a value in 
the Deviation Amount field.

Standard Amount + Deviation Amount = Actual Amount

5 Check Payment Completed and click Generate Payment.

The application removes the completed payments from the Payment Activities 
list.
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6 Click the Payments view tab.

The payment generated in Step 5 appears in the Payments list.

7 Complete the fields in the Payments record.

Some of the fields in a Payments record are described in the following table. 

In a larger organization, an employee in the financial accounts department, 
rather than a CRA, might be responsible for supplying the check number, date, 
and amount. Information may also be automatically loaded from a back-office 
finance system.

8 Click Roll Up in the Payments list.

See “To roll up payment amounts for a protocol” on page 349, Step 1, for more 
information about the Roll Up button.

9 Optional: Click the hyperlink in the Payment # field to view the payment 
activities associated with this payment.

Field Comments

Check Amount The amount for the check. This is usually, but does not need to 
be the same as the Earned Amount. 

The sum of all values in the Check Amount column equals the 
Paid to Date value of the site.

Earned Amount The sum of the Actual Payment amounts for the completed 
payment subject activities.

The sum of all values in the Earned Amount column equals the 
Earned to Date value of the site.

Payment # The application automatically generates this unique number.

Type For payment subject activities, this field defaults to Activity.

The choices in this drop-down list are configured by using the 
PAYMENT_TYPE_CODE type in the List of Values.
Version 7.5, Rev. A Siebel Life Sciences Guide 347



Setting Up and Making Subject Activity Payments

End-User Procedures
Generating Ad Hoc Payments for Sites
Ad hoc payments not associated with subject activities can be created for sites. 

To generate an ad hoc payment

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to generate a payment. 

3 Click the Payment Activities view tab.

4 In the Payment Activities list, add a record, and complete the necessary fields.

Some of the fields in a Payment Activities record are described in the following 
table.

:

5 Click Generate Payment.

The application removes the completed payments from the Payment Activities 
list.

6 Follow Step 6 on page 347 to Step 9 on page 347 to complete the payment.

Field Comments

Activity Type The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values and setting the Parent LIC 
to the General.

Payment This field must be selected.

Completed This field must be selected.

Standard 
Amount

The payment amount.
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Rolling Up Paid Amounts to the Protocol Level
You need to use the Roll Up buttons to update the Paid to Date fields on the Protocol, 
Region, and Sites screens. These fields do not update automatically.

To roll up payment amounts for a protocol

1 Roll up paid and earned amounts for a site:

a Navigate to the Sites Management screen.

b Select a site.

c Click the Payments view tab.

d In the Payments list, click Roll Up.

This updates the Paid to Date and the Earned to Date fields in the Site form.

2 Repeat Step 1 for each site in the region or protocol. 

3 If the site belongs to a region, update the paid amount for the region:

a Navigate to the Regions screen.

b Select the region.

c Click the Payments view tab.

d In the Payments list, click Roll Up.

This updates the Paid to Date field in the Region form and makes any 
currency conversions that are required.

NOTE: When site payments roll up to the region level, the exchange rate is 
determined by the exchange date set at the region level.

4 If there are other regions associated with the protocol, repeat Step 3 for each 
region.
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5 Roll up paid amounts for the protocol.

a Navigate to the Protocols screen.

b Select the protocol.

c Click the Payments view tab.

d In the Payments list, click Roll Up.

This updates the Paid to Date field in the Protocol form and makes any 
currency conversions that are required.

NOTE: When site payments roll up to the protocol level, the exchange rate is 
determined by the exchange date set at the protocol level.
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This chapter describes how to set up and use trip reporting in Siebel eClinical. 

The study managers or clinical administrators can set up templates for trip 
reporting. These templates are then used by the clinical research associates (CRAs) 
when they create trip reports to record their visits to sites. 

Advantages of using the trip reports in Siebel eClinical are:

■ Trip reports are made consistent across the organization and are based on GCP 
(Good Clinical Practice) and SOPs (standard operating procedures)

■ CRAs save time planning trips and writing trip reports

■ Managers save time reviewing trip reports

■ A formatted, tamper-proof report for print or PDF can be generated from the trip 
report record

■ A central repository for all trip reports
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Business Scenario
This scenario is example workflow performed by the clinical administrator and the 
clinical research associates (CRAs). Your company may follow a different workflow 
according to its business requirements. 

The Clinical Administrator
In this scenario, a clinical administrator prepares a set of trip report templates for 
the CRAs to use when preparing for and writing up their visits to clinical sites. 

The clinical administrator decides to prepare four templates, one for each type of 
site trip the CRAs are typically required to perform:

■ Site evaluation. A site visit to evaluate a site’s qualification for a study

■ Site initiation. A site visit to initiate a site

■ Site monitoring. A site visit to monitor study progress, to monitor and retrieve 
case report forms (CRFs)

■ Site close-out. A site visit to close-out or terminate a site at the conclusion of a 
study

The CRAs
The CRA is the end user of the Siebel eClinical product. Before visiting a site, the 
CRA uses the trip report feature to prepare for the visit. The follow-up items list 
reminds the CRA of the open activities arising from previous visits that need to be 
closes. 

After preparing a draft trip report, the CRA makes a hard copy of the report that she 
takes with her on the site visit. She refers to this to help her keep track of the 
activities she carries out while at the site.

On her return from a site visit, the CRA completes her trip report and generates a 
final report. She forwards this report to her manager for approval. After approval, 
she (or her manager) archives the report (an ROI file) as an attachment to the site 
record.
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Example Workflow for Clinical Trip Reports
This section details sample tasks often performed by administrators and end-users 
when administering clinical trip reports. Your company may follow a different 
workflow according to its business requirements.

Administrator Procedure
Administrators create trip report templates. For more information, see “Creating a 
Trip Report Template” on page 354.

End-User Procedures
The following list shows tasks end users typically perform when administering 
clinical trip reports. These tasks are typically performed in the following order:

1 Create trip report record. Before a visit, you can use a trip report template to 
prepare an activities checklist and follow-up items. For more information, see 
“Creating a Trip Report Before a Site Visit” on page 356.

2 Complete, distribute, and archive a trip report. After visiting a site, use the Trip 
Report view to record activities accomplished, site personnel met, and follow-up 
items. For more information, see “Completing a Trip Report After a Site Visit” on 
page 359.
Version 7.5, Rev. A Siebel Life Sciences Guide 353



Administering and Using Clinical Trip Reports

Administrator Procedures
Administrator Procedures
This section provides instructions for the following task:

■ To create a trip report template

Creating a Trip Report Template
Typically, the clinical administrator prepares a number of generic trip report 
templates, perhaps one designed for each of the different stages in the study. (See 
“The Clinical Administrator” on page 352.)

The trip report template is an activity template of type Clinical Trip Report. This is 
one of a number of activity templates used in Siebel eClinical. 

Other activity templates used in Siebel eClinical are subject visit templates 
(“Defining a Subject Visit Template” on page 300), clinical site templates (“Creating 
a Clinical Protocol Site Template” on page 325), and contact assessment templates 
(“Creating an Assessment Template” on page 327).

To create a trip report template

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Templates list, add a record, and complete the necessary fields.

Some of the fields in an Activity Template record are described in the following 
table.

Field Comments

Protocol Title Typically, this field is not used in a trip report template.

This field is used when creating a clinical protocol site 
template. See “To create a clinical protocol site template” 
on page 325.

Type Must be Clinical Trip Report.

Auto Trigger, Public, Sales 
Method, Sales Stage

These fields are not applicable to a Clinical Trip Report.
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3 Click the Activity Template Details view tab.

4 In the Activity Template Details list, add a record, and complete the necessary 
fields to describe an activity for trip or a follow-up item to be carried out after 
the trip.

Some of the fields in an Activity Template Details record are described in the 
following table.

5 Add a record for each of the activities that you want to appear in the template. 

Field Comments

Activity Must be Check List for the activity to appear in the Checklist 
Activities of the Trip Report Detail view.

The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values.

Type The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values and setting the Parent LIC 
to Check List.

Status Leave this field blank, or set it to a value such as planned, not 
started, or auto-created.

The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

Budgeted Cost, 
Cost, Cost Estimate, 
Duration, Lead, 
Units, Priority

Typically, these fields are not used in a clinical trip report.
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End-User Procedures
This section provides instructions for the following tasks:

■ To create a trip report

■ To print or email a trip report on page 358

■ To complete a trip report on page 359

■ To distribute and archive a trip report on page 361

Creating a Trip Report Before a Site Visit
Although a trip report is designed to be written after a site visit, it can be used 
during a site visit to guide the CRA through a list of required activities.

The Trip Reports view contains two lists: 

■ Checklist Activities. Activities in this list can be generated by the trip report 
template or can be added individually.

■ Follow-up Items. These are the activities that need to be followed up later. They 
can be created during the current trip or carried forward from previous trips until 
they are closed. You can create new follow-up items in the Current Trip Follow-
Up Items list. Also you can choose to display all follow-up items for a site, or 
you can filter the list to display only open and recently closed items.

To create a trip report

1 Navigate to the Site Management screen.

2 In the Sites list, select the site for which you want to create the trip report.

3 In the More Info view, click Trip Report.

This creates a new trip record in the Trip Report view and automatically fills in 
some fields as appropriate for the selected site.
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4 Complete or edit other fields in the Trip Report form.

Some of the fields in a Trip Report form are described in the following table. See 
also Step 2 on page 360.

5 In the Template field, select the name of the trip report template that you want 
to apply. 

When you click off the Template field, the activities defined in the template 
appear in the Checklist Activities list. 

If you select a second template, the activities from the second template are 
appended to the activities generated by the first template. For example, you 
would do this if you wanted to combine a site monitoring trip with a site close-
out trip.

Field Comments 

Completed Date Defaults to the current date.

Start Date Defaults to the current date and time.

Owned By This field defaults to the creator of the trip report. Other names 
can be added to indicate a shared trip report.

Type The nature of the trip, for example, prestudy, site initiation, or site 
monitoring. 

The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values and setting the Parent LIC 
to Trip Report.

Visit Name A descriptive name for the trip report.
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6 Optional: Edit the activities in the Checklist Activities list, or add more activities 
to the list.

Some of the fields in a Checklist Activities record are described in the following 
table.

7 If there are follow-up items from previous trips review them:

a In the Current Trip Follow-Up Items list, from the drop-down menu, select All 
Follow-Up Items.

This displays all follow-up issues for that site (open and closed; past, present, 
and future).

b Click Filter. 

This displays all the open-to-date follow-up items and any follow-up items 
that were closed between completed dates of the last trip and the current trip.

To print or email a trip report

1 Navigate to the Trip Report view of the Site Management screen.

a Navigate to the Site Management screen.

b In the Sites list, select the site associated with the trip report.

c Click the Site Visits view tab.

NOTE: Do not click the Trip Report button on the Site Visits list unless you 
want to create a new Trip Report record.

d Click the hyperlink in the Start Date field of the visit. 

The Trip Report view appears.

Field Comments 

Status The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

Suppress 
Calendar

When selected, this field indicates that the activity does not 
appear on the user’s calendar.
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2 From the application-level menu, choose View > Reports.

3 Select and run the Trip Report report. 

This opens the Siebel Report Viewer.

4 Print, email, or save the report.

For more information about the Siebel Report Viewer, see Fundamentals.

Completing a Trip Report After a Site Visit
After the site visit, the end users record details of their trips, such as:

■ Which of the planned activities were completed

■ What additional activities were carried out

■ Which site personnel they met

■ Any follow-up items arising from the trip

The records in the Trip Report Detail view can be updated and edited at any time. 
For this reason, it is likely that the end user will want to create a static report at the 
completion of the trip, using the Siebel Report Viewer. This read-only document is 
ideal for archiving: as a printed document, as a file, or as an attachment to the site 
record in the Siebel Life Sciences database. 

To complete a trip report

1 Navigate to the Trip Report view, and select the trip report that you want to 
complete. 

For details on how to do this, see Step 1 on page 356.
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2 Complete or edit fields in the Trip Report form.

Some of the fields in the Trip Report form are described in the following table. 
See also Step 4 on page 357.

3 In the CheckList list, complete the Status and Comments fields for planned 
activities and add any unplanned activities that you may have carried out.

4 In the Current Trip Follow-Up Items list, add any follow-up activities resulting 
from the site visit. 

5 In the Current Trip Follow-Up Items list, from the drop-down menu, select All 
Follow-Up Items and click Filter to display all open follow-up items and those 
closed between the current and previous trip.

6 Update the records for those follow-up items that were addressed during the site 
visit.

Some of the fields in a Current Trip Follow-Up Items record are described in the 
following table.

Field Comments 

Attendees The contacts (site personnel) whom you met during the visit.

Completed 
Date

It is important to change the default date to the actual date that the trip 
was completed. This is because the Filter button in the All Follow-Up 
Items list uses this completed date to determine which closed follow-
up items to display (Step 7 on page 358).

Field Comments 

Completed 
Date

It is important that this date be filled in. The filter in the All Follow-Up 
Items list uses this date to determine which closed follow-up items to 
display (Step 7 on page 358). 

Status This field automatically changes to Done when a completed date is entered 
for the item. 
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To create a case report form tracking activity

1 Navigate to the Trip Report view.

2 In the Case Report Forms Tracking view, add a record.

3 Click the select button in the Subject Initial field, select a subject and visit in the 
Pick Subject and Visits dialog box, and complete the necessary fields.

Some of the fields in the Case Report Forms Tracking list are described in the 
following table.

To distribute and archive a trip report

1 Follow Step 1 on page 358 to Step 3 on page 359 to create a report in the Siebel 
Report Viewer.

2 From within the Siebel Report Viewer, email the report, for example, to 
colleagues and to a manager for approval.

3 From within the Siebel Report Viewer, save the report as an ROI file, and then 
close the Siebel Report Viewer.

For more information about the Siebel Report Viewer, see Fundamentals.

4 Navigate to the Site Management screen.

5 Click the Attachments view tab.

6 Add the ROI file as an attachment to the site record.

Field Comments

Retrieved This field is checked when the CRA retrieves the case report forms from 
the site.

Source 
Document

This field is checked when the case report form is source documented.

Subject Initial The unique subject-and-visit combination associated to this case report.

Note: Each record in the Pick Subject and Visits dialog box can only be 
used once for a case report.
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This chapter is meant to be used as a supplement to the documentation for Siebel 
Professional Services Automation which is in Siebel Professional Services 
Automation Guide (Projects Management and Microsoft Project Integration 
chapters) and Applications Administration Guide (Professional Services chapter).

Siebel eClinical Projects is designed to help project managers manage clinical trial 
projects. The projects are associated with individual protocols. Timelines, 
milestones, costs, and resources can be entered, viewed, and updated from the 
Projects screen. The Microsoft Project integration feature allows data exchange 
between Siebel eClinical Projects and Microsoft Project. 
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Business Scenario
This scenario is example workflow performed by the administrator and the project 
manager for the clinical trial. Your company may follow a different workflow 
according to its business requirements. 

Project Manager Tasks
The project manager works for a large clinical research organization (CRO) that has 
been awarded a contract to carry out a clinical trial for a pharmaceutical company. 
He is responsible for setting up and running the clinical trial project. 

Setup and Staffing
First the project manager enters some basic information about the project into 
Siebel eClinical. Then he determines which employees should have visibility to the 
project data by entering them in the project access list. 

To optimize the resource assignment, the project manager first enters the resource 
requirements in the team workbook, and then he uses Siebel Assignment Manager 
to help with the staffing. He specifies the roles, skills, competencies, and availability 
required for the team and lets Resource Manager find the best candidate for the 
roles.

For this large project the CRO may need some subcontractors to complete certain 
aspects of the project. Because the subcontractors are paid on an hourly rate, the 
project manager associates the appropriate billing rate list to the project. The project 
manager also needs to add employees of the subcontracting company to the 
subcontractor resource list.

Other external contacts and accounts can also be added to the project. For example, 
information about the central laboratory, and the primary contact at this laboratory 
are added.
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Tasks, Activities, and Risks
Milestones can be set as tasks or activities. The project manager can create them 
within Siebel eClinical Projects or import them from a Microsoft Project file. Each 
Siebel activity has a budget, and the actual costs of these activities are updated as 
the project progresses. Periodically the project manager reviews these project costs, 
making sure that the project is staying within budget. Payments made to sites for 
subject activities are rolled up to the project costs.

Project risks are documented as they arise, as well as the resolution activities to 
address the risks.

Exchanging Data with Microsoft Project
To create a Gantt chart of the project milestones, the project manager exports the 
project data to a Microsoft Project file. 
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Example Workflow for Clinical Projects
This section details sample tasks often performed by administrators and end-users 
when managing clinical projects. Your company may follow a different workflow 
according to its business requirements. 

Administrator Tasks
The following list shows tasks administrators typically perform to manage clinical 
projects. These tasks must occur before the project manager creates the project:

■ Creates various project activity templates. These templates are used by many 
project managers carrying out similar clinical trials. For more information, see 
“Creating a Project Activity Template” on page 368.

■ Maintains the employee profiles of skills and competencies that are used by Siebel 
Assignment Manager. For more information, see “About Setting Up Employee 
Profiles” on page 370.

■ Sets up the position types and rate lists. These are required to allow subcontractors 
(and employees) to bill the project for their time. For more information, see 
“Setting Up Position Types and Rate Lists for Billing” on page 371.

■ Creates or modifies mapping templates for data exchange between the Siebel eClinical 
project and a Microsoft Project file. For more information, see “Mapping Siebel 
Project Fields to Microsoft Project Fields” on page 372.

End-User Procedures
These tasks can be performed only after the administrator has completed the 
required preparatory work described in the previous topic, “Administrator 
Procedures.” These tasks may be carried out according to your company’s business 
needs: 

■ Create a project record. For more information, see “Creating a Project” on 
page 377.

■ Give employees access to the project; add contacts and accounts to the project’s team 
workbook. For more information, see “Associating People and Accounts with 
Projects” on page 378.
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■ Create activities and tasks. For more information, see “Adding Activities and 
Tasks to a Project” on page 380.

■ Review project costs. For more information, see “Monitoring Project Costs” on 
page 381.

■ Document project risks and resolution activities. For more information, see 
“Managing Risk” on page 382.

■ Export project data to an MS Project file. For more information, see “About 
Exchanging Project Data with Microsoft Project” on page 384.
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Administrator Procedures
This section provides instructions for the following tasks:

■ To create a project activity template on page 369

■ To add position types as products on page 371

■ To create a rate list on page 371

■ To create a mapping template on page 372

This section also provides information about setting up employee profiles for use in 
Siebel Assignment Manager. (See “About Setting Up Employee Profiles” on 
page 370.)

About Administrator Procedures
The procedures that an administrator needs to carry out in support of projects 
depends upon which features of the Projects will be used by the organization. You 
may not need to perform all the procedures listed here.

Creating a Project Activity Template
Activities can be created both within (Siebel) Projects screen and within Microsoft 
Project. If the study managers are primarily entering activities through the Projects 
screen, then creating project activity templates will be advantageous. If study 
managers are primary importing activities from Microsoft Project file, then project 
activity templates need not be created.

Typically, the administrator prepares a number of project templates, perhaps each 
designed for a different stage in the life of a study.

The project is an activity template of type “Project.” Other activity templates used 
in Siebel eClinical are subject visit templates (“Defining a Subject Visit Template” 
on page 300), clinical site templates (“Creating a Clinical Protocol Site Template” on 
page 325), trip report templates (“Creating a Trip Report Template” on page 354), 
and contact assessment templates (“Creating an Assessment Template” on 
page 327).
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To create a project activity template

1 From the application-level menu, choose View > Site Map > Application 
Administration > Activity Templates.

2 In the Activity Templates list, add a record, and complete the necessary fields.

Some of the fields in an Activity Templates record are described in the following 
table.

3 Click the Activity Template Details view tab.

4 In the Activity Template Details list, add a record, and complete the necessary 
fields to describe an activity or milestone for the project.

Some of the fields in a Activity Template Details record are described in the 
following table.

Field Comments

Auto Trigger, Public, Sales 
Method, Sales Stage

Typically, these fields are not used in a project activity 
template.

Protocol Title This field is optional. A project activity template can be 
applied to any project, regardless of the protocol 
associated with the project.

Type Must be Project.

Field Comments

Activity The value of this field determines the values available in the 
Type field. 

The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List Values.

Budgeted Cost Enter the budget for the activity.

Cost If this field is selected, the Cost field will be editable in the 
generated activity. If the Cost flag is not selected, then any value 
in the Cost field in the generated activity is read-only.
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5 Add a record for each activity that you want to appear in the template.

About Setting Up Employee Profiles
The end user may use Siebel Assignment Manager to automatically search the 
employee database for the available employees whose skills best fit the needs of the 
project. Siebel Assignment Manager requires that profiles of skills and competencies 
be set up for employees. 

For information on using Siebel Assignment Manager, see Siebel Assignment 
Manager Administration Guide.

Use of Siebel Assignment Manager is not required. The end user can assign team 
members directly into the Team Workbook view, without using Siebel Assignment 
Manager.

Cost Estimate This field is usually left blank.

A value entered here appears in the Actual Cost field of the 
generated activity. 

Lead The lead time plus the planned start date of the activity plan 
determine the planned start date of the activity.

Priority Use this field to set a priority ranking, such as 2-High, for the 
activity.

Status Leave this field blank, or set it to a value such as planned, not 
started, or auto-created.

The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

Type The choices in this drop-down list are configured by using the 
TODO_TYPE type in the List of Values and setting the Parent LIC 
to the activity type.

Units Units for lead time.

Field Comments
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Setting Up Position Types and Rate Lists for Billing
If project team members are to bill their time to the project through the Team 
Workbook view, position types and rate lists should be set. 

Position types, such as consultant, are set up as products and flagged as resources. 
Lists of hourly rates for the position types are then set up. When the rate list is 
applied to the project, the hourly rates for the team members are automatically 
supplied in the team workbook. 

For more information about position types and rate lists for Professional Services, 
see Applications Administration Guide.

To add position types as products

1 From the application-level menu, choose View > Site Map > Product 
Administration.

2 In the Products list, add a record, and complete the necessary fields.

Some of the fields in a Products record are described in the following table.

To create a rate list

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Rate Lists.

2 In the Rate Lists list, add a record, and complete the necessary fields.

3 In the Rate Lists list, drill down on the Rate List hyperlink.

4 In the Rate List Line Items list, add a record.

5 In the Add Position Types dialog box, select the Position Type and click OK.

This list of resources has been created as a product. 

Field Comments

Product A product (resource) name, for example, Consultant.

Project Resource Check this field.
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6 In the Rate List Line Items list, complete the remaining fields.

Mapping Siebel Project Fields to Microsoft Project Fields
If you want to exchange data between your project in the Siebel eClinical and an 
MPP file in Microsoft Project, you may need to set up mapping templates to define 
which Microsoft Project fields correspond to which Siebel eClinical project fields. 

Some mapping templates have already been defined for you in the Project Mappings 
view of the Data Administration. However, you may want to create a new mapping 
template, or copy and modify an existing one.

For more information, see about Microsoft Project Field Mappings for Professional 
Services in Applications Administration Guide.

To create a mapping template

1 From the application-level menu, choose View > Site Map > Data 
Administration > Project Mappings.

2 In the Project Mappings list, add a record, and complete the necessary fields.

3 In the Mapping Categories list, add a record and, from the Category drop-down 
list, select a mapping category.

4 In the Category Fields list, add a record.

5 From the Microsoft Project Field Name drop-down list, select a field name.

6 In the Siebel Field Name field, enter the business component field name that will 
map to the Microsoft Project field. 

NOTE: Continue to add information in the Mapping Categories list, and Category 
Fields list until the mapping template is complete.
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End-User Procedures
This section provides instructions for the following tasks:

■ To create a project on page 377

■ To add employees to a project on page 378

■ To add a contact to a project using the Organization Analysis view on page 379

■ To add a partner account to a project on page 379

■ To add an activity to a project using a project activity template on page 380

■ To create a task and associate activities to it on page 381

■ To view costs associated with a project on page 382

■ To add a risk and resolution activities to a project on page 382

This section also provides information about Microsoft Project integration. (See 
“About Exchanging Project Data with Microsoft Project” on page 384.)
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About the Projects Screen
There are many views in the Projects screen for the standard Siebel eClinical 
application. Many implementations may choose to use only a subset of these views. 
Refer to Table 15 for a brief description of each of the views that are available in the 
Projects screen. 

Table 15. Views in the Projects Screen

View Comments

Access Use this view to provide project visibility. Add the names of the 
project team members and also managers or executives who want 
visibility to monitor the progress of the project. The Access view has 
a similar function to the Team field in other screens.

Activities This view lists activities associated with the project. Activities in this 
view may have been created manually or by project activity 
templates. Activities belonging to tasks do not appear in this view.

Depending on the mapping template used, activities may be tasks 
and summary tasks imported from Microsoft Project. 

Activity Plans Use this view to generate activities from project activity templates. 
Additional activities can be added manually to the activities already 
associated with an activity plan.

Agreements Use this view to create and store subcontractor agreements. See the 
Project Contact Management chapter in Siebel Professional Services 
Automation Guide.

Attachments Attach project documents in this view. For general information about 
attachments, see Fundamentals.

Calendar This view shows a monthly calendar of the activities associated with 
the project. Activities belonging to tasks and standalone activities 
appear in this view. For general information about the calendar 
views, see Fundamentals.

Charts Various analysis charts for backlog, cost, fees, revenue, and type can 
be plotted from this view.

Contacts Use this view to maintain a list of contacts associated with the 
project. Enter names of employees in subcontracting or partner 
organizations. 
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Costs This view shows budgeted and actual costs for the project: including 
costs associated with standalone activities and with tasks, and 
payments made to the sites or investigators for subject activities. 

Clinical Contacts Use this view instead of the Contacts and the Subcontractors views. 
The view contains two lists: one for contacts and one for accounts. 
Contacts entered in this view do not appear in the Organizational 
Analysis view.

Financial Profile Use this view to gain an overall perspective of a project’s financial 
information, status, and progress. Use this view to change the 
Delivery status for the project (green, yellow or red). For more 
information, see Siebel Professional Services Automation Guide.

Invoices Use this view to create invoices for time and expenses logged against 
a project. For more information, see Siebel Professional Services 
Automation Guide.

Notes Use this view to keep private and public notes about the project. For 
general information about the Notes view, see Fundamentals.

Orders Use this view to create a product or material order and associate it 
with the project. For more information, see Siebel Professional 
Services Automation Guide.

Organizational 
Analysis

This view displays an organizational chart of contacts, showing the 
relationships between them. 

Partners Use this view to maintain a list of partner accounts associated with 
the project.

Use this view to keep a list of accounts associated with the project, 
such as vendors who handle printing of the clinical trial materials or 
the shipping of sample drugs. 

Because the Partners, Subcontractors, and Clinical Contacts views 
contain account information, depending on your business process, 
you may use one or more of these views to keep track of accounts 
associated with project. 

Plan Integration Use this view to exchange data between the Siebel eClinical project 
and Microsoft Project. For more information, see about Microsoft 
Project integration in Siebel Professional Services Automation Guide.

Table 15. Views in the Projects Screen

View Comments
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Revenues Use this view to associate multiple types of revenue with a project 
and to chart revenues. For more information, see Siebel Professional 
Services Automation Guide.

Risks Use this view to maintain a list of the risks associated with the project 
and resolution activities required to address those risks.

Service Requests Use this view to create a service request and associate it with the 
project. For more information, see Siebel Professional Services 
Automation Guide.

Status Report Use this view to create a status report summarizing the project’s 
progress, forecast, and issues. For more information, see Siebel 
Professional Services Automation Guide.

Subcontractors Use this view to keep a list of subcontractors associated with the 
project. (Also see “Clinical Contacts” on page 375 and “Partners” on 
page 375 in this table.)

Task Use this view to create and modify tasks for the project. Depending 
on the mapping template used, tasks may be tasks and summary 
tasks imported from Microsoft Project.

Team Workbook Use this view to assign team members to roles in the project. This can 
be done manually or it can be done automatically using Siebel 
Assignment Manager. Team members must be listed in the workbook 
before they can be assigned to activities.

Time & Expense Use this view to adjust and summarize time sheets and expense 
reports associated with the project. For more information, see about 
time sheets and expense reporting in Siebel Professional Services 
Automation Guide.

Table 15. Views in the Projects Screen

View Comments
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Creating a Project
The first step is to create the project record and to associate a protocol with the 
project. 

NOTE: It is recommended that only one project be associated with a protocol. 
However, the application does not prevent the association of a protocol to multiple 
projects. In this case, costs associated with payments to sites are rolled up to each 
project.

To create a project

1 Navigate to the Projects screen.

2 From the Show drop-down list, select My Projects.

3 In the Projects list, add a record.

a Enter the Start date and End date for the project.

b Associate a protocol with the project.

c Complete the remaining fields as necessary.

Some of the fields in a Project record are described in the following table.

Field Comments

Account For example, enter the name of the pharmaceutical company 
for whom this project is being carried out.

Actual Cost This field is calculated by summing the actual costs of all the 
tasks, activities, and site payments associated with the 
project.

Budgeted Cost This field is calculated by summing the budgeted costs of all 
the tasks, activities, and site payments associated with the 
project.

Currency This field displays the currency in which all costs are 
evaluated.

Project # A unique identification number for the project.
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Associating People and Accounts with Projects
Employees. Employees in Siebel eClinical can be given access to the project and 
added to the team workbook. 

Contacts. Contacts can be associated with projects through the Contacts view, the 
Organizational Analysis view, and the Clinical Contacts view. The same contacts 
appear in the Contacts view and the Organizational Analysis view. 

Accounts. Accounts can be associated with projects through the Partners view, the 
Subcontractors view and the Clinical Contacts view. Adding accounts to the 
Subcontractors view allows you to add employees from the subcontracting accounts 
to the project’s team workbook. (For more information about adding 
subcontractors, see Siebel Professional Services Automation Guide.)

To add employees to a project

1 Give employees visibility to a project by adding them to the Access view. 

For more information about providing access to a project, see Siebel Professional 
Services Automation Guide.

2 Allow employees and subcontractors to be assigned to activities and to bill time 
to the project by adding them to the Team Workbook view. 

If a rate list has been set up, make sure that the Resource field on the Resource 
Detail form of the Team Workbook view is set for the team members.

For more information about the team workbook for projects management, see 
Siebel Professional Services Automation Guide.

Protocol # All protocols in the database can be selected from this drop-
down menu. The creator of the project is not required to be 
a member of the protocol team.

Rate List If a rate list has been set up for the project team members, 
enter it in this field. Use the more button if this field is not 
visible. (See “Setting Up Position Types and Rate Lists for 
Billing” on page 371.)

Field Comments
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To add a contact to a project using the Organization Analysis view

1 Navigate to the Projects screen.

2 Select a project.

3 Click the Organization Analysis view tab.

4 From the Organization Analysis drop-down list, select Contacts. 

5 In the Contacts list, add a record, and complete the necessary fields.

6 From the Contacts drop-down list, select Organization Analysis. 

An organization chart of the contacts appears. Any employee-manager 
relationships set in Step 5 are indicated. 

To add a partner account to a project

1 Navigate to the Projects screen.

2 Select a project.

3 Click the Partners view tab.

4 In the Partners list, add a record, and complete the necessary fields.

Some of the fields in a Partners record are described in the following table.

Field Comments

Account Type The choices in this drop-down list are configured by using the 
ACCOUNT_TYPE type in the List of Values.

Role The choices in this drop-down list are configured by using the 
PROJECT_PARTNER_ROLE type in the List of Values.

Site This is the account site, a unique identifier for the account. It is 
not related to the sites where clinical trials are carried out.
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Adding Activities and Tasks to a Project
Activities can be added to the project in a variety of ways:

■ Enter activities in the Activities view.

■ Generate activities in the Activity Plan view by applying a project activity 
template. (See “To add an activity to a project using a project activity template” 
on page 380.)

■ Enter activities manually in the Activity Plan view. These activities must be 
associated with an activity plan based on a template.

■ Create a task in the Task view and associate activities with the task. (See “To 
create a task and associate activities to it” on page 381.)

■ Import activities from a Microsoft Project file (See “About Exchanging Project 
Data with Microsoft Project” on page 384.)

A task is a container for activities. Activities associated with tasks are different from 
regular standalone activities. Activities that belong to tasks cannot be generated by 
project activity templates. They can only be created manually from within the 
Project Task Activity view. A standalone activity cannot be added to a task, nor can 
a task activity be disassociated from the task.

Activities imported from Microsoft Project can be either standalone activities or task 
activities, depending upon how the mapping template has been set up. 

For more information, see about creating activities and tasks for projects 
management in Siebel Professional Services Automation Guide.

To add an activity to a project using a project activity template

1 Navigate to the Projects screen.

2 In the Projects list, select the project with which the activities will be associated.

3 Click the Activity Plans view tab.

4 In the Activity Plans list, add a record.
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5 In the Template field, select a template from the drop-down list.

The activities associated with the activity plan appear in the Activities list 
subview.

NOTE: Activities can also be added manually to the Activities view.

To create a task and associate activities to it

1 Navigate to the Projects screen.

2 In the Projects list, select the project with which the tasks will be associated.

3 Click the Tasks view tab.

4 In the Tasks list, add a record, and complete the necessary fields.

5 In the Tasks list, drill down on the Name hyperlink.

6 In the Activities list, add a record, and complete the necessary fields.

Monitoring Project Costs
The Cost view provides the end user with a valuable summary of all costs 
associated with a particular project and protocol.

The cost items are displayed in three lists:

■ Project Activities. Displays those activities from the Activities view where the 
Cost field is selected.

■ Project Tasks. Displays those tasks from the Tasks view where the Cost field for 
the task is selected. The actual cost and budgeted cost for a task are determined 
by summing the costs of the activities contained in the task.

■ Clinical Payments. Displays payments made to the sites associated with the 
protocol. These payment amounts are rolled up into the actual cost field in the 
Project form.
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End users cannot add, modify, or delete records in this view. 

NOTE: All costs in this view are in the default currency set for the project.

To view costs associated with a project

1 Navigate to the Projects screen.

2 In the Projects list, select the project for which you want to view costs. 

3 Click the Costs view tab.

4 Click a hyperlink in the Clinical Payments or Project Tasks list to see the 
activities associated with a cost item. 

Managing Risk
An important aspect of project management is risk management. The features of the 
Risks view allow the end user to enter information about project risks and create 
and assign resolution activities to address the risks. 

For more information, about assessing risks for projects management, see Siebel 
Professional Services Automation Guide.

To add a risk and resolution activities to a project

1 Navigate to the Projects screen.

2 In the Projects list, select the project to which the risks will be associated.

3 Click the Risks view tab.
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4 In the Risks list, add a record, and complete the necessary fields.

Some of the fields in a Risks record are described in the following table.

5 In the Risks list, drill down on the Name hyperlink.

6 In the Resolution Activities list, add a record, and complete the necessary fields. 

Some of the fields in a Resolution Activities record are described in the following 
table.

Field Comments

Priority The choices in this drop-down list are configured by using the 
PS_RISK_PRIORITY type in the List of Values.

Severity The choices in this drop-down list are configured by using the 
PS_RISK_SEVERITY type in the List of Values.

Type The choices in this drop-down list are configured by using the 
PS_RISK_TYPE type in the List of Values.

Field Comments

Priority The choices in this drop-down list are configured by using the 
ACTIVITY_PRIORITY type in the List of Values.

Status The choices in this drop-down list are configured by using the 
EVENT_STATUS type in the List of Values.

Type The choices in this drop-down list are configured by using the type in the 
TODO_TYPE List of Values.
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About Exchanging Project Data with Microsoft Project
Resource, task, and summary task information from Microsoft Project data can be 
exchanged with Siebel eClinical Project. Some standard mapping templates are 
provided with Siebel eClinical, and the administrator can create additional mapping 
templates (see “Mapping Siebel Project Fields to Microsoft Project Fields” on 
page 372).

Table 16 shows how features in Siebel eClinical Project map to features in Microsoft 
Project.

CAUTION: Microsoft Project dependencies are not exchanged. To maintain 
dependencies in your Microsoft Project file, do not export your project from Siebel 
eClinical to Microsoft Project. 

Export filters can be applied to restrict data exported from Siebel eClinical to 
Microsoft Project.

For information about Microsoft Project integration and how to exchange data 
between an MPP file and a Siebel eClinical project, see Siebel Professional Services 
Automation Guide.

Table 16. Mapping Between Siebel eClinical Project and Microsoft Project

Siebel eClinical Project Microsoft Project

Roles in the Team Workbook view Resources

Activities in the Activities view, 

or

Tasks in the Tasks view

Summary Tasks

Activities in the Activities view, 

or

Tasks in the Tasks view

Tasks
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Consistent product and price list information allows your company to sell its 
products. This chapter describes how to manage product information and pricing 
structures by setting up and defining products, product lines, product features, and 
price lists. 

Using the procedures given in this chapter, you will be able to perform the 
administrator tasks of defining products (both internal and external) and entering 
information about promotional items, competitive products, markets (therapeutic 
classes), and compounds under clinical trial. End users use the Products views to 
view product information and enter product change requests.

For more information on the differences between administrator and end-user tasks, 
see “Business Scenario” on page 387.
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How Siebel Life Sciences Stores Product Information
Siebel Life Sciences provides two different tables for storing product information: 

■ An internal product table (S_PROD_INT)

■ An external product table (S_PROD_EXT) 

These tables supply data used in various chart views, such as those in the Analysis 
screen. 

About the Internal Product Table
The internal product table (S_PROD_INT) is used primarily for proprietary product 
data, including products that are detailed or distributed as samples or promotional 
items by sales representatives. The administrator can categorize products according 
to product level, therapeutic class, and product type as well as define market 
categories, such as an antibiotics market. For more information on entering 
products in the internal product table, see “Defining Internal Products” on page 391.

NOTE: After you enter a product into the internal product table, you cannot delete it. 
However, you can prevent it from appearing in drop-down lists and dialog boxes by 
making it inactive. For more information, see the procedure “To make a product 
inactive” on page 397.

About the External Product Table
The external product table (S_PROD_EXT) is used for syndicated data from content 
providers, and for any additional data the administrator chooses to enter about 
competitive or complementary products. Check with your content provider for 
information on the product identifiers they use. For more information on loading 
syndicated data, see Chapter 19, “Importing Data.”

Products entered in the external product table can also be entered in the internal 
product table. However, for any product that is entered in both tables, make sure 
that the product name and other product identifiers match exactly in both tables. 

For more information on entering products in the external product table, see 
“Defining External Products” on page 389.
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Business Scenario
This section outlines an example workflow performed by a Siebel Products 
administrator and end users. Your company may follow a different workflow 
according to its business requirements.

A pharmaceutical company has a new product to bring to market. To make the new 
product available to sales representatives in the field, the administrator defines the 
new product within the system, adds a price list, and then associates the new 
product with the price list. Finally, he adds new background information (called 
decision issues) that the Home Office wants to communicate to the field. Sales 
representatives use Siebel Products to view product information and enter change 
requests.
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Example Workflow for Managing Products
This section details sample tasks often performed by administrators and end-users 
when managing products. In this scenario, the administrator is responsible for 
setting up Siebel Products so that end users can view product information. Your 
company may follow a different workflow according to its business requirements. 

Administrator Procedures
The following list shows tasks administrators typically perform to set up product 
information:

■ Add a new product (called an internal product) to Siebel Products. For more 
information, see “Defining Internal Products” on page 391.

■ Define product features and set up any product literature. Administrators enter 
additional product details including key features, information on related 
products, product comparison data, and associate literature. For more 
information, see “Specifying Additional Product Information” on page 398.

■ Add any competitive and complementary products (called external products) to Siebel 
Products. For more information, see “Defining External Products” on page 389.

■ Add products to catalogs. For more information, see “Adding Products to 
Catalogs” on page 406.

■ Define a price list and then associate it with the new product. For more information, 
see “Defining Price Lists” on page 400.

■ Define decision issues. For more information, see “Defining Decision Issues” on 
page 405.

End-User Procedures
The following list shows tasks end users typically perform when viewing product 
information:

■ View product information. For more information, see “Viewing Product 
Information” on page 407

■ Enter product change requests. For more information, see “Adding a Product 
Change Request” on page 408.
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The following administrator procedures are described in this section:

■ To add an external product on page 390

■ To add an internal product or a market on page 395

■ To make a product inactive on page 397

■ To specify additional product features on page 398

■ To add information on related products on page 398

■ To associate related literature on page 398

■ To add product comparison information on page 399

■ To add a price list on page 400

■ To associate a price list with a product on page 401

■ To define company features on page 402

■ To define product features on page 402

■ To enter competitor comparison information on page 403

■ To add a decision issue on page 405

■ To add a product or lot number to a catalog on page 406

Defining External Products 
Use the External Products view to manage information about competitive and 
complementary products and to associate those products with the companies that 
produce them.
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Siebel Life Sciences stores the information you enter in the External Products view 
in the external product table (S_PROD_EXT). In addition, it also displays this 
information in the Competitor Comparison Administration view. For more 
information on the internal and external product tables, see “How Siebel Life 
Sciences Stores Product Information” on page 386.

NOTE: Make sure that the product information you specify in the External Products 
view matches exactly the information specified for the same product in the Products 
view. For more information, see “Defining Internal Products” on page 391. 

To add an external product 

1 From the application-level menu, choose View > Site Map > Application 
Administration > External Products.

2 In the External Products list, add a record and complete the necessary fields. 

Some of the fields in an External Products record are described in the following 
table.

 

Field Comments

Competitor Indicates whether or not the company specified in the Vendor field 
is a competitor. For more information on how to create account 
records, see “Specifying a Competitor” on page 187. 

Product If the product is also entered in the internal product table, the name 
entered here must match the name entered in the Product 
Administration view. For more information, see “Defining Internal 
Products” on page 391. 

Product Type Specifies whether the product is competitive or complementary.

Vendor The manufacturer of this product. 
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Defining Internal Products
Use the Product Administration view to enter and update information about your 
company’s internal products, promotional items, competitive products, markets 
(therapeutic classes), and compounds under clinical trial. Siebel Life Sciences stores 
the information entered in this view in the internal product table (S_PROD_INT). 
For more information, see “How Siebel Life Sciences Stores Product Information” 
on page 386.

To create a new internal product, you create a new record in the Product 
Administration view. In creating a new internal product you specify:

■ Product categorization settings. Use the values described in Table 17 to categorize 
new products, or create market (therapeutic class) records.

■ Samples and promotional items settings. Use the values described in Table 18 on 
page 393 to define samples and promotional items.

NOTE: If you plan on tracking your samples inventory or samples disbursements 
using lot numbers, create lot numbers for samples. For more information, see 
“Defining Lot Numbers” on page 148.

Product Categorization Settings
You categorize products or create market (therapeutic class) records using the 
Product Administration field values described in Table 17.

 

Table 17. Recommended Product Categorization Settings

Record Type

Product 
Level 
Field Type Field 

Inventory 
Field

Orderable 
Field 

Sales 
Product 
Field 

Sales 
Service 
Field 

Market (therapeutic class) 1 Market Null Null Null Null

Detailed product.

Product associated with call 
details, meetings, formularies, 
objectives, or opportunities

2 Detail Null Null Selected Null
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About Samples and Promotional Items Settings 
FDA regulations stipulate that samples disbursements must be tracked by lot 
number. However, it is not required that the actual samples inventory be tracked by 
lot number. Using Table 18 on page 393:

■ Locate a product type and description that matches the product you are creating. 

Competitive product.

For more information, see 
“About the External Product 
Table” on page 386.

2 Competitor Null Null Null Null

Sample products disbursed on 
contact calls or account calls *

3 Sample Null if 
tracking by 
lot number

Selected if 
tracking by 
product 
name

Selected Selected Null

Promotional item disbursed on 
contact calls or account calls *

5 Promotion
al Item

Selected 
(if desired)

Selected Null Null

Equipment, medical, or 
surgical devices

Null Null Null Selected Selected Null

Services Null Null Null Selected Selected Selected

Product configuration models Null Null Null Selected Selected Null

Product available for clinical 
trial 

Null Compound Selected 
(if desired)

Null Null Null

* If the product will be tracked by lot number, you must specify additional settings, as described in “About 
Samples and Promotional Items Settings” on page 392.

Table 17. Recommended Product Categorization Settings

Record Type

Product 
Level 
Field Type Field 

Inventory 
Field

Orderable 
Field 

Sales 
Product 
Field 

Sales 
Service 
Field 
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■ Configure the Inventory, Lot # Tracking, and Inventory by Lot fields using the 
values described in the last three columns.

For more information on defining lot numbers, see “Defining Lot Numbers” on 
page 148.

Table 18. Sample and Promotional Items Settings

Product Type Description

Inventory Field 
(Product 
Administration 
View)

Lot # Tracking 
Field 
(Product 
Administration 
View)

Inventory by Lot 
Field 
(Lot Setup View)

Samples Full tracking by lot number: 

■ Samples disbursements tracked 
by lot number

■ Samples inventory tracked by lot 
number

No tracking by product name. 

Null Selected Selected

Samples Partial tracking by lot number:

■ Samples disbursements tracked 
by lot number

■ Samples inventory not tracked 
by lot number

No tracking by product name. 

Null Selected Null

Samples Full tracking by product name: 

■ Samples disbursements tracked 
by product name

■ Samples inventory tracked by 
product name

No lot number tracking.

Selected Null Null

Samples Partial tracking by product name:

■ Samples disbursements tracked 
by product name

■ Samples inventory not tracked 
by product name

No lot number tracking.

Null Null Null
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Promotional-
items

Full tracking by product name:

■ Promotional-items 
disbursements tracked by 
product name

■ Promotional-items inventory 
tracked by product name

Selected Null Null

Promotional-
items

Partial tracking by product name:

■ Promotional-items 
disbursements tracked by 
product name

■ Promotional-items inventory not 
tracked by product name

Null Null Null

Table 18. Sample and Promotional Items Settings

Product Type Description

Inventory Field 
(Product 
Administration 
View)

Lot # Tracking 
Field 
(Product 
Administration 
View)

Inventory by Lot 
Field 
(Lot Setup View)
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To add an internal product or a market 

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, add a record and complete the necessary fields. 

Some fields are described in the following table.

Field Comments

Name The name of the product, promotional item, or market (therapeutic 
class). 

If this product also exists in the external product table, this name must 
match the product name in the External Product Administration view. For 
more information, see “Defining External Products” on page 389. 

If this product will be tracked in inventory, either by product name or by 
lot number, include both the product name and the dosage (for example, 
Axis 2mg).

Part # The part number of this product. If a product image will be displayed on 
a Web site created with Siebel Life Sciences portals, do not include spaces 
or special characters in the part number. 

Type The type of product being added. For the recommended settings, see 
Table 17 on page 391. 

If this product also exists in the external product table, select Competitor 
so that the products will match up correctly. 
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3 In the More Info form, click the show more button and complete the necessary 
fields. 

Some fields are described in the following table.

Field Comments

Lot # Tracking Applies only to products that will be disbursed as samples. 
Select this field if the product will be tracked by lot number, 
either for purposes of disbursement tracking or for inventory 
tracking. If you select this field:

■ You must define lot numbers for the product as described in 
Table 18 on page 393.
For more information on defining lot numbers, see “Defining 
Lot Numbers” on page 148.

■ You should not check the Inventory field. This field is read-
only if the Samples Lots Enabled system preference is set to 
FALSE. 

Inventory Applies to products that will be tracked in inventory by product 
name rather than by lot number. If you check this field, you 
should not check the Lot # Tracking field. 

For more information, see Table 17 on page 391 and then 
Table 18 on page 393.

Orderable Select this field for any product or service that may be included 
in a samples order or in a sales order. For more information, see 
Table 17 on page 391.

Parent Product The parent product of this product within the product hierarchy. 
Products that will be disbursed as samples should have a parent 
product. A parent product may be a market (therapeutic class). 

Product Level Enter the appropriate value according to your product hierarchy. 
For the recommended setting, see Table 17 on page 391. 

If this product also exists in the external product table, enter 2 
so that the products will be matched up correctly. 

Therapeutic Class The therapeutic class (or market) of the product. There is no 
functionality associated with this drop-down list. Market type 
(or therapeutic class) functionality is tied to the Parent Product 
field; a new market is added by creating a new record in the 
Products view and setting the Type field to Market.
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For more information on specifying additional product information, see “Specifying 
Additional Product Information” on page 398. 

To make a product inactive

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, select the product that you want to make inactive. 

3 In the Products form, click the show more button and clear the following fields:

■ Product Level

■ Type 

■ Lot # Tracking

■ Inventory 

■ Orderable

■ Sales Product 

After end users synchronize with the server, they will not see the product in any 
drop-down list or dialog box. However, they will see the product listed in views that 
display products.

Sales Product Check this field (and the Orderable field) for any product or 
service that your company actually sells (and will therefore be 
included in a sales order). For more information, see Table 17 on 
page 391.

UoM Unit of measure; that is, the measure by which the product is 
sold or marketed.

WAC Wholesaler average cost; that is, the average wholesale cost of 
the product.

Field Comments
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Specifying Additional Product Information
You can specify additional product information in the Product Administration view 
by selecting the product in the Products list and then making selections from the 
lower Show drop-down list. Using these subviews you can specify additional 
product features or associate product literature, other related products, and product 
comparison information. 

To specify additional product features

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, select a product. 

3 From the lower Show drop-down list, select Product Key Features.

An expanded Product form appears.

4 Scroll down to the Feature list, add a record, and enter a description.

To associate related literature

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, select a product. 

3 From the lower Show drop-down list, select Product Literature.

4 Scroll down to the Product Literature list and add a record.

5 In the Add Literature dialog box, select one or more records and click OK.

The selected records are added to the Literature list.

Repeat Step 4 and Step 5 to add other related literature.For more information on 
adding other selections to the Add Literature dialog box, see the chapter on 
literature administration in Applications Administration Guide. 

To add information on related products

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.
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2 In the Products list, select a product. 

3 From the lower Show drop-down list, select Related Products.

4 Scroll down to the Related Products list and add a record.

5 In the Add Internal Products dialog box, select one or more products and 
click OK. 

Repeat Step 4 and Step 5 to add other related products. For more information on 
adding on other selections to the Add Internal Products dialog box, see To add an 
internal product or a market on page 395.

To add product comparison information

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, select a product. 

3 From the lower Show drop-down list, select Product Comparison.

4 Scroll down to the Product Comparison list and add a record.

5 In the Add Product Comparisons dialog box, select one or more products and 
click OK. 

The products are added to the Product Comparison list.

Repeat Step 4 and Step 5 to add other related products to the Related Products list.
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Defining Price Lists
You can use the Price List views to create and maintain an unlimited number of 
price lists for your products. Using these views, you can:

■ Add and update price lists

■ Define and update price list names and descriptions

■ Create new records based on existing price lists

■ Associate products with price lists

■ Enter pricing information (such as effective date, terms, and shipping 
information)

To add a price list 

1 From the application-level menu, choose View > Site Map > Pricing 
Administration > Price List.

2 In the Price Lists, More Info form, add a record and complete the necessary 
fields.

Some fields are described in the following table.

 

Field Comments

Currency The currency for this price list. The values that appear in the 
Pick Currency Code dialog box are defined in the Application 
Administration, Currency view.

Name The name for the price list.

Payment Terms The payment terms of the price list. The values that appear in 
the Pick Payment Terms dialog box are defined in the 
Application Administration, Payment Term view. 

Shipping Method The shipping method for products associated with this price list. 
The values that appear in the Shipping Method drop-down list 
are defined in the list of values for FS_CARRIER.

Shipping Terms The shipping terms for products associated with this price list. 
The values that appear in the Freight Terms drop-down list are 
defined in the list of values for FREIGHT_TERMS. 
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3 Click the Price List Line Items view tab. 

4 In the Price List Line Items list, add a record and complete the necessary fields.

The products that appear in the Name field and the Add Internal Products dialog 
box are defined in the Product Administration view. For more information, see 
“Defining Internal Products” on page 391.

To associate a price list with a product

1 From the application-level menu, choose View > Site Map > Product 
Administration > Product Administration.

2 In the Products list, select a product. 

3 From the lower Show drop-down list, select Price Lists.

4 Scroll down to the Product List list and add a record.

5 In the Add Price Lists dialog box, select one or more price lists and click OK. 

The price lists are added to the Price Lists list.

Repeat Step 4 and Step 5 to associate other products with the appropriate price lists. 
For more information on adding other selections to the Add Price Lists dialog box, 
see “To add a price list” on page 400. 

NOTE: You can also associate images with products so that the images appear in the 
Products. For more information, see the chapter on basic product administration in 
Product Administration Guide.
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Managing Competitor Information
Effective sales and marketing requires that your company have up-to-date and 
consistent information about the competitive landscape. This section describes how 
to administer information about competitors and competitive products. 

Tracking competitor information in Siebel Life Sciences involves the following 
steps:

■ Adding account records for competitors and selecting the Competitor field. For 
more information, see “Specifying a Competitor” on page 187.

■ Adding records for competitors’ products. For more information, see “Defining 
External Products” on page 389.

■ Adding comparative and competitive literature files to the application. For more 
information, see the chapter on literature administration in Applications 
Administration Guide.

To administer competitor information you must: 

■ Define company features and product features that can be used to compare your 
company and its products with those of your competitors. For more information, 
see the procedures “To define company features” on page 402 and “To define 
product features” on page 402.

■ Enter information about competitive products, product and company 
comparisons, and competitive and comparative literature. For more information, 
see the procedure “To enter competitor comparison information” on page 403. 

To define company features

1 From the application-level menu, choose View > Site Map > Data 
Administration > Company Features. 

2 In the Company Features list, add a record and complete the necessary fields.

Repeat Step 2 to define additional company features.

To define product features

1 From the application-level menu, choose View > Site Map > Product Features 
Administration > Product Features Administration. 
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2 In the Product Feature list, add a record and complete the necessary fields.

Some of the fields in a Product Features record are described in the following 
table.

 

To enter competitor comparison information

1 From the application-level menu, choose View > Site Map > Data 
Administration > Competitor. 

The Competitors list appears.

This list displays every account flagged as a competitor. Note that the 
Competitor Flag field is checked for every record. For more information on 
adding competitors, see “Specifying a Competitor” on page 187.

2 In the Competitors list:

■ Select a competitor.

■ Optionally, enter the competitor’s World Wide Web address (URL) in the 
Home Page field. 

3 Click the Competitor Comparisons view tab.

Field Comments

Feature The product comparison criterion; for example, Once a Day 
Formulation. 

Description A description of the feature, if necessary.
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4 In the Competitor Comparisons list, add a record and complete the necessary 
fields.

Some fields are described in the following table.

5 Optional: Click the Competing Product Comparison view tab, add a record, and 
complete the necessary fields.

6 Optional: Click the Literature view tab:

■ Add a record in the Competitor’s Literature list and complete the necessary 
fields.

■ Add a record in the Comparative Literature list and complete the necessary 
fields.

7 Optional: Click the Product Literature view tab, add a record in the Product 
Literature list, and complete the necessary fields.

8 Optional: Click the Product Literature view tab and select a product in the 
Product Literature list:

■ In the Competitor’s Product Literature list, add a record and complete the 
necessary fields.

■ In the Comparative Product Literature list, add a record and complete the 
necessary fields.

For information on these fields, see the chapter on literature administration in 
Applications Administration Guide. 

Field Comments

Feature The features listed in the Add Competitive Company Features dialog 
box are defined in the Company Feature Administration view. For more 
information on adding company features, see “To define company 
features” on page 402. 

Rank Enter the numeric rank of the feature as defined by your business 
process. 
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Defining Decision Issues
Contacts often raise important issues during a call. Decision issues are the 
objections a contact may raise when evaluating a product prior to making a 
prescribing decision. Often these objections are related to the efficacy of the 
product, its pharmacological properties, the recommended dosage, its safety profile, 
drug interactions, competitor’s claims, product availability, price and generic 
substitution. 

Using the Data Administration, Decision Issues view, you can:

■ Add and edit decision issues within the application

■ Enter explanations about specific decision issues and provide instructions to 
representatives in the field on how to discuss them

■ Associate literature and related issues with decision issues

Sales representatives can then use this information to prepare for calls on contacts 
and accounts. They can also associate decision issues with particular calls, 
indicating which issues are of concern to particular contacts. 

NOTE: Before you can use the procedures described in this section, you must first add 
product literature as described in Applications Administration Guide.

To add a decision issue

1 From the application-level menu, choose View > Site Map > Data 
Administration > Decision Issues.

2 In the More Info form, add a record and complete the necessary fields.

3 To specify another related issue, click the Related Issues view tab.

4 In the Related Issues list, add a record.

The Add Related Issues dialog box appears.

5 Select one or more issues and click OK.

The application adds the selected issues to the Related Issues list. 
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6 From the application-level menu, choose View > Site Map > Catalog 
Administration > Categories.

7 Select a category to which you want to assign a decision.

8 Click the Decision Issues tab view.

9 Add new records to associate decision issues to categories.

For more information on adding literature and attachments to decision issues, see 
Applications Administration Guide. 

Adding Products to Catalogs
Products are added to categories within a catalog. Starting with Siebel Life Sciences 
version 7.0.3, products—including samples and promotional items—and lot 
numbers need to be associated with catalogs to determine drop-down list visibility. 
Access groups are assigned to a catalog to control visibility to users. For more 
information about access groups, see Security Guide for Siebel eBusiness 
Applications.

To add a product or lot number to a catalog

1 From the application-level menu, choose View > Site Map > Catalog 
Administration.

2 Add a record and complete the necessary fields.

3 Drill down on the hyperlink in the Name field.

4 In the Categories list add a record.

5 Use the buttons on the Categories list to create subcategories.

6 Click the Products view tab.

7 Add a record to the products list for each product or lot number you want to add 
to the category.
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End-User Procedures
The following end-user procedures are described in this section:

■ To view product information

■ To add a product change request record on page 408

NOTE: Your responsibilities determine whether you have access to the All Products 
view or the All Products across Organizations view. The procedures that reference 
the All Products view can also be performed using the All Products across 
Organizations view. The view you select sets the context for the content within the 
view. 

Viewing Product Information
The views in the Products screen allow end users to view lists of products and 
obtain information such as prices, key features, and product defects. The Siebel 
administrator is responsible for entering information on products, product issues, 
price lists, and other information displayed in the Products views. For more 
information, see “Administrator Procedures” on page 389.

To view product information

1 Navigate to the Products screen.

2 From the Show drop-down list, select All Products.

3 In the Products list, select a product. 

4 Click a view tab. 

NOTE: To view hidden view tabs, scroll to the right.
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Adding a Product Change Request
End users who receive information about a product change request that has not 
already been entered in the system, can add a product change request.

To add a product change request record

1 Navigate to the Products screen.

2 From the Show drop-down list, select All Products.

3 In the Products list, select a product.

4 Click the Change Requests view tab.

5 In the Change Requests list, add a record.

6 In the Add Change Request dialog box, click New.

The application adds a new record to the Change Requests list.

7 In the Change Requests list:

■ Enter a description in the Summary field.

■ Select the type of request in the Type field.

■ Drill down on the Change Request hyperlink.

The Change Request form appears.

8 In the Change Request form, complete the necessary fields. 

To return to the Product Change Request list, click the back button to the right of 
History.
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In this chapter, you will learn how to import data into your Siebel Life Sciences 
database.

About Data
There are two general categories of data: proprietary data and syndicated data. 
These two types of data possess different characteristics and should generally be 
loaded into Siebel base tables using different processes.

NOTE: Loading data directly into Siebel base tables is not supported. Because of the 
complexity of table relationships and Mobile Web Client requirements, and the risk 
of loss of data integrity, Siebel Enterprise Integration Manager (EIM) must be used 
to import data into Siebel base tables. Do not attempt to modify data directly in the 
physical tables. 

■ Proprietary data. This is data that resides in an existing database and must be 
imported into the Siebel Life Sciences database during initial implementation or 
on an ongoing basis. 

For proprietary data, Siebel eBusiness Application Integration (eAI) is used. 
Siebel Enterprise Integration Manager, one method of eAI, is a subsystem in the 
Siebel Life Sciences software that manages the exchange of data between Siebel 
Life Sciences database tables and other corporate databases. It includes a 
number of data integrity features, such as generation of foreign-key references 
and case adjustment. 
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■ Syndicated data. This is read-only data about sales, Rx, and profitability that is 
provided periodically by third-party vendors. Once delivered, this data must be 
loaded into the Siebel Life Sciences database and made available to users in a 
timely fashion. Although you can use Siebel EIM (with transaction logging 
turned off) to import syndicated data, direct loading with a database utility (such 
as SQL* Loader) is faster for importing the large volumes of syndicated data 
typically loaded by pharmaceutical companies.

The Siebel Life Sciences views and business components that require data 
import, and the data values for those views, are shown in Table 22 on page 433.
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Business Scenario
This scenario is an example of the tasks performed by the database administrator, 
the application administrator, and the sales representatives. Your company may 
follow a different sequence according to its business requirements. 

The database administrator (DBA) transfers company data into the Siebel Life 
Sciences interface data tables. The Siebel EIM transfers the data to the Siebel Life 
Sciences base tables.

Later, the DBA receives syndicated data from a data provider (for example, IMS 
Health) and transfers this data to a staging table.

The application administrator uses administrative views to map EIM_SYND_DATA 
fields to S_SYND_DATA, to load the data from the staging table into the application 
base tables.

After loading a syndicated data update, the application administrator extracts 
portions of the data according to territory assignment and sends a compressed 
version of the data extracts to mobile users in the field.

The sales representatives download the data extracts and import them into their 
local databases. Using the imported data in the Analysis views, they can evaluate 
their performance and determine where to focus their sales activities.
Version 7.5, Rev. A Siebel Life Sciences Guide 411



Importing Data

Administrator Procedures
Administrator Procedures
This section provides instructions for the following tasks for database and 
application administrators. The tasks are usually performed in the following order:

1 Import data using Siebel EIM 

2 Import syndicated data

3 Extract syndicated data

4 Route the imported data to users

Importing Data with Siebel EIM
Siebel EIM manages the exchange of data between Siebel database tables and other 
corporate databases. This section provides information specific to Siebel Life 
Sciences and supersedes information in Siebel Enterprise Integration Manager 
Administration Guide. For general information on Siebel EIM, read Siebel Enterprise 
Integration Manager Administration Guide.

Stages of the Data Import Process
The data import process with Siebel EIM uses two stages, as shown in Figure 12 on 
page 413. 

1 The data is first copied from external data tapes (or other provided media) into 
the interface tables for the Siebel Industry Application (SIA), using a native 
database data-loading utility (such as SQL* Loader). 

For information about the interface tables and their relationships to base tables 
in the Siebel application database, read “Data and Related Interface Tables” on 
page 415. For further details on Siebel Industry Application interface tables, such 
as the contents of each table, read Interface Tables Reference for Siebel Industry 
Applications.
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2 Using EIM, you transfer the data from the interface tables to predefined 
destination columns in the base tables of the Siebel Life Sciences database. The 
EIM process uses a configuration file (default.ifb). 

For general information about default.ifb and instructions on using Siebel 
EIM, read Siebel Enterprise Integration Manager Administration Guide.

 

Recommended Import Order
To correctly establish the relationships between dependent data elements, the data 
should be imported in the order recommended below. In general, reference data 
such as therapeutic classes, competitive metrics, and competitive issues should be 
imported first, followed by employee and product data (internal products, external 
products, and medical specialties), followed by contacts data. Syndicated data 
should be loaded last.

The following list shows the recommended import order for all data types specific 
to Siebel Life Sciences.

1 Reference data (therapeutic classes, competitive metrics, and so on)

2 Employees

3 Broadcast messages

4 Products (both internal and external)

5 Leads

6 Medical specialties

7 Insurance plans

8 Accounts

Figure 12. Process Flow From an External Database to the SIA Database
Version 7.5, Rev. A Siebel Life Sciences Guide 413



Importing Data

Administrator Procedures
9 Opportunities

10 Formularies

11 Contacts

12 Contact ratings and rankings

13 Quotes

14 Documents

15 Proposal templates

16 Forecasts

17 Fulfillment data

18 Call lists

19 Objectives

20 Marketing campaigns

21 Product consumption

22 Service requests

23 Product defects

24 Activities and appointments

25 Notes

26 File attachments

27 Syndicated data
414 Siebel Life Sciences Guide Version 7.5, Rev. A



Importing Data

Administrator Procedures
Data and Related Interface Tables
The process for importing syndicated data takes advantage of the fact that 
syndicated data is read-only. Because the row ID on the S_SYND_DATA table is 
never referred to anywhere else in the Siebel data model, it can be populated with 
dummy values that differ from usual row IDs. The application administrator uses 
SQL*Loader to populate the ID field with a unique sequential value, a process 
which provides either full or partial table-level extraction. Using views in the 
Syndicated Data Administration screen, you can define complex routing rules for 
syndicated data.

Table 19 shows the relationships between the data, interface tables, and base tables.

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description

Account Details EIM_ACCNT_DTL S_ORG_EXT Organization

S_ORG_EXT_LSX 1:1 Extension table for Account 
Types

S_ORG_EXT_X 1:1 Account Best Times to Visit

Activities EIM_ACTIVITY S_EVT_ACT Activities

EIM_ACTIVITY1 S_EVT_ACT Activities Only User Key

S_ACT_SIGN Signatures

EIM_ACTIVITY2 S_EVT_ACT Activities Only User Key

S_ACT_PRDINT Activity Products

S_ACT_ISS Activity Issues

S_ACT_PROD_ISS Issues for Activity Products

Addresses EIM_ADDR_ORG S_ADDR_ORG Account Addresses including 
Bricks
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Agreements and 
Contracts

EIM_AGREEMENT S_DOC_AGREE Agreements and Contracts

EIM_AGREE_LS S_DOC_AGREE Contracts

S_AGREE_PAY Contract Payments

EIM__ENTLMNT S_ENTLMNT Entitlements and Contract Price 
Group

S_ENTLMNT_ITEM Price Group Products

S_ENTLMNT_FEE Nonproduct Fees

S_ENTLMNT_ITEM_FEE Product Fee Price Group

Brick EIM_AREA_LS S_AREA_LS Bricks

Chat and 
Discussions

EIM_DISCN_LS S_TOPIC_LS Chat/Discussion Topics

S_TOPIC_CON_LS Chat User Registration

S_MESG_BRD_LS Message Board

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description
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Clinical EIM_CL_ACT_LS S_EVT_ACT Clinical Activity Columns

EIM_CL_DSGN_LS S_CL_DSGN_LS Clinical Designs

EIM_CL_PGM_LS S_CL_PGM_LS Clinical Programs

S_CL_PGM_ATT_LS Clinical Program Attachments

S_CL_PGM_APP_LS Clinical Program Applications

EIM_CL_PTCL_LS S_CL_PTCL_LS Clinical Protocols

S_CL_PTCL_LSXM 1:M Protocol Extension Table

S_CL_PTL_ATT_LS Clinical Protocol Attachments

S_CL_PTL_POS_LS Clinical Protocol Positions

S_CPTCL_DSGN_LS Clinical Protocol Designs

EIM_CL_SUBJ_LS S_CL_SUBJ_LS Clinical Subjects

S_CL_SUBJ_ST_LS Clinical Subject Status

S_CL_SJ_CSNT_LS Clinical Subject Consent

S_CL_SBJ_ATT_LS Clinical Subject Attachments

EIM_PTL_SITE_LS S_PTCL_SITE_LS Clinical Protocol Sites

S_PTL_ST_POS_LS Clinical Protocol Site Positions

S_PTL_ST_ATT_LS Clinical Protocol Site Attachments

S_PTL_ST_CON_LS Clinical Protocol Site Contacts

S_PS_STMPVER_LS Clinical Protocol Site Template 
Versions

S_CL_ACT_EXC_LS Clinical Protocol Site Activity 
Exceptions

S_CL_PYMNT_LS Clinical Payments

EIM_SBJ_TMPL_LS S_SUBJ_TMPL_LS Subject Templates

S_SBJTMP_VER_LS Subject Template Versions

EIM_TMPL_PLNITM Subject Template Visits

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description
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Companies EIM_ACCOUNT S_ORG_EXT Organization

S_ACCNT_POSTN Position for Account

S_ADDR_ORG Account Addresses

S_ORG_REL Account Affiliations

EIM_ACCOUNT1 S_ORG_EXT Organization Only User Key

S_ACCNT_CLS_RNK Account Ratings and Rankings

S_ACCNT_MED_PROC Account Medical Procedures

S_ACCNT_MED_SPEC Account Medical Specialties

Contacts EIM_CONTACT S_CONTACT Contacts

S_ADDR_PER Contact Addresses

S_CONTACT_REL Contact Affiliations

S_PER_ORG_UNIT Contact to Account Affiliations and 
Roles

S_STATE_LIC_LS Contact State Licenses

EIM_CONTACT1 S_CONTACT Contacts Only User Key

S_POSTN_CON Contact Positions

S_CON_ADDR Contact Address Usage

EIM_CON_DTL S_CONTACT Contacts Only User Key

S_CONTACT_LSX 1:1 Contacts Extension Table

S_CONTACT_LSXM 1:M Contacts Extension Table

Formularies EIM_FRMULRY_LS S_FORMULARY Formulary Opportunities

S_FRMULRY_PROD Formulary Products

Industry EIM_INDUSTRY S_INDUST Account and Contact Types

Insurance Plans EIM_INS_PLAN_LS S_INS_PLAN Insurance Plans

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description
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Medical Education EIM_ME_EVT_LS S_ME_EVT_LS MedEd Events

S_ME_EVT_POS_LS MedEd Event Positions

S_ME_EVT_PRD_LS MedEd Event Products

S_ME_EVT_INV_LS MedEd Event Invitees

EIM_ME_PLN_LS S_ME_PLN_LS MedEd Plans

S_ME_PLN_MDF_LS MedEd Plan Funds

S_ME_PLN_PRD_LS MedEd Plan Products

EIM_ME_SES_LS S_ME_SES_LS MedEd Sessions

S_ME_SES_PRD_LS MedEd Session Products

S_ME_SES_INV_LS MedEd Session Invitees

S_ME_SES_LIT_LS MedEd Session Literature

S_ME_SES_MAT_LS MedEd Session Materials

Medical Procedures EIM_PROC_LS S_MED_PROC Medical Procedures

Medical Specialties EIM_SPEC_LS S_MED_SPEC Medical Specialties

Objectives EIM_ACCT_SRC S_ACCNT_SRC Target Accounts for Objectives

EIM_CONTACT2 S_CONTACT Contacts Only User Key

S_CAMP_CON Target Contacts for Objective

EIM_SRC S_SRC Objectives

S_SRC_POSTN Objective Positions

Products EIM_PROD_INT S_PROD_INT Products-Details, Samples, 
Markets, Lots, and Promotional 
Items

EIM_PROD_INT1 S_PROD_INT Products

S_PROD_POSTN Personal Product List

S_PROD_REL Product Relations

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description
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For further information, see Interface Tables Reference for Siebel Industry 
Applications. That book lists the contents of each table referred to in Table 19 on 
page 415: 

■ Specific data and file attachments that Siebel EIM can process.

■ Names of the interface tables.

■ Target base tables mapped to the interface tables.

■ Any secondary tables associated with the target tables (where data from the 
interface tables might ultimately reside).

Samples EIM_SAMPLE_LS S_SAMPLE_TXN Sample Transactions

S_MPL_TXN_ITEM Sample Transaction Item

EIM_POSITION S_POSTN Positions

S_STOCK_POSTN Stock Inventory by Position

S_STOCK_PERIOD Stock Period

Signature 
Disclaimers

EIM_SIGNDIC_LS S_SIGN_DISC_LS Signature Disclaimers

Syndicated Data EIM_SYN_DATA_LS S_SYND_DATA Syndicated Data

Table 19. Data and Related Interface Tables

Data Interface Table Base Table Table Description
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Importing, Extracting, and Routing Syndicated Data
The process described here for importing syndicated data takes advantage of the 
fact that syndicated data is read-only. Because the row ID on the S_SYND_DATA 
table is never referred to anywhere else in the Siebel data model, it can be populated 
with dummy values that differ from usual row IDs. The application administrator 
uses SQL*Loader to populate the ID field with a unique sequential value, a process 
which allows either full or partial table-level extraction. Using views in the 
Syndicated Data Administration screen, you can define complex routing rules for 
syndicated data.

NOTE: Routing rules are used by Siebel Remote and Replication Manager to 
determine what data and transactions are routed to mobile client databases and 
regional databases. For more information on routing rules, see Siebel Remote and 
Replication Manager Administration Guide and Security Guide for Siebel eBusiness 
Applications.

The views that require syndicated data import are shown in Table 22 on page 433.

The general steps for loading syndicated data and distributing it to mobile users are: 

1 Load the data into the base tables of the Siebel Life Sciences database.

If you choose to use EIM to load the data, turn off transaction logging.

2 Extract the data required by mobile users. 

3 Transfer the extracted data files to mobile users.

Loading Data into the Siebel Life Sciences Database
Before you can view syndicated data in Siebel Applications, you must first populate 
the foreign keys fields in the S_SYND_DATA table. These keys are populated from 
the sales representative (POSITION_ID), territory (TERR_ID), product group 
(MARKET_ID), product (PROD_ID), contact (CON_ID), area (AREA_ID), and 
period (PERIOD_ID) fields. Each of these is a key to a record in another Siebel 
application table. Therefore, these fields need to be populated with valid row IDs 
for the corresponding position, territory, product group, product, and period 
business components.
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To load syndicated data, the application must have the row IDs for the foreign key 
data that is stored in the S_SYND_DATA table. The data files used to load syndicated 
data are supplied in a format in which any key information is supplied as a textual 
description. This means that unless EIM is used to load the data, the textual 
descriptions need to be converted into their Siebel application table row ID 
equivalents.

Different data types need to be supplied to make a record visible in S_SYND_DATA. 
The only compulsory foreign key field is the PERIOD_ID. However, there is a unique 
index on the table that comprises all of the foreign key fields: S_SYND_DATA_U1. 
Table 20 lists all of the foreign keys fields, their foreign key table, and a description 
of what the field contains for Siebel Life Sciences.

Use a native data loader (recommended method) such as SQL*Loader in Oracle or 
BCP in SQL Server. For the purposes of example, Oracle is used as the target 
database, although the technique applies equally to SQL Server. Alternatively, you 
can use Visual Basic and Com.

Table 20. Foreign Key Fields in Syndicated Data Loading

Field Table Description

AREA_ID S_AREA_LS Brick/Mini Brick Id 

CON_ID S_CONTACT Contact for this sales data

MARKET_ID S_PROD_INT Product Group

OU_EXT_ID S_ORG_EXT Account

PERIOD_ID S_PERIOD Period

PLAN_ID S_INS_PLAN Plan

POSITION_ID S_POSTN Person who owns the data (for example, a sales 
representative)

PRDINT_ID S_PROD_INT Product

TERR_ID S_ASSN_GRP Territory
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Using SQL*Loader to Load the Data
Data records in Siebel applications do not refer to the row ID field in the 
S_SYND_DATA table. You can insert any value in this field if it is unique in the 
record. Therefore, you can use a native database utility to populate this table. This 
method discusses the use of the Oracle SQL*Loader utility. As with the Visual Basic 
and COM method, using SQL*Loader requires that you resolve the foreign key 
references either before or after the data has been loaded into the table.

To use SQL*Loader to load the data

1 Resolve the foreign keys before loading.

Process the input file one line at a time and convert each foreign key value into 
a row ID. To save time, first load the data directly into the table as it is stored in 
the flat file, then update the foreign key fields using SQL statements.

2 Load the data file using a .ctl format file. 

The following is an example of loading a data file:

options (rows=100)
load data
infile 'c:\myfile.txt'
badfile 'c:\myfile.bad'
append
into table S_SYND_DATA
fields terminated by ","
trailing nullcols
(ROW_ID SEQUENCE (MAX,1),
CREATED SYSDATE, CREATED_BY CONSTANT "1-0",
LAST_UPD SYSDATE, LAST_UPD_BY CONSTANT "1-0",
MODIFICATION_NUM CONSTANT 0,
CONFLICT_ID CONSTANT "0",
POSITION_ID, TERR_ID,
PERIOD_ID, DATA_SRC_CD CONSTANT "RXTer",
MARKET_ID, PRDINT_ID, ATTRIB_01)

3 Run the SQL*Loader utility from the command line using the following syntax:
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SQLLDR73.EXE database/userid@pw control=c:\my.ctl 
log=c:\my.log

NOTE: The exact file name and syntax of the Loader utility is determined by the 
version of Oracle being used.

4 When the data has been loaded, resolve the foreign key references for each field. 
This step makes the data visible to the users, as in the following example.

UPDATE s_synd_data
FROM s_period p
SET s_synd_data.period_id=p.id
WHERE p.name=s_synd_data.period_id ;

This code updates the Period field in the Syndicated Data Table to the ID of the 
Period rather than to the textual description of the period. You must modify and run 
this code for each foreign key field referred to in Table 20 on page 422. The code 
only needs to be run for each field that you load, not for all of the fields.

Alternative Method: Using Visual Basic and COM to Load the Data
Use Visual Basic and the Siebel COM interface to retrieve the Siebel table row ID 
information by searching for the field that contains the text and return the ID field.

Summary Records
Sales forces are frequently hierarchically organized, with a sales representative 
being the lowest level of the hierarchy, rising through various managerial levels. It 
is possible that someone at the top of the hierarchy needs to see all of the syndicated 
data in the system. This may be practical if the particular user is connected to the 
database. However, if the managerial levels are remote users, they will have 
visibility on a very large number of records; their synchronization times will be 
extremely long.

A solution to this problem is to store summary records in the S_SYND_DATA table. 
Summary records are totals of the sales data for territory, region, division, and other 
groupings, stored with a type flag in an extension column that indicates the level of 
summarization is being stored. The summary records can be created by SQL scripts 
or with a database package such as Microsoft Access. They can be loaded using the 
two methods described in the previous sections.
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In addition to loading summary records, you also must configure the table using 
Siebel Tools, to make sure that a manager-level user sees only summary records, 
rather than detail records, on the sales data views. Using this technique, you can 
also implement drill-down functionality for connected managers so that they can 
start at top level data and work down. For more information, see Siebel Tools 
Reference.

Extracting Data for Mobile Users
Once the data is in the database, it needs to be made visible to the users. The data 
is visible by position and can be viewed on many chart and analysis views in Siebel 
Life Sciences. This is fine for connected users, but the typical user of such data will 
be the sales rep or sales manager of a particular territory, who are likely to be 
remote users, synchronizing with the database using Siebel Remote. Therefore, the 
data needs to be extracted from the database.

The application administrator extracts syndicated data according to data-routing 
(visibility) rules that the administrator defines. When you do this, a full export-
process audit trail is generated through log files. You can run multiple instances of 
the extraction process on each Siebel Server to maximize hardware capacity. The 
resulting output files are written in a compressed form and then zipped again to 
minimize file transfer time.

NOTE: You will need to work with Siebel Technical Services when you perform this 
procedure the first time.

The general steps for data extraction are:

1 Create a data extraction rule.

2 Associate the necessary nodes of mobile users with the rule.

3 Define the portion of the data you want to extract and specify whether any 
truncation or deletions should be performed on the extracted data. 

4 Set the environment by running the siebenv.bat file at the command prompt 
under the Siebel Server bin directory.

5 Run the Syndexp.exe executable file to perform the extraction.
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These general steps are detailed in the following procedures.

To create a data extraction rule

1 From the application-level menu, choose View > Site Map > Syndicated Data 
Administration > Export Rules. 

2 Click to select the Rules list and add a record. 

3 Complete the fields described in the following table. 

You can create multiple rules for different types of extractions. For example, you 
could create one rule for Rx data and another rule for Outlet Level data. You can 
also extract data by multiple criteria (for example, sales force or position).

The WHERE part of a SQL SELECT statement specifies the rows of the 
S_SYND_DATA table that should be exported. In most cases, this WHERE clause is

WHERE T.POSITION_ID = [Position Id]

When you specify the users to extract, it will match their position ID to the position 
ID on the syndicated data table and extract only the data that is visible to them.

To associate nodes with an extract rule

1 In the Syndicated Data Export Rules view, select the correct extract rule. 

If a different view is currently displayed, navigate to Data Administration > 
Export Rules and select the appropriate rule. 

2 Click in the Nodes list and add a record. 

Field Comments

Name Required. A descriptive name for the rule.

Outfile Id Required. Enter a unique, three-character ID. This ID will be used as 
the name of a temporary data file created by the extraction process.

Active If the rule is not active, it will not be processed by the extraction 
process.
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3 Complete the fields. Some fields are described in the following table. 

To specify the data that is routed to mobile users

1 In the Syndicated Data Export Rules view, select the correct extract rule. 

If a different view is currently displayed, navigate to Data Administration > 
Export Rules and select the appropriate rule. 

2 Click in the Tables list and add a record. 

Field Comments

Name You can select multiple nodes in the Add Nodes dialog box.

Group Code A code used for the grouping of nodes within the same extraction 
rule. You can specify the Group Cd value as an argument for the 
extraction process that is run with the Syndexp.exe executable file. 
With this group code, multiple Syndexp.exe processes can be run 
for the same extraction rule on the same Siebel Server.

Node Type Code An attribute column for the nodes, used to identify the remote 
nodes. (The Syndexp.exe process services only remote nodes.)

Active Only nodes specified as active will be processed.
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3 Complete the fields. The fields are described in the following table. 

4 In the Syndicated Data Administration screen, from the Show drop-down list, 
select SQL Statements.

5 Click in the Pre SQL Statements list and add a record. 

Field Comments

Table Name Required. Generally, this value should be S_SYND_DATA. The 
exception to this general rule is if you have created an extension 
table or if you are using another table to store syndicated data.

Where String Enter a string that defines the data to be extracted. Generally, these 
strings use standard SQL WHERE statements to build the extraction 
scripts. In addition to using static column values and column names 
to specify the data to be extracted, you can use two case-sensitive 
variables, [Position Id] and [Employee Id]. 

An example WHERE string definition that uses the Position Id 
variable is provided below. This example extracts data where the 
position ID in the syndicated data is equal to the position ID of the 
user. 

Example:

WHERE T.POSITION_ID = [Position Id]

A second example, provided below, extracts data for all positions 
assigned to an employee. Note that <TableOwner> in the example 
should be replaced with the appropriate Siebel database TableOwner 
value.

Example:

WHERE EXISTS (SELECT 1 FROM 
<TableOwner>.S_EMP_POSTN R WHERE T.POSITION_ID = 
R.POSITION_ID AND R.EMP_ED = [Employee Id])

Sequence Enter a numeric value that defines the order in which tables will be 
extracted.

Active Only tables specified as active will be processed.
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6 Complete the fields described in the following table. 

You can refresh the entire syndicated data table, or you can refresh only certain 
specified data periods. 

NOTE: Do not use the TRUNCATE TABLE function. Use the DELETE function 
instead.

To set the environment 

1 In a DOS window, navigate to the siebel_server\BIN directory.

2 Run the siebenv.bat file. 

CAUTION: If you do not run siebenv.bat, you may encounter the following error 
message: “Unable to start common api. Error in DATAExpStartApis function.”

3 Set the environment variables.

NOTE: Syndexp.exe will not detect nodes in a clustered environment successfully 
unless you manually set CLUSTER_NETWORK_NAME in either siebenv.bat or 
syndexp.bat.

Field Comments

SQL Text This SQL statement cleans up the data in the remote database in 
preparation for importing newer data, by deleting the existing data that 
will be replaced by newer data. If the entire syndicated data table will 
be extracted, the table should be truncated. If the latest month’s data 
will be extracted, then the most aged month’s data should be deleted. 

Comments Optional description of statement’s purpose; for example, describe the 
portion of the data you want to extract.

Sequence Enter a numeric value that defines the order in which SQL statements 
will be executed.

Active Only statements specified as active will be processed.
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Refer to the command line arguments listed in Table 21 for multiple variables 
that are specific to the user environment. For more information on administering 
data extracts, see Siebel Remote and Replication Manager Administration Guide.

Table 21. Command Line Arguments for Environment Variables 

Argument and Meaning Comment

/A Create Attachment Default: Y

/C ODBC Data Source Default Environment Variable: 
SIEBEL_DATA_SOURCE

/D Siebel Table Owner Required

/E Extract Rule Name Required

/F File Server Directory Default Environment Variable: SIEBEL_FSRV_ROOT

/G Group Code Required

/L Log File Default: syndexp.log

/N Repository Name Default Environment Variable: 
SIEBEL_REPOSITORY

/P Password Required

/Q Log FreQuency Default: -1

/R Read Consistency Default: N

/S Use Sequence Number Default: N

/T Data File Type Default: compressed

/U Username Required

/V AppServer name Required

/X Appserver Home Directory Default Environment Variable: SIEBEL_HOME
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To perform the data extraction

1 In the siebel_server\BIN directory, run the Syndexp.exe executable file.

Use the command line arguments listed in Table 21 on page 430 to define 
multiple variables that are specific to the user environment. For example:

syndexp /U sadmin /P sadmin /D phdemo /E “Rule One” /C 
siebsrvr_siebel

NOTE: Interruption of the extraction process at any point causes the system to fail 
and necessitates restarting the data extraction from the beginning.

2 If an interruption occurs, you must go into the Pharma Node Attachment 
Administration view (View > Site Map > Syndicated Data Files) and delete the 
previously generated data files. You also must go into each node and delete the 
latest file that was created in the previous run. 

After the program executes the Syndicated Data Loading (SDL) process, it 
displays the name of the user whose data is being extracted. This process 
continues until it has completed the extraction process for each user defined in 
the Syndicated Data Export Rules. 

3 After you successfully complete the extraction process, you may want to create 
a batch file for use with subsequent extractions. 

The extracted files are output in a compressed form to minimize file transfer time. 
Files are transferred using Siebel Remote, which is described in Siebel Remote and 
Replication Manager Administration Guide. After mobile users receive their 
extracted files, they must import the data into their local databases.

Full and Partial Data Extracts
Because syndicated data loading does not use EIM to maintain synchronization 
between the server and the remote databases, you must force a resynchronization 
step at the end of each direct load. Force resynchronization either by re-extracting 
an entirely new remote database for each mobile user or by performing a partial 
extract that includes only the refreshed syndicated data. A new, full database extract 
creates a database snapshot file for a given mobile user. A partial extract contains 
only S_SYND_DATA table data.
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Some users receive syndicated data updates once a week, while some may receive 
syndicated data updates monthly or quarterly. Therefore, partial extract is preferred.

Possible Data Loss
Sometimes remote users connect to Siebel Server using unstable dial-up 
connections that prevent the data file from being transferred correctly, so that the 
data file does not reach the remote server. Siebel Server does not verify that the data 
file reached its destination successfully. At the end of the transfer step, Siebel Server 
removes the data file from the server.

In the case in which a data file is lost and removed from the server, you must extract 
a new data file for users.

CAUTION: The loss of data or files may occur without warning. You might not be able 
to automatically determine the success or failure of a particular transfer. As a result, 
sales representatives may be using incorrect data for up to several months without 
realizing it.

Troubleshooting Syndicated Data Loading
If the Siebel application client session freezes or terminates during a syndicated data 
file import, do the following procedure.

To fix a session freeze or termination

1 In a DOS window, navigate to the siebel_server\FS folder.

2 Copy S_NODE_ATTxxx.SAF (containing S_NODE_ATTxxxx.dat) to 
CLIENT\LOCAL\FILES.

3 Navigate to the CLIENT\LOCAL\FILES folder.

4 Delete S_NODE_ATTxxxx.dat.

5 Restart the Life Sciences client.

6 Click Import.
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Views Requiring Syndicated Data Import
This section lists the Siebel Life Sciences views and business components that 
require data import and indicates which data values should be loaded into the 
syndicated data table. 

Table 22 lists the views that require data import.

 

Table 22. Views and Business Components Requiring Data Import

Screen View Business Component

Accounts Charts > Sales Pharma Sales Consumption

Charts > Profitability Pharma Consumption
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Analysis Direct Sales Trend by Territory - Volume Pharma GA Sales Consumption

Direct Sales Trend by Account - Volume Pharma GA Sales Consumption

Indirect Sales Trend by Territory - Volume Pharma GA Sales Consumption

Indirect Sales Trend by Territory - Share Pharma GA Sales Consumption

Indirect Sales Trend by Zip - Volume Pharma GA Sales Consumption

Indirect Sales Trend by Zip - Share Pharma GA Sales Consumption

Indirect Sales Trend by Brick - Volume Pharma GA Sales Consumption

Indirect Sales Trend by Brick - Share Pharma GA Sales Consumption

Indirect Sales Trend by Account - Volume Pharma GA Sales Consumption

Indirect Sales Trend by Account - Share Pharma GA Sales Consumption

Rx Trend by Territory - Volume Pharma GA Rx Consumption

Rx Trend by Territory - Share Pharma GA Rx Consumption

Rx Trend by Prescriber - Volume Pharma GA Rx Consumption

Rx Trend by Prescriber - Share Pharma GA Rx Consumption

Rx Trend by Plan and Territory - Volume Pharma GA Rx Consumption

Rx Trend by Plan and Territory - Share Pharma GA Rx Consumption

Rx Trend by Plan and Prescriber - Volume Pharma GA Rx Consumption

Rx Trend by Plan and Prescriber - Share Pharma GA Rx Consumption

Rx Trend by Payment Type and Prescriber Pharma GA Rx Consumption

Rx Trend by Payment Type and Territory Pharma GA Rx Consumption

Rx Trend by Brick Pharma GA Rx Consumption

Indirect Sales by Brick-Share

Indirect Sales by Brick-Volume

Pharma GA Markets

Pharma GA Sales Consumption

Table 22. Views and Business Components Requiring Data Import

Screen View Business Component
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Data Loading Matrix for Syndicated Data
The Data Loading Matrix, shown in Table 23 on page 436, and the Attribute by Data 
Source Matrix, shown in Table 24 on page 437, are provided to facilitate loading 
sales, Rx, profitability, and influence data. Table 9-4 indicates, by view, the 
combination of data source, mandatory ID, and plan type values a record must have 
to be displayed in the view. The following list explains the table headings:

■ View. Name of the Analysis, Contacts, Accounts, or Products view.

■ Data Source. Value that determines which view will display the data stored in the 
record. The valid values are SlsDirAct, SlsDirBrk, SlsDirTer, SlsDirZip, SlsIndAct, 
SlsIndBrk, SlsIndTer, SlsIndZip, RSPT, RXBrk, RXEVM, RXSMI, RSXMM, RXPrf, 
RXTer, RXXPT, RXZip, Anlsys ROI, and Anlsys EvsR.

Contacts Rx Trend > Rx Trend by Product Pharma GA Rx Consumption

Pharma Consumption

PreCall > Rx Trend Contact BC

Pharma GA Rx ConsumptionPreCall > Rx Trend and Formulary

PreCall > Rx Trend by Plan

Objectives My Objectives 

My Team’s Objectives

Pharma Campaign

The Actual and Last Actual Update 
fields are the only fields in the business 
component that require data import.

Targets

(The Actual Amount fields in the Target 
Accounts and Target Contacts lists)

Pharma Campaign Target Account

Pharma Campaign Target Contact

The Actual Amount field is the only 
field in each business component that 
requires data import.

Table 22. Views and Business Components Requiring Data Import

Screen View Business Component
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■ Mandatory Id. Value that indicates the ID field that must be non-NULL for a 
database record to be displayed in the corresponding view. There are four key 
ID fields: Account Id, Contact Id, Territory Id, and Zip Id. For each view listed in 
the table, one of these ID fields is required and the other three must be NULL. 

■ Plan Type. Value that indicates the type of plan ID a database record must have 
to be displayed in the view. 

 

Table 23. Data Loading Matrix

View Data Source Mandatory ID Plan Type

Accounts > Charts > Sales SlsIndAct Account Id Total

Accounts > Charts > Profitability Anlsys ROI Account Id Total

Analysis > Direct Sales Trend > by Territory - Volume SlsDirTer Territory Id Total

Analysis > Direct Sales Trend > by Account - Volume SlsDirAct Account Id Total

Analysis > Indirect Sales Trend > by Territory - Volume SlsIndTer Territory Id Total

Analysis > Indirect Sales Trend > by Territory - Share SlsIndTer Territory Id Total

Analysis > Indirect Sales Trend > by Zip - Volume SlsIndZip Zip Id Total

Analysis > Indirect Sales Trend > by Zip - Share SlsIndZip Zip Id Total

Analysis > Indirect Sales Trend > by Brick - Volume S1sIndBrk Area Id Total

Analysis > Indirect Sales Trend > by Brick - Share S1sIndBrk Area Id Total

Analysis > Indirect Sales Trend > by Account - Volume SlsIndAct Account Id Total

Analysis > Indirect Sales Trend > by Account - Share SlsIndAct Account Id Total

Analysis > Rx Trend > by Territory - Volume RXTer Territory Id Total

Analysis > Rx Trend > by Territory - Share RXTer Territory Id Total

Analysis > Rx Trend > by Prescriber - Volume RXPrf Contact Id Total

Analysis > Rx Trend > by Prescriber - Share RXPrf Contact Id Total

Analysis > Rx Trend > by Plan and Territory - Volume RXTer Territory Id Plan

Analysis > Rx Trend > by Plan and Territory - Share RXTer Territory Id Plan
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Table 24 indicates, by data source, the data values that should be loaded into the 
syndicated data table (S_SYND_DATA) attribute fields.

 

Analysis > Rx Trend > by Plan and Prescriber - Volume RXPrf Contact Id Plan

Analysis > Rx Trend > by Plan and Prescriber - Share RXPrf Contact Id Plan

Analysis > Rx Trend > by Payment Type and Prescriber RXPrf Contact Id Payer

Analysis > Rx Trend > by Payment Type and Territory RXTer Territory Id Payer

Contacts > Rx Trend > Rx Trend by Product* RXPrf Contact Id Total

Contacts > Profitability Anlsys ROI Contact Id Total

Contacts > Sample Influence Anlsys EvsR Contact Id Total

Products > Product Profitability > Sample ROI* Anlsys ROI Territory Id Total

Products > Sample Influence Anlsys EvsR Territory Id Total

* Fourth level menu

Table 23. Data Loading Matrix

View Data Source Mandatory ID Plan Type

Table 24. S_SYND_DATA Attribute by Data Source

Data Source Attribute 1 Attribute 2 Attribute 3 Attribute 4 Attribute 5

Anlsys EvsR TRx Number of Calls Number of 
Samples

Number of Details

Anlsys ROI Revenue Samples Cost Promotion Cost Call Expenses Other 
Expenses

RSPT Product NRx Product TRx Market NRx Market TRx

RXBrk Product NRx Product TRx Market NRx Market TRx

RXEVM Product NRx Product TRx Market NRx Market TRx

RXPrf Product NRx Product TRx Market NRx Market TRx

RXSMI Product NRx Product TRx Market NRx Market TRx

RXSMM Product NRx Product TRx Market NRx Market TRx
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RXTer Product NRx Product TRx Market NRx Market TRx

RXXPT Product NRx Product TRx Market NRx Market TRx

RXZip Product NRx Product TRx Market NRx Market TRx

SlsDirAct Product Sales $ Product Sales Units

SlsDirBrk Product Sales $ Product Sales Units

SlsDirTer Product Sales $ Product Sales Units

SlsDirZip Product Sales $ Product Sales Units

SlsIndAct Product Sales $ Product Sales Units Market Sales $ Market Sales Units

SlsIndBrk Product Sales $ Product Sales Units Market Sales Market Sales Units

SlsIndTer Product Sales $ Product Sales Units Market Sales $ Market Sales Units

SlsIndZip Product Sales $ Product Sales Units Market Sales $ Market Sales Units

Table 24. S_SYND_DATA Attribute by Data Source

Data Source Attribute 1 Attribute 2 Attribute 3 Attribute 4 Attribute 5
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End-User Procedures
Extracted files are transferred using Siebel Remote (as described in Siebel Remote 
and Replication Manager Administration Guide). After mobile users receive their 
extracted files, they must import the data into their local databases.

The process is described in the following procedure.

To import syndicated data files

1 Using Siebel Remote, synchronize your local database with extracted data files 
that have been routed to you. Extracted data files are received as attachment 
files.

2 Click the Import button and the extracted data files are downloaded to the 
\LOCAL\FILES folder of your hard drive. 

3 After importing the extracted data files into your local database, delete the 
downloaded files from the \LOCAL\FILES folder. 

NOTE: Users may postpone downloading of extracted data files by turning off the 
Retrieved Published Files option in their synchronization setup. Whether or not the 
extracted data files are downloaded, header information is transferred to the mobile 
client during the synchronization session. This information appears in the 
Syndicated Data Files view.

For further information, see Siebel Remote and Replication Manager Administration 
Guide. 
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This appendix involves configuration of the Siebel Life Sciences application using 
Siebel Tools. It assumes that you are familiar with the processes and conventions of 
working with Siebel Tools to change one or more user properties. For further 
information about changing user properties, see Siebel Tools Reference.
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Targeting Configuration
The Siebel Life Sciences targeting engine can be configured for use in any business 
component, including those that you create. It uses the user properties found in 
Table 25 and Table 26.

Table 25. TargetCategory User Property 

 Field Required Description

Name Required TargetCategory.

Changed Read-only An indicator of whether or not the user property is changed.

Value Required A value that the targeting engine uses to determine which 
saved lists are available to the business component. This 
value is strictly user-defined. Siebel ePharma ships with the 
default values “Contacts” for contact-related business 
components and “Accounts” for account-related business 
components. 

One TargetCategory can be active per business component.

Inactive Optional An indicator of whether or not the user property is active.

Comments Optional Comments describing the user property.

Table 26. TargetId User Property 

 Field Required Description

Name Required TargetId.

Changed Read-only An indicator of whether or not the user property is changed.

Value Required A value the targeting engine uses to determine the field in 
the business component that will be matched against the 
saved list ID. If the TargetId record is not defined as a user 
property for the business component, the targeting engine 
defaults to ROW_ID.

One TargetId can be active per business component.

Inactive Optional An indicator of whether the user property is active.

Comments Optional Comments describing the user property.
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With these user properties, you can apply a target list in any business component 
and indicate what value in the business component will be stored for later retrieval. 
For example, to allow targeting functionality on opportunities, add the user property 
in Table 27 to each Opportunity business component. 

Once active, this user property will allow users to save a target list of opportunities 
and apply the list across screens in any opportunity-related business component.

Table 27. Example TargetCategory User Property 

 Field Required Description

Name Required TargetCategory.

Changed Read-only An indicator of whether the user property is changed 
(optional).

Value Required “Opportunity” (or any value you choose).

Inactive Optional An indicator of whether the user property is active.

Comments Optional Comments describing the user property.
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New Visit Type Configuration
Using Siebel Tools, you can configure buttons that allow you to generate specific 
visit-type activities based on predefined visit templates. The default configuration 
provides three default buttons: Screen, Rescreen, Enroll. It uses user properties 
found in Table 33 on page 458.

■ Create a date field in the Clinical Subject business component and create a date 
field with the same name in the LS Subject Status VBC business component. 
This date is used as a starting point for all your visit activities. Visits and 
Activities in the template belonging to the new visit type are calculated based 
upon the date entered in this date field and the lead time for the visit or activity. 

■ Put the user properties in this field. See Table 33 on page 458 for information on 
what to set for the user properties. You may need to create a new list of values 
for the Template Type Code and Subject Status Code.

■ Create a new popup dialog box based on LS Subject Status VBC business 
component that displays when a button is clicked from the form. Base the popup 
dialog box on the CSSFramePopupVstTmplDt class. The only required value in 
this popup dialog box is the VisitTemplateDate control. This date field maps to 
the date field in the LS Subject Status VBC created above. All fields in this dialog 
box are treated as required fields. The users must fill in data for each field.

■ Add the button to the list or form.

NOTE: The best way to configure these buttons is to copy one of the default button 
configurations and apply the same properties to your new button.
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Sequential Priority Configuration
As mentioned in Chapter 5, “Recording Calls,” the Siebel administrator can 
configure the Priority field in the Call Products Detailed list to allow each record 
added to the list to be sequentially and uniquely numbered, with the first record 
receiving 1. In the preconfigured application, more than one record can contain 1 
in the Priority field.

To enable sequential numbering in the Priority field

1 In Siebel Tools, select the Business Component object in the Object Explorer.

2 Query for Pharma Account Call.

3 Lock the associated project, for example Pharma Call.

4 Expand the Business Component object and select the Business Component 
User Prop object.

5 Change the Value field to Y for the Validate Product Priority business component 
user property.

6 Repeat Step 1 through Step 5, running a query for the Pharma Professional Call 
business component in Step 2.

7 Compile the .srf file, selecting the Locked projects radio button.

8 Relaunch the application. 
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Charting Denormalized Syndicated Data
Siebel Life Sciences allows you to chart denormalized syndicated data. To take 
advantage of this enhancement, configuration is required at the business 
component, table, and applet levels.

Schema for Territory Data Files
The territory data files created by your syndicated data provider must have the 
following characteristics:

■ They must be plain ASCII files.

■ They must follow the schema described in Table 28.

Table 28. Territory File Schema

Field Type Length

Record Length Alphanumeric 8

Territory Number Alphanumeric 10

ME Number Alphanumeric 10

Check Digit Alphanumeric 1

Last Name Alphanumeric 25

First Name Alphanumeric 25

Middle Initial Alphanumeric 1

Suffix Alphanumeric 4

Title Alphanumeric 5

Address 1 Alphanumeric 30

Address 2 Alphanumeric 30

Address 3 Alphanumeric 30

Address Indicator Alphanumeric 1

City Alphanumeric 28
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State Alphanumeric 2

Zip Code + 4 Number 9

Specialty Alphanumeric 3

Called On Code Alphanumeric 1

No Contact Indicator Alphanumeric 1

Project Start Date Alphanumeric 10

Current Week Date Alphanumeric 10

Prior-To Date Alphanumeric 10

Client Data Alphanumeric 49

Programming Info Alphanumeric 11

PRODUCT A Alphanumeric 30

Week 9 Beg. Date Alphanumeric 10

Week 9 End Date Alphanumeric 10

Week 9 Activity Indicator Alphanumeric 3

Week 9 Activity Indicator Name Alphanumeric 10

Week 8 Beg. Date Alphanumeric 10

Week 8 End Date Alphanumeric 10

Week 8 Activity Indicator Alphanumeric 3

Week 8 Activity Indicator Name Alphanumeric 10

Week 7 Beg. Date Alphanumeric 10

Week 7 End Date Alphanumeric 10

Week 7 Activity Indicator Alphanumeric 3

Week 7 Activity Indicator Name Alphanumeric 10

Week 6 Beg. Date Alphanumeric 10

Table 28. Territory File Schema

Field Type Length
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Week 6 End Date Alphanumeric 10

Week 6 Activity Indicator Alphanumeric 3

Week 6 Activity Indicator Name Alphanumeric 10

Week 5 Beg. Date Alphanumeric 10

Week 5 End Date Alphanumeric 10

Week 5 Activity Indicator Alphanumeric 3

Week 5 Activity Indicator Name Alphanumeric 10

Week 4 Beg. Date Alphanumeric 10

Week 4 End Date Alphanumeric 10

Week 4 Activity Indicator Alphanumeric 3

Week 4 Activity Indicator Name Alphanumeric 10

Week 3 Beg. Date Alphanumeric 10

Week 3 End Date Alphanumeric 10

Week 3 Activity Indicator Alphanumeric 3

Week 3 Activity Indicator Name Alphanumeric 10

Week 2 Beg. Date Alphanumeric 10

Week 2 End Date Alphanumeric 10

Week 2 Activity Indicator Alphanumeric 3

Week 2 Activity Indicator Name Alphanumeric 10

Week 1 Beg. Date Alphanumeric 10

Week 1 End Date Alphanumeric 10

Week 1 Activity Indicator Alphanumeric 3

Week 1 Activity Indicator Name Alphanumeric 10

PRODUCT B Alphanumeric 30

Table 28. Territory File Schema

Field Type Length
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Week 9 Beg. Date Alphanumeric 10

Week 9 End Date Alphanumeric 10

Week 9 Activity Indicator Alphanumeric 3

Week 9 Activity Indicator Name Alphanumeric 10

Week 8 Beg. Date Alphanumeric 10

Week 8 End Date Alphanumeric 10

Week 8 Activity Indicator Alphanumeric 3

Week 8 Activity Indicator Name Alphanumeric 10

Week 7 Beg. Date Alphanumeric 10

Week 7 End Date Alphanumeric 10

Week 7 Activity Indicator Alphanumeric 3

Week 7 Activity Indicator Name Alphanumeric 10

Week 6 Beg. Date Alphanumeric 10

Week 6 End Date Alphanumeric 10

Week 6 Activity Indicator Alphanumeric 3

Week 6 Activity Indicator Name Alphanumeric 10

Week 5 Beg. Date Alphanumeric 10

Week 5 End Date Alphanumeric 10

Week 5 Activity Indicator Alphanumeric 3

Week 5 Activity Indicator Name Alphanumeric 10

Week 4 Beg. Date Alphanumeric 10

Week 4 End Date Alphanumeric 10

Week 4 Activity Indicator Alphanumeric 3

Week 4 Activity Indicator Name Alphanumeric 10

Table 28. Territory File Schema

Field Type Length
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Week 3 Beg. Date Alphanumeric 10

Week 3 End Date Alphanumeric 10

Week 3 Activity Indicator Alphanumeric 3

Week 3 Activity Indicator Name Alphanumeric 10

Week 2 Beg. Date Alphanumeric 10

Week 2 End Date Alphanumeric 10

Week 2 Activity Indicator Alphanumeric 3

Week 2 Activity Indicator Name Alphanumeric 10

Week 1 Beg. Date Alphanumeric 10

Week 1 End Date Alphanumeric 10

Week 1 Activity Indicator Alphanumeric 3

Week 1 Activity Indicator Name Alphanumeric 10

Table 28. Territory File Schema

Field Type Length
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Enabling Inventory Reconciliation Without Lot Numbers 
As discussed in Chapter 6, “Managing Samples,” Siebel ePharma allows you to 
create sample products and associate lot numbers with the samples, then ship and 
disburse samples by lot numbers while maintaining and reconciling inventory 
without lot numbers. 

Retaining Sample Product Visibility
To allow inventory without lot numbers while retaining sample product visibility, 
the administrator must do the following:

■ Set the value of the Lots For Disperse Only system preference to TRUE 

■ Check the Lot# Tracking flag in the Product Administration screen

■ Use Siebel Tools to reconfigure fields and replace business components

To enable inventory and reconciliation of samples without lot numbers

1 From the application-level menu, choose View > Site Map > Application 
Administration > System Preferences.

2 In the System Preference Name list, locate and select the Lots for Disperse Only 
record.

3 Change the field value to TRUE.

4 Verify that Sample Lots Enabled system preference is set to TRUE.

5 Navigate to Product Administration and check the Lot# Tracking flag.

6 Open Siebel Tools.

7 Choose View > Object Explorer > Flat tab.

8 Select Field, query for any Field with the value Picklist Pharma Samples Stocked 
Lots, and replace each occurrence with Picklist Pharma All Unexpired Lots.

9 Select Applet, query for any business component with the value Pharma Sample 
Stocked Lots Pick List Applet-CE, and replace each occurrence with Pharma 
Sample Lot for Picklist.
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10 Select Applet, query for any business component with the value Pharma Stocked 
Lot Pick Applet and replace each occurrence with Pharma Sample Lot for 
Picklist.

11 Compile srf.
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Business Component User Properties
Siebel business components are based on the CSSBusComp class directly, or on a 
C++ class derived from CSSBusComp. Business component user properties allow 
Siebel configurators to control and adjust the behavior of Siebel Life Sciences using 
Siebel Tools.

General Business Component User Properties
Table 29 lists the user properties that are general and can apply to any business 
component.

 

Table 29. User Properties for All Business Components 

User Property 
Name User Property Value Description

TargetCategory Value

User-defined value that connects different business 
components together so that they interact for the 
targeting feature. 

Example:
Contacts

Tells the business component 
which target category to use 
when saving and applying 
target lists. 

TargetId Field

Field from the business component you want to save as 
the ID of the list and use when applying a target list to 
this business component. 

Example: 
Contact Id

Tells the business component 
which field from the business 
component to use when 
saving and applying target 
lists.
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Specific Business Component User Properties
The following business component user properties are specific to a particular C++ 
class. This means that the properties are valid only for business components that 
are based on the C++ class implementing the user property or any of the related 
derived C++ classes.

Group 1 Business Components
Table 30 on page 454 lists the user properties that are related to the following 
business components: 

■ Action (class CSSBCActivity) 

■ Calendar (class CSSBCCalendar)

Group 2 Business Components
Table 31 lists the user properties that are related to the following business 
components:

Table 30. User Properties Related to Group 1 Business Components 

User Property Name User Property Value Description

Read-only Activity Types ,ActivityType1,Activity Type2,…,

Value must start and end with a 
comma, and no spaces between 
values.

Example:
,Attendee Call,Meeting Invitee,

Tells the business component 
which activity types are to be 
read-only at the record level. 
Activity Type is the field category.

Read-only Fields for 'Activity 
Type'

Activity Type is the category 
value. 

Example: 
Read-only Fields for 'Account 
Call'

,field1,field2,…,

Value must start and end with a 
comma, and no spaces between 
values.

Example: 
,Contact Last Name,Opportunity,

Tells the business component 
which fields are to be read-only for 
a particular activity type. Activity 
Type is the field category. 

Status Field Field

Field from the business component.

Tells the business component 
which field is to be used to 
indicate the status.
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■ Pharma Call Products Detailed (class CSSBCProductDetailed)

■ Pharma GA Call Products Detailed (class CSSBCProductDetailed)

 

Group 3 Business Components
Table 32 on page 456 lists the user properties that are related to the following 
business components:

■ Pharma Account Call

■ Pharma Attendee Call

■ Pharma Template Call

■ Pharma Contact Call

■ Pharma Promotional Items Dropped

■ Pharma Contact Call Sample Dropped

■ Pharma Activity Product Issues

■ Pharma Call Sample Dropped

■ Pharma Meeting

■ Pharma Meeting Attendee

Table 31. User Properties Related to Group 2 Business Components 

User Property Name User Property Value Description

Max Auto Generated 
Priority

Number

A numeric value. 

Example: 
3

Tells the business component the maximum 
number to go up to when auto-generating 
priorities for the products detailed. 

Template Fields Field1,field2,…

No start or end comma or spaces 
between values.

Example: 
Name,Priority,Product Issue

Tells the business component what fields to 
copy from the Smart Call template if a Smart 
Call is chosen. 
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■ Pharma Meeting Activity

■ Pharma Meeting Speaker

NOTE: Not all properties are used in all business components.

Table 32. User Properties Related to Group 3 Business Components 

User Property Name User Property Value Description

Cascading Fields ,field1,field2,…,

Value must start and end with a 
comma. 

Example:
,Start Date,Start Time,

Tells the business component which fields 
should cascade values to a child call 
component. Make these fields Force 
Active in the child call. Works in 
combination with the SubCall Component 
user property.

Must Detail Products Y or N Tells the business component whether 
detailed products are required for a call.

OnlySubmitByPosition Y or N Tells the business component whether the 
position that entered the record is the only 
one that can submit it.

Status Field Field

Field from the business component.

Tells the business component which field 
is to be used to indicate the status of the 
activity.

SubCall Component Business component name

Any business component name. 

Tells the business component the child 
component to which it should cascade 
values. Works in combination with the 
Cascading Fields user property.

Template Components Business component name

Any business component name.

Tells the business component what child 
components should be copied from the 
Smart Call template if a Smart Call is 
chosen.

Template Fields Field1,field2,…

No start or end comma.

Example:
Name,Priority,Product Issue

Tells the business component what fields 
to copy from the Smart Call template if a 
Smart Call is chosen.
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Group 4 Business Components
Table 33 lists the user properties that are related to the Clinical Subject (class 
CSSBCBCClinicalSubject) business components.

Attendee Call ReadOnly ,field1,field2,…,

Value must start and end with a 
comma. 

Example: 
,Start Date,Start Time,

Tells the business component what fields 
are read-only when the type is Attendee 
Call.

Validate Sample Ref # Y or N Tells the business component whether it 
should require a sample reference number 
when submitting a call.

Update After Submit ,field1,field2,…,

Value must start and end with a 
comma. 

Example: 
,Comment,

Tells the business component what fields 
are editable after a call is submitted. 
Generally this user property should be 
used only to make the Comment field 
editable. 

Update After Synch ,field1,field2,…,

Value must start and end with a 
comma. 

Example: 
,Comment,

Tells the business component what fields 
are editable after a call is synchronized 
(with Siebel ePharma Handheld on a 
PDA). Generally this user property should 
be used only to make the Comment field 
editable. 

Table 32. User Properties Related to Group 3 Business Components 

User Property Name User Property Value Description
Version 7.5, Rev. A Siebel Life Sciences Guide 457



Information for Siebel Application Developers

Business Component User Properties
These properties, used within the eClinical application, allow you to configure new 
buttons in the application that relate to subject activity. These user properties are 
at the Field level (Business Component > Field > Field User Properties).

 

Configuring the Visit Generation Buttons
The standard Siebel eClinical application has three visit generation buttons (Screen, 
Rescreen, and Enroll) on the Subject form.

Using Siebel Tools, you can: 

■ Reconfigure the buttons to better suit your business needs

Table 33. User Properties Related to Group 4 Business Components

User Property Name User Property Value Description

Template Type Code No default. 

Select 
CLNCL_SUBJ_VST_TMPL_TYPE 
from the List of Values

(Application Administration > 
List of Values > List of Values)

Defines the visit activity applied when the 
newly configured button is selected.

Subject Status Code No default.

Select CLNCL_SUBJECT_STATUS 
from the List of Values

(Application Administration > 
List of Values > List of Values)

Defines the status for the subject that is 
applied when the newly configured button is 
selected.

Template Version Field 
Name

No default. 

Must be made Force Active in the 
Business Component.

The corresponding Version ID Field Name 
that is populated with the version ID of the 
template version that created the activity.

Subject Consent 
Required

Y or N

Default=N

This flag indicates whether or not the subject 
has the Informed Consent Date filled in for 
the active template for your protocol site. If 
you set this to Y, and the date is not filled in 
correctly, an error occurs.

Append All Activities Y or N

Default=N

When set to Y, activities are appended.
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Business Component User Properties
■ Create new buttons for application of additional templates on the Subject form
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Business Component User Properties

4

The following flow chart illustrates the logic behind these buttons. The logic is the 
same for all three buttons, although content of the error messages does vary.
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Configuring the Submit Button
Configuring the Submit Button
As mentioned in Chapter 5, “Recording Calls” and in Chapter 6, “Managing 
Samples,” when you click the Submit button in either the Contact Call Detail and 
Account Call Detail views, the application verifies that at least one product has been 
recorded and detailed. Table 34 describes the specific actions that occur when 
clicking the Submit button in the views in which it appears.

This requirement can be changed by the administrator using Siebel Tools. The 
business component user property is Update After Submit. By default, only 
Comment is editable after clicking the Submit button. Table 32 on page 456 shows 
the user property values that are to be changed.

Table 34. Submit Button

View Access Path
Transaction 
Type Clicking the Submit Button...

Contact Call 
Detail

Activities > 
Contact Call 
Detail

Disbursement Changes the Contact Call detail Status 
field Submitted.

Except for the Comment field, sets the 
record to read-only.

Sets all child records to read-only.

If samples were dropped, creates a 
Samples Transaction History record.

Inventory 
Count

Samples > 
Inventory Count

Verifies each value has been entered 
in the Count field.

Changes the status of each record to 
Inactive.

Creates an active transaction by 
moving the count to the latest 
inventory period.
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Configuring the Submit Button
Sent 
Samples

Samples > My 
Samples 
Adjustments

Inventory 
Adjustment

Updates the user inventory to reflect 
the quantity entered in Line Items list 
Quantity field.

Updates Sample Adjustments by 
changing the Active Flag to N (No).

If the Transfer Status is Submitted, the 
application updates Line Items list by: 

■ Setting the Stock Update flag to Y 
(Yes)

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Sent 
Samples

Samples > My 
Sent Samples

Transfer Out Updates the user inventory to reflect 
the quantity entered in Line Items list 
Quantity field.

Updates My Sent Samples by setting 
the Active Flag to N (No).

If the Transfer Status is Submitted, the 
application updates the Line Items list 
by: 

■ Setting the Update Flag to Y (Yes)

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Table 34. Submit Button

View Access Path
Transaction 
Type Clicking the Submit Button...
462 Siebel Life Sciences Guide Version 7.5, Rev. A



Information for Siebel Application Developers

Configuring the Submit Button
Sample 
Order

Samples > My 
Samples Order

Sample Order Updates the user inventory to reflect 
the quantity entered in Line Items list 
Quantity field.

Update Samples Order by setting the 
Active Flag to N.

If the Order Status is submitted, the 
application updates the Line Items list 
by:

■ Setting the Stock Update flag to Y

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Received 
Samples

Samples > My 
Received 
Samples

Transfer In Updates the user inventory to reflect 
the quantity entered in Line Items list 
Received Quantity field.

Updates Sample Invoices by setting 
the Active flag to N.

If the Invoice Status is submitted, the 
application updates the Line Items list 
by:

■ Setting the Stock Update flag to Y

■ Updating the Stock Position ID 

■ Changing the Item Status to 
Submitted

Table 34. Submit Button

View Access Path
Transaction 
Type Clicking the Submit Button...
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Changing Read-Only Fields
As mentioned in Chapter 5, “Recording Calls” and in Chapter 6, “Managing 
Samples,” the Siebel administrator can change the fields that become read-only 
after a call is submitted (or synchronized with Siebel ePharma Handheld on a PDA).

Read-only properties are shown in Table 30 on page 454. The User Property Value 
column shows how the user property values are to be changed.

Special MedEd Classes—User Properties
In Siebel 7, two special C++ classes have been created for MedEd:

■ CSSBCPharmaMEPlan

■ CSSBCPharmaMESubPlan

Both classes support EditMode user property. When the EditMode user property 
value is set to the value Admin, the data ownership (granting update or delete 
privilege to the user) is not checked. This means that anyone on the sales team, for 
example, can update the fields in this business component.

Two existing Buscomp classes, CSSBCPharmaMEActCost and 
CSSBCPharmaMEEventPos, are classes without these user properties, and therefore 
require administrator privileges to update or delete.
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Controlling Query Behavior in Multi-Value Group Fields
In order to implement the Siebel Life Sciences Targeting functionality, the default 
behavior of queries in Multi-Value Group (MVG) fields has been changed. In this 
new MVG behavior, an EXISTS statement is automatically added to every query in 
Siebel Life Sciences. This allows detailed cross-business object queries in the 
Targeting view. For example: 

■ Find all the Contacts

■ Who are ranked High in a specific therapeutic class

■ Who have not been visited for over a month by any sales representative

■ With a best time to call on Monday afternoon

This MVG behavior, however, also prevents the following query in an MVG field:

EXISTS (A) AND EXISTS (B).

To disable the EXISTS statement 

1 From the application-level menu, choose View > Site Map > Application 
Administration > System Preferences. 

2 Set the Default MVG Exists Query to FALSE.
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account call activities

See also activities
Account view tab, using to manually 

schedule an account call 114
Activities screen, adding from 112
activity type, about 97
calendar, scheduling an account call in 

115
creating, about 112
details about the call, entering 114
New Call button, using to add an account 

115
Scheduling button, using to automatically 

schedule account call 114
Account Call Detail view, about displaying 

130
account calls

See also Smart Calls, creating
Account Call Detail view, displaying 130
attendee information, entering for an 

account call 131
completed account call, submitting 133
general activities, entering for an account 

call 133
mobile users, about submitting account 

calls 133
products detailed information, entering 

for an 130
recording, about 129

account hierarchies
See also account hierarchies, generating
aggregated activities for an account, 

viewing 197
aggregated coverage team for an account 

hierarchy, viewing 197

aggregated list of contacts for an account, 
viewing 198

aggregated opportunities for an account 
hierarchy, viewing 198

error message that record is not included 
as defined hierarchy 196

roll-up views, about viewing 196
account hierarchies, generating

See also account hierarchies
about 188
default account hierarchies, about 189
default account hierarchy, generating 

(procedure) 189
default account hierarchy, viewing if end 

users are using the app 190
dynamic account hierarchy of selected 

accounts, creating 190
account team, about visibility and Contact 

Denormalization process 29
Account view tab

account call, using to manually schedule 
an account call 114

route, using to add account to 90
accounts

adding for clinical trial 307
calling, specifying best time to call 66
contact, indicating an affiliation between 

64
projects, about associating with 378
role, specifying for an affiliated account 

65
routes, about adding to 89
routes, adding using the Accounts view 

tab 90
routes, adding using the Explorer view 

tab 91
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Accounts screen and views, described 42
accounts, administering and managing

account address, about editing 194
account hierarchies in roll-up views, 

about viewing 196
account hierarchies, about 182
account hierarchies, error message that 

record is not included as defined 
hierarchy 196

account hierarchies, generating 188
account profile information, adding for an 

account 195
account, adding 194
account, deleting 188
accounts, about 194
accounts, defined 181
affiliated contact, adding new role for 201
affiliation between a contact and a 

subaccount, indicating 205
affiliation between account, indicating 

(procedure) 201
affiliation between and account and a 

contact, indicating 200
affiliations between accounts, about 

indicating and upward and downward 
affiliations 201

aggregated activities for an account, 
viewing 197

aggregated coverage team for an account 
hierarchy, viewing 197

aggregated list of contacts for an account, 
viewing 198

aggregated opportunities for an account 
hierarchy, viewing 198

brick, associating with an existing 
account address 191

bricks, about and how they work 183
business scenario 184
category information for an account, 

adding 199
competitor, specifying an account as 187
contact information, about associating to 

plan 208

contact’s role, updating 209
contacts, associating with account plans 

208
default account hierarchy, generating 

(procedure) 189
default account hierarchy, viewing if end 

user are using the app 190
documentation, tracking associated with 

an account 209
dynamic account hierarchy of selected 

accounts, creating 190
formulary information, adding to an 

account 207
plan designs and formularies, about 206
plan information, adding to an account 

207
pre-call information, about viewing 205
pre-call information, viewing (procedure) 

206
subaccounts, about and affect to data 

access (table) 203
subaccounts, adding 204
subaccounts, entering detailed 

information for 204
upward and downward account 

affiliations, viewing for an account 
202

workflow for managing accounts example 
185

active inventory period, about 137
activities

See also account call activities
about and activity types 97
account call, about creating an 112
account call, adding an account using the 

New Call button 115
account call, adding from the Activities 

screen 112
account call, automatically scheduling 

using the Schedule button 114
account call, entering details about the 

call 114
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account call, manually schedule an 
account call in the Account view tab 
114

account call, scheduling an account call 
in the calendar 115

Activities list, creating activity in 103
business scenario 79
calendar, giving others access to 103
contact call activities, automatically 

scheduling using the Schedule button 
110

contact call activities, creating 108
contact call activities, creating from 

Activities screen 109
contact call activities, manually 

scheduling a call using the Calls view 
111

contact call activities, scheduling in the 
calendar 111

defined and about 75
general activity, adding 99
general activity, creating in the Calendar 

view 100
general activity, editing an activity 103
meeting, about setting up and list of tasks 

104
meeting, adding (procedure) 104
meeting, adding a meeting activity 105
meeting, adding a meeting invitee 107
meeting, adding a meeting speaker 106
meeting, updating the Cost field in the 

Meeting Invitees list 108
project, adding to using a project activity 

template 380
site, assigning to using a template 332
specialized activities, creating in Calendar 

view 103
status of activities associated with an 

objective, changing 287
Activities screen

account call, adding from 112
contact call, using to add 109
views, description of 42

activity payments
about 340
currencies and exchange rate dates, about 

setting 340
standard payment amounts, setting up in 

the subject visit template 343
activity template, creating for MedEd event 

253
Actual Amount fields

importing data for, about 283
loading, about using EIM 285

adjustment transaction, about submitting 
154

administrator tasks
Manager List Mode user property, default 

settings (table) 25
My Team’s filter, about 25
table of 20

affiliated contact data, modifying the 
routing of 71

affiliations
account and a contact, indicating 

between 200
accounts, about indicating between 201
affiliated contact, adding new role for 201
contact and a subcontact, indicating 

between 205
independent accounts, about using 

Account Sub Account view 203
aggregated activities for an account, 

viewing 197
Agreements screen and views, described 42
Analysis screen and views, described 42
analysis, using

brick, displaying all contacts associated 
with 229

brick-level syndicated data, about 
analyzing 228

business scenario 222
indirect sales by brick, correlating actual 

calls made with 229
payer information, adding 224
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prescription trends by brick, correlating 
actual calls made with 229

receiving data extracts, postponing 225
sales, Rx, and call data, about filtering 

data 231
sales, Rx, and call data, about working 

with 230
sales, Rx, and call data, displaying data 

230
Siebel Life Sciences views available from 

Analysis screen (table) 226
syndicated data extracts, importing 225
workflow for analysis example 223

assessment template
creating 327
purpose of 327
scores, about ranking a contact 56

Assets screen and views, described 42
assigning tasks

contact assignments, about and example 
28

Contact Denormalization mode, 
differences from Assignment Manager 
28

Contact Denormalization mode, rules, 
requirements, and exceptions 29

predefined assignment objects, about and 
table of 26

Siebel Assignment Manager, about using 
26

Assignment Item Type Industry Name, 
about support of 26

Assignment Manager. See Siebel 
Assignment Manager

assignment objects, about and table of 26
attachments

contact, adding to 69
objective, adding to 284

attendee calls
sample transactions, attendees recorded 

for an account call 139
Submit button, attendees recorded for an 

account call 121

attendee information, entering for account 
call 131

audience for guide 15

B
Batch mode, about running Contact 

Denormalization in 29
bricks

about and how they work 183
account address, associating with 191
brick, displaying all contacts associated 

with 229
brick-level syndicated data, about 

analyzing 228
contact, associating with 55
defined 53
defining (procedure) 54
ePharma, about how used in 54
indirect sales by brick, correlating actual 

calls made with 229
prescription trends by brick, correlating 

actual calls made with 229
business component user properties

See also configuring
about 453
group 1 business components (table) 454
group 2 business components (table) 454
group 3 business components (table) 455
group 4 business components (table) 457
user properties for all business 

components (table) 453
visit generation button, configuring 458

C
calendar

access, giving others access to 103
account call, scheduling in 115
contact call, scheduling in 111
current view, printing 103
general activity, creating in Calendar view 

100
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specialized activities, creating in Calendar 
view 103

Calendar screen and views, described 42
call data

displaying data 230
filtering data, about 231
working with, about 230

calling
affiliated account, specifying best time to 

call 66
contact, specifying best time to 62
pre-call information, viewing 67

Calls view, using to manually schedule a 
contact call 111

calls, planning
See also activities; calls, scheduling
activities, user create business scenario 

79
personal lists, about creating 82
personal lists, adding product to 83
personal lists, users set up business 

scenario 76
route plans, users define business 

scenario 77
route, about adjusting scheduling 

conflicts 97
route, creating (procedure) 88
route, using to schedule calls 95
routes, about adding accounts to a route 

89
routes, about creating and list of tasks 87
routes, adding accounts using the 

Accounts view tab 90
routes, adding accounts using the 

Explorer view tab 91
scheduling conflicts, about adjusting 96
target lists, about assigning to a route 92
target lists, about targeting 84
target lists, applying one or more lists 86
target lists, assigning to a route 

(procedure) 94
target lists, creating (procedure) 85
target lists, deleting 86

target lists, merging 92
target lists, steps to create 84
target lists, user create business scenario 

76
tools for planning calls, list of 74
workflow example for planning calls 80

calls, recording
Account Call Detail view, displaying 130
account calls, about recording 129
account calls, entering products detailed 

information for an 130
attendee information, entering for an 

account call 131
attendees calls, creating for each attendee 

121
business scenario 122
completed account call, submitting 133
completed contact call, submitting 128
Contact Call Detail view, displaying 125
decision issues discussed during the call, 

recording information about 128
general activities, entering for an account 

call 133
products detailed, recording information 

about 126
promotional items dropped, recording 

information about 127
samples dropped, application activity 120
samples dropped, recording information 

about 126
Submit button, effect on views (table) 118
Submit button, effects when clicked in 

Contact Call Detail or Account Call 
Detail view 120

workflow example 123
calls, scheduling

See also calls, planning
route, about adjusting scheduling 

conflicts 97
route, using to schedule calls 95
scheduling conflicts, about adjusting 96

Campaigns screen and views, described 42
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case report form tracking activity, creating 
361

catalog, adding product or lot number to 
catalog 406

category information
about adding 60
account, adding for 199

change request record, adding for a product 
408

charts
graphical charts, creating for clinical trials 

318
time off territory charts, viewing 239

checklist activities, about 98
clinical program, adding new clinical 

program 295
Clinical Programs screen and views, 

described 43
clinical projects, managing

activities, defined 380
activity, adding to a project using a 

project activity template 380
business scenario 364
contact, adding to a project using the 

Organization Analysis view 379
employee profiles, setting up 370
Microsoft Project, about exchanging 

project data with 384
partner account, adding to a project 379
people and accounts, about associating 

with projects 378
position types and rate lists, about setting 

up for billing 371
position types, adding as products 371
project activity template, about creating 

368
project activity template, creating 

(procedure) 369
project costs, about and displaying cost 

items 381
project costs, viewing associated with a 

project 382
Project screen views (table) 374
project, adding employees to 378

project, creating (procedure) 377
rate list, creating 371
risk and resolution activities, adding to a 

project 382
Siebel Project fields, mapping to 

Microsoft Project fields 372
task, creating and associating activities to 

the task 381
task, defined 380
workflow example 366

clinical protocol site activities, about 98
clinical protocol site template

about creating 325
creating (procedure) 325

clinical research associates
See also sites and clinical contacts, 

managing
documentation milestones, tracking 335
documentation, adding to a site 336
investigator or contact, assessing 337
site team, assigning employees to 331

clinical trial, setting up and carrying out
account, adding 307
accounts and contacts, defined and about 

adding 307
business scenario 291
contact, adding 308
documentation tracking activities, 

creating 305
documentation, reviewing and tracking 

312
existing documentation, updating and 

adding for tracking 305
graphical charts, creating 318
hierarchical relationship of programs, 

protocols, regions, and sites (diagram) 
290

new clinical program, adding 295
new protocol, adding 297
protocol payments, reviewing 318
regions, about setting up 299
regions, adding to a protocol 299
site, adding 309
subject visit template, about defining 300
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subject visit template, adding a subject 
visit template 302

subject visit template, applying a new 
version for an enrolled subject 316

subject visit template, applying new 
version to a site 316

subject visit template, creating new a 
version 306

subject visit template, examples 
(diagram) 301

subject, enrolling in study 315
subject, entering and screening 312
subject, rescreening a subject 314
workflow managing clinical trials 

example 293
clinical trip reports, administering and using

case report form tracking activity, 
creating 361

clinical administrator business scenario 
352

clinical research associates business 
scenario 352

trip report template, creating 354
trip report, about and Trip Report view 

356
trip report, about completing after site 

visit 359
trip report, completing after site visit 

(procedure) 359
trip report, creating (procedure) 356
trip report, distributing and archiving 361
trip report, printing or emailing 358
workflow example 353

clinical trip template, creating (procedure) 
354

Company Identifier field, about 51
competitor information, managing

See also products, managing
about 402
company features, defining 402
competitor comparison information. 

entering 403
product features, defining 402

competitor, specifying an account as a 187
configuring

See also business component user 
properties

contact data routing, modifying 71
denormalized syndicated data, charting 

446
inventory and reconciliation of samples 

without lot numbers, enabling 451
MedEd classes user properties, C++ 

classes created for 464
Multi-Value Group fields, controlling 

query behavior 465
read-only fields, changing 464
sequential numbering in the Priority field, 

enabling 445
Submit button, about and user property 

values 461
TargetCategory user property (table) 442
TargetCategory user property (table), 

example 443
TargetID user property (table) 442
visit generation buttons, configuring 458
visit-type activities, creating 444

contact address, about editing 58
contact assessment, creating 66
contact assignments, about and example 28
contact call activities

See also activities and individual contact 
entries

about 75
about creating 108
Activities screen, creating from 109
activity type, about 97
calendar, scheduling a contact call in 111
Call view, using to manually schedule 

contact call 111
Schedule button, using to automatically 

schedule 110
Contact Call Detail view, displaying 125
contact calls

See also Smart Calls, creating and 
individual contact entries
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mobile users, about submitting contact 
calls 129

Contact Denormalization mode
Assignment Manager, differences from 28
rules, requirements, and exceptions 29

Contact Id, deleted, consequences of 167
contact information, about associating to 

plans 208
contact records

blank last and first name, about and 
troubleshooting 53

merging, about 52
contacts

See also individual contact entries
account plans, associating with 208
adding for clinical trial 308
affiliated contact, adding new role 201
affiliation between a contact and a 

subaccount, indicating 205
affiliation between an account and a 

contact, indicating 200
aggregated list of contacts for an account, 

viewing 198
contact’s role, updating 209
fitness, assessing 337
MedEd event, inviting to 270
MedEd speaker, designating as 256
project, adding using the Organization 

Analysis view 379
projects, about associating with 378
site, associating with 331
targeting (procedure) 85
viewing all regardless of assignment 

method 29
contacts, managing

See also individual contact entries
adding, about 58
affiliated account, specifying best time to 

call 66
attachment, adding to a contact 69
best time to call a contact, specifying 62
brick, about how used in ePharma 54
brick, associating a contact with 55

brick, defined 53
brick, defining (procedure) 54
business scenario 48
category information, adding 60
contact address, about editing 58
contact and an account, indicating an 

affiliation between 64
contact assessment, creating 66
contact data routing, modifying 71
contact, adding (procedure) 59
contact, defined 47
contact, indicating affiliations between 63
contact’s primary specialty, specifying 52
deleting a contact (procedure) 53
deleting a contact, about 52
deleting a contact, alternative to 53
documentation, tracking associated with 

a contact 70
merging contact records, about 52
pre-call information, viewing 67
primary speciality and unique identifier 

information, about 51
ranking a contact, about 56
role, specifying for an affiliated account 

65
speciality, defining 52

correspondence, generating for MedEd 
event invitees 272

Cost Allocation field, total of values entered 
263

Cost field, updating in the Meeting Invitees 
list 108

count adjustments, creating and submitting 
155

CRA. See clinical research associates
currencies, setting for protocols 340

D
Data Loading Matrix

about 435
S_SYND_DATA attribute by data source 

(table) 437
table 436
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data tables, data EIM can process 420
data, importing

business scenario 411
data, types of 409
extracting data for mobile users, about 

425
extracting data for mobile users, about 

full and partial data extracts 431
extracting data for mobile users, about 

possible data loss 432
extracting data for mobile users, 

associating nodes with rule 426
extracting data for mobile users, creating 

data extraction rule 426
extracting data for mobile users, general 

steps for 425
extracting data for mobile users, 

performing data extraction 431
extracting data for mobile users, setting 

the environment 429
extracting data for mobile users, 

specifying data routed to mobile users 
427

Siebel EIM, importing data with 412
summary records, about and loading into 

S_SYND_DATA table 424
syndicated data loading, troubleshooting 

432
syndicated data, about importing, 

extracting and routing 421
syndicated data, Data Loading Matrix for 

435
syndicated data, Data Loading Matrix for 

(table) 436
syndicated data, importing 439
syndicated data, loading data in database 

421
syndicated data, S_SYND_DATA attribute 

by data source (table) 437
syndicated data, steps for loading and 

distributing to mobile users 421
views requiring syndicated data import 

(table) 433

data, types of 409
decision issues, defining

about 405
adding decision issue 405

decision issues, recording information 
about 128

deleting
account 188
contact 52
contact, alternative to 53
objective, about 281
Smart Call, about 217
target list 86

denormalized syndicated data, charting
See also configuring
schema for territory data files 446

direct sales, defined 221
discrepancies, tracking 172
documentation

account, tracking associated with 209
clinical trial, reviewing and tracking 312
contact, attaching to 69
contact, tracking associated with 70
existing documentation, updating and 

adding for tracking 305
literature items, requesting when using 

local database 287
MedEd session, associating with 256
MedEd session, specifying literature for 

269
milestones, tracking 335
site, adding documentation to 336
tracking activities, creating 305

downward affiliations
account’s upward and downward 

affiliations, viewing 202
list, about 201

DTE maps
exporting from the server database to an 

XML file 31
importing to local client from an XML file 

32
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dynamic account hierarchies, creating for 
selected accounts 190

Dynamic mode, about running Contact 
Denormalization in 29

E
EIM

ePharma data EIM can process 420
interface tables 412

EIM. See Siebel EIM, using to import data
electronic signatures

about checking 166
receipts, generating for calls with 

electronic signatures 167
Signature Audit Administration, 

displaying 166
Signature form, last name and first name 

fields empty 167
emailing, print report 358
employee profiles, setting up 370
employees

MedEd event, inviting to 270
project, adding to 378
projects, associating with 378
site team, assigning to 331

Event term, defined 244
Exception Amount, editing for multiple 

activities 345
exchange dates, setting for protocol 340
EXISTS statement, disabling 465
expense reports, including time off territory 

costs 238
Explorer view tab, using to add accounts to 

a route 91
exporting

DTE data maps from the server database 
to an XML file 31

workflow process from the server 
database to an XML file 30

external products
about defining 389
adding (procedure) 390
table, about 386

extracting data for mobile users
about 425

data extraction rule, creating 426
data loss, about possibility 432
data, specifying that is routed to 427
environment, setting 429
full and partial data extracts, about 431
general steps for 425
nodes. associating with extraction rule 

426
performing (procedure) 431

F
follow-up activities, about 98
formularies

about 206
formulary information, adding to an 

account 207
plan information, adding to an account 

207

G
general activities

account call, entering for 133
activity type, about 97
adding (procedure) 99
Calendar view, creating in 100
Calendar view, creating specialized 

activity in 103
calendar, giving others access to 103
editing an activity 103
meeting, about setting up and list of tasks 

104
meeting, adding (procedure) 104
meeting, adding a meeting activity 105
meeting, adding a meeting invitee 107
meeting, adding a meeting speaker 106
meeting, updating Cost field in the 

Meeting Invitees list 108
guide

audience for guide 15
organization of 16

I
images, about associating with products 401
importing
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DTE maps to a local client from an XML 
file 32

syndicated data extracts, postponing 225
syndicated data files, importing 225
workflow processes to a local client from 

an XML file 31
inactive inventory period, about 137
indirect sales, defined 221
initial inventory

about establishing 152
initial inventory count, about establishing 

169
products, adding and submitting a initial 

count 153
interface tables

data the EIM can process, table of 420
in data import process 412

internal products
adding 395
defining, about 391
internal products, making inactive 397
product categorization settings (table) 

391
samples and promotional items settings, 

about 392
table, about 386

Intersection of Lists option
target lists, applying one or more lists 87
target lists, merging 93

inventory counts
adjusting and common reasons for 173
discrepancies, identifying 176
inventory period, reconciling (procedure) 

179
multiple quantities, adjusting with a new 

adjustment transaction 177
inventory periods

about and types of (table) 137
creating and submitting 175
initial inventory period, reconciling 

(procedure) 157
inventory counts, identifying 

discrepancies 176

inventory period, creating and submitting 
175

multiple quantities, adjusting with a new 
adjustment transaction 177

reconciling (procedure) 179
reconciling, about and prerequisites 173

inventory reconciliation
about and the Prescription Drug 

Marketing Act 136
inventory periods, about and types of 

(table) 137
PDMA compliance and lot numbers 137

inventory tracking
See also lot numbers
initial count adjustments, creating and 

submitting 155
initial inventory period, reconciling 157
managing without lot numbers, about 

154
tracking and reconciling without lot 

numbers (procedure) 155
investigator, assessing fitness of 337
invitee

calls, automatically scheduling 272
MedEd session, registering 271

L
lead time, for MedEd activity defined 253
License Number field, about 51
literature

local database, requesting when using 
287

MedEd session, associating with 256
MedEd session, specifying literature for 

269
product information, associating 398

Literature screen and views, described 43
loss, recording sample loss 173
lot numbers

See also inventory tracking
catalog, adding to 406
defining (procedure) 149
defining, about 148
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inventory and reconciliation of samples 
without lot numbers, enabling 451

lot number tracking, disabling 151
multiple lot numbers, about defining 150
Prescription Drug Marketing Act (PDMA) 

and lot numbers 137
Siebel Samples Management, 

implementation options 33
Lots for Disperse Only system preference, 

about setting to TRUE 151

M
Manager List Mode user property

default settings (table) 25
mapping template, creating 372
market, adding 395
marketing goal. See objectives
materials, specifying for MedEd session 270
MedEd activity, about 98
MedEd classes user properties, C++ 

classes created for 464
MedEd event term, defined 244
MedEd events, managing

activity plan, creating from a MedEd 
event 264

aggregated activity costs, viewing for a 
MedEd plan 266

business scenario 245
call to an invitee, automatically 

scheduling 272
contact or employee, inviting to a MedEd 

event 270
correspondence, generating for multiple 

invitees 272
event types, about 244
invitee, registering for a MedEd session 

271
lead time for MedEd activities, defined 

253
literature item, adding to the application 

256
MedEd activities, about tracking costs 264
MedEd activity, recording cost of 266

MedEd attendees, about inviting and 
registering 270

MedEd event, creating an activity 
template for 253

MedEd events, about 260
MedEd events, creating 261
MedEd literature, about administering 

255
MedEd master plan, creating 252
MedEd plan, about establishing funds 249
MedEd plan, creating 258
MedEd plan, specify which plan to charge 

for event costs 263
MedEd plan, steps to establish a fund and 

associate with plan 251
MedEd plan, verifying that a fund is 

available for association with 251
MedEd settings, lists of values for (table) 

254
MedEd speaker, designating a contact as 

256
sessions, about setting up within MedEd 

event 267
sessions, creating for MedEd event 267
sessions, specifying literature for a MedEd 

session 269
sessions, specifying material for a MedEd 

session 270
speakers, viewing all 266
subplan, creating 259
terminology 244
workflow for managing MedEd events 

example 247
MedEd screen and views, described 43
MedEd Team term, defined 244
meeting

activity type, about 97
Cost field, updating in the Meeting 

Invitees list 108
invitee, adding 107
meeting activity, adding a 105
meeting, adding a 104
New Meeting button, about using 104
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setting up, about and list of tasks 104
speaker, adding 106

Microsoft Project
project data, about exchanging with 384
Siebel Project fields, mapping to 372

mobile users
data, specifying that is routed to 427
environment, setting 429
extracting data, about 425
extracting data, about full and partial data 

extracts 431
extracting data, about possible data loss 

432
extracting data, creating data extraction 

rule 426
extracting data, general steps for 425
extracting data, performing (procedure) 

431
nodes, associating with an extraction rule 

426
Smart Call, about synchronizing before 

using 218
submitting account calls, about 133
submitting contact calls, about 129
syndicated data, steps for loading and 

distributing 421
mobile Web clients

position rollup, setting up for 30
site team, about assigning employees to 

331
Multi-Value Group fields, controlling query 

behavior 465
My Routes view, using to schedule calls 95
My Team’s Contacts view, 7.0.3 version 

contact changes 58
My Team’s filter, understanding behavior of 

25

N
Name field drop-down list, about sample 

not appearing 127
New Call button, using to add account call 

115

New Meeting button, about using 104

O
objectives

Actual Amount fields, about loading 
using EIM 285

attachments, adding to an objective 284
business scenario 277
creating an objective 280
dates, changing for an objective 285
defined 275
deleting an objective, about 281
literature items, requesting when using 

local database 287
Objectives screen, views available from 

(table) 279
recommended activities, about adding to 

objective 281
recommended activities, adding to an 

objective (procedure) 282
recurring objectives, about creating 281
reviewing objectives 286
status of activities associated with an 

objective, changing 287
status of an objective, checking 288
status of an objective, checking using 

charts 288
target accounts or contacts, specifying for 

an objective 283
teams and individuals, about defining 

objectives for 276
workflow (diagram) 278

Objectives screen and views, described 43
Opportunities screen and views, described 

43
Orders screen and views, described 43
Organization Analysis view, using to add a 

contact to a project 379
organization of guide 16

P
partner account, adding to a project 379
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payer information, adding 224
payment amounts

ad hoc payments, generating 348
final adjustments, making and generate 

payment 346
protocol, rolling up paid amounts 349
subject visit activities, setting site-specific 

payment amounts 344
payment exceptions, about setting payment 

exceptions for a site 344
Payment Flag, about using to indicate 

payment subject activities 340
payment subject activities, about 340
Payments screen and views, described 44
PDMA. See Prescription Drug Marketing Act 

(PDMA)
peer affiliations

account’s upward and downward 
affiliations, viewing 202

list, about 201
personal lists

about 74
business scenario 76
creating about 82
product, adding to a personal list 83

plan designs
about 206
formulary information to an account, 

adding 207
plan information, adding to an account 

207
Plan term, defined 244
position rollup, setting up for mobile Web 

clients 30
position types, adding as products 371
Pre-Call view tab

pre-call information, about viewing 205
pre-call information, viewing 67
pre-call information, viewing (procedure) 

206
Prescription Drug Marketing Act (PDMA)

inventory reconciliation, and 136
PDMA compliance and lot numbers 137

workflow issues 136
price lists, defining

See also products, managing
about price lists 400
price list, adding 400
product, associating with a price list 401

Primary Specialty
data, about using EIM to load 52
field, about 51

printing
current Calendar view 103
trip report 358

Priority field, enabling sequential 
numbering 445

product information
See also individual product entries
product comparison information, adding 

399
product features, specifying additional 

398
related literature, associating 398
related products, adding information on 

398
product samples, implementation options 

for using Siebel Samples Management 
33

products
See also individual product entries
price list, associating with a product 401

Products screen and views, described 44
products, managing

See also competitor information, 
managing; price lists, defining, and 
individual product entries

business scenario 387
decision issues, about 405
decision issues, adding decision issue 405
external product table, about 386
external product, adding (procedure) 390
external products, about defining 389
images, about associating with products 

401
internal product or a market, adding 395
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internal product table, about 386
internal product, making inactive 397
internal products, about defining 391
lot number, adding to a catalog 406
product categorization settings (table] 

391
product change request record, adding 

408
product comparison information, adding 

399
product features, specifying additional 

398
product information, viewing 407
product, adding to a catalog 406
related literature, associating 398
related products. adding information on 

398
samples and promotional items settings, 

about 392
workflow example 388

Professionals screen and views, described 
43

project activities, about 98
project activity template

about creating 368
activity, using to add to a project 380
creating (procedure) 369

project costs, monitoring
about and displaying cost items 381
costs, viewing associated with a project 

382
Project screen view (table) 374
projects

activity, adding to project using a project 
activity template 380

contact, adding using the Organization 
Analysis view 379

creating (procedure) 377
employees, adding to project 378
partner account, adding to 379
people and accounts, about associating 

with projects 378

promotional items dropped, recording 
information about 127

proprietary data, about 409
protocols

See also clinical protocol site template
currencies and exchange rate dates, about 

setting 340
new protocol, adding 297
payment amounts, rolling up 349
project, about associating with 377
protocol payments, reviewing 318
regions, adding to 299
revising and creating a new subject visit 

template 306
Protocols screen and views, described 44

Q
Quotes screen and views, described 44

R
rate list, creating 371
read-only fields, changing 464
received quantities, tracking discrepancies 

172
reconciled inventory period, about 137
recording calls. See calls, recording
regional study managers. See 

documentation, milestones
regions, setting up

about 299
protocol, adding regions to 299

Rep Specialty drop-down list, about adding 
additional values to 51

resolution activities, adding to a project 382
Retrieve Published Files option, using to 

delay receiving data extracts 225
returned samples, about 158
risk activities, adding to project 382
ROI (return on investment)

analysis, time off territory 238
role, specifying for affiliated account 65
routes
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about 75
Accounts View tab, using to add accounts 

to 90
accounts, about adding to 89
creating, about and list of tasks 87
Explorer View tab, using to add accounts 

to 91
route plans business scenario 77
route, creating (procedure) 88
routing rules, about 421
schedule calls, using the My Routes view 

to 95
schedule calls, using the Target Accounts 

view to 96
scheduling conflicts, about adjusting 96
target lists, about assigning to 92
target lists, assigning to (procedure) 94
target lists, merging 92

Rx data
displaying data about 230
filtering data, about 231
working with, about 230

S
S_PROD_EXT table, about 386
S_PROD_INT table, about 386
S_SYND_DATA table, about using to import 

syndicated data 421
sales data

displaying data, about 230
filtering data, about 231
working with, about 230

sales goal. See objectives
Sample Event Administration, displaying 

167
Sample Management. See Siebel Samples 

Management
sample theft or loss, recording 173
samples

captured signatures 166
inventory and reconciliation of samples 

without lot numbers, enabling 451

Name field drop-down list, sample does 
not appear 127

recorded for the call, application activity 
120

returns, about 158
samples dropped, recording information 

about 126
Siebel Samples Management, 

implementation options 33
samples activities, monitoring (procedure) 

160
samples inventory, about active and 

inactive period 137
samples order, creating (procedure) 170
Samples screen and views, described 44
samples transaction

Add, Adjust, and Submit buttons, about 
enabling or disabling 148

how it works 146
impact on inventory counts, list of 147
line items 175
past samples transaction, about adjusting 

162
product, adding to samples transaction 

163
quantity, adjusting in 165

samples transfer
creating (procedure) 158
creating, about 158
receipt of, about acknowledging 171
receipt of, acknowledging (procedure) 

172
samples, managing

business scenarios, about and list of 140
electronic signatures, about checking 166
electronic signatures, generating receipts 

for calls with 167
initial count adjustments, creating and 

submitting 155
initial inventory count, about establishing 

169
initial inventory period, reconciling 157
initial inventory, about establishing 152
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inventory count, adjusting and common 
reasons for 173

inventory count, creating and submitting 
175

inventory counts, identifying 
discrepancies 176

inventory period, about reconciling and 
prerequisites 173

inventory period, reconciling (procedure) 
179

inventory reconciliation, about 136
inventory tracking and reconciliation, 

about managing without lot numbers 
154

inventory, adding products and 
submitting an initial count 153

inventory, tracking and reconciling 
without lot numbers 155

lot number tracking, disabling 151
lot numbers, about defining 148
lot numbers, about defining multiple lot 

numbers 150
lot numbers, defining (procedure) 149
master inventory, administrator and end 

users establish business scenario 143
master samples inventory, administrator 

establishes business scenario 141
multiple quantities, adjusting with a new 

adjustment transaction 177
sample theft or loss, recording 173
sample transactions, understanding 136
samples activities, monitoring 160
samples order, creating 170
samples transaction, about adjusting a 

past transactions 162
samples transaction, adding a product to 

163
samples transaction, adjusting a quantity 

in 165
samples transaction, how it works 146
samples transfer, about acknowledging 

receipt of 171
samples transfer, about creating 158

samples transfer, acknowledging receipt 
of (procedure) 172

samples transfer, creating (procedure) 
158

Siebel Samples Management, about 
working with calls 138

Signature Audit Administration, 
displaying 166

Signatures form, last name and first name 
fields empty 167

users transfer samples to one another 
business scenario 144

Schedule button
account call, using to automatically 

schedule 114
contact call, using to automatically 

schedule 110
screens, views and functions described 

(table) 42
Service Requests screen and views, 

described 44
Session term, defined 244
sessions, setting up within MedEd event

about 267
creating for MedEd event (procedure) 267
literature, specifying for a MedEd session 

269
materials, specifying for a MedEd session 

270
shipped quantities, tracking discrepancies 

172
sick days, recording as time off territory 234
Siebel Assignment Manager

about 26
contact assignments, about and example 

28
Contact Denormalization mode, 

differences from Assignment Manager 
28

Contact Denormalization mode, rules, 
requirements, and exceptions 29

predefined assignment objects, about and 
table of 26
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Siebel eClinical, setting up mobile Web 
clients for position rollup 30

Siebel EIM, using to import data
about 412
data and related interface tables 420
data and related interface tables (table) 

414
import order, recommended 413

Siebel Project
Microsoft Project fields, mapping to 

Project fields 372
Microsoft Project, about exchanging data 

with 384
Siebel Samples Management

calls, about working with 138
implementation options 33

Siebel Tools
Submit button, about configuring and 

user property values 461
visit generation buttons, configuring 458
visit-type activities, creating 444

signatures
electronic signatures, checking 166
receipts, generating for calls with 

electronic signatures 167
Signature Audit Administration, 

displaying 166
Signature form, last name and first name 

fields empty 167
Site Management screen and views, 

described 44
sites

activities, assigning to using a template 
332

ad hoc payments, generating 348
adding for clinical trial 309
contacts, associating with a 331
documentation, adding documentation to 

336
payment amounts for subject visit 

activities, setting site-specific 344

payment amounts, making final 
adjustments and generating payments 
346

payment exceptions, about setting 344
subject visit template, applying new 

version to a site 316
sites and clinical contacts, managing

activities, assigning to a site using a 
template 332

assessment template, creating 327
assessment template, purpose of 327
business scenarios 322
clinical protocol site template, about 

creating 325
clinical protocol site template, creating 

(procedure) 325
contact and account information, about 

managing 329
document, adding to a site 336
documentation milestones, tracking 335
investigator or contact, assessing 337
site team, assigning to 331
site, associating contacts with 331
workflow examples 323

Smart Calls templates, about 110
Smart Calls, creating

business scenario 214
dates and reference numbers for samples, 

about entering 220
defined 213
deleting a Smart Call, about 217
Smart Call information, entering as an 

administrator 217
Smart Call information, entering as an 

end user 219
Smart Call template, applying to a call 220
Smart Call template, making available to 

users 218
Smart Call, adding as an administrator 

216
Smart Call, adding as an end user 218

SmartScript screen and views, described 44
Solutions screen and views, described 44
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speakers
MedEd event speakers, viewing all 266
MedEd speaker, designating a contact as 

256
meeting, adding a meeting speaker 106

standalone activities, about 380
Status field, changing status to Submitted 

111
subaccounts

about and affect to account data access 
(table) 203

adding subaccounts 204
affiliation between a contact and a 

subaccount, indicating 205
detailed information for, entering 204

subject activities, about 98
subject activity payments, setting up and 

making
activity payment amounts, about 340
ad hoc payments, generating 348
business scenario 341
currency and exchange rate dates, about 

setting 340
payment amounts, making final 

adjustments and generate payments 
346

payment exceptions for a site, about 
setting 344

protocol, rolling up paid amounts to 349
standard payment amounts, setting up in 

the subject visit template 343
subject activities, marking as completed 

345
subject visit activities, setting site-specific 

payment amounts 344
subject visit template

about defining 300
adding a subject visit template 302
creating new a version 306
examples (diagram) 301
new version, applying for an enrolled 

subject 316
new version, applying to a site 316

standard payment amounts, setting up 
343

subjects
enrolling in study 315
entering and screening 312
rescreening a subject 314
subject activities, marking as completed 

345
subject visit template, applying new 

version for an enrolled subject 316
Subjects screen and views, described 45
Submit button

about configuring and user property 
values 461

Contact Call Detail or Account Call Detail 
view, effects when clicked in 120

views, effect on (table) 118
summary records, about and loading into 

S_SYND_DATA table 424
syndicated data

about 410
Data Loading Matrix (table) 436
Data Loading Matrix, about 435
Data Loading Matrix, S_SYND_DATA 

attribute by data source (table) 437
importing (procedure) 439
importing, extracting, and routing, about 

421
loading data into database 421
mobile users, steps for loading and 

distributing 421
troubleshooting loading 432
views requiring syndicated data import 

(table) 433
syndicated data extracts

importing 225
receiving data extracts, postponing 225

system preferences, setting 33

T
target accounts or contacts, specifying for 

an objective 283
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Target Accounts view, using to schedule 
calls 96

target lists
business scenario 76
creating (procedure) 85
creating, steps to create 84
deleting a target list 86
merging a target list 92
one or more lists, applying 86
route, about assigning to 92
route, assigning to (procedure) 94
targeting, about 74, 84
Union of Lists option, applying one or 

more lists 87
Union of Lists option, merging target lists 

93
TargetCategory user property

example (table) 443
table 442

TargetID user property (table) 442
Targeting screen and views, described 45
tasks

creating and associating activities to the 
task 381

defined 380
templates

activities, assigning to a site using a 
template 332

assessment template, creating 327
assessment template, purpose of 327
clinical protocol site template, about 

creating 325
clinical protocol site template, creating 

325
mapping template, creating 372
MedEd event, creating activity template 

for 253
project activity template, about creating 

368
project activity template, creating 

(procedure) 369
project activity template, using to add an 

activity to a project 380

Smart Call template, about 110
Smart Call template, applying to a call 220
Smart Call template, making available to 

users 218
subject visit template, about defining 300
subject visit template, adding a subject 

visit template 302
subject visit template, applying new 

version for an enrolled subject 316
subject visit template, applying new 

version to a site 316
subject visit template, creating a new 

version 306
subject visit template, examples 

(diagram) 301
subject visit template, setting up standard 

payment amounts 343
trip report template, creating 354

theft, recording sample theft 173
Time off territory activity, about 98
time off territory, tracking

about 234
business scenario 235
completed time off territory record, 

submitting 238
routing rules, amending for Time Off 

Territory records 240
time off territory charts, viewing 239
time off territory record, adding 237
workflow tracking time off territory 

example 236
TOT by Creator, chart display described 239
TOT by Reason, chart display described 239
Trip Report button, caution about using 358
trip report template, creating 354
trip reports

 See also clinical trip reports, 
administering and using

about and Trip report view 356
case report form tracking activity, 

creating 361
completing a trip report (procedure) 359
completing after site visit, about 359
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creating (procedure) 356
distributing and archiving 361
printing or emailing 358

troubleshooting, loading syndicated data 
432

U
Union of Lists option

target lists, applying one or more list 87
target lists, merging 93

upward affiliations
account’s upward and downward 

affiliations, viewing 202
list, about 201

V
vacation, recording as time off territory 234
visit generation buttons, configuring 458
Visual Basic, using to load data 424

W
workflow processes

exporting from the server database to an 
XML file 30

importing to a local client from an XML 
file 31

X
XML file

DTE maps, exporting from the server 
database to an XML file 31

DTE maps, importing from a local client 
32

exporting workflow processes from the 
server database to 30

importing workflow processes to a local 
client from 31
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